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Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Getting Started

Overview of Student Financial Planning  
Student Financial Planning automates student financial aid processing.

Oracle Student Financial Planning Cloud Service (SFP) automates the processes of applying for and receiving Student
Financial Aid funds in accordance with United States Department of Education (ED) guidelines and private sources. You
can configure automated communications, tasks, and data exchange with ED, third-party systems, and students for
minimal staff hands-on processing. A Baseline Configuration is delivered and updated with every release to cover the
processing needs for most schools.

Here are some of the things you can do with SFP:

• Configure real-time dynamic checklists and alerts in Student Self-Service to guide students through applying
for, meeting requirements for, and receiving student financial aid through enrollment, withdrawal, separation,
or graduation.

• Configure and automate Institutional Student Information Record (ISIR) processing. Document requests,
electronic document submission with e-signatures, application verification, and ISIR corrections can be
automated.

• Configure and automatically create detailed Costs of Attendance (COAs) for individual students.

• Configure and automate the creation of Financial Aid Award Packages and offers using the student’s COA and
SAI/EFC for Scheduled Academic Years (SAY), Borrower Based Academic Years (BBAY), and other complex ED
eligibility scenarios. You can also award non-ED financial aid programs like CommonLine loans.

• Configure disbursement criteria for automatic disbursement of funds to cover direct costs and authorize
credit balance disbursements instantly as students meet criteria. Handle downstream processing including
electronic and paper student notifications, Common Origination and Disbursement (COD) communications,
G5 drawdowns, and CommonLine disbursement rosters. Automate Post-Withdrawal Disbursements, Late
Disbursements and Grant Overpayments including electronic student notification and disbursement
acceptance.

• Automate the Return to Title IV funds process for program or term withdrawals. Unearned aid is automatically
returned to ED and reinstated if a student returns. Automatic downstream processing for Post-Withdrawal
Disbursements and Grant Overpayments is done by engaging students electronically with Student Self Service.

Note:  SFP is one of two Student Financial Aid (SFA) products from Oracle Higher Education. The other product,
Student Aid Eligibility (SAE), is a subset of SFP features used specifically for U.S. Department of Education (ED)
Institutional Student Information Record (ISIR), document, and professional judgment processing to determine
student eligibility. SFP includes both administrative (Financial Aid System; also known as FAS) and Student Self
Service features. When you see “SFA” referenced in Oracle Help topics, it means the topic is applicable to both SFP
and SAE. In some shared topics, you may see "SFP only" or similar language if part of a topic is only applicable to SFP.

1
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State and Institutional Financial Aid  
Use configurable mechanisms to collaborate with system integrators and other schools to administer state and
institutional student financial aid.

For individual US state and institutional fund processing, Oracle Student Financial Planning Cloud Service provides
configurable mechanisms so institutions can administer funds based on the fund guidelines. Oracle encourages
institutions and system integrators to collaborate on solutions using the provided mechanisms. Sharing these solutions
can be a value-added service to the broader Higher Education community through portable setup and configuration.

2
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2  Understanding Status Definitions

Status Definitions  
Here are definitions of statuses used across Student Financial Aid (SFA) features. Status Definitions that are only
applicable to the Student Financial Planning (SFP) product and not to the Student Aid Eligibility (SAE) product are
indicated with the Note: "These statuses are used in SFP only."

Academic Statuses
The academic status is defined by the institution's Student Information System (SIS).

Note:  These statuses are used in SFP only.

Status Description

RG Regular

AP Academic Probation

DA Disqualified for Admission

AD Academic Disqualification

SD Scholastic Disqualification

SS Scholastic Suspension

EX Expulsion

Admission Statuses
The admission status is defined by the institution's Student Information System (SIS).

Note:  These statuses are used in SFP only.

Status Description

AM Admitted

CD Conditional

DC Denied for Cause

DE Admission Deadline Exceeded

DF Deferred

DN Denied

3



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 2
Understanding Status Definitions

ND Non-Degree

OP Orientation Pending

PV Provisional

RE Re-entry Required

RI Registered International Credits

RG Regular

RR Registered

Batch Job Execution Report

Status Description Suggested Customer Actions

ABANDONED No activity has been detected from the job for 1
hour so the job is marked as ABANDONED. This
is an abnormal terminal job execution status.

Clients can trigger the job using the procedure
described in KM article 2782213.1 or wait for
the job to run using the system’s batch jobs
schedule. If subsequent runs of the job finish in
an ABANDONED status, clients should open an
SR.

COMPLETED The job successfully completed processing as
many records as possible.

Clients should review existing reporting to
reconcile for potential errors that might have
occurred during job processing.

FAILED The job failed due to an internal error. Clients can trigger the job using the procedure
described in KM article 2782213.1 or wait for
the job to run using the system’s batch jobs
schedule. If subsequent runs of the job finish in
a FAILED status, clients should open an SR.

STARTED The job is running and processing data. None.

STARTING The job was triggered to start but has not
started processing data.

If a job remains in this status for an extended
period of time, this can indicate the job is
awaiting system resources to proceed. If a job
does not move from STARTING status, clients
should open an SR.

STOPPED The job was forced to stop by an internal
process.

Clients can trigger the job using the procedure
described in KM article 2782213.1 or wait for
the job to run using the system’s batch jobs
schedule. If subsequent runs of the job finish in
a STOPPED status, clients should open an SR.

UNKNOWN The job finished with an unanticipated status.
No additional completion information is
available.

Clients can trigger the job using the procedure
described in KM article 2782213.1 or wait for
the job to run using the system’s batch jobs
schedule. If subsequent runs of the job finish
in an UNKNOWN status, clients should open an
SR.

Disbursement Acceptance Statuses
A disbursement may require acceptance (that is, Late Disbursements and PWDs) and will follow certain state transitions
throughout it's life-cycle.

4
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Note:  These statuses are used in SFP only.

Status Description

Disbursement Acceptance Pending For Title IV loans, Disbursement Acceptance outbound message is sent to student/parent and requires
accepted value

Disbursement Acceptance Not Required For Title IV grants, eligible PWD or Late Disbursement is automatically disbursed and does not require
acceptance

Disbursement Accepted For Title IV loans, the PWD or Late Disbursement has an accepted value from student/parent

Disbursement Not Accepted For Title IV loans, the PWD or Late Disbursement was not an accepted from student/parent

Disbursement Not Accepted by Due Date For Title IV loans, the PWD or Late Disbursement was not an accepted from student/parent by
configured due date

Disbursement Criteria Statuses
Note:  These statuses are used in SFP only.

Status Description

Not Met Requirements for the disbursement criteria have not been fulfilled

Met Requirements for the disbursement criteria have been fulfilled

Disbursement Statuses and Triggers
Note:  These statuses are used in SFP only.

Status Description Trigger

Projected Disbursement Amount and Anticipated
Disbursement Date has been determined,
 but the fund has not yet been awarded or if
awarded requires acceptance

The student has been packaged and the
disbursement amount and anticipated
disbursement date is set, however, the fund
status is Projected or Estimated

Disbursement Scheduled Anticipated Disbursement Date and
Disbursement Amount is determined but the
Disbursement has not met the Origination
Criteria (if applicable)

Fund has been Awarded and Accepted
and Origination Criteria (that is, acceptable
enrollment/admissions status)

Pending COD Origination Start Date For non-campus based Title IV funds (excluding
IASG), fund is pending COD origination start
date

Fund has met configurable Origination Criteria,
 but COD is not open for the award year
 
Origination Criteria is evaluated in the
Origination Batch Job
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Origination Ready to be Sent to COD For non-campus based Title IV funds (excluding
IASG), fund is ready to be originated/re-
originated

Fund has met configurable Origination Criteria
 
Origination Criteria is evaluated in the
Origination Batch Job
 

Origination Sent to COD For non-campus based Title IV funds (excluding
IASG), Origination/Re-origination file sent for
the disbursement

An origination request has been sent to COD

Origination Rejected For non-campus based Title IV funds, COD has
rejected the origination for the disbursement

COD returned a response of Rejected to the
origination request

Origination Accepted For non-campus based Title IV funds, COD has
accepted the origination for the disbursement

COD returned a response of Approved to the
origination request

Disbursement On Hold For NFR Funds where the funds are not yet
ready to be disbursed

A user has manually placed a disbursement On
Hold

Disbursement Canceled Disbursement has not been disbursed and is
being canceled

Disbursement has not disbursed and is being
canceled
 
(See Cancellation Reasons)
 

Disbursement Ready to be Sent to COD For non-campus based Title IV funds (excluding
IASG), disbursement is ready to be sent to COD

All Disbursement Criteria for the disbursement
has been Met
 
Disbursement Criteria is evaluated in a
Disbursement Criteria batch job
 

Disbursement Sent to COD For non-campus based Title IV funds (excluding
IASG), disbursement file sent to COD

The disbursement request has been sent to
COD

Disbursement Rejected For non-campus based Title IV funds, COD has
rejected the disbursement

COD returned a response of Rejected to the
disbursement request

Disbursement Ready for Review School can configure a Non-Federal Fund to
require user review after disbursement criteria
is evaluated and met

A Non-Title IV disbursement meets all
Disbursement Criteria but requires user review

Disbursed For non-campus based Title IV funds, COD has
accepted the fund
 
For all other funds, the fund has met the
disbursement criteria
 

COD returned a response of Approved to the
disbursement request OR
 
A Non-Title IV disbursement that required
review, has been reviewed and approved by a
user
 

Disbursement Returned Disbursement has been disbursed and a part of
all of the disbursement is being returned

Disbursement requires to be returned
 
eligibility amount changed (reduced)
 
student requested to return a portion of the
funds
 
a credit balance check was returned
 
return to Title IV calculation resulted in a return
 

Held for QC Review Disbursement is On Hold due to a QC Hold Disbursement is subject to a disbursement
related QC Hold
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QC Reviewed Disbursement is no longer On Hold and will
subsequently be disbursed, canceled, or
returned

A disbursement related QC Hold has been
released

Pending Re-opened Award Year System has created a negative disbursement
for an Award Year that has been closed-out

There is a return or a disbursement required for
an Award Year that has been closed out

Pending Previous Financial Award ID
Cancellation

This status is used when a student is converted
with more than one Financial Award ID for
a single loan period. Student Financial Aid
holds all originating and disbursing for the
latest financial award ID until all non-disbursed
disbursements are canceled.
 
In order to ensure that the newly created
Financial Award ID is used moving forward,
 Student Financial Aid displays this status until
the old (converted) IDs are fully canceled.
 

Student is converted and has more than one
Financial Award ID for a single loan period

Pending COD Acceptance of Stafford Loan When the award amount changes for
Subsidized and Unsubsidized funds in the same
academic year, Student Financial Aid prevents
re-originating the fund with the increased
amount until the decreased amount has been
fully accepted by COD.

One Stafford Loan has been increased while
the other has a decreased amount and
communication with COD is pending

Pending Loan Fees Update When the loan fee and rebate amount
associated to a fund changes, the existing
award needs to be canceled with COD prior to
originating the new amounts. This status will be
used on the newly created disbursements while
waiting for the prior amount to be canceled.

Loan Fee Percentage Period has changed

Pending Previous Award Year Cancellation
 

When a disbursement is associated with
multiple award years, Student Financial Aid
waits until the award year being canceled
is fully canceled prior to originating the
current year disbursement. The current year
disbursement remains in a Pending Previous
Award Year Cancellation status until the award
year being canceled is fully canceled.

Disbursement for a previous award year is
being canceled

Document Information

Document Type Definition

Document An official paper or computer file that provides information or proof about a student/spouse/parent
borrower

Metadata Data that provides information about other data (e.g. First Name, Date of Birth, Social Security Number
etc.)

Document Sub-Type A document that requires multiple documents under one document name because each version
contains different information or proof about a student/spouse/parent borrower (e.g. W2s, Tax
Returns, Student Statement)

7
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Document Statuses

Status Description

Requested Document request has been sent to the student or appropriate party/system
 
Document continues to be displayed in the Pending Requests screen unless the Document Request is
canceled by a user
 

Received Document message has been received from the institution's Document Management System and has
not been accepted or rejected by Student Financial Aid
 
Manual Review Required (either based on configuration or due to failing metadata acceptance logic)
 
Document Remains in a required state and will only be updated to No Longer Required if the Manual
Review results in the document being Approved or Canceled
 
Document continues to be displayed in the Pending Requests screen until Manual Review is complete
and removed only if the Manual Review results in the document being Approved by a user or the
document request is Cancelled by a user
 

Acceptable Document has been received and has passed validation and all acceptance criteria
 
Document does not require manual review (manual review may have been required, but has been
completed and document was approved)
 
Document is updated to No Longer Required
 
Document is no longer displayed in the Pending Requests screen
 

Unacceptable Document Management System determined the document was Unacceptable upon receipt or the
document has been manually rejected by a user
 
Document is still required
 
Document continues to be displayed in the Pending Requests screen unless the document request is
Canceled by a user
 

Inactive Document has passed its expiration period (e.g. only active for their associated award year).
 
Example: If a FAFSA for a closed award year is received after the configured Award Year ISIR Deadline
Date, the document status is updated to Inactive
 

Eligibility Statuses
Note:  These statuses are used in SFP only.

Status Description

Eligible Student meets eligibility requirements for the type of Title IV funding

Ineligible Student does not meet eligibility requirements for the type of Title IV funding

8
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Enrollment Statuses (Hours)
Note:  These statuses are used in SFP only.

Status Description

Full Time 12+ semester hours per semester/trimester or 12+ quarter hours per quarter

Three Quarter Time 9 - 11 semester hours per semester/trimester or 9 - 11 quarter hours per quarter

Half Time 6 - 8 semester hours per semester/trimester or 6 - 8 quarter hours per quarter

Less Than Half Time less than 6 semester hours per semester/trimester or less than 6 quarter hours per quarter

Enrollment Statuses (Student)
Note:  These statuses are used in SFP only.

Status Code Description

Admitted/Not Started AM The student has not yet started any coursework
but has been admitted to the institution

Full-time F Student is enrolled full-time and is actively
attending class

Half-time or more, but less than full-time H Student is enrolled at least half-time, but less
than full-time
 
Does not apply to non-term schools
 

Less than half-time L Student is enrolled less than half-time
 
Does not apply to non-term schools
 

Approved Leave of Absence A Student is currently enrolled at this institution
but is on an approved leave of absence

Never Attended X Individual on whose behalf a loan was certified
or awarded, who was admitted, may have
enrolled (registered), but never attended
classes at this institution
 
(Institution does have a record of the individual)
 

Cancel C Student has canceled their prospective
enrollment

Graduated G Student has completed the course of study and
is not currently admitted to, nor enrolled in, a
different course of study at this institution

Deceased D Student is deceased

9
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Withdrawn (voluntary or involuntary) W Student has officially withdrawn from all
courses at this institution, stopped attending all
classes at this institution but did not officially
withdraw, or for any reason did not re-enroll
at this institution for the next regular (non-
summer) term without completing the course
of study

Enrollment Statuses (Sub Type)
Note:  These statuses are used in SFP only.

Status Code Description

Deceased D Student is deceased

Official Withdraw OW Student has officially withdrawn from all
courses at this institution

Unofficial Withdraw UW Student stopped attending all classes at this
institution but did not officially withdraw
 
Student did not re-enroll at this institution for
the next regular (non-summer) term without
completing the course of study
 

Administrative Withdraw AW Student has been withdrawn due to a failure to
pay tuition and fees

Enrollment Types
Enrollment types are followed by the Enrollment Start Date (i.e. Original Enrollment - Enrollment Start Date).

Note:  These statuses are used in SFP only.

Type Description

Original Enrollment The Enrollment Type is being set for the first time and student is not an External Transfer OR
 
Student does have a prior enrollment, but the Enrollment Type is not any of the following:
 
Advancing Degree
 
Re-Entry within 180 Days
 
Re-Entry after 180 Days
 
Change of Program - Same Payment Period
 
Change of Program - New Academic Year
 

External Transfer Student does not have any prior enrollment within the system AND
 

10
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Student has an overlapping loan period from a different school
 

Advancing Degree Student has a prior enrollment (internally) that overlaps their current enrollment and the status of the
prior enrollment is Graduated

Changing Programs - Same Payment
Period

Student Changed Programs and Met all conditions required to remain in the same payment period

Change of Program - New Academic Year Student Changed Programs and did not Meet all conditions required to remain in the same payment
period and is not re-entering the same program within 180 days

Re-Entry within 180 days Student is not an External Transfer and is re-entering into the same program equal to or less than 180
days from the latest Official Last Date of Attendance (OLDA)

Re-Entry after 180 days Student is not an External Transfer and is re-entering into the same program greater than 180 days
from the latest Official Last Date of Attendance (OLDA)

Fund Acceptance Statuses
Note:  These statuses are used in SFP only.

Status Description

Pending Acceptance Fund has met configured award criteria but requires fund acceptance

Accepted Fund has been accepted

Fund Not Accepted Fund not accepted by the student

Fund Not Accepted by Due Date Fund acceptance not received by configured due date for fund type

Fund Limited by Previous Acceptance Fund Acceptance is Pending Additional Acceptance and additional fund acceptance not received by
configured due date.

Pending Additional Acceptance Fund Acceptance has been received and award amount has increased.

Fund Statuses
The Fund status is found in the Fund Information Table on the Packaging Screen.

Note:  These statuses are used in SFP only.

Status Description

Projected Required input data is not Actual.
 
For inputs to be Actual the following is required:
 
Valid ISIR or an Unverified ISIR (ISIR status is based on fund type) for the Award Year that is being
awarded. If the ISIR is Valid for a past award year, the status will remain Projected.
 
NSLDS record received within the last 30 days.
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Status Description

The fund code Effective_Date within the FAS_FUND_CONFIG configuration workbook has not been set
or hit for the fund award year.
 
COA configuration for the fund award year has not been set.
 

Estimated Required input data is Actual
 
ISIR and NSLDS are acceptable to progress to Estimated status
 
Award criteria batch job has run and fund type has Not Met all configured award criteria
 
Award Criteria is visible ...
 
For Non-Federal Funds (NFF) the status should be manually set during the awarding process
 

Awarded Award Criteria batch job has run and fund type has Met all configured award criteria or the fund type
does not have to satisfy any award criteria
 
For NFF Funds the status should be manually set during the awarding process
 
For Other Resource Funds, Student Financial Aid sets the status to Awarded
 

G5 Statuses
Note:  These statuses are used in SFP only.

Status Description

G5 Ready Disbursement satisfies all set G5 ready criteria

G5 Ready - Refund Disbursements to be refunded to ED

G5 Confirmed Disbursement has been drawn down from G5

G5 Confirmed - Refund Disbursement has been refunded from successful G5 draw down transaction

Grant Overpayment Statuses
Note:  These statuses are used in SFP only.

Status Description

Not Reported Grant Overpayment exists on the student record, but the overpayment has not been reported to
NSLDS or referred to DRS

Reported Grant Overpayment exists on the student record and the overpayment has been reported to NSLDS or
referred to DRS

Resolved Grant Overpayment on the student record has been resolved and set to zero
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ISIR Code/Discrepancy Statuses

Status Description

Auto Cleared Any configured statements for automatic resolution have been evaluated

Clearance Not Required The code/discrepancy has been configured to not require clearance (e.g. comment code) and is strictly
informative

Manually Cleared Any configured statements for automatic resolution have been evaluated, but could not automatically
clear the code/discrepancy
 
The code/discrepancy has been cleared from the manual review task
 

Processing The code/discrepancy is not clear, but is processing based on configured rules or within the manual
review task

Student Follow Up The code/discrepancy has been configured to require a follow-up student action to resolve the issue
 
The code/discrepancy is pending an update to be made via FAFSA on the Web
 

ISIR Statuses

Status Description

Inactive ISIR is not the active ISIR for the student. Either a subsequent ISIR has replaced the current one, or it
was received before/ after the end of the ISIR Review - corrections period.

Pending ISIR is selected as the active ISIR and is pending the ISIR Review and/or ISIR Verification process

Unverified ISIR has been cleared of any required resolution for ISIR Review but has not been verified due to being
received outside of the ISIR Verification period.
 
Also could be set if a user cancels the ISIR Verification process (Future At Will Action)
 

Invalid User has elected to cancel ISIR Review (Future At Will Action)
 
The ISIR has been manually updated to an invalid status by an authorized user (At Will Action)
 

Corrected ISIR has been corrected based on ISIR Review and/or ISIR Verification

Valid ISIR has been cleared of any required resolution for ISIR Review, has been verified (if required) and can
be used to determine eligibility for all Title IV funding for the student

MPN Statuses
Note:  These statuses are used in SFP only.

Status Description

A Accepted
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R Rejected or not on file with Common Origination and Disbursements (COD)

P Pending

C Closed

I Inactive

Packaging Statuses
The packaging status is found on the Packaging screen under the Packaging Summary.

Note:  These statuses are used in SFP only.

Status Description

Estimated All funds in the Academic Year are Estimated or Projected

Partially Awarded At least one fund in the Academic Year is Awarded and at least one other fund in the Academic Year is
not Awarded

Awarded All fund statuses in the Academic Year are Awarded

Pending Repackage If the package has been or needs to be manually repackaged

QC Hold Statuses
Note:  These statuses are used in SFP only.

Status Description

On Hold Status when a QC Hold for a FAS process is in progress

Released Status when a QC Hold has been either released by a user or auto-released by the FAS (in the instance
the QC Hold is replaced via a repackage)

Replaced by Updated Hold Status when hold has been replaced by an updated amount for that particular hold level for that FAS
process

Hold No Longer Valid Status when a hold has become outdated, but the replacement hold has not yet been created due to
sequence of the FAS processing

R2T4 Process Statuses
Note:  These statuses are used in SFP only.

Status Description

Not Required The R2T4 calculation is not required
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Not Started The R2T4 calculation has not started

Scheduled The R2T4 calculation has been scheduled

Paused The R2T4 calculation has been paused

Held for QC Review The R2T4 calculation is on hold due to a QC Hold

Canceled The R2T4 calculation has been canceled

Completed The R2T4 calculation has been completed

R2T4 Process Pending Reasons
Note:  These statuses are used in SFP only.

Status Description

Pending Configured Delay The school can configure the R2T4 to trigger immediately or after a specific number of days based
on the type of withdrawal. For example, if a student has a withdrawal type of Official Withdrawal, and
the configured delay is 0 days, the R2T4 calculation may be triggered once the enrollment status is
received. However, if a student has a withdrawal type of Unofficial Withdrawal, and R2T4 calculation
has a configured delay of 14 days the R2T4 calculation will be triggered on the 15th day from the
student's Date of Determination (DOD).
 
Withdrawal Types
 
Official Withdrawal
 
Unofficial Withdrawal
 
Administrative Withdrawal
 
Deceased
 

Note:  The default trigger time frame for all withdrawal types will be 0 days if no configuration is
defined.

Any changes that effect the trigger time frame that are received before the R2T4 calculation is
triggered, do not change the scheduled calculation. For example, if the student's DOD is changed
within the time period that an R2T4 calculation is scheduled, the calculation will still be triggered on
the day it was originally intended.
 

Pending R2T4 SAFI The R2T4 calculation is ready to be calculated and Student Financial Aid has requested an R2T4
SAFI (i.e. the ReturnToTitleIvSafiIndicator is true). Student Financial Aid will wait until the new SAFI is
received, and will allow any repackaging prior to doing the R2T4 calculation

Pending Valid ISIR Process If the status of an active award year ISIR (associated to the payment period) is Pending, Student
Financial Aid will wait for the open Valid ISIR process to be completed before triggering the R2T4

Pending Packaging Process If the Academic Year Packaging status for the payment period being assessed is Pending Repackage,
 Student Financial Aid waits until the packaging or repackaging process is completed before doing the
R2T4

Pending Ledger Date Reconciliation If the Ledger Posting Date in the Student Resource Element of the latest SAFI does not equal the
disbursement date for the matching payment ID or have all the payment IDs, Student Financial Aid
waits until a new SAFI is received and completes the reconciliation prior to doing the R2T4

15



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 2
Understanding Status Definitions

Pending Change of Program Task Queue The R2T4 calculation is pending the completion of an Evaluate Student Change of Program task.
Student Financial Aid waits because if the student remains in the same payment period the R2T4
calculation will be canceled.

Pending Override Completion If there is an R2T4 override that is still processing, the calculation will wait for it to be completed before
doing the R2T4 calculation.

Note:  Student Financial Aid triggers the R2T4 calculation 30 days from the Date of Determination, to ensure that
the calculation is run within the required time frame set by the Department of Education (i.e. 45 days to process
return of funds to the Department of Education and 30 days to request authorization to make a post-withdrawal
disbursement of Title IV loan funds). Student Financial Aid does consider the current state of the active ISIR,
package and disbursements at this time. If the active ISIR(s) for the associated award years of the payment period
being assessed for R2T4 are not in a status of Valid or Unverified, the system triggers a cancellation of all future
disbursements that rely upon the active ISIR(s). The R2T4 calculation persists based on the current state of anticipated
disbursements that have been canceled (and/or have a cancellation reason set).

Reconciliation Discrepancy Statuses
Note:  These statuses are used in SFP only.

Status Description

Pending Discrepancy has not yet been reviewed for resolution but has been triggered from the Reconciliation
process

Resolved in FAS User has resolved discrepancy based on their review and other updates persisted in the FAS

Resolved in COD User has resolved discrepancy based on their review and other updates persisted outside of the system
in COD

Unresolved User cannot resolve the discrepancy and will be carried forward into future reports

Reconciliation Statuses
Note:  These statuses are used in SFP only.

Status Description

Pending Reconciliation record has not yet been reviewed or approved

Reconciled User has approved reconciliation record summary

Unreconciled User has not approved reconciliation record summary

Repackaging Triggers
Note:  These statuses are used in SFP only.
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Trigger Source Trigger Description (i.e. Repackaging Reason)

SAFI Message Student Academic and Financial Information Message was received

ISIR status has been updatedISIR

Subsequent ISIR was not validated prior to Valid ISIR Deadline being reached

Student Demographic Information
Message

Student Demographic Message was received

Fund Acceptance Message was receivedFund Acceptance

Fund Acceptance was not received by due date

SAP Status Updated SAP Status was updated

LOA LOA/Breaks Message was received

LOA Student has begun LOA

PLUS Loan Application Message was received

Credit Status Response Message was received

Credit Decision Override Message was received

TEACH Grant Counseling Acknowledgement Message was received

COD Message Classes

ATS Note Acknowledgement Message was received

Disbursement Criteria Disbursement Criteria not met by due date

Disbursements Canceled Disbursement were re-evaluated

Aid Year Close Out Award Year is closed and pending disbursement exists

Award Management At least one fund has become Awarded

NFR NFR Fund was added or modified

NSLDS NSLDS/FAH Message was received

Package Detail Override Package details were manually overridden

Package Detail Override COA details were manually overridden

Academic Year / Payment Period
Instructional Weeks and Credits have been
met

Student's Academic Year / Payment Period Credits and Instructional Weeks have been met

External Transfer Overlapping Loans for External Transfers Evaluated

Change of Program Student Changed Programs

Re-Entry within 180 Days Student re-entered within 180 days

Re-Entry after 180 Days Student re-entered after 180 days

Student Record Hold Student Record Hold was released

Sequester Reduction Required Sequester Reduction was Required
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Payment Period Disbursement Amount
or Payment Period Max Disbursement
Amount is Updated

Disbursements are updated, affecting projections for future loans.

Fund Allocation Fund allocation has been reached and amount needs to be adjusted

At will repackaging Student was repackaged at will

COA Adjustment An adjustment was made to the student's COA

Academic Year Overrides Academic year info overridden

Default Overpay Code Overridden Borrower Default Overpay Code Manually Overridden

Student Record Manually Overridden Student Record Details were manually overridden

Awarding Close Out Awarding has closed and funds not Awarded

Student Ended PP After Credits and Weeks
Met

Student Ended PP After Credits and Weeks Met

SAP Statuses
Note:  These statuses are used in SFP only.

Status Code Description

Regular RG Student has met all minimum criteria to pass
their SAP or is a new student
 
Student is eligible to receive Title IV aid
 

Financial Aid Warning FW Student has not met either the minimum
qualitative (GPA) measure or the quantitative
(pace of completion) for the period
 
Student is eligible to receive Title IV aid
 

Financial Aid Disqualification FD Disqualified from receiving any financial aid
until SAP can be met
 
Student is not eligible to receive Title IV aid
 

Financial Aid Probation FP Appeal granted for one payment period
 
Student is eligible to receive Title IV aid
 

SAP Statuses (Appeal)
Note:  These statuses are used in SFP only.
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Status Description

Approved Student has appealed, and the decision has been approved

Denied Student has appealed, and the decision has been denied

SAP Statuses (Component)
Note:  These statuses are used in SFP only.

Status Description

Pass The SAP component evaluation passed configured criteria
 
Components: Pace of Completion, Maximum Program Time Frame, and GPA
 

Fail The SAP component evaluation failed configured criteria
 
Components: Pace of Completion, Maximum Program Time Frame, and GPA
 

Scheduling Statuses
Note:  These statuses are used in SFP only.

Status Description

Passed Student completed the course and earned a passing grade.

Scheduled Student is scheduled to take the course at a future date.

Projected Student is projected to take the course at a projected future date.

Enrolled Student is currently enrolled in the course.

Failed Student completed the course and earned a non-passing grade.

Incomplete Course has ended, but students in the process of completing the course work.

Withdrawn Student withdrew from the course.

Student Notification Categories

Category Description

Informational Only A notification intend to provide information to the student. No action required.

Submit Document/Information A notification for the student to submit a document or additional information to the Institution that can
be consumed by the FAS. Action required.
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FA to Collect Student Info A notification for the student to provide the Financial Aid Office with additional information. However,
the student will not need to submit a document or additional information that can be consumed by the
FAS. (e.g. Verbal clarification about available information on the Student Record). Action required.

Student Notification Statuses

Status Description

Open Student Notification is Open and requires the student/borrower action.

Closed Student Notification is Closed and does not require any additional action from the student/borrower.

Task Statuses

Status Description

Assigned Assigned to an individual user
 
The user has not started the task
 

In Progress Assigned to an individual user
 
The user started the task and can resume working on the task
 

Unassigned Task is not currently assigned to a user. If a task was in an Assigned or In Progress status and a
supervisor manually un-assigns the task, it will be updated to an unassigned status.

Verification Status Codes

Status Description

V The student has been verified. This includes students selected by FPS/CPS and those chosen to be
verified by the institution based on its own criteria.

W The student was selected for Verification by FPS/CPS or the institution, and the institution chose to
pay the first disbursement of Pell without documentation. This code must be updated once Verification
is complete, or COD will reduce the Pell grant to zero.

S FPS/CPS selected the student for verification, but the institution did not verify the student because the
student satisfied one of the exclusions or because the institution participates in the Quality Assurance
Program and the student’s application did not meet the institution's verification criteria.

BLANK A blank value is repaired when an institution does not perform verification because FPS/CPS nor the
institution selected the student to be verified.

20



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 3
Using the Dashboard

3  Using the Dashboard

Dashboard  
This chapter describes the Student Financial Aid dashboard.

Overview
When you login, the page that opens is your Dashboard. The 2 types of dashboards are:

• Task Overview.

• Supervisor View.

The dashboards and information available to you are determined by your role and placement in the organizational
hierarchy. Dashboards provide pertinent summary information to assist you in making decisions to meet your business
goals.

Product Demos
Note:  To view videos on how to use some features documented in this guide, see Oracle Fusion Cloud Student
Financial Aid: Legacy User Guide Demos (Doc ID 2629905.1) on My Oracle Support at https://support.oracle.com.

Task Overview Dashboard
Based on role permissions, you can do the following:

• Claim additional unassigned tasks.

If there are unassigned tasks associated to the student record, Student Financial Aid displays those tasks in a
pop-out dialog box. Upon claiming the first task, you are able to claim additional unassigned tasks at this time
(based on permissions). You can always visit the student record to claim additional unassigned tasks (based on
permissions) later. See Claim A Task.

• Start a task.

You can start a task from the task queue that is assigned to you. Once you click Start, you can review the
task instructions, task details, and add comments (if applicable). If you need to review alternate screens, save
updates prior to navigating away from the task screen (that is, update fields, save corrections for later, and so
on).

• Resume a task.

If you did not have all the information necessary to complete a task, you can resume working the task from the
point you last saved the task before navigating to an alternate screen.

• Request documents.

Some tasks may be configured to allow you to request additional documents from within the task.

• Complete a task.
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If you have all the information needed to complete a task, make all necessary updates (that is, approve/reject,
updates data fields, enter free form text, and so on) click the complete task button to complete the task. There
may be times when you complete a task without resolution, (for example, you are unable to successfully match
a student to an ISIR, Complete ISIR Review task without clearing all codes).

Supervisor Dashboard
Based on role permissions, Supervisors can do the following:

• View task queue metrics.
You can view all the task queues, how many tasks are assigned to a queue, and how many are in an assigned
status.

• View specific task queue details.
You can drill down to a specific task queue and view additional details about a specific queue.

• Assign tasks.
You can assign one or multiple tasks to a user.

• Re-assign tasks.
You can re-assign one or multiple tasks to a different user

• Un-assign tasks.
You can un-assign tasks that have been previously claimed by a user so they can be claimed by new users

• Re-prioritize tasks.
You can update the priority. Priority is based on configuration. If priority is not configured, the system assigns
the oldest unassigned task first (that is, first in, first out).

User Interface Path to Main Screen
Log In > Dashboard.

• Use the Dashboard dropdown to toggle between Task Overview and Supervisor View, depending upon your
role permissions.

.

Tasks  
These are the tasks used in Financial Aid processing.

Each of the task topics describes:

• The task.

• How the task is created.

• How to complete the task.
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• The completed task result.

Complete ISIR Review  
This task is for students that have ISIR C-Codes that need to be reviewed and cleared.

This task is created when:

• An ISIR fails Automated Code Clearing Criteria.

• An ISIR code or discrepancy is flagged for manual review based on system configuration.

Here's how you complete this task:

1. Review ISIR C-Codes.
2. Review related Documents.
3. Clear C-Codes by selecting appropriate values.
4. Click Complete Task or Complete Task with Open Codes.

The expected task results are:

• When C-Codes are cleared and the task is completed, the ISIR becomes valid.

• If the task is completed with open C-Codes, the ISIR remains pending. At-will documents attached to the open
ISIR process can re-trigger the task once the documents are received and accepted.

Complete ISIR Verification  
This task is for students that have been selected for ISIR Verification.

This task is created when an ISIR fails Automated Code Clearing Criteria.

Here's how you complete this task:

1. Review ISIR C-Codes.
2. Review related Documents.
3. Clear Verification by selecting appropriate values.
4. Select Complete Task or Complete Task without Completing Verification.

The expected task results are:

• When completed with all Verification items verified, the ISIR becomes valid.

• When the task is completed without all Verification items verified, the ISIR remains pending. At-will documents
attached to the open ISIR process can re-trigger task queue once the documents are received and accepted.

Evaluate Overaward Packages  
You can review Financial Aid awards for overawarded students with awards that the application can't automatically
lower.
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The application creates this task when a student is awarded funds that exceed their Cost of Attendance (COA) and
can't automatically adjust the funds. This is usually because the funds aren't awarded by the application; for example,
Student Resources.

Here's how you complete this task:

1. Review funds in the student's financial aid package.
2. Manually update funds to resolve the overaward, adjust the applicable Student Resources received in the SAFI,

or adjust the student's COA.
3. Update the Resolution Description value.
4. Click Complete Task.

The expected task results are:

• Packaging Status is updated from Pending Repackage to Estimated, Partially Awarded, or Awarded based
on the fund statuses.

• The next time the application triggers the Disbursement Criteria batch job, the application updates the
Student's Package is not Pending Manual Review Disbursement Criteria to Met.

Evaluate Student Changes of Program  
You can review a student's Financial Aid eligibility if they change academic programs in the same payment period or a
new Academic Year.

This task is created when a SAFI is received for a student with a primary program that is different than that of the prior
SAFI and the student has met conditions necessary to stay in the same payment period.

Here's how you complete this task:

1. Review student data to determine if these 5 criteria are met:

◦ The student is continuously enrolled at the school.

◦ The coursework in the payment period the student is transferring out of is substantially similar to the
coursework the student will be taking when he or she first transfers into the new program.

◦ The payment periods are substantially equal in length in weeks of instructional time and credit hours or
clock hours, as applicable.

◦ There are little or no changes in school charges associated with the payment period.

◦ The credits from the payment period the student is transferring out of are accepted toward the new
program. Student was not on LOA during Program Change.

2. Indicate True or False for each of the 5 criteria.
3. Click Complete Task. The system automatically takes the next course of action based on whether all 5 criteria

are True or False.

Expected task results are:

• A new enrollment is created.

• The student is repackaged.
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Update Origination Files  
You can review students that don't have the required response for a High School Diploma on their ISIR and select the
appropriate Student Eligibility Code. Completing this task allows Direct Loan originations with Common Origination and
Disbursement (COD) to proceed.

The Origination Review Task / Review Origination File Update Task is created when a value of:

• 2 (GED/State Certificate),

• 4 (Neither High school diploma, GED/State Certificate, nor Home schooled), or

• BLANK

is received on the student’s ISIR for the HS Diploma or Equivalent field.

Here's how you complete the task:

1. Select an appropriate value for the Student Eligibility Code and any additionally required fields.
2. Click Complete Task.

Expected task result is originations are sent to COD.

Process an NFF Document  
You can review received Non-Federal Fund (NFF) code documents.

This task is created when a Non-Federal Fund with a configured document code is received requires review.

Here's how you complete this task:

1. Review the Non-Federal Fund Documents to determine next steps based on the requirement of the particular
NFF fund.

2. Make updates as needed to complete task.
3. Update the Resolution Description value.
4. Click Complete Task.

Expected task results are:

• Student can be manually repackaged and packaging logic, if configured, can use document metadata received
and accepted during the document process.

• Document becomes part of the student's record.

Reevaluate a NFF Fund  
You can re-evaluate a Non-Federal Fund (NFF) due to an overaward or if the fund requires final review before
disbursement.
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The application creates this task when:

• An NFF fund is configured to require review prior to disbursing, and all other disbursement criteria have been
met; in other words the disbursement is in the status of Disbursement Ready for Review.

• The student is overawarded and has an NFF fund that needs to be manually adjusted.

Here's how you complete this task:

1. Review Re-evaluation Reason that triggered the task.
2. a. If configured to Re-evaluate Prior to Disbursing, review NFF disbursement to validate it can be

disbursed.
b. If the student is overawarded due to NFF funds, manually update the NFF funds to resolve the overaward.

3. Click Complete Task.

Expected task results are:

• If the Re-evaluation Reason is Re-evaluate Prior to Disbursing, disbursement will progress. If QC holds are
present, disbursement status is updated to Held For QC Review. Otherwise, disburse the fund.

• If the Re-evaluation Reason is Overaward Caused by NFF fund, the packaging status remains in Pending Re-
package until the overaward is resolved, and the fund won't disburse until the overaward is resolved.

Report Grant Overpayment Resolution  
You can do a final review to confirm the resolution when a student's grant overpayment has been repaid and resolved.

This task is created when a Grant Overpayment Balance is automatically set to zero.

Here's how you complete the task:

1. Review the U.S. Department of Education NSLDS professional access website and review the grant
overpayment status.

2. Click Complete Task if the information received and displayed is accurate.

Expected task result is:

• If the task is completed because the Grant Overpayment has been remedied, the Grant Overpayment QC Hold is
created with a Resolved status.

Review Documents for Approval  
You can manually review documents is flagged for manual review due to configuration or that fail automated
acceptance criteria.

This task is created when:

• A document is configured for manual review.

• A document fails automated acceptance criteria.

• An unsolicited document is received with the config flag for review.
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To resolve this task:

1. Review the document.
2. Select a Document Owner.
3. Select an Approval Status.
4. Update Metadata Fields as needed.
5. Select Complete Task.

Expected task results are:

• The document Approval Status is saved and is recognized in future processing.

Once all requested documents requested using the ISIR Code clearing rules are received and accepted, ISIR
Code clearing conditions are evaluated.

Report Grant Overpayment and Notify NSLDS  
You can report students who have not resolved their grant overpayments within the designated number of days to the
National Student Loan Database System (NSLDS) and Debt Resolution Services (DRS).

This task is created when the Grant Overpayment resolution due date is reached, and the student has not repaid the
Grant Overpayment.

To resolve this task:

1. Review external payments to ensure a payment has not been received.
2. If a payment has been received, add the payment within the task.
3. Manually update NLSDS.
4. Select Complete Task.

Expected task results is:

• Grant Overpayment is manually reported to NSLDS, as needed.

Review Professional Judgment  
You can review Professional Judgment decisions.

This task is created when Professional Judgment is received.

Here's how you complete the task:

1. Review the received document.
2. Select the appropriate Approval option.
3. Request additional documents, if needed.
4. Update configured ISIR fields.
5. Click Complete Task.
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Expected task result is:

• An ISIR correction file is created if corrections were made.

Review SAP Appeal  
You can review Satisfactory Academic Profess (SAP) appeals.

This task is created when an SAP appeal is received.

Here's how you complete the task:

1. Review the received document.
2. Select the appropriate Approval option.
3. Override SAP Status, as needed.
4. Click Complete Task.

Expected task results are:

• If you approve the SAP appeal, the application updates the SAP status to FP.

• If you don't approve the SAP appeal, the SAP status remains FD.

• If you cancel the SAP appeal, the SAP status remains FD.

• If the SAP status is updated, the application triggers an SAP letter.

Review SAP Evaluation  
You can review a Satisfactory Academic Progress (SAP) evaluation flagged for manual review.

This task is created when:

• Student is flagged for manual SAP Review via the SAFI.

• Configured criteria is met for a manual SAP review.

Here's how you complete the task:

1. Review SAP Calculation details.
2. Override SAP Status and SAP Calculations, as needed.
3. Click Complete Task.

Expected task result is:

• SAP Status is overridden as needed.

Update Fund Award Year Close Date  
You can review a closed Award Year for a fund when a Refund or Re-Entry has happened within 180 days.
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This task is created when a withdrawn student returns in the same Academic Year that includes funds in a closed Award
Year. You can determine if the closed Award Year needs to be reopened.

Here's how you complete the task:

1. Review the student's return status.
2. Open Award Year, if student is deemed eligible for funds.
3. Click Complete Task.

Expected task result is:

• Funds are reinstated if Award Year is re-opened.

Task Overview  
The Task Overview Dashboard enables you to manage your individual workflow by starting/resuming, working and
completing tasks.

Overview
Student Financial Aid defaults to the Task Overview Dashboard upon login. From the Task Overview screen you can
view a snapshot of the number of tasks that have been assigned to you from specific task queues and in which task
queues you can claim available, unassigned tasks.

Note:  You can only see task queues that your assigned roles have been assigned the general permissions to view.
Task queue permissions are assigned to you based on your primary responsibilities.

What Student Financial Aid Does Automatically
Student Financial Aid (SFA) automatically does the following things:

Displays task queues
SFA shows only the task queues the user has permission to view. However, there may be other permissions that have
been restricted so the user can view the task queue, but not complete any associated tasks.

Informs the user there are tasks available tasks to be claimed
When tasks are available and are unassigned, SFA displays a download icon in the left sidebar of the associated task
queue.

Informs the user how many tasks are assigned to the user
When tasks are assigned to a user, SFA sums the total number of assigned tasks and displays the number in the left
sidebar of the associated task queue.
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Displays each task assigned to you in each task queue
You can view tasks that you have either claimed or that have been assigned to you by your supervisor. Within the
task queue, you can easily determine which tasks are new (start button) versus the tasks already in progress (resume
button).

Displays Non-Completed Tasks
When you claim a task SFA will display a pop-out dialog box if there are any other non-completed tasks associated to
the student record. This allows you to see if there are tasks associated to the Student Record, claim unassigned tasks
(with applicable permissions), see if tasks are assigned to other users and the status of those tasks.

The pop-out dialogue box allows the user to gain additional details related to open/pending tasks and to continue
working a student record if multiple tasks are open for the student.

The user is not required to claim non-completed tasks; however, if the task is "Unassigned" and the user has the
associated permission to work the task, the user can claim a single task, multiple tasks, or all tasks associated to the
student. If the user does not have the associated permissions to work the task, the user is still able to see that non-
completed tasks exist. If a task is "Assigned" and the user has permissions to work that task, the user will not be able to
claim the task, but the user will be able to see who the task is "Assigned" too.

View Student Tasks - Header

1. Total Tasks for this Student

◦ Total number of non-completed tasks you do and do not have permission to claim

2. Total Tasks You have Permission to See

◦ Total number of non-completed tasks you have permission to claim

3. Total Unassigned Tasks

◦ Total number of non-completed tasks that are "Unassigned"

4. Student Name/IRN

View Student Tasks - Columns

• Check Box (check to claim task)

• Type

• Task Owner

• Priority

• Created Date

• Status

Note:  This pop-out dialog box is also visible on the Student Record, by clicking on the View Student Tasks link in the
header.

Prioritizes tasks
SFA assigns or prioritizes tasks based on configuration (that is, First in First Out, Program End Date, Program Start Date,
and so on).
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Configurable Attributes
Default screen after a task is claimed
The school can configure SFA to determine which screen will be displayed when a task is claimed. The user may remain
on the Dashboard and see the newly claimed task in the queue or be taken to the task workflow upon claiming a task.

To View the Task Overview screen
Student Financial Aid User Interface > Dashboard > Task Overview (default view).

Related Topics
• Claim A Task

Claim a Task  
You can claim a task that is unassigned by clicking the claim task button that is presented when there are unassigned
task in the task queue.

Overview
The new task is assigned to you based on configuration (that is, date received, task priority, and so on).

Required Role Permissions
The user must have a role with these General Permissions through Roles Management to complete these manual
processing steps:

• Dashboard

• Task

• Document Review Task

The user must have a role with the View Document and Doc Review Task, Document Permissions through Roles
Management to complete these manual processing steps:

• Drivers License

• Birth Certificate

• Independent Verification

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Claim Tasks from the Dashboard

Log into the Student Financial Aid User Interface (UI).

1. Navigate to Dashboard > Task Overview (default screen upon login).
2. Click the Review Document for Approval task queue.

◦ Confirm there is a download icon in the sidebar and a Claim A Task button displayed.

3. Click Claim A Task.
If there are other unassigned tasks for the student, you can claim them too:
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◦ Select additional tasks.

◦ Click the Claim # of # button.

4. The task(s) will remain in your queue until they are completed or reassigned.
Claim Tasks From the Student Record

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.

◦ Navigate to Student Record > Student Summary (default screen)

2. Click the View Student Tasks link in the header - OR -
3. Click the View Student Tasks link in the right sidebar in the Pending Actions, Tasks section.

Supervisor View  
The Supervisor View Dashboard enables you to manage tasks within each task queue.

Overview
Through the Supervisor View Dashboard you can assign or un-assign tasks. For example if an employee has tasks
assigned to themselves and will be out for an extended period of time, you can un-assign those tasks and assign them
to other users or leave them unassigned so other users can claim them from their dashboard.

This dashboard also provides administrators a view of each task queue and its specific details to assist you in managing
task workflows.

What Student Financial Aid Does Automatically
Student Financial Aid automatically does the following things:

Displays supervisor dashboard
From this screen, you can see how many total tasks are in each queue and how many have been claimed/assigned to
users.

Displays specific details for each task queue
When a Task Queue is selected by a user, the FAS will display details about the task queue. Each task queue will display
different attributes that are specific to the tasks and available information. Some examples would include but are not
limited to, the Task Owner, Priority Status, Creation Date, Student Name, (Task) Status, External Student ID, Award Year,
and others.

Task Queue Content

Commonly Used Columns Examples of Other Columns

Task
Owner

Priority Created
Date

Status Student
Name

External
Student
ID

Award
Year

Process
Status

Fund
Types

Document
Type

Due
Dates

Approval
Status

Other
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Configurable Attributes
• Queue Content

◦ The information returned in a task queue can be configured to meet the schools business needs.

• Task Priority

◦ Unless configured, tasks are assigned first-in-first-out (FIFO).

To View the Supervisor Dashboard
Student Financial Aid User Interface > Dashboard > Supervisor View

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• Dashboard Supervisor

• Dashboard

See Set General Permissions Matrix for additional information.

View the Supervisor Dashboard
1. Task Queue: Click to drill down to view additional details.
2. Total Tasks: Total number of tasks in the specific queue.
3. Claimed Tasks: Total number of tasks in an Assigned status.

Un-assign, Un-assign and Update Task Priority
1. Common Task Queue Details
2. Specific Task Queue Details
3. Assign tasks to users
4. Un-assign tasks to users
5. Update the priority of the task (priority is based on configuration)
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4  Using Administration

Administration Overview  

Administration  
Through Administration, you can manage regulatory compliance, the G5 process, security and the system.

Checklist for New Award Year Processing  
These are actions required on an annual basis to ensure accurate processing of Institutional Student Information
Records (ISIRs) from the U.S. Department of Education (ED).

Annual award year changes to ISIR record layouts require that you update your system setup so that incoming ISIR
records are processed correctly. Here is a checklist for what you need to do:

1. Review and update your Configuration Workbooks as needed.
2. Enable ED Award Year-based file formats.
3. Ensure that TD Client is enabled and healthy.

Review and Update Configuration Workbooks  
You must review and update your configuration for ISIR processing for every new award year.

Review and update the following Configuration Workbooks for ISIR Processing for each new Award Year. Workbooks
related to Student Financial Planning (SFP) only are noted:

• %_DOCUMENTS.csv - Add Award Year-specific documents.

• %_DOCMETADATA.csv - Add Award Year-specific document meta data.

• %_ISIR_C_CODES.csv - Add Code_numbers. Update Documents_Required, Auto_Code_Clearing_Logic, and
Additional_Notification_Message columns for each code.

• %_ISIR_REJECT_CODES.csv

• %_ISIR_DISCREP.csv

• %_ISIR_ASSUMPT.csv
(applicable to the 2023-2024 and prior Aid Years only)

• %_ISIR_HIGHLIGHT.csv

• %_ISIR_MGMT.csv

• %_PJ.csv

• %_ISIR_C_CODES_TO_FIELDS.csv

• %_ISIR_VERIFICATION_CODES.csv - Add ISIR Verification Code_numbers and Verification_Tracking_Groups;.
Update Documents_Required, Auto_Code_Clearing_Logic, and Additional_Notification_Message columns for
each code -
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• %_ISIR_REJECT_TO_C_CODES.csv

• %_ISIR_REJECT_CODES_TO_FIELDS.csv

• %_FAS_FUND_CONFIG.csv(SFP only)

• %_NFR_ATTRIB.csv (SFP only)

• %_COA.csv (SFP only)

• %_T4_CRIT.csv (SFP only)

• %_REGULATORY_DEADLINE.csv - Update FAFSA, ISIR Correction, and ISIR Verification dates.

Oracle's delivered Baseline Configuration updates can be used as a guide for the necessary Award Year configuration
changes. Once all required Configuration Workbooks are updated for the new Award Year, upload them using the FAS
UI > Administration > System Management > Configuration Administration page. See full details at Configuration
Administration.

Enable ED Award Year-Based File Formats  
For each new Award Year, you must enable the Award Year-specific U.S. Department of Education (ED) file formats that
you want to process. This includes Central Processing System (CPS) formats for ISIR and Common Origination and
Disbursement (COD).

The application doesn't process files received from CPS and COD (for SFP only) in an un-enabled Award Year-specific
file format, but they remain in a system queue. When you enable a file format, the application automatically processes
any files in the queue.

1. Navigate to: Administration > FAS Management > DOE File Management. (DOE is synonymous with ED.)
2. Select an award year.
3. Select the file names.
4. Click Edit Selected.
5. Enter the file processing start date and time in a mm/dd/yyyy hh:min AM/PM format.
6. Click Apply.

For more details, see DOE File Management.

Manage TD Client  
TD Client is the mechanism used to transfer files back and forth between a school and the United States Department of
Education Student Internet Gateway (SAIG).

Enable and Disable TD Client
You can use this feature to universally control the transmission of files with the Central Processing System (CPS)/FAFSA
Processing System (FPS) or Common Origination and Disbursement (COD) using the SAIG. This feature applies to both
Award Year-based and Non-Award Year based file formats.

You can also evaluate the status of the TD Client connection in this feature. A status of Passed or Not Passed displays
based on the health check outcome.

Note:  There are two TD Clients:
• FTI TD Client for transmission of ISIRs that contain sensitive Federal Tax Information (FTI) data received from

FPS.

• TD Client for all other ED data.
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Required Role Permissions
The user must have a role with the following General Permission through Roles Management in order to complete the
manual processing steps listed below:

TD Client Management.

See: Set General Permissions Matrix

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI).

Enable and Disable FTI TD Client or TD Client
1. Navigate to: Administration > System Management > TD Client Management.
2. Select the FTI TD Client Selection Indicator to toggle between Active (enabled) and Suspended (disabled).
3. Select the TD Client Selection Indicator to toggle between Active (enabled) and Suspended (disabled).

Check FTI TD Client or TD Client Health
1. Navigate to: Administration > System Management > TD Client Management.
2. Click the Check TD Client Health button for the FTI TD Client or the TD Client.

A status of Passed or Not Passed displays.
3. If Not Passed, select the TD Client Selection Indicator  to Suspended (disabled).
4. Click Save.
5. Wait at least 90 minutes.
6. Log into the Department of Education's site to reset customer password.
7. Confirm the password works using EdConnect or some other tool.
8. Navigate to Administration > System Management > SAIG Administration
9. Enter TG Number.

Note:  Make sure you include the entire TG Number including the TG prefix, just as you would when using
ED's EDConnect software.

10. Enter Password.
11. Click Test Password.
12. Click Save upon confirmation of a successful test.
13. Navigate to: Administration > System Management > TD Client Management.
14. Select the TD Client Selection Indicator  to Active (enabled).
15. Click Save.
16. Click the Check TD Client Health button. A status of Passed or Not Passed displays. If Not Passed, repeat this

task starting with Step 3.

Using FAS Management  

FAS Management  
Through FAS Management an authorized user can manage fund allocations, quality control holds, and FAFSA
completion periods. Explore the following features within associated child pages.

Fund Allocation Management
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Note:  Fund Allocation is only applicable to Student Financial Planning (SFP).

Complete the following tasks:

• View a Fund Allocation Schedule

• Adjust a Fund Allocation Schedule

QC Holds Management

Note:  QC Holds Management is only applicable to Student Financial Planning (SFP).

Complete the following tasks:

• Enable QC Holds

• Disable QC Holds

• Configure QC Hold Reasons

• Remove QC Hold Reasons

Regulatory Management

Note:  Regulatory Management is applicable to both Student Aid Eligibility (SAE) and Student Financial Planning
(SFP).

Complete the following tasks:

• Add an Award Year

• Set FAFSA Completion Period Dates

• Edit FAFSA Completion Period Dates

Fund Allocation Management  
Student Financial Planning (SFP) enables an institution to create a Fund Allocation Schedule to automatically reserve
and release specific fund types over the course of the award year.

Overview
You can use the application configuration of a fund allocation for fund types awarded within the application on an award
year/non-award year basis to limit awarding to the amount allocated within the fund. The application allows the fund to
be allocated to configured periods. You can update the amounts within these periods to manage/ensure that funds can
be reasonably available throughout the award year. The application also displays relevant fund calculations and allows
you to enter adjustments as the amount of resources changes.

What Student Financial Planning Does Automatically
SFP automatically does the following things:
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Reserves funds from the fund allocation
Once the allocation periods and the amounts per period are established, the application automatically reserves funds
for eligible students within the appropriate period. Reserved funds include estimated and awarded funds for eligible
students.

If a reserved amount associated with an allocation period is updated, the application automatically updates the reserved
column.

Releases awards from the fund allocation
SFP releases funds and calculates the remaining amount available for the allocation period. The application tallies
the number of students awarded the fund source and calculates the total amount reserved, released, disbursed, and
remaining.

The application releases any reserved amounts for a student when the award year associated with the reserved
payment period has been updated and when the students planned disbursements in the payment period are less than
the reserved amount.

Re-packages student when an allocation period is updated
If you update any allocation period(s) the application automatically evaluates each student's awards when they are
being re-packaged and will include or update the fund type if the student is eligible to receive the fund type.

The application also repackages any student if his or her eligibility changes, resulting in the student becoming eligible
or ineligible for the fund source, and immediately recalculates the reserved, released, disbursed and remaining
amounts.

Any time a student is repackaged, the application automatically evaluates the student record being re-packaged and
updates or includes the fund type if funds are or have become available since the last time the student was packaged.

Re-packages when allocation Period are fully reserved
The application completes a re-package for all students with reserved amounts within an allocation period when there is
no remaining eligibility left within the allocation period.

The application does not allow funds to be reserved or disbursed until an award year allocation schedule has been set
up.

Mass Import or Update of Fund Allocation
The FasFundAllocationConfigEvent message allows you to create and update the fund allocation configuration for
any fund code configured to require a fund allocation. The message allows all create and update functions available on
the Fund Allocation FAS UI page. You can submit a message to update the fund allocation configurations for multiple
funds or fund allocation periods within a single MPG event. Within the message, you can define the total fund amount
per fund, set allocated amounts and whether the fund can be disbursed for a defined period of time.

Please note:

• The event message must adhere to existing validation rules enforced in the Fund Allocation management UI,
otherwise, the event will not be processed.

• Validation errors are displayed on the Application Event error report.

Configurable Attributes
Configure the award year allocation schedule
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You can configure the periods in which to allocate the fund throughout the award year. To set up the allocation
schedule, you must create at least one period in order to allocate funds. You can then create additional periods, set the
maximum amount to allocate per period and decide if the period should be Ready for Disbursement.

Required Role Permissions
You must have a role with this General Permission through Roles Management to access Fund Allocation:

• Administration

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To View the Fund Allocation Details & Schedule

1. Student Financial Planning User Interface > FAS Management > Fund Allocation
2. Enter the Fund Type.
3. Select an Award Year.
4. Click Search.
5. Review the Fund Allocation Configuration.
6. Review the Fund Allocation Schedule.
7. Click the number in the Pending Disbursements column to view details associated to Pending Disbursements.

Award Year Details

• Fund description

• Award year

• Initial fund amount

Allocation Schedule Details

• Total fund allocation

• Number of students awarded

• Total reserved to date

• Total awards released

• Net reserved

• Total funds currently available

• Number of students disbursed

• Total funds disbursed

• Total disbursements released

• Net disbursements

• Monthly available within the fund allocation

Related Topics
• Create A New Fund Allocation

• Edit A Fund Allocation

Create A New Fund Allocation  
The institution can Create a Fund Allocation for available fund sources.
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Overview
The configured fund allocation may be on an award year or non-award year basis. Only after the fund allocation is
created and made ready for disbursement will Student Financial Planning begin to award the fund.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > FAS Management  > Fund Allocation Management
2. Select the Fund Type
3. Click the New Allocation button
4. Select Award Year
5. Enter the Initial Fund Amount
6. Click Save
7. Confirm a new allocation schedule for a new award year was created

Related Topics
• Edit A Fund Allocation

Edit A Fund Allocation  
You can edit the allocation schedule and make adjustments to the fund allocation.

Overview
When you Edit a Fund Allocation you can update the initial fund amount, update the allocation period dates,
redistribute funds and choose if funds will be available for disbursement.

Reallocating Funds

• You can add allocation periods as necessary, but periods cannot overlap.

• You can add funds to an allocation period without requiring the reduction of future periods resulting in a total
that exceeds the award year allocation. However, Student Financial Planning will not allow you to save the
updates until an alternate period is reduced so the total allocation for all periods is equal to or less than the
award year amount.

• Student Financial Planning does not alert you while you are making incremental adjustments to each allocation
period if the updates result in an excess of the total fund allocation for the award year. However, Student
Financial Planning does alert if you try to save updates and the exceeds the total fund allocation.

• You cannot redistribute funds that would result in a remaining balance that is less than the reserved amount for
that configured period. For example, if the allocation amount for a specific period is $10,000 and the reserved
amount for that period is $8,000, the user can redistribute the remaining $2,000. If the user attempts to
redistribute $2,001 Student Financial Planning will not allow the request to be completed.
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When Making Adjustments to the Fund Allocation you can adjust the fund amount by applying credits or debits to
the initial fund amount. Student Financial Planning does not allow funds in excess of the awarded aggregate amount.
If applicable, you can set a deposit date and payment type for any credits to the fund allocation. As credits and debits
are applied, Student Financial Planning provides notes in the student history and you can identify the source using an
available drop down menu of fund sources.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

Navigate to Student Financial Planning User Interface > FAS Management > Fund Allocation

Edit the initial fund amount

1. Choose the Fund Type and associated Award Year
2. Click the Edit button
3. Update the Initial fund Amount
4. Click Save

Adjust the allocation period dates

1. Choose the Fund Type and associated Award Year
2. Click the Edit button
3. Click the date you want to adjust and use the calendar picker to select a new date
4. Click Save

Make funds available for disbursement

1. Choose the Fund Type and associated Award Year
2. Click the Edit button
3. Check the "Ready for Disbursement" box for the allocation period you want to make available
4. Click Save

Create a new allocation period

1. Choose the Fund Type and associated Award Year
2. Click the Edit button
3. Click the New button to add a new allocation period
4. Confirm a new allocation period is added

◦ Update as necessary

5. Click Save

Reallocate the funds

1. Choose the Fund Type and associated Award Year
2. Click the Edit button
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3. Enter a new amount for each allocation period you want update
4. Click Save

Add an adjustment

1. Choose the Fund Type and associated Award Year
2. Click the Edit button
3. Click the New button for Adjustments to Fund Allocation
4. Enter all the necessary Adjustment info:

a. Adjustment
b. Comments
c. Source Type
d. Payment Type
e. Deposit Date (current system date auto populates)
f. Date of Adjustment (current system date auto populates)

Related Topics
• Create A New Fund Allocation

QC Holds Management  
The Quality Control (QC) Holds are utilized to analyze and validate automated financial aid processing in an ongoing
effort to promote better service to students, compliance, and continuous improvement to business processes and
application functions.

Overview
If errors are identified, those errors are escalated to the proper department to resolve the error.

Note:  The QC Hold Reason feature has been deprecated. Ignore these fields when you see them in the UI.

QC Hold Statuses

Status Description

On Hold Status when a QC Hold for a FAS process is in progress

Released Status when a QC Hold has been either released by a user or auto-released by the FAS (in the instance
the QC Hold is replaced via a repackage)

Replaced by Updated Hold Status when hold has been replaced by an updated amount for that particular hold level for that FAS
process

Hold No Longer Valid Status when a hold has become outdated, but the replacement hold has not yet been created due to
sequence of the FAS processing

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:
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Initiates QC Holds
Student Financial Planning initiates a QC Hold at defined holding points in order for the Quality Control (QC) process to
be completed prior to the completion of other critical financial aid processes to prevent system and/or manual errors.

When a student record has a QC Hold, subsequent processing actions are prevented from being completed and future
tasks are not initiated until the QC Hold is Released. Student Financial Planning automatically documents the date the
hold is initiated and displays the type of hold placed on the Student Record.

QC Hold Types

Process Hold Type QC Hold Trigger Process Triggered when Hold is
Released

Awarding • Award Amounts Determined • Awarding processing
determined award amount(s)

• Award amount is updated

• Award Outbound Message

Credit Balance • Credit Balance Amount
Determined

• Credit Balance amount is
determined

• Credit Balance amount is
updated

• Credit Balance Information
Outbound Message

• Ready to be Disbursed • All disbursement criteria
is equal to Met for a
disbursement

Title IV Funds (Excluding IASG AND
Campus-Based Funds):
 

• COD Disbursement File

Non-Federal Funds, IASG, &
Campus-Based Funds:
 

• Disbursement Status updates
to Disbursed

• Disbursement Information
Outbound

• Read to be Returned • Disbursement is to be
returned

Title IV Funds (Excluding IASG AND
Campus-Based Funds):
 

• COD Disbursement File

Non-Federal Funds, IASG, &
Campus-Based Funds:
 

• Disbursement Status updates
to Disbursement Returned

• Return to Lender Outbound
Message

Disbursement

• Ready to be Canceled • Disbursement is to be
canceled

Title IV Funds (Excluding IASG AND
Campus-Based Funds):
 

• COD Disbursement File

Non-Federal Funds, IASG, &
Campus-Based Funds:
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• Disbursement Status Updates
to Disbursement Canceled

• Cancel Disbursement
Outbound Message

• Late Disbursement
Acceptance for Grant
Determined

• Late disbursement
acceptance status for a grant
is determined

• Disbursement Acceptance
Information Outbound
Message

• Late Disbursement Request
for Disbursement Acceptance
for Loan Determined

• Late disbursement
acceptance status for a loan is
determined

• Disbursement Acceptance
Information Outbound
Message

R2T4 • R2T4 Calculation Complete • R2T4 calculation is
determined to not be required
OR

• R2T4 calculation is complete
(subsequent actions are
paused until the hold is
released)

• Reduction of Funds Process
OR

• PWD Process OR

• Grant Overpayment Process
OR

• Cancellation of Future
Disbursements

• R2T4 Amount is Fully Earned

Grant Overpayment • Grant Overpayment
Determined

• Grant Overpayment is
determined OR

• Grant Overpayment is
updated

• Grant Overpayment Student
Notification Outbound
Message

• PWD Disbursement
Acceptance for Grant
Determine

• PWD acceptance status for a
grant is determined

• Disbursement Acceptance
Information Outbound
Message

Post-Withdrawal Disbursement

• PWD Request for Acceptance
for Loan Determined

• PWD acceptance status for a
loan is determined

• Disbursement Acceptance
Information Outbound
Message

Triggers QC Hold information
When a QC Hold is initiated, Student Financial Planning generates the appropriate QC Hold Information and then
triggers the QC Hold Outbound Message to external systems. The QC Hold Message is specific for each hold type.

Displays QC Hold information
Student Financial Planning displays the specific QC Hold Information details, per QC Hold Type.

Triggers an Automatic Release of Holds
To prevent the QC Hold process from creating compliance and/or processing complications, Student Financial Planning
automatically releases a QC Hold when either of the following occurs:

• The configured hold deadline has been met

• The student's external student ID is included in an inbound QC Hold Release message
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Sets specific QC Holds on targeted student populations
Student Financial Planning utilizes the QC Holds Type Configuration Initiation (Inbound) Message to turn specific hold
types On, Off, or to the system Default (global) settings for students contained in the message. On the student QC Hold
screen, the details include the comments column as to why the hold was turned on or off.

Responds to QC Hold information web service request
When a QC Hold Information Web Service Request is received Student Financial Planning triggers the QC Hold
Information (Outbound) Message to provide details on QC Holds currently initiated for the requested student including
the hold type, ID, status, date, and associated academic year (if applicable).

Student Financial Planning sends the information when one of the following occurs:

• QC Hold Status is updated to, On Hold, Released, Replaced by Updated Hold, or Hold No Longer Valid

• Receipt of the QC Hold Information Web Service Request has been received

Configurable Attributes
Configure and Set the QC Holds Selection Indicator

Authorized users can configure the QC Holds Selection Indicators (i.e. True, False, Default).

Authorized users can set the QC Holds selection indicator per QC Hold Type globally (via QC Holds Management), for
a targeted student population (via FasQcHoldInitiationConfigEvent message), or individually (via QC Holds UI) on the
student record.

When the QC Hold Selection Indicator is set to:

• Default: Student Financial Planning uses the global setting found in the QC Management UI under the
Administration settings

• True or On Hold: Student Financial Planning turns on the QC Hold Type indicated for the student

◦ This will override the global setting.

• False or No Hold: Student Financial Planning turns off the QC Hold Type indicated for the student

◦ This will override the global setting.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Administration

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To View the QC Holds Management Screen Student Financial Planning User Interface > Administration > FAS
Management > QC Holds Management
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Related Topics
• Enable and Disable QC Holds via UI

• Enable and Disable QC Holds via Event Message

• Release QC Hold via Event Message

Enable and Disable QC Holds via UI  
An administrator can Enable and Disable a QC Hold through the Student Financial Planning User Interface (UI).

Overview
When you enable the QC Holds through QC Holds Management, the hold is set globally for every student. Anytime the
triggering action occurs, the hold will be set.

The global setting can be overridden by using the FasQcHoldInitiationConfigEvent message. See Enable and Disable QC
Holds via Event Message for more details.

Tips for Manually Updating QC Holds
QC Holds on the Current and Prior Enrollment

When a student changes programs, both the prior program and the current program may have pending QC Holds.

• It is important to release Ready to be Canceled QC Holds on prior enrollments within same PP immediately
upon COP.

• If you fail to do so, it may result in COD Rejects; for example, 039, 167: Prior Enrollment Cancellation Holds for
COP within same PP need to be released before a new program can be originated.

Suggested Order to Release Pending QC Holds:

• Release holds in the prior program before the current enrollment.

• Release Ready to be Returned QC Holds prior to Ready to be Canceled QC Holds. This allows any returns to
be completed prior to cancellation of funds (if applicable).

• If you release cancel holds before return holds, it may result in rejected disbursements.

Don't Let QC Holds Stay On Hold Too Long

Note:  There are downstream impacts to not releasing QC Holds:
• When there is a QC Hold, all downstream processing is prevented.

• If QC Holds for prior enrollments aren't released before releasing QC Holds for the current enrollment
disbursements may not disburse correctly and may get Rejected.

• Student may become ineligible for funds if QC Holds aren't released when an award year closes.

Releasing "Ready to be Canceled" QC Holds on "Closed Award Years"

If you release a Ready to be Canceled QC Hold after an Award Year has closed, the application attempts to Originate
those disbursements.
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Note:  You should not Originate Pell Funds after an Award Year has closed.

• Use Disbursement Administration to prevent the origination from being sent out.

• Before releasing the QC Hold, confirm if the Disbursement in question has been reduced to zero on the COD
website:

◦ If the amount has been reduced to Zero, release the hold.

◦ Before the Originations Batch Job is triggered, update the disbursement using Disbursement
Administration.

- Update the disbursement sequence: Disbursement sequence should be equal to 66 or greater, but
should match COD.

- Update the disbursement status: Disbursement Canceled.
- Update the cancellation reason and date: Date should match the date the cancellation occurred.
- Delete a disbursement: Delete any extra disbursement that is created as a result of the QC Hold

being released.
- Update the disbursement status from Ready to Send to COD to Disbursement Canceled or other as

appropriate.

Note:  You should not release Ready to be Canceled holds on funds associated with a closed award year if you don't
have permissions to view disbursements on COD or to use disbursement administration.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• Configure QC Hold

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration >  FAS Management > QC Holds Management
2. Select the QC Holds you want to enable
3. Click Save

Enable and Disable QC Holds via Event Message  
Use the FasQcHoldInitiationConfigEvent message to manage QC (quality control) holds for individual students.

Overview
The application uses the values in this event message to supersede the applicable configuration setting at the
application level.

Using the FasQcHoldInitiationConfigEvent message enables or disables the placing of a QC Hold for the designated
triggering event at individual student level. Using this event message overrides the QC Hold setting at the application
level for the event.
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For example, if an Award QC Hold is set to True based on the application level configuration, you can use the
FasQcHoldInitiationConfigEvent to override this configuration with a value of False for an individual student. When you
do this, the application won't set an Award QC Hold regardless of the application configuration.

Note:  Any QC Hold configuration must be set at either the application level or, for an individual, via the
FasQcHoldInitiationConfigEvent before the applicable action from the triggering event on the student record.
Otherwise, there isn't an effect from the triggered QC Hold as QC Holds aren't retroactive.

Required Role Permissions
The user must have a role with the following General Permission through Roles Management in order to complete the
manual processing steps:

• Student Holds

• For the configuration of the QC holds: Configure QC Hold permission.

• For viewing QC Holds on the Student Record: Student Holds permission.

• For updating QC Holds on the Student Record: Student Holds Modify permission.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > System Management > Load Message File.
2. Browse to or drag and drop the file to want to load.
3. Click OK.

Related Topics
• Set General Permissions

Release QC Hold via Event Message  
The FASReleaseQCHoldEvent web service initiates the same hold release mechanism as checking the Released check
box via the Student Financial Planning User Interface (UI).

Overview
Use this message to remove individual holds or, with an Auto Release query, to release a mass population of holds at
once. When using this web service with an Auto Release Query, the application generates one FASReleaseQcHoldEvent
message for each QC Hold released.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps:

• Administration.

• System Management.

• Load Message File.

The user must have the ability to send Event Messages through the Message Processing Gateway. Do this in the UI. See
Load Message File.

49



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 4
Using Administration

Related Topics
• Set General Permissions Matrix

• Load Message File

Regulatory Management  
You can set the Regulatory FAFSA Completion Start and End Date for a given award year.

What Student Financial Aid Does Automatically
Student Financial Aid (SFA) automatically does the following things:

Sends the request for the FAFSA
Once the FAFSA Completion Start Date is met, if the student requires an award year ISIR, SFA will request the award year
FAFSA from the student. SFA will close the notification once the FAFSA is received and becomes payable.

Closes/Cancels requests for the FAFSA
If the FAFSA has not been received or become payable by the FAFSA Completion End Date, SFA automatically closes any
open request for the award year FAFSA.

Configurable Attributes
Regulatory Deadline Management
SFA is configured to meet the regulation deadlines set by the U.S. Department of Education. However, the institution
can configure more stringent Regulatory Deadlines.

• FAFSA Completion Period Start/End Dates

• ISIR Corrections Start/End Dates

• ISIR Verification Start/End Dates

• Award Year Start/End Dates

• Origination and Disbursement Start Dates

Note:  Only FAFSA Completion Period Start/End Dates can be set in the FAS UI. The other deadline dates must be
configured in the Regulatory Deadlines Configuration Workbook. For more information, see Regulatory Deadlines
Guide.

Navigation to the Student Financial Aid User Interface Functionality
To View the Regulatory Management Screen
SFA User Interface > Administration > FAS Management > Regulatory Management .

Add a FAFSA Completion Period  
If Student Financial Aid (SFA) hasn't automatically generated the Free Application for Federal Student Aid (FAFSA)
Completion Period for a future award year, the institution can add a FAFSA Completion Period.
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Overview
If the institution doesn't add a FAFSA completion period at the appropriate time, Student Financial Planning adds the
completion period per the U.S. Department of Education (ED) published guidelines for the award year.

All FAFSA messaging is based upon the configured FAFSA completion period for the award year, per the student's
enrollment period.

SFA uses a 4-digit format to represent the Award Year; for example, 2022 represents the 2021-2022 Award Year.

Required Role Permissions
The user must have a role with this General Permission through Roles Management to complete these manual
processing steps.

• Administration

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the SFA User Interface (UI)

1. Navigate to Administration > FAS Management > Regulatory Management
2. Click New.
3. Enter 4 Digit Award Year (for example, 2017).
4. Enter the FAFSA Completion Start Date: MM/DD/CCYY (for example, 01/01/2016).
5. Enter the FAFSA Completion End Date: MM/DD/CCYY (for example, 06/30/2017).
6. Click Save.

Update the FAFSA Completion Period  
The Free Application for Federal Student Aid (FAFSA) Completion Period dates define when the FAFSA must be
completed and sent to the Central Processing System.

Overview
The U.S. Department of Education (ED) application cycle lasts 18 months for every award year (for example, 01/01/2022
through 06/30/2023 for the 2022-23 award year). You can update the FAFSA Completion Period to be less than the ED
18-month cycle. However, if you don't configure the FAFSA completion period, Student Financial Aid (SFA) uses the
completion period per ED published guidelines for the award year.

All FAFSA messaging is based upon the configured FAFSA completion period for the award year, by the student's
enrollment period.

SFA uses a 4-digit format to represent the Award Year; for example, 2022 represents the 2021-2022 Award Year.

Required Role Permissions
The user must have a role with this General Permission through Roles Management to complete the manual processing
steps:

• Administration

See Set General Permissions Matrix for additional information.
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Manual Processing Steps
Log into the SFA User Interface (UI).

1. Navigate to Administration > FAS Management > Regulatory Management.
2. Select Award Year.
3. Enter 4- Digit Award Year (for example, 2022).
4. Enter the FAFSA Completion Start Date: MM/DD/CCYY (for example, 01/01/2016).
5. Enter the FAFSA Completion End Date: MM/DD/CCYY (for example, 06/30/2017).
6. Click Save.

DOE File Management  
You can enable or disable the receipt of Award Year-based Institutional Student Information Record (ISIR) or Common
Origination and Disbursement (COD) file formats from the United States Department of Education (ED, formerly
referred to as DOE).

Enable and Disable ED File Formats
For every Award Year, the application requires you to enable each ED file format that you want Student Financial
Planning (SFP) to process from the Central Processing System (CPS, for ISIRs) and COD (SFP-only).

The application doesn't process files for un-enabled formats, and they remain in the queue. Once the respective file
format is enabled, the application automatically processes any files in the queue.

Required Role Permissions
The user must have a role with this General Permission through Roles Management in order to complete the manual
processing steps:

• DOE File Management.

See: Set General Permissions Matrix

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI).

Enable DOE File Formats
1. Navigate to: Administration > FAS Management > DOE File Management.
2. Select an award year.
3. Select the file names.
4. Click Edit Selected.
5. Enter the File Processing Start Date and Time in a mm/dd/yyyy hh:min AM/PM format.

Note:  Ensure the File Processing Start Date and Time is not in the future.

6. Click Apply.
Disable DOE File Formats

1. Navigate to: Administration > FAS Management > DOE File Management.
2. Select an award year.
3. Select the file names.
4. Click Edit Selected.
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5. Ensure the File Processing Start Date and Time field is blank.
6. Click Apply.

Using G5 Management  

G5 Management  
The G5 process enables an institution to request payments, adjust drawdowns and return cash to The Department of
Education for the following Title IV programs: Federal Pell Grant Program, TEACH grant program, Federal Supplemental
Educational Opportunity Grant (FSEOG) and the Direct Loan Program (Subsidized, Unsubsidized & Plus Loans).

Overview
Student Financial Planning G5 Managementcalculates the daily G5 drawdown amount per fund source, per award year,
for all disbursements and refunds that are in a G5 Ready or G5 Ready - Refund status. Authorized users can complete a
G5 drawdown transaction by entering a control number, view individual disbursements, update completed transactions,
and view a transaction history for all prior G5 drawdowns.

Status Definitions

G5 Statuses

Status Description

G5 Ready Disbursement satisfies all set G5 ready criteria

G5 Ready - Refund Disbursements to be refunded to ED

G5 Confirmed Disbursement has been drawn down from G5

G5 Confirmed - Refund Disbursement has been refunded from successful G5 drawdown transaction

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Identifies disbursements & refunds for the net daily calculation
Student Financial Planning identifies the disbursements and refunds for each fund type that is determined to be G5
Ready and calculates the daily G5 drawdown amount for all applicable fund types. After the drawdown calculation is
completed, you can enter the G5 Control Number to complete the drawdown transaction.

Calculates the drawdown amount
Student Financial Planning calculates the net amount of money to be drawn down from G5 daily, based upon eligible
disbursements and refund amounts calculated per award year.

• For all Direct Loans, the FAS will use the Incremental Net Disbursement Amount generated for that
disbursement

• For all other fund types, the FAS will use the Incremental Disbursement Amount generated for that
disbursement
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Manages G5 statuses
Student Financial Planning manages all disbursements in G5 Ready and G5 Ready - Refund status so they can be
included or subtracted in the daily G5 drawdown calculation. Upon completion of the drawdown transaction, Student
Financial Planning automatically updates disbursements in G5 Ready status to G5 Confirmed and disbursements in a G5
Ready - Refund status to G5 Confirmed - Refund.

Completes follow-up actions upon completion of the G5 drawdown
Student Financial Planning assigns a unique Transaction ID and associates the ID with the completed drawdown. The
transactions are grouped daily. After the Transaction ID is associated with the drawdown, Student Financial Planning
automatically sends a G5 message for all payments and refunds within the completed drawdown transaction and
includes the G5 drawdown transaction date, amount and status.

Displays drawdown calculation
The New G5 Net Drawdown Amounts and a G5 Transaction History per Fund Source are displayed in the Student
Financial Planning User Interface.

• Amounts are displayed per fund source, per award year, per day

• Direct Loan Subsidized, Unsubsidized, Parent PLUS and Grad Plus are displayed in one category titled, Direct
Loans

• All other fund sources will be displayed separately as Pell, IASG, FSEOG, and TEACH

Displays student identifier and disbursement identifier
Student Financial Planning displays the student's External Student ID and the Payment/Return ID for all disbursements
included in a drawdown calculation. You can view this information before and after the drawdown has been completed.

Configurable Attributes
There are no configurable attributes for this feature

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Administration

• G5 Drawdown

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To View Available Drawdowns  Student Financial Planning User Interface > Administration > G5 Management >
Available Drawdowns

To View G5 Transaction History
Student Financial Planning User Interface > Administration > G5 Management > G5 Transaction History
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View & Complete Available Drawdowns  
You can View Available G5 Drawdowns.

Overview
The Student Financial Planning User Interface groups the drawdowns by award year, fund type, and date. You can
Complete a New G5 Transaction one of two ways. You can drawdown the entire amount available for a fund type, which
may include multiple days or you can select to drawdown a fund type by date.

Once you decide if you are going to draw down a total amount for a fund type per award year or if you will drawdown
just the amount for a specific date for a fund type per award year, you will have to enter either a Control Number
(positive net drawdown) or a Reference Number (negative net drawdown) to complete the drawdown. The Control
Number/Reference Number used to complete a transaction remains associated with each disbursement within the
drawdown. If necessary, you can edit a completed drawdown and associate it with an additional Control Number.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• G5 Drawdown

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > G5 Management > Available Drawdowns
2. Click View Disbursements to view disbursements associated with the drawdown amount
3. You can review all records or reduce the number of records by searching by ID or Student ID
4. Determine if you want to drawdown the total net amount or the net amount for a specific date

a. New G5 Transaction: Will complete drawdown for all dates for fund type per award year
b. New G5 Transaction for Selected: Check the box to drawdown only the amount displayed for a specific

date
5. Enter a Control Number (positive net drawdown) or a Reference Number (negative net drawdown) to complete

the drawdown
6. Click Save.

View & Edit G5 Transaction History  
You can View G5 Transaction History and Edit G5 Transactions in the Student Financial Planning User Interface.
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Overview
You can use filters to view G5 Transactions by date range, award year or fund type. You can add or update G5 Control
Numbers and associate an amount to each Control/Reference ID Number for completed drawdown transactions. If
necessary, you can also associate a partial drawdown amount or control number with another G5 Transaction ID.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• G5 Drawdown

See Set General Permissions Matrix for additional information.

Manual Processing Steps
View G5 Transaction History
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > G5 Management > G5 Transaction History
2. Use filters to reduce the returned results

a. Transaction Start Date
b. Transaction End Date
c. Use Range (will search for transactions completed between the transaction start and end dates)
d. Award Year
e. Fund Type

Add New Control Entry
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > G5 Management > G5 Transaction History
2. Click the Add New Control Number button
3. Enter new Control Number
4. Enter Amount
5. Click Save

Edit control number and/or amount
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > G5 Management > G5 Transaction History
2. Click the Edit button
3. Update Control Number
4. Update Amount
5. Save

Related Topics
• View & Complete Available Drawdowns
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Update G5 Details on a Single Disbursement  
You have the ability to add/edit/remove the following fields from the disbursing screen in the pop-up window when
viewing details for a specific disbursement sequence number: G5 Control Number and G5 Transaction Date.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Override G5 Disbursement

• Override Disbursing Criteria

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Add Control Number

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student Record > Financial Information Disbursing > Disbursing

◦ Click the Sequence Number for any disbursement (i.e. Federal Direct Unsubsidized Stafford Loan: Disb.
#1, Seq. #1)

3. Scroll down to the G5 Details section and click Override
4. Enter Control Number
5. Update Transaction Date (if necessary)
6. Click Save
7. Confirm G5 Status updated to G5 Confirmed

Remove Control Number
1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student Record > Financial Information Disbursing > Disbursing

◦ Click the Sequence Number for any disbursement (i.e. Federal Direct Unsubsidized Stafford Loan: Disb.
#1, Seq. #1)

3. Scroll down to the G5 Details section and click Remove
4. Confirm you want to make the update
5. Confirm G5 Status updated to N/A

Update G5 Status from N/A to G5 Ready
The disbursement must have been previously in a G5 Confirmed/G5 Confirmed -Refund Disbursement state and the G5
Status Overridden.

To test this, first, complete Add Control Number and then Remove Control Number .

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student Record > Financial Information > Disbursing
3. Click the Sequence Number for any disbursement (i.e. Federal Direct Unsubsidized Stafford Loan: Disb. #1, Seq.

#1)
4. Scroll down to the G5 Details section and click Override
5. Confirm you want to make the update
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6. Confirm G5 Status updated to G5 Ready

Using Security Management  

Security Management  
Use Security Management to manage password policy, roles, and users.

Password Policy

Complete the following tasks through Password Policy:

• Update the Default Policy.

Roles Management

Complete the following tasks through Roles Management:

• Create Roles.

• Edit Roles.

User Management

Complete the following tasks through User Management:

• Add Users.

• Edit Users.

• Disable Users.

• Assign Users Roles.

For information about SAML/SSO integration, see Integration of SAML 2.0 and SSO.

Password Policy  
An authorized user can Set or Update the Password Policy that all users are subject to use to access the Student
Financial Aid user interface.

Overview
By default, there are 8 different parameters that are set to as the minimum policy. An authorized user can make changes
to the default settings to increase security.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administrator

See Set General Permissions Matrix for additional information.
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Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Navigate to Menu Bar > Administration > Security Management > Password Policy
2. Add/Update parameters

◦ Password History (times): The number of times a new password must be entered before using a previous
password

◦ Expiration Period: The number of days before Student Financial Aid requires the user to update his
password

◦ Minimum Length: The minimum number of total characters the password must be

◦ Minimum Lower Case Characters: The minimum number of characters that must be lower case

◦ Minimum Upper Case Characters: The minimum number of characters that must be upper case

◦ Minimum Numbers: The minimum number of characters that must be a number

◦ Minimum Special Characters: The minimum number of characters that must be a special character

◦ Special Characters: The actual special characters that the user can use

3. Click Save

Click Reset to refresh and rest the password policy to the default parameters.

Roles Management  
Through Roles Management the institution can create specific Roles and manage which General Permission and
Document Permissions are enabled for each role.

Create a New Role

Set Roles and Role Permissions:

• Create a Role Code/Role Name.

• Set General Permissions.

• Set Document Permissions.

General Permissions

Provides users access or visibility to:

• Screens.

• Links.

• Buttons.

• Task Queues.

• Manual Override (At-Will Actions).

Document Permissions

Provides users access or visibility to:

• View specific documents.
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• Approve/Reject documents through the Review Document for Approval task.

• Process Non-Federal Forms (NFF) via Process an NFF Document task.

Note:  For information about sending Role information using Security Assertion Markup Language (SAML), see
Integration of SAML 2.0 and SSO.

Create A New Role  
Roles Management enables you to customize roles and assign users to those New Roles within Student Financial Aid.

Overview
You can view, create, and update roles, role permissions, and assign specific users, specific roles. This feature allows you
to control the access permitted to each role and staff member.

You can create a new role and assign specific permissions to the role. Some of the access you can assign permissions to
include:

General Permissions

• Task Queues

• Manual At-Will Actions

• Information displayed on the User Interface

• Editing functions

• Reports

• Workflows

Document Permissions

• Visibility to a document(s)

• Document Review Tasks

• Non-Federal Funds Forms Task

Once a role has been created, you are able to add or remove permissions to that role.

Student Financial Aid manages permissions based on the institution's configuration, established roles, and role
permissions. All users assigned to a role have access to all permissions granted to that role and any updates made to a
role, impact all users assigned to that role.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

See Set General Permissions Matrix for additional information.
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Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Navigate to Administration > Security Management > Roles Management
2. Click the New button
3. Enter Role Code

◦ Must follow format constraints (i.e. alpha-numeric characters only)

4. Enter Role Name
5. Enable General Permissions

◦ Check the boxes you want the user to have access/visibility to

6. Enable Document Permissions

◦ Check the boxes you want the user to have access/visibility to

7. Click Save.

Set Document Permissions  
Student Financial Aid provides the school administrator complete flexibility in creating divisions of labor through Roles
Management.

Overview
Administrators can create, view, and update all roles based on permission mapping. In addition, the administrator can
enable Document Permissions based on the user's area of expertise.

There are three areas you can enable/disable document permissions:

View Document NFF Forms Task Doc Review Task

Visibility to specific documents Approve/Reject Non-Federal Forms (NFF)
through the Process an NFF Document task
queue

Approve/Reject documents through the Review
Document for Approval task queue

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Navigate to Administration > Security Management  > Roles Management
2. Select the Role you want to enable or update permissions
3. Click the Document Permissions tab
4. Check the box to enable the Document Permission
5. Uncheck the box to disable the Document Permission
6. Click Save
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Note:
• Click the Check-Box in the header row to enable/disable all documents for that column (on that page).

• Make sure to enable/disable Document Permissions on each available page.

• If an Award Year is not listed, the document is considered a Lifetime Document.

Set General Permissions  
Student Financial Aid provides you flexibility in creating divisions of labor through Roles Management.

Overview
Administrators can create, view, and update all roles based on permission mapping. In addition, the administrator can
assign General Permissions based on a specific production process and further assign users to roles based on their
area of expertise.

Note:  Each General Permission other than Dashboard, Task, Student, and Administration has a Permission
dependency. The Permission dependency is the highest level navigation in the General Permissions Matrix
table in this topic. For example, the Permission dependency for the Match Unmatched ISIRs Permission is the
Administration Permission.See Set General Permissions Matrix to learn more.

Required Role Permissions
The user must have a role with this General Permission through Roles Management in order to complete the manual
processing steps listed below:

• Administration.

See Set General Permissions Matrix for additional information.

Manual Processing Steps

1. Sign into the Student Financial Aid FAS User Interface (UI).
2. Navigate to Administration > Security Management > Roles Management.
3. Select the Role for which you want to enable or update permissions.
4. Enable or disable General Permissions:

◦ Check the box to enable the General Permission.

◦ Uncheck the box to disable the General Permission.

5. Click the General Read-Only Permission toggle switch to enable or disable that permission. The General
Read-Only Permission can't be assigned to the System Administrator Role.

6. Click Save.

Note:  Make sure to enable or disable General Permissions on each available page.

Related Topics
• Set General Permissions Matrix
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Set General Permissions Matrix  
Student Financial Aid provides you flexibility in creating divisions of labor through Roles Management.

Overview
Administrators can create, view, and update all Roles based on permission mapping. In addition, the administrator can
assign General Permissions based on a specific production process and further assign users to Roles based on their
areas of expertise.

Note:  Each General Permission other than Dashboard, Task, Student, and Administration has a Permission
dependency. The Permission dependency is the highest level navigation in the General Permissions Matrix
table in this topic. For example, the Permission dependency for the Match Unmatched ISIRs Permission is the
Administration Permission.

Note:  Permissions that are only applicable to Student Financial Planning (SFP) and not Student Aid Eligibility are
noted.

General Permissions Matrix

General Permission Gives the User Permission to: Navigation

Administration Access all Administrative functions including:
• FAS Management.

• G5 Management. SFP only.

• Security Management.

• System Management.

 

Administration
 

Administrative Relief SFP only.
Override a close -out date for a Non-Federal
Fund.
 

Administration >  System Management >
Administrative Relief > Override button in the
Override Fund Closeout Date column.
 

At Will Repackage SFP only
Repackage the Student based on current inputs.
 

Student > Financial Information >
Packaging > Repackage button
 

At Will SAP Status Update SFP only.
Change the Current SAP Status or Override SAP
Calculation.
 

Student > Student Record > SAP
Information > Change link associated with the
Current SAP Status field and the Override SAP
Calculation button
 

COA Adjustment SFP only.
Add a Positive or Negative Adjustment to the
COA.
 

Student > Financial Information >
Packaging >  > View Details icon (eye icon)
associated with Package Status, Adjustment
button.
 

Configuration Administration View the Configuration Administration page.
 
Load Configuration through the SFP user
interface.
 

Administration > System Management > 
Configuration Administration
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View Configuration Load History.
 
Download Current Configuration.
 
Review the Configuration File Guide, hierarchy,
 naming standards, and so on.
 

Configure QC Hold SFP only.
Globally enable configured QC holds.
 

Administration >  FAS Management > QC
Holds Management
 

Create R2T4 SFP only.
Create and Replace an R2T4 record.
 
Trigger R2T4 Calculation.
 

Student > Financial Information > R2T4
Information > Create R2T4
 
Student > Financial Information > R2T4
Information >  Replace R2T4  button
 
Student > Financial Information > R2T4
Information > Trigger R2T4 Calculation
 
button

Credit Balance Creator SFP only.
Create a credit balance on a student record.
 

Student > Financial Information > Credit
Balance > Create Credit Balance page and
button
 

Credit Balance Modifier SFP only.
Modify the credit balance amount, recipient,
 and date at any point.
 

Student > Financial Information > Credit
Balance >  Resulting Credit Balance
Information
 

Credit Balance Not Sent Modifier SFP only.
Modify the credit balance amount, recipient,
 and date only if the credit balance event
outbound message has not been sent.
 

Student > Financial Information > Credit
Balance > Resulting Credit Balance
Information
 

Dashboard View the Dashboard page. The user only sees
Task Queues and Tasks they have permissions
to.
 

Dashboard
 

Dashboard Supervisor View the Supervisor View Dashboard:
• Assign Tasks.

• Un-assign Tasks.

• Update Priority of Tasks.

 

Dashboard > Supervisor View
 

Disbursement Administrator SFP only
View Disbursement Administration page and
ability to update:

• Disbursement Numbers.

• Sequence Numbers.

• Disbursement Status.

• Cancellation Reason.

• Cancellation Date.

• Total Amount.

• Incremental Amount.

Administration > System Management >
Disbursement Administration
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• Increment Net Amount.

• Payment ID.

• Return ID.

• Delete Disbursement Record.

• Save Disbursement Records (doesn't send
anything to COD).

• Re-Originate by Fund Type.

• Send Originations to COD for all Fund
Types.

 

Disbursement Override SFP only.
Override the Payment Period Disbursement
Amount.
 

Student > Financial Information >
Disbursing >  Edit Disb Amt  button
 

Document Request Canceller Cancel a document request.
 

Student >  Documents > Pending Requests >
Cancel button
 

Document Requestor Request documents.
 

Student > Documents > Received
Documents/Pending Requests > Request
Document(s) button
 

Document Review Task View Review Document for Approval Task
Queue.
 

 > Dashboard >  Task Overview > Review
Document for Approval
 

DOE File Management Enable or disable receipt of Award Year based
file formats.
 

Administration > FAS Management > DOE
File Management > Choose Award Year,
 select or deselect File Name
 

Edit COA SFP only.
Update from Total COA to Actual COA and vice-
versa.
 

Student > Financial Information >
Packaging >  COA button
 

Edit Comments Update comments entered by self.
 

Student > Student History / Comments >
Comments
 

Enrollment Overrides SFP only.
Override the Enrollment Information. :

• Update Current Status.

• Update Active Enrollment.

• Choose to Hide/Display the Enrollment.

 

Student > Student Record > Enrollment
Information
 

FA History Request SFP only.
Request the NSLDS Financial Aid History.
 

Student > USDE > NSLDS > Request NSLDS
File > New Request button
 

FTI Viewer View Federal Tax Information (FTI) from the ISIR
anywhere FTI data is displayed.
 

Student > USDE > ISIR
 

Fund Allocation Management SFP only. Administration > FAS Management > Fund
Allocation Management
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Add new and edit existing fund allocations for
awards that require an allocation schedule.
 

 

Fund Eligibility Viewer SFP only.
View the Fund Eligibility page.
 

Student > Financial Information >
Packaging > Fund Eligibility icon; the eye icon
associated with the Fund Information link.
 

G5 Drawdown SFP only.
View Available Drawdowns:

• Complete a New G5 Transaction.

• Complete a New G5 Transaction for
Selected.

• View Disbursements within an Available
Drawdown.

 
View G5 Transaction History:

• Add New Control Entry.

• View Disbursements.

• Edit Drawdown Control Number and/or
Amount.

 

Administration > G5 Management
 

General Read-Only Supersedes all Role permissions and prevents
the user from being able to complete any
manual overrides.

• This permission isn't listed with other
General Permissions. Rather, it's activated
using the General Read-Only Permission
toggle switch on the Roles Management
page.

• The General Read-Only Permission can't
be assigned to the System Administrator
Role.

 

Administration > Roles Management
 

Grant Overpayment Resolution Task Review SFP only.
View the "Report Grant Overpayment
Resolution to NSLDS and DRS" Task Queue.
 

Dashboard > Task Overview > Report Grant
Overpayment Resolution to NSLDS and DRS
 

Grant Overpayment Task Review SFP only.
View the "Review Grant Overpayment and
Notify NSLDS and DRS" Task Queue.
 

Dashboard > Task Overview > Review Grant
Overpayment and Notify NSLDS and DRS
 

Grant Overpayment Create SFP only.
Create a new Grant Overpayment on the
student record.
 
The button appears in the following cases:

• There is packaging data available.

• At least one Title IV Grant fund is
disbursed and doesn't already Grant
Overpayment created.

• If an R2T4 has occurred for that student
Program Enrollment Status = W.

Student > Financial Information >  Grant
Overpayment > Create Grant Overpayment
button
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• For the current academic year.

 
The button doesn't appear in the following
cases:

• No Packaging data available.

• None of the current Title IV Grant funds
are disbursed.

• All available disbursed Title IV Grant funds
already have Grant Overpayments created
for full amounts; either through a task or
manual intervention.

• If an R2T4 has not occurred for that
student.

 

Hide R2T4 SFP only.
Hide an R2T4 Record.
 

Student > Financial Information > R2T4
Information > Hide R2T4 button
 

ISIR Review Task View "Complete ISIR Review" Task Queue.
 

Dashboard >  Task Overview >  Complete ISIR
Review
 

ISIR Status Override Update the status of the Active ISIR.
 

Student > USDE > ISIR, pencil icon associated
with Status field
 

ISIR Verification Task View "Complete ISIR Verification" Task Queue.
 

Dashboard > Task Overview > Complete ISIR
Verification
 

ISIR Corrector Make and Submit ISIR Corrections to the "Valid"
and "Active" ISIR.
 

Student > Financial Information > ISIR >
Make Corrections button
 

Load ISIRs Load ISIR files.
 

Administration > System Management > 
Load ISIRs
 

Load Message File View the Load Message File page and load XML
files to the MPG.
 

Administration > System Management  >
Load Message File
 

Manage Summer Term SFP only.
Add or remove Summer Terms from an
Academic Year.
 

Student >  Financial Information >
Packaging > Manage Summer Term button
 

Match Unmatched ISIRs Select IDs to which Unmatched ISIRs can be
matched.
 

Administration > FAS Management >
Unmatched ISIRs
 

NFF Eval Review Task SFP only.
View the "Re-Evaluate NFF Fund" Task Queue.
 

Dashboard >  Re-Evaluate NFF Fund
 

NFF Forms Task Review SFP only.
View the "Process an NFF Document" Task
Queue.
 

Dashboard > Task Overview > Process an NFF
Document
 

NFF Workflow SFP only. Student > Financial Information >  Non-
Federal Funds > Select Fund Type button
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Add or edit Non-Federal Funds on a Student
Record.
 

 

Origination File Update Review SFP only.
View the "Origination File Update" Task Queue.
 

Dashboard > Task Overview > Origination
File Update
 

Over Award Review Task SFP only.
View the "Evaluate Over Award Packages" Task
Queue.
 

Dashboard > Task Overview > Evaluate
Overaward Packages
 

Override Academic Years SFP only.
Override Academic Year and Payment Period
start and end dates.
 

Student > Financial Information >
Packaging >  Override Academic Years button
 

Override Anticipated Disbursement Date SFP only.
Override the Anticipated Disbursement Date by
Fund Type.
 

Student > Financial Information >
Disbursing >  Payment Period > Anticipated
Disbursement Date column, pencil icon
 

Override Disbursement Date SFP only.
Override the Disbursement Date by Fund Type.
 

Student > Financial Information >
Disbursing >  Payment Period > Date column,
 pencil icon
 

Override Disbursing Criteria SFP only.
Override Disbursement Criteria between Not
Met and Met by Fund Type:

• Override individual criterion.

• Override all criteria.

 

Student > Financial Information >
Disbursing >  Payment Period > Sequence # >
Override >   button and Override All button
 

Override G5 Disbursement SFP only.
Edit G5 information from the Disbursement
page.
 

Student > Disbursing > G5 Details > Override

Override Plus Application Default Overpay
Code

SFP only.
Override the Default Overpay Code in the
borrower details section of the application.
 

Student > USDE > Plus Application > Parent/
Grad PLUS Applications > Borrower Details > 
Override Default Overpay Code button
 

Package Fund Edit SFP only.
Add/Edit/Remove Fund Types.
 

Student > Financial Information >
Packaging > Fund Information Table
 

Password Policy Enter parameters for creating passwords.
 

Administration > Security Management  > 
Password Policy
 

Professional Judgement Review Task View the "Review Professional Judgment" Task
Queue.
 

Administration > Security Management >
Review Professional Judgment
 

R2T4 Override Edit SFP only.
Override R2T4 data or terminate R2T4.
 

Student >  Financial Information > R2T4 > 
Override R2T4 Data button and Terminate
R2T4 Data button

Re-Trigger SAP Evaluation SFP only.
Re-evaluate a SAP period record.
 

Student > SAP Information  > Trigger New
SAP Evaluation button
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Regulatory Management Set FAFSA Completion Start and End dates by
Award Year.
 

Administration >  FAS Management >
Regulatory Management
 

Role ISIR Code Updater Update the Status of an ISIR Code.
 

Student > USDE > ISIR > ISIR Codes > Change
link
 

Roles Management Create and manage Roles.
 

Administration >  Security Management > 
Roles Management
 

SAIG Errors View SAIG Error Details.
 

Administration > System Management >
SAIG Errors > View Detail button
 

SAP Appeal Review Task SFP only.
View the "Review SAP Appeal" Task Queue.
 

Dashboard > Review SAP Appeal
 

SAP Review Task SFP only.
View the "Review SAP Evaluation" Task Queue.
 

Dashboard > Review SAP Evaluation
 

SSN Viewer View the student's full Social Security Number.
 

Student > View link, anytime the SSN field is
displayed on page.
 

SAP Appeals Override SFP only.
Update the Number of Approved Appeals on
File.
 

Student > Student Record > SAP
Information > Change link
 

Student View any Student Record.
 

Student
 
Enter search terms in the Search Student box.
 

Student History View the Student History or Comments tab and
associated pages.
 

Student >  Student History/Comments >
Student History  or Comments
 

Student Holds View the Student Holds page:
 

• QC Holds.

• Student Records Hold.

Student > Student Holds > QC Holds or
Student Record Holds
 

Student Holds Modify Modify Holds (for example, Release, Update):
 

• QC Holds.

• Student Records Hold.

Student > Student Holds > QC Holds or 
Student Record Holds

Note:  Requires Student Holds permissions.

 

Student Letters View Student Letters.
 

Student > Student Record > Student Letters
 

Student Summary View the Student Summary page.
 

Student > Student Record > Student
Summary
 

System Management View and use of all items contained within
System Management:

Administration > System Management
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• SAIG Errors.

• Load ISIR File.

• Load Message File.

• Disbursement Administration.SFP only

• Administration Relief. SFP only

 

Task View the contents of a Task.
 

Dashboard > Task Overview Select a Task
Queue, Click Start or Resume button for any
Task.
 

TD Client and VUG Enable or disable TD Client.
 

Administration > System Management >  TD
Client Management
 

Transfer Change of Program Evaluator SFP only.
View the "Evaluate Student Change of Program"
Task Queue.
 

Dashboard > Evaluate Student Change of
Program
 

Transfer Overlapping Academic Years
Evaluator

Do not use. Deprecated. Not Applicable.
 

Update Fund Award Year Closeout SFP only.
View the "Update Fund Award Year Close Date"
Task Queue.
 

Dashboard >  Update Fund Award Year Close
Date
 

Updating Manual SAP Indicator SFP only.
Update the manual SAP review flag in the
Student Record.
 

Student > Student Summary select Student
Name and ID number down chevrons to expand
Student information and expose the Override
Manual SAP Indicator link.
 

Updating Professional Judgement Decision
Status

Manually override the Professional Judgement
Decision Status.
 

Student > Financial Information > 
Professional Judgement
 

User Management You can add and manage system users
manually.
 

Administration > Security Management >
User Management
 

View Hidden R2T4 SFP only.
View Hidden and Canceled R2T4 records.
 

Student > Financial Information > R2T4 >
View Hidden R2T4
 

View Unmatched ISIRs View unmatched ISIRs.
 

Administration > FAS Management >
Unmatched ISIRs
 

XML Viewer View COD Response XML File.
 

Student > Financial Information > Common
Record Information > Origination Response /
Disbursement Response > Fund Type >
Award Year  > Date/Time (received response)
 > View Complete COD XML button
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Set General Permissions Read Only  
Activating the General Read-Only Permission for a Role suppresses any ability for the user to create, update, or delete
data elements within the Student Financial Aid FAS User Interface regardless of any other assigned General Permissions
or Document Permissions.

Overview
For example, if the Dashboard is an enabled permission along with the View Document and Doc Review Task
permissions for any associated documents the user can see that a document is pending review via the View Student
Tasks link, but can't claim or complete the task. If the user has the At-Will Repackage and General Read-Only
Permission enabled, the user can view the package, but can't repackage the student, because the General Read-Only
Permission supersedes the At-Will Repackage permission.

Required Role Permissions
When the user has the following General Permission through Roles Management they aren't permitted to make any
manual overrides of any type in the Student Financial Aid FAS User Interface, regardless of any other enabled General
Permissions or Document Permissions.

• General Read-Only

See Set General Permissions Matrix for additional information.

General Read Only Permission Impacts
Administration and General Read Only
If a role is assigned with both the Administration and General Read Only General Permissions, the user will be able to
view any permission enabled Administration screens, but the user will not be able to do any of the following actions:

FAS Management G5 Management Security Management System Management

• Create or update any fund
allocations

• Enable/Disable or configure
any QC Holds

• Add/Update any FAFSA
Completion Periods

• Complete G5 Drawdowns

• Edit completed G5
Transactions

• Update the Password Policy

• Create/Update Roles

• Create/Update Users

• Update Fund Closeout Dates

• Update Awarding Closeout
Dates

• Make any updates through
Disbursement Administration

• Load ISIRs or Message Files

Student Information Permission and General Read Only
When the General Read-Only Permission is enabled, the following Manual Overrides on student-related screens are
masked, not available to the user, and not visible in the UI:

The impacts include, but are not limited to the following:

1. Student Header > Override Manual SAP Indicator
2. USDE > ISIR > View ISIR tab >ISIR Status Edit Icon
3. USDE > ISIR > View ISIR Codes tab > ISIR Code Change Link
4. View Student Tasks "Claim # of #" button
5. Documents >  > Received/Pending Documents > Request Documents button
6. Documents >  > Received Documents Edit Details button
7. Documents >  > Received Documents View Details button
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8. Documents > Received Documents  > View Details > Request Documents button
9. Documents > Received Documents > View Details > Edit Details button

10. Documents > Received Documents > View Details > Add Comments button
11. Financial Information > Disbursing > Edit Disb Amts button
12. Financial Information > Disbursing > Current Disbursement Date Column > Edit Icon
13. Financial Information > Disbursing > Anticipated Disbursement Date Column > Edit Icon
14. Financial Information > Disbursing > Seq. #  > Disbursement Criteria Override All button
15. Financial Information > Disbursing > Seq. #  > Disbursement Criteria Override buttons

Manual Processing Steps
1. Sign into the Student Financial Aid FAS User Interface (UI).
2. Navigate to Administration > Security Management > Roles Management.
3. Click the General Read-Only Permission toggle switch to enable or disable that permission. The General

Read-Only Permission can't be assigned to the SYS_ADMIN Role.
4. Click Save.

Related Topics
• Set General Permissions Matrix

User Management  
Through User Management an authorized user can manage users and role assignments. Explore the following features
within associated child pages.

Edit a User
If for any reason you need to edit a user, you can easily update their username, name, email, and/or role assignments.
Make sure to save updates and inform the user they must log out and then log back into the Student Financial Aid user
interface for the updates to take effect.

Disable a User
You can even disable a user temporarily or permanently. When a user account is disabled the user is not able to log in
to their account. The user is not deleted from the user account information screen, so if you later need to re-enable the
user, you can simply update the users account by choosing the appropriate radio button.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Add a New User
Log into the Student Financial Aid User Interface (UI)

1. Navigate to Administration > Security Management > User Management

72



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 4
Using Administration

2. Click the New User button
3. Enter Username
4. Enter First Name
5. Enter Last Name
6. Enter Email
7. Select Roles
8. Click Save

To add multiple new users, check the Create Another box and Student Financial Aid will save the existing record and
open a new user dialog box automatically.

Edit and/or Disable a User
Log into the Student Financial Aid User Interface (UI)

1. Navigate to Administration > Security Management > User Management
2. Click the row for the User to Edit/Disable
3. Update user info (if needed)
4. Update roles (if needed)
5. Enable/Disable as needed

a. Add a comment if you are disabling a user
6. Click Save

Using System Management  

System Management  
Through System Management you can control the Awarding and Fund Close-Out Dates per fund type, override
specific disbursement details, and load ISIRs and/or other files through the Messaging Processing Gateway (MPG).

Administrative Relief  
Student Financial Planning (SFP) limits the packaging of any new awards past the configured Awarding Close Out Date
and removes projected/estimated awards from the package.

Overview
Only students Awarded funds by the Awarding close-out date remain packaged and pending disbursement until the
Fund Close Out Date is met. And once the system date is equal to or greater than the COD Close Out Date the system
Prohibits any COD communication for that fund type, for that award year.

• Phase 1: Award
◦ Cancel projected awards

◦ Select upcoming award year

◦ Limit new awards

• Phase 2: Fund
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◦ Build-down awards

◦ Cancel non-disbursed disbursements

◦ Shift award year

◦ Transfer all updates to COD

• Phase 3: COD

◦ Prohibit automated COD communication

◦ Disbursement status updates

If a return or a re-entry within 180 days creates a disbursement in a closed-out award year, SFP creates a Manual Fund
Award Year Closeout Date Evaluation Review task for manual review and you will be able to determine if the award year
needs to be re-opened so processing can continue within the SFP system.

What Student Financial Planning Does Automatically
SFP automatically does the following things:

Cancels disbursements in a closed-out award year
When the SFP system date is equal to a configured or overridden award year close-out date for a fund type, SFP cancels
all pending disbursements associated with the closed-out award year for Title IV and non-federal fund types. If the
institution re-opens an award year by extending the configured close-out date for the fund type, SFP re-triggers the
process to cancel any pending disbursements once the new/updated award year close-out date has been reached.

Updates the award year for cross-over periods
SFP evaluates all periods for a given fund type that have closed-out to determine whether the award year can be
updated for the period. If the award year can be updated for a period, SFP calculates the student's fund eligibility for
that period using the updated award year. When the award year for a period is updated due to an award year close-
out, SFP does not create any new disbursements under the new award year, until all disbursements from the closed-out
award year are canceled.

Once an award year has been updated for a period due to the award year close-out, SFP does not revert the period to
the previous award year even if the award year is re-opened. If the student re-enters, SFP ensures that the award year is
not updated for the period in which he has re-entered, even if the award year has closed-out and all award year update
criteria have been met. SFP evaluates whether the award year close-out date has occurred each time eligibility has been
calculated for a period (e.g. payment period, loan period).

SFP only updates the award year for Title IV fund types.

Limits awarding of funds in close-out award years
After the configured award year close-out date for a fund type has passed, SFP ensures that funds are not awarded or
updated within the close-out award year.

Limits updates to disbursements upon the COD close out date
Once the award year has closed-out for a fund type, SFP ensures that disbursements are not updated/processed within
the closed-out award year for both Title IV and non-federal fund types. SFP limits disbursement amounts from being
created within the closed-out award year. However, returned disbursements can be created for a closed-out award year
(e.g. due to R2T4 calculation) and disbursements can potentially be created in a closed-out award year if the academic
year evaluated is part of a re-entry within 180 days.
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SFP only allows disbursements to be processed if the award year is open for the fund type.

Prohibits COD communication after the COD close out date
After the COD close-out date for a fund and award year has passed, SFP prohibits all automated COD transactions for
the fund type/award year combination. After the COD close-out date has been reached, all disbursements triggered
for origination are updated to Origination Pending Re-opened Award Year and all triggered disbursements/returns
are updated to Disbursement Pending Re-opened Award Year. When a funds disbursement statuses is Origination/
Disbursement Pending Re-Opened Award Year, the disbursement is not picked up by the origination/disbursement file
delivery batch job.

You can manually update the COD close-out date configuration after the initial COD close-out date has been reached for
a fund type and Aid Year. When the COD close-out date has been updated, the system sets all disbursements previously
set to Origination/Disbursement Pending Re-opened Award Year to Origination/Disbursement Ready to be sent to
COD.

After the COD close-out date is reached, you can use Disbursement Administration to manually process and
communicate disbursement groups to COD for a fund type/Aid Year combination.

Note:
• For automated fund close-out processing with COD, set the Award Year close-out date prior to the COD close-

out date.

• To process a fund group post COD close-out, navigate to Administration > System Management >
Disbursement Administration and update the disbursement group to the appropriate Origination/
Disbursement Sent to Cod status

Configurable Attributes
• The institution can configure the award year close-out date.

• The institution can configure the fund close-out date.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Administration

• Administrative Relief

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view default or overridden close-out dates
Student Financial Planning User Interface > Administration > System Management > Administrative Relief

Update Close-Out Dates  
You can manually override the Award Year, Fund, and COD Closeout Dates through the Administrative Relief page in the
Student Financial Planning UI.
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Overview
If the Awarding Close-Out Date is equal to or less than the current date, Student Financial Planning:

• Doesn't package students for that fund type for that Award Year.

• Cancels disbursements for that fund type/Aid Year that are only projected or estimated.

• Leaves non-disbursed disbursements for awarded funds alone until the Fund Close-Out Date is met.

If you extend the date before the configured date, funds aren't impacted. If you override an Awarding Close-Out Date
after the configured date, funds that have been canceled due to Awarding Close-Out Date and awarded out of the
subsequent Award Year (due to a cross-over period) aren't repackaged with prior year funds. When the overridden
Awarding Close-Out Date is met for a fund type/Aid Year, the application:

• Doesn't package students for that fund type for that Award Year.

• Cancels disbursements for that fund type/Aid Year that are only projected or estimated.

• Leaves non-disbursed, disbursements for awarded funds alone until the Fund Close-Out Date is met.

If the Fund Close-Out Date is equal to or less than the current date, the application cancels any non-disbursed
disbursements and removes them from the student's package. When the Fund Close-Out Date is overridden, the
application uses the new date to determine if funds that have been awarded but not yet disbursed should be canceled
and/or removed from the package.

If the COD Close-Out Date is equal to or less than the current date, the application prevents all communication to COD
for that fund type/Award Year by updating the Disbursement Status to Origination/Disbursement Pending Re-Opened
Award Year because disbursements in this status aren't be picked up by the origination/disbursement file delivery batch
job. When the COD Close-Out Date is overridden, the application uses the new date to determine if communication to
COD is prohibited or not.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps:

• Administration

• Administrative Relief

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration  > System Management > Administrative Relief .
2. Click Override in the Override Awarding Closeout Date column.
3. Enter the new Date.
4. Click Save.
5. Click Override in the Override Fund Closeout Date column'
6. Enter the new Date.
7. Click Save.
8. Click Override in the Override COD Closeout Date column.
9. Enter the new Date.

10. Click Save.
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Upon the next repackage or when the Award Year Close-Out batch job runs the following occurs:

1. If the Awarding Close-Out Date is =< Current Date.
a. No longer award the fund type for new packages.
b. If the fund has already been awarded, it remains awarded until the Fund Close-Out Date is met.

2. If the Fund Close-Out Date is =< Current Date:
a. Cancel or remove Awarded funds that aren't disbursed from the package.

3. If the COD Close-Out Date is =< Current Date:
a. COD communication is prevented.

Disbursement Administration  
Disbursement Administration is totally manual and Student Financial Planning accepts any value entered by the user.

Overview
It should only be used by experienced/authorized users only that have an in-depth knowledge of the origination
and disbursement process and integrations/workflows setup between Student Financial Planning and Common
Originations and Disbursement (COD). To use these features, the user must be assigned a role that has the
Disbursement Administrator, General Permission enabled.

When a student record is updated through the Disbursement Administration screen, the update is a one-time manual
update. Neither the fund type nor the disbursement requires additional monitoring. The receipt of new documents,
messages, etc will continue to be processed automatically. It should be noted, that one-time manual updates made by a
user can be overridden by future automated process updates.

Making updates through the Disbursement Administration screen allows the institution to update the Student Financial
Planning system to match the accurate information reported by COD or to update COD with accurate information
processed by Student Financial Planning. This functionality was created to allow the institution maximum flexibility to
update disbursements and disbursement information.

Note:  When an adjustment is made outside the application directly with COD, you must update the application to the
sequence number created on COD (66-99). If you don't update the sequence number to a value between 66-99, the
next time the application communicates with COD, COD will reject the disbursement record for incorrect sequence
numbers.

Student Financial Planning User Interface Actions
In order to update disbursements, there are different options available. From the Disbursement Administration user
interface, you can:

1. Save Disbursement Records

◦ The Student Financial Planning User Interface is updated, but communication is not sent to COD

◦ The Disbursing screen is updated, but no further downstream automation occurs

◦ Future automated or manual updates could override a one-time manual override made through the
Disbursement Administration screen
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2. Send Originations to COD

◦ Communication is sent to COD for the entire fund group, for every fund type

◦ Downstream automation occurs automatically:
- Disbursing screen updates with manually overridden data
- Additional Disbursement Sequence Numbers are automatically created as necessary
- Disbursement Status for updated disbursement(s) set appropriately in order to be picked up in

origination/disbursement batch jobs
3. Re-Originate

◦ Communication is sent to COD for the entire fund group, but only for the fund type selected (for example,
Pell - 2015-2016 AY1 PP1)

◦ Downstream automation occurs automatically:
- Disbursing screen updates with manually overridden data
- Additional Disbursement Sequence Numbers are automatically created as necessary
- Disbursement Status for updated disbursement(s) set appropriately in order to be picked up in

origination/disbursement batch jobs

Using the Disbursement Administration UI versus the Disbursing UI
When an authorized user updates disbursement information through the Disbursement Administration UI
(Administration > System Management  > Disbursement Administration), the update is a one-time manual override.
The disbursement isn't put into manual mode; therefore, future automation is not interrupted. Future automation or
manual updates may override the one-time manual override a user made using the Disbursement Administration tool.
A common scenario for making updates using the Disbursement Administration UI is to update the system to match
changes that were made directly in the COD system, being careful to match the COD-generated sequence number.

You are also able to update disbursement information using the Disbursing UI (Student > Financial Information >
Disbursing).

When updates are made through the Disbursing UI the disbursement that is updated is put into manual mode and must
be monitored throughout the duration of the payment period. If only one fund type for one payment period is manually
overridden, only that fund type for that payment period is put into manual mode. If a disbursement is increased or
reduced and it results in a need for additional disbursement sequence numbers, Student Financial Planning will create
any required additional sequence numbers, complete any related math for that disbursement, set the disbursement
status correctly. For more information on using the Disbursing UI, see Disbursing.

Overrides within the Disbursement Administration UI
Overrides done within the Disbursement Administration UI should be thought of as setting a value that can potentially
be overridden by the system as needed and won't prevent automation.

These fields can be subsequently updated by the system as needed during automation:

• Disbursement Status

• Total Amount

• Incremental Amount

• Incremental Net Amount

• Cancellation Reason

• Cancellation Date

• Re-Originate
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The system won't override these manually updated fields but will automate additional updates based on the values set
by the user:

• Disbursement Number

• Sequence Number

• Payment ID

• Disbursement Date

• Return to Lender ID

• Return Date

• Delete

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Administration

• System Management

• Disbursement Administrator

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the disbursement administration screen  Student Financial Planning User Interface > Administration >
System Management  > Disbursement Administration

Select A Student  
You can review and update any disbursement in a student's program from the Disbursement Administration screen.
First, you must Select a Student.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• System Management

• Disbursement Administration

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > System Management > Disbursement Administration
2. Enter the student External Student ID in the search field
3. Select the correct student from the available options displayed

If you navigate away from this screen, you will need to repeat these steps.
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Update a Disbursement Loan ID  
You can update a Disbursement Loan ID.

Overview
When Common Origination and Disbursement (COD) identifies a record with an invalid Loan ID and rejects it, you can
take manual steps to send an updated correct record.

You can delete the generated disbursements, trigger repackaging, and update any remaining disbursements manually
and report them to COD.

Required Role Permissions
You must have a Role with the following General Permissions through Roles Management to complete the manual
processing steps:

• Administration

• System Management

• Disbursement Administrator

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI).

1. Navigate to Administration > System Management > Disbursement Administration.
2. Enter the student's External Student ID in the search field and select student.
3. Select the check box in the Delete column for the disbursements that have an incorrect Disbursement Loan ID.
4. Click Save Disbursement Records.
5. Query the same student in the main tool bar.
6. Navigate to Student > Package.
7. Click Repackage to trigger a manual repackage.
8. Refresh the page until you observe an updated Package Create Date/Package Version.
9. Navigate to Administration > System Management > Disbursement Administration.

10. For all remaining disbursements:
a. Select a blank Cancellation Reason.
b. Click the "X" by each Cancellation Date to remove it.
c. Select a Origination Ready to be Sent to COD Disbursement Status.
d. Click Save Disbursement Records.
e. Click Send Originations to COD.

The application automatically submits the student's information to COD after triggering the batch jobs.

Update Manually Created Incorrect Amounts  
When a user manually updates a disbursement with an incorrect amount, you can reset the fund and recreate the
disbursements.
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Required Role Permissions
You must have a Role with the following General Permissions through Roles Management to complete the manual
processing steps:

• Administration

• System Management

• Disbursement Administrator

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI).

1. Navigate to Administration > System Management > Disbursement Administration.
2. Enter the student's External Student ID in the search field and select student.
3. Select the check box in the Delete column for the disbursements that have an incorrect Disbursement Loan ID.
4. Click Save Disbursement Records.
5. Query the same student in the main tool bar.
6. Navigate to Student > Package.
7. Click Repackage to trigger a manual repackage.
8. Refresh the page until you observe an updated Package Create Date/Package Version.
9. Navigate to Administration > System Management > Disbursement Administration.

10. Identify the newly created disbursements and for each and click the Re-originate link.
11. Click Send Originations to COD.

The application automatically submits the student's information to COD after triggering the batch jobs.

Update Disbursement Number and Sequence Number  
You can update the Disbursement Number and/or Sequence Number for any given disbursement.

Overview
A user may change the disbursement and/or sequence numbers to update the Student Financial Planning disbursing
screen so that it matches what is reported via Common Originations and Disbursements (COD) or in order to update
COD.

Additional Rational for reconciling SFO when adjustments are made outside the SFP system.

When an adjustment is made outside the system directly with COD, you must update Student Financial Planning to the
sequence number created on COD (66-99). If you do not update the sequence number to a value between 66-99, the
next time the system communicates with COD, COD will reject the disbursement record for incorrect sequence numbers
(i.e. Reject 56).

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• System Management

• Disbursement Administrator
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See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > System Management > Disbursement Administration
2. Enter the student's External Student ID in the search field and select student
3. Double click the existing number under the Disb. # column to update the Disbursement Number
4. Double click the existing number under the Seq. # column to update the Sequence Number
5. Take Action

a. Click Save Disbursement Records to save the information in the Student Financial Planning UI
b. Click Send Originations to COD to communicate the originations for the entire fund group for every

fund type
c. Click Re-originate to communicate the originations for the entire fund group for the fund type selected

Tips for updating the Disbursement/Sequence Numbers

If you are updating Student Financial Planning to reflect the disbursement number and/or sequence number reported
in COD, you do not have to re-originate the disbursements, just click "Save the Disbursement Records" button. Once you
save the disbursements, confirm the disbursement/sequence numbers are updated correctly in the Disbursing UI and
the updated info matches what is reported on COD. If you do not click the "Re-originate" link, the updates are not sent
to COD and are only updated in the Student Financial Planning UI.

However, if you need to change the disbursement/sequence numbers in order to update COD, update the
disbursement/sequence number appropriately, update the disbursement status to "Origination Ready to Send to COD,"
and then click the "Re-Originate" link for each disbursement record that you updated. When the Disbursement Batch
Job runs, it picks up all disbursements in a status of "Origination Ready to Send to COD."

Update the Disbursement Status  
You can update the disbursement status.

Overview
However, some disbursement statuses require additional fields to be updated. If you update the disbursement status to
any of the following, to keep the data consistent, confirm or correct the additional editable fields:

Status Editable Fields

Disbursed • Payment ID

• Disbursement Date

Disbursement Cancelled • Cancellation Reason

• Cancellation Date

Disbursement Returned • Return to Lender ID

• Return Date

Payment ID: When a user updates the status to Disbursed, Student Financial Planning validates that the sequence
number is equal to 1. If that requirement is met, Student Financial Planning generates a unique Payment ID (based on
the defined Payment ID rules). However, you can override it.
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Return to Lender ID: When a user updates the status to Disbursement Returned, Student Financial Planning validates
the sequence number is greater than 1 and there is a sequence number 1 in a status of Disbursed. If that requirement
is met, Student Financial Planning generates a unique Return to Lender ID (based on the defined Return to Lender ID
rules). However, you can override it.

Return Date: Student Financial Planning should only allow you to add a return date if the disbursement status is
Disbursement Returned. When a return date is entered, a Return to Lender ID must also be entered.

Tips for Updating the Disbursement Status

Instead of setting the status to “Projected”, “Origination Ready to be Sent to COD” or “Disbursement Cancelled”, set the
disbursement status to “Disbursement Scheduled”.

When the status is set to "Disbursement Scheduled" the disbursement cancellation process is triggered, the
disbursement then goes through QC and then Student Financial Planning decides if the cancellation process needs to
be communicated to COD. If you do not use the "Disbursement Scheduled" status the system cancels the cancellation
process and the COD engine does not recognize that the disbursement is canceled. Unlike previously the system cannot
simply go off the cancellation reason being set since Student Financial Planning is now communicating funds while a
disbursement is on QC hold. Student Financial Planning had to introduce a disbursement process that the system can
start, finish, cancel, and so on, and that is being used by the COD engine to determine how to communicate it.

Note:  It is VERY IMPORTANT to update Student Financial Planning if COD is updated outside of the Student
Financial Planning system. If Student Financial Planning is not updated to match COD, rejects may occur.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• System Management

• Disbursement Administration

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate toAdministration > System Management > Disbursement Administration
2. Enter the student's External Student ID in the search field and select the student
3. Click the Disbursement Status drop-down menu for the disbursements you want to update
4. Choose a new disbursement status

◦ Complete any other additional updates as necessary

5. Click Save Disbursement Records

◦ Confirm Updates

◦ Refresh screen and review updates

In this scenario, if you need to communicate the updates to COD:

◦ To send only the updated disbursement record(s) to COD, click Re-originate to the right of each updated
disbursement
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◦ To send all disbursement records to COD, click Send Originations to COD.

6. Review disbursing screen and confirm the disbursement status updated.

Manually Trigger Disbursement Information or Return to Lender Messages  
For disbursements with a Disbursement Status of “Disbursed” or “Disbursement Returned”, you can manually trigger
the Disbursement Information Event message or the Return to Lender Event message, respectively.

Overview
You can trigger the Disbursement Information Event or the Return to Lender Event messages regardless of whether you
configured a fund to send disbursements.

Required Role Permissions

The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Disbursement Administration

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > System Management > Disbursement Administration.
2. Enter the student's External Student ID in the search field and select the student.
3. Select Trigger Disbursement Message for Disbursed disbursements, as needed.
4. Select Trigger Return Message for Disbursement Returned disbursements, as needed.
5. Click Save.

Downstream Impact
Once you’ve selected either message trigger option, Disbursement or Return, for a disbursement, the Message
Processing Gateway sends the appropriate outbound message.

Example Scenario
This feature can be used to support testing the disbursement process without having to load the COD responses or
wait for any disbursement criteria to force the system to generate the outbound messages. Also, this feature can be
used when transactions are done outside of the system, and you need to manually trigger a message to your financial
system.

Update The Cancellation Reason And Date  
You can add, update or remove the cancellation reason and date through the disbursement administration screen.

Overview
You can choose from any of the alternate cancellation reasons or remove it. Make sure to update the disbursement
status appropriately when updating the cancellation reason.

Tips for Updating the Cancellation Reason and Date
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Adding the Cancellation Reason

• Update the Disbursement Status to Disbursement Canceled

• Select Cancellation Reason

• You must enter a Cancellation Date

Editing the Cancellation Reason

• Confirm the Disbursement Status is Disbursement Canceled

• Select any alternate Cancellation Reason

• Update the Cancellation Date as needed

Removing the Cancellation Reason

• Update the Disbursement Status (see Update the Disbursement Status)

• Select the Null value

• Remove the Cancellation Date

Note:  Make sure to Save Disbursements, Send to COD or Re-originate the fund group to complete the update. See
Disbursement Administration for more details about these options.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• System Management

• Disbursement Administrator

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Add a Cancellation Reason / Date
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > System Management > Disbursement Administration
2. Enter the student's External Student ID in the search field and select the student
3. Click the Disbursement Status drop-down menu and update the status to Disbursement Canceled
4. Click the Cancellation Reason drop-down menu and choose a Cancellation Reason
5. Click the Cancellation Date field to access the calendar picker and choose a Cancellation Date
6. Click Save Disbursement Records

◦ Confirm Updates

◦ Refresh screen and review updates

In this scenario, if you need to communicate the updates to COD:

◦ To send only the updated disbursement record(s) to COD, click Re-originate to the right of each updated
disbursement.
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◦ To send all disbursement records to COD, click Send Originations to COD.

7. Review disbursing screen and confirm the Disbursement Status
8. Click the Sequence Number and confirm the Cancellation Reason

Remove a Cancellation Reason / Date
Log into the Student Financial Planning User Interface (UI)

1. Select the appropriate disbursement status from the disbursement status drop-down menu
2. Select the "Null/Blank" option at the top of the Cancellation Reason drop down menu
3. Click the X to the right of the Cancellation Date to remove it
4. Click Save Disbursement Records

In this scenario, if you need to communicate the updates to COD:
◦ To send only the updated disbursement record(s) to COD, click Re-originate to the right of each updated

disbursement
◦ To send all disbursement records to COD, click Send Originations to COD.

5. Review disbursing screen and confirm the Disbursement Status
6. Click the Sequence Number and confirm the Cancellation Reason (Section should not be displayed)

Update the Disbursement Amounts  
You can Update the Disbursement Total Amount, Incremental Amount and/or Incremental Net Amount.

Overview
There are no validations or updates that are automatically made to loan fees. Therefore, you will need to use the
disbursement’s current loan fee rates to determine what the net and gross amounts should be to avoid rejects with COD.

Tips for updating the Disbursement Amount (Disbursing vs Disb Admin)

If you updated Disbursement Amounts directly through COD and you need to update the Student Financial Planning
User Interface, complete the updates through Disbursement Administration. If however, you need to update COD,
make Disbursement Amount updates through the Disbursing screen instead of Disbursement Administration. When
you make the update to the disbursement amount on the Disbursing screen, Student Financial Planning automatically
creates the correct Disbursement/Sequence Numbers to correctly update COD.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• System Management

• Disbursement Administrator

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > System Management > Disbursement Administration
2. Enter the student's External Student ID in the search field and select the student
3. Double click the Disbursement Amount you want to update and enter new amount

86



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 4
Using Administration

4. Click Save Disbursement Records
◦ Confirm Updates

◦ Refresh screen and review updates

In this scenario, if you need to communicate the updates to COD:

◦ To send only the updated disbursement record(s) to COD, click Re-originate to the right of each updated
disbursement.

◦ To send all disbursement records to COD, click Send Originations to COD.

5. Review disbursing screen and confirm updates.

Update The Payment ID And Disbursement Date  
When you update the disbursement status to Disbursed, you need to Update the Payment ID and Disbursement Date
associated with the disbursement.

Overview
The application validates that the sequence number is equal to 1. If that requirement is met, the application generates a
unique Payment ID based on the defined Payment ID rules. However, you can override the Payment ID.

Tips for updating the Payment ID and Disbursement Date

• If you are using the Disbursement Administration tool to trigger a disbursement, the Disbursement Date should
be added and should be equal to the current system date.

• If you Update the Disbursement Date to match the source system (for example, Ledger Posting Date) or
COD, make sure the disbursement status is Disbursed and enter the Disbursement Date that is posted to the
student's ledger.

• You can enter or update a Payment ID using the Disbursement Admin UI or API that meets one of the following
conditions:

◦ If Payment ID is from an external source, it doesn't begin with the letter P.

◦ If Payment ID begins with the letter P, it matches that Payment ID the system generated Payment ID.
If conditions aren't met, an error message displays.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete
these manual processing steps:

• Administration

• System Management

• Disbursement Administrator

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > System Management  > Disbursement Administration
2. Update the Disbursement status

◦ Update to Disbursed to reconcile with source system and/or COD
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◦ Update to Disbursement Ready to be sent to COD to trigger the disbursement

3. Confirm / Update the Payment ID (Required)
4. Use the Date Picker and choose the Disbursement Date (Required)

◦ Ledger Posting Date - To reconcile with source system and/or COD

◦ Current System Date (i.e. today) - to trigger the disbursement

5. Click Save Disbursements Records

◦ Confirm modifications

◦ Send Originations to COD and/or Re-Originate if you need to communicate the updates to COD

6. Review the disbursing UI to confirm changes

Additional Actions Required - Disbursement Date

After updating the Disbursement Date in the Disbursement Administration UI, you may be required to navigate to the
Packaging UI and click the Repackage button.

Disbursement Date

The disbursement date is a required field and should never be NULL for disbursements that are being sent to COD or
have disbursed.

Update the Return to Lender ID and Return Date  
When you update the disbursement status to Disbursement Returned, you need to Update the Return to Lender ID and
Return Date.

Overview
The application validates the sequence number is greater than 1 and that there is a sequence number 1 in a status of
Disbursed. If those requirements are met, the application generates a unique Return to Lender ID based on defined
rules. However, you can override the Return to Lender ID.

Tips for updating the Return to Lender ID and Date

The Return to Lender ID and Return Date are required and should be set or updated together.

• The Sequence 1 disbursement must be in a status of Disbursed .

• The Sequence Number must be great than 1 to update the status to Disbursement Returned.

• A Return Date must be entered if the disbursement is being returned.

• There must be a unique Return to Lender ID Number.

• You can enter or update a Return ID using the Disbursement Admin UI or API that meets one of the following
conditions:

◦ If Payment ID is from an external source, it doesn't begin with the letter R.

◦ If Payment ID begins with the letter R, it matches that Payment ID the system generated Payment ID.
If conditions aren't met, an error message displays.

Student Financial Planning should only allow the user to add a return date if the disbursement status is Disbursement
Returned.
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Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• System Management

• Disbursement Administrator

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > System Management  > Disbursement Administration
2. Update the Disbursement Status to Disbursement Returned

◦ Sequence Number for disbursement(s) must be greater than 1

◦ There must be a Sequence Number 1 in a status of Disbursed

3. Confirm/Update the Return to Lender ID and Return Date

◦ Manually Update the Return to Lender ID and/or Return Date (if needed)

4. Save Disbursement Records

◦ Confirm modifications

◦ Send Originations to COD and/or Re-Originate if you need to communicate the updates to COD

5. Review the disbursing UI to confirm changes.

Delete a Disbursement  
When you manually Delete a Disbursement, the entire disbursement record is deleted as if it never existed in Student
Financial Planning.

Overview
Also, a Student History Entry is created when you manually delete a disbursement using the Disbursement Admin tool.
For audit trail clarity, there are two types of entries with detailed program/fund information including user identifying
information:

• An entry for each individual disbursement that is deleted.

• An entry if an entire Fund Group is deleted by a user. A Fund Group consists of all disbursements in an award
year for Title IV Grants or all disbursements in a Loan period for Title IV Loans.

Tips for Deleting a Disbursement

If the student is repackaged it may result in the disbursements being repackaged.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration
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• System Management

• Disbursement Administrator

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Administration > System Management  > Disbursement Administration
2. Check the box next to the disbursements you want to delete
3. Click the Save Disbursement Records button

◦ Confirm modifications

4. Confirm the disbursements selected have been deleted
5. Review the Disbursing UI to confirm changes

◦ Confirm the Packaged Amount has been zeroed out on the Packaging UI (if applicable)

Recreate Deleted Disbursments  
You can recreate a fund and its associated disbursements after they were manually deleted or overridden.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps listed below.

• Administration.

• System Management.

• Disbursement Administrator.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI).

1. Navigate to Administration > System Management  > Disbursement Administration.
2. Search for the student.
3. Verify that the expected fund isn't present. If the fund is present, no further steps are necessary.
4. If you don't find the fund, navigate to Student > Packaging.
5. Scroll down to the bottom of the Fund Information section of the package and click Add Fund.
6. Add Fund and click Save.
7. Navigate to Administration > System Management  > Disbursement Administration.
8. Find the newly generated disbursements and update the details as needed.
9. Click Save Disbursement Records.

10. Scroll to the Fund you want to recreate.
11. Update the Disbursement Status to Disbursed.
12. Enter Payment ID.
13. Enter Disbursement Date.
14. Click Save Disbursement Records.
15. Review the student record as needed.
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Load ISIRs  
ISIRs can be loaded through the Student Financial Aid User Interface.

Overview
You can Load ISIRs into Student Financial Aid one at a time, by adding multiple ISIR records to one file or by uploading
multiple files. There is, however, a 1MB maximum file size limitation.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• System Management

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Navigate to Administration > System Management > Load ISIRs
2. Click the Choose Files button
3. Select files

◦ You can load a single file with a single ISIR record

◦ You can load a single file with multiple ISIR records

◦ You can load multiple files with single or multiple ISIR records

◦ There is a maximum upload file size of 1MB

4. Send (sends files through the Student Financial Aid US Department of Education Gateway)
5. Confirm the files upload successfully

You may want to confirm the file(s) are visible in the Student Financial Aid user interface by reviewing the ISIR
information screen. See View ISIR to learn how.

Related Topics
• View ISIR

Load Message File  
The Load Message File screen allows you to upload an inbound MPG message file.

Overview
You can upload one or multiple files for a single student or multiple students. When you upload an MPG file through the
Student Financial Aid User Interface (UI), the file posts to the MPG URL, handled by the Message Processing Gateway
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(MPG) the same as if it is received from an external source. The system reports any http errors on the UI if a post to
MPG fails. Also, before Student Financial Aid does a post to the MPG URL the system does xml schema validation in
java to make sure it will pass. If the post fails xml schema validation the system does not complete the post and the
MPG never sees it. Student Financial Aid reports the xml schema validation errors on the UI so the user can see it,
fix them and try again. However, it is possible for a Student Financial Aid API event to fail in Student Financial Aid for
reasons that cannot be checked in advance through xml schema validation. If the message fails any defined business
validation rules, these errors will not display on the UI, but can be reviewed in the app_event_error report or via the
MessageValidationErrorReply event.

When a file is uploaded unsuccessfully, the Error Code and Error Message will be displayed.

When a file is uploaded through the Student Financial Aid UI, a student history entry is catalogued.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Load Message File

• System Management

• Administration

See Set Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Navigate to Administration > System Management > Load Message File
2. Select Files manually
3. Drag and drop file(s) onto the page
4. Review MPG message upload info on the UI
5. View the uploaded file (View only, no edit functions)
6. Navigate to Student  > Student History/Comment > Student History
7. Select the category Manual Mode
8. Click the Entry title to view student history message

SAIG Errors  
Use the Student Aid Internet Gateway (SAIG) Error Handling feature to process errors and route them to specific task
queues for review and resolution.

Overview
The Student Aid Internet Gateway (SAIG) allows Federal Student Aid trading partners to securely exchange batch data
with your financial aid processing applications.

Here are some important acronyms:
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Acronym Description

SAIG Student Aid Internet Gateway

CPS Central Processing System

FPS FAFSA Processing System

COD Common Origination and Disbursement

NSLDS National Student Loan Data System

TSM Transfer Student Monitoring

FAH Financial Aid History

What Student Financial Aid Does Automatically
Student Financial Aid (SFA) automatically:

Recognizes Students with No Grants or Loans on NSLDS
Sometimes, the student doesn't have any grant or loan history in NSLDS, there are warning edits in their TSM or FAH
files. In these cases, SFA the warning edits but considers the student eligible for financial aid, awards, and disburses
funds.

Matches COD Errors
The application matches its outbound records to inbound COD records to determine if the document originated from
your institution. If there isn't a match, the application classified received COD record as Not Matching.

Matches FPS/CPS and NSLDS Errors
The application matches student records to inbound FPS/CPS and NSLDS records. If there isn't a match, the application
classifies the received FPS/CPS or NSLDS record as Not Matching.

Creates an SAIG Error Handling Task
The application creates SAIG Error Tasks and sorts them into related COD, FPS/CPS, and NSLDS queues.

Re-Submits files to COD, FPS/CPS, and NSLDS
When you resolve an SAIG Error, the application re-submits the file through the SAIG for COD, FPS/CPS and/or NSLDS
to process the file. If the student record has multiple errors, the application only resubmits the file through the SAIG
when all applicable errors are resolved. After you resolve an error, you can try to process an inbound file again if the
SAIG doesn't recognize the file type.

Required Role Permissions
The user must have a role with these General Permissions through Roles Management to view the SAIG Error Queue:

• Administration.

• System Management.

• SAIG Errors.
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See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Aid User Interface Functionality
To review the SAIG Error Queue, navigate to:
Administration > System Management > SAIG Errors

1. You can reduce returned results by selecting an Award Year.
2. You can sort by Received Date or Error code.

SAIG Administration  
You can connect to the U.S. Department of Education's (ED) Student Aid Internet Gateway (SAIG) and update your
school's SAIG Password.

Overview
Navigate to the SAIG Administration screen and enter the TG Number, Password, and test password connectivity. After
this, running the Vocado U.S. Department of Education Gateway (VUG) uses the new or updated connection details.

An audit history of all the changes made to the SAIG connection details are displayed on the SAIG Administration
page. An audit record is created for each update to the connection details, including the User and Date/Time the
change was made. Audit history records are sorted with the most recent change first.

Note:  There are two SAIG mailboxes to control:
• FTI-SAIG for Federal Tax Information (FTI) data.

• SAIG for all other ED data.

Required Role Permissions
You must have a role with the following General Permissions through Roles Management to complete the manual
processing steps.

• Administration.

• SAIG Administration.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Reset FTI-SAIG and SAIG Passwords
Log into the Student Financial Aid User Interface (FAS UI).

1. Navigate to Administration > System Management > SAIG Administration > Reset FTI-SAIG Password or
Reset SAIG Password

2. Enter the TG Number for FTI-SAIG or SAIG.

Note:  Make sure you include the entire TG Number including the TG prefix, just as you would when using
ED's EDConnect software.

3. Enter Password.
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4. Click Test Password.
5. Click Save upon confirmation of a successful test.

Note:  ED requires your FTI-SAIG and SAIG passwords be changed every 90 days. Be sure to update your password in
the system immediately after updating with ED.

Note:  If the password test fails, follow steps to check TD Client Health in Manage TD Client.

Manage TD Client  
TD Client is the mechanism used to transfer files back and forth between a school and the United States Department of
Education Student Internet Gateway (SAIG).

Enable and Disable TD Client
You can use this feature to universally control the transmission of files with the Central Processing System (CPS)/FAFSA
Processing System (FPS) or Common Origination and Disbursement (COD) using the SAIG. This feature applies to both
Award Year-based and Non-Award Year based file formats.

You can also evaluate the status of the TD Client connection in this feature. A status of Passed or Not Passed displays
based on the health check outcome.

Note:  There are two TD Clients:
• FTI TD Client for transmission of ISIRs that contain sensitive Federal Tax Information (FTI) data received from

FPS.

• TD Client for all other ED data.

Required Role Permissions
The user must have a role with the following General Permission through Roles Management in order to complete the
manual processing steps listed below:

TD Client Management.

See: Set General Permissions Matrix

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI).

Enable and Disable FTI TD Client or TD Client
1. Navigate to: Administration > System Management > TD Client Management.
2. Select the FTI TD Client Selection Indicator to toggle between Active (enabled) and Suspended (disabled).
3. Select the TD Client Selection Indicator to toggle between Active (enabled) and Suspended (disabled).

Check FTI TD Client or TD Client Health
1. Navigate to: Administration > System Management > TD Client Management.
2. Click the Check TD Client Health button for the FTI TD Client or the TD Client.

A status of Passed or Not Passed displays.
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3. If Not Passed, select the TD Client Selection Indicator  to Suspended (disabled).
4. Click Save.
5. Wait at least 90 minutes.
6. Log into the Department of Education's site to reset customer password.
7. Confirm the password works using EdConnect or some other tool.
8. Navigate to Administration > System Management > SAIG Administration
9. Enter TG Number.

Note:  Make sure you include the entire TG Number including the TG prefix, just as you would when using
ED's EDConnect software.

10. Enter Password.
11. Click Test Password.
12. Click Save upon confirmation of a successful test.
13. Navigate to: Administration > System Management > TD Client Management.
14. Select the TD Client Selection Indicator  to Active (enabled).
15. Click Save.
16. Click the Check TD Client Health button. A status of Passed or Not Passed displays. If Not Passed, repeat this

task starting with Step 3.

Configuration Administration  
You can manage application setup done through Configuration Workbooks using Configuration Administration in the
FAS (administrative) UI.

File Structure, Naming Conventions, and Workbooks
Setting up your instance of Student Financial Aid (SFA) is largely done through the management of Configuration
Workbooks. To update your Configuration, Oracle recommends:

• Download your current Configuration.

• Making changes to the Workbook Comma-Separated Value (CSV) files and Groovy scripts, as needed.

• Upload the entire updated Configuration back into your environment.

This automatically enforces the correct file loading hierarchy.

If you want to upload partial updates, you must follow the prescribed hierarchy and dependencies.

For example, if you want a new document to clear a particular ISIR C-Code, update the Document and Document
Metadata Workbooks files before you update the ISIR C Code Workbook to reference the new document. When
uploading only the files needed to clear the particular ISIR C-Code, upload the Document and Document Metadata files
before you upload the ISIR C Code file.

This table illustrates the hierarchy structure with dependencies of Configuration Group Categories you must follow
when updating your Configuration Workbooks. Each CSV file requires a standard naming convention and a .csv file type
extension.

Here's some information about the Configuration Workbook table columns:

• Group Category - The Group Categories are used as buckets for grouping Configuration Workbooks into
processing areas to help with troubleshooting and prioritizing during implementation. The compressed file
containing the Workbooks can include one or any combination of categories as the application sequences them
automatically in hierarchical order during the upload process.
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• Workbook/Naming Standard - The column includes the name of the workbook and the naming standard to
use when saving the CSV files. You must strictly adhere to the .csv naming standard in the Configuration File
Guide for the application to recognize and accept the request to load the Configuration. You can add your own
file identification data where the percent (%) symbol exists.

• Description - This is what the Workbook is used for in SFP processing.

• Workbook Dependency - This column indicates what Workbook, if any, needs to be populated before
populating this Workbook.

• Annual Updates - This column indicates which Workbooks require updating due to US Department of
Education (ED) annual Award Year updates.

Note:  Workbooks that are applicable to Student Financial Planning (SFP) only are noted in the Description column.

Group Category Workbook/Naming
Standard

Description Workbook Dependency Annual Updates

Documents Documents Guide/ %_
DOCUMENTS.csv

Use this workbook to
define your institutional
documents and set
additional related
parameters; for example,
 manual review required,
 student notification
messages, and so on.

N/A Yes

Documents Doc Metadata Guide/ %_
DOCMETADATA.csv

Use this workbook to
define associated metadata
fields for Document
Codes based on the
Documents workbook,
 and set additional related
parameters; for example,
 data type, enumeration
values, and so on.

Documents Yes

ISIR ISIR Reject Codes Guide/ %_
ISIR_REJECT_CODES.csv.

Use this workbook to define
code clearing logic and
associate any additional
student notification
messages per SAR reject
code.

N/A Yes

ISIR ISIR C Codes Guide/ %_
ISIR_C_CODES.csv

Use this workbook to define
code clearing logic, any
document requests, and
any additional student
notification messages per
SAR c-code.

N/A Yes

ISIR ISIR Reject Codes To Fields
Guide/ %_ISIR_REJECT_
CODES_TO_FIELDS.csv

Use this workbook to
associate SAR reject codes
to ISIR field names.

N/A Yes

ISIR ISIR Reject To C-Codes
Guide/ %_ISIR_REJECT_
TO_C_CODES.csv

Use this workbook to
associate SAR reject codes
to SAR comment codes.

N/A Yes
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Group Category Workbook/Naming
Standard

Description Workbook Dependency Annual Updates

ISIR ISIR C Codes to Fields
Guide/ %_ISIR_C_CODES_
TO_FIELDS.csv

Use this workbook to
associate SAR c-codes to
ISIR field names.

N/A Yes

ISIR ISIR Verification
Codes Guide/ %_ISIR_
VERIFICATION_CODES.csv

Use this workbook to define
verification clearing logic,
 any document requests,
 and any additional student
notification messages per
verification comment code
and tracking group.

N/A Yes

ISIR ISIR Discrepancy Guide/ %_
ISIR_DISCREP.csv

Use this workbook to
define logic per ISIR field to
determine discrepancies,
 for example, conflicting
information, that should
trigger ISIR corrections.

N/A Yes

ISIR ISIR Assumptions Guide/
%_ISIR_ASSUMPT.csv

Note:
Applicable to the
2023-2024 and prior Aid
Years only.
 

Use this workbook to
define code clearing
logic and associate
any additional student
notification messages per
ISIR assumption field.

N/A Yes

ISIR ISIR Management Guide/
%_ISIR_MGMT.csv

Use this workbook to
define material change
criteria to determine what
record should be flagged
when subsequent ISIR
transactions are received,
 per award year.

N/A Yes

ISIR ISIR Highlights Guide/ %_
ISIR_HIGHLIGHT.csv

Use this workbook to define
code clearing logic and
associate any additional
student notification
messages per ISIR highlight
field.

N/A Yes

ISIR Professional Judgment
Guide/ %_PJ.csv

Use this workbook to
define their Professional
Judgment types, and
associate any initiating
documents and criteria for
each PJ process.

N/A Yes

Packaging Fund Priority Guide/ %_
FUND_PRIORITY.csv

(SFP Only) Use this
workbook to set the order
at which SFP evaluates
the student's eligibility for
funds; for example, Pell is

N/A
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Group Category Workbook/Naming
Standard

Description Workbook Dependency Annual Updates

first, then other grants, and
finally loans.

Packaging FAS Fund Config Guide/ %_
FAS_FUND_CONFIG.csv

(SFP Only) Use this
workbook to configure/
define specific details
around each fund, such as
went to freeze the fund, the
criteria required to be met
before originating Title IV
funds, and so on.

Fund Priority No

Packaging Non Federal Fund Attributes
Guide/ %_NFR_ATTRIB.csv

(SFP Only) Use this
workbook to configure
any non-federal fund they
would like to package
students for (whether
automated or manual).

Fund Priority Yes

Packaging Package Schedule
Guide/ %_PACKAGE_
SCHEDULE.csv

(SFP Only) For non-
term institutions, this
configuration determines
whether a student's
payment period or
academic year can end in
the middle of a course.

N/A No

Packaging Package Schedule
Attributes Guide/ %_
PKGSCHEDATTRIB.csv

(SFP Only) Use this
workbook to configure
calculation to determine
the number of months for
a student, and how to treat
the summer term if there is
enrollment in the summer.

N/A No

Packaging COA Guide/ %_COA.csv (SFP Only) This workbook
is where institutions
configure the Cost of
Attendance items.

N/A Yes

Packaging COA Term Academic Year
Guide/ %_COA_TERM_
ACY.csv

(SFP Only) This workbook
defines what makes a
student a full-time full year
student. This will be used
when determining the Pell
COA.

N/A No

Packaging Title IV Criteria Guide/ %_
T4_CRIT.csv

(SFP Only) Use this
workbook to configure the
awarding criteria for Title IV
funds.

N/A Yes

Packaging Origination Property
Guide/ %_ORIGINATION_
PROPERTY.csv

(SFP Only) Use this
workbook to configure the
origination criteria for Title
IV funds requiring COD
communication.

N/A No

Packaging CIP Code Rules Guide / %_
CIP_CODE_Rules.csv

(SFP Only) This workbook
defines which CIP codes
have changed from the
2010 to the 2020 year. Any

N/A No
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Group Category Workbook/Naming
Standard

Description Workbook Dependency Annual Updates

changed CIP codes from
2018-2019 to 2019-2020
should include a row
in this workbook. This
configuration enables the
correct CIP code for an
academic program to be
communicated to COD if its
CIP code has been changed
from the 2010 year CIP
classification to the 2020
year CIP classification

Packaging COA College Financing Plan
Guide / %_COA_CFP.csv

(SFP Only) This workbook
maps Cost of Attendance
(COA) item types from
your COA.csv workbook
to defined COA categories
within the College
Financing Plan (CFP). It
has a dependency on the
COA.csv workbook.

Cost of Attendance No

Packaging Fund CFP Guide/ %_FUND_
CFP.csv

(SFP Only) This workbook
associates application
Fund Codes with College
Financing Plan (CFP)
categories.

N/A No

Disbursements Disbursements Guide/ %_
DISB.csv

(SFP Only) Use this
workbook to define
disbursement criteria per
fund code. This is used with
regulatory disbursement
rules in the application.
You can also define how
long a disbursement has
to meet the criteria before
it is canceled and whether
a disbursement message
should be triggered upon
disbursing the fund.

N/A No

Disbursements Late Disbursement PWD
Criteria Guide/ %_LATE_
DISBURSEMENT_PWD_
CRITERIA.csv

(SFP Only) This workbook
defines how to disburse late
disbursements and post-
withdrawal disbursements.

N/A No

School School Guide/ %_
SCHOOL.csv

Use this workbook to
establish general school
level details necessary for
processing financial aid.
Some parameters defined
here include: Federal
School ID, OPEIDs, Right to
Cancel Deadline, and so on.

N/A No

School Regulatory Deadlines
Guide/ %_REGULATORY_
DEADLINE.csv

Use this workbook to define
the regulatory dates that
should be considered per
award year for transmitting
files with FPS/CPS and

N/A Yes
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Group Category Workbook/Naming
Standard

Description Workbook Dependency Annual Updates

COD; for example, ISIR
Correction Start/End Dates
and COD Origination Start/
End Dates.

School Roles Guide/ %_ROLE.csv Use this workbook to define
permissions for each user
account role that should be
established for accessing
the application.

N/A No

School Student Hold Guide/ %_
STUDENT_HOLD.csv

Use this workbook to define
types of student record
holds, and whether the
valid ISIR process will run
for each student on the
respectively defined type of
Student Record Hold.

N/A No

School SAML Attribute Guide/ %_
SAML_ATTRIBUTE.csv

Use this workbook to define
user-friendly names for
data items used in the
Security Assertion Markup
Language (SAML) single
sign-on feature for student
self-service.

N/A No

R2T4 R2T4 Charges Guide/ %_
R2T4_CHARGE.csv

(SFP Only) Use this
workbook to define the
charge types that should
be used when determining
charges in the R2T4
calculation.

N/A No

R2T4 R2T4 Guide/ %_R2T4.csv (SFP Only) Use this
workbook to define any
time delay to consider
when triggering an R2T4
calculation, based on the
type of withdrawal; for
example, Official versus
Unofficial withdrawal.

N/A No

R2T4 R2T4 Break Type Guide/ %_
R2T4_BREAK_TYPE.csv

(SFP Only) Non-term
schools use this workbook
to define how breaks
should be treated when
calculating the R2T4
Rate of Progression; in
other words, whether
unapproved course breaks
are considered or whether
LOA breaks should be
inclusive of the LOA start
date.

N/A No

R2T4 R2T4 SAFI Request Guide%_
R2T4_SAFI_REQUEST.csv

(SFP Only) Use this
workbook to define
how many days after a
student withdraws that
the application requests
the R2T4 SAFI; in other

N/A No
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Group Category Workbook/Naming
Standard

Description Workbook Dependency Annual Updates

words, the SAFI that is
flagged to trigger the R2T4
calculation.

R2T4 R2T4 CHBD Guide/ %_
R2T4_CHBD.csv

(SFP Only) Use this
workbook to set additional
criteria that should
be considered when
determining Could Have
Been Disbursed criteria
per fund code, based
on Admissions and/or
Academic statuses from the
SAFI.

Fund Priority, FAS Fund
Config

No

R2T4 Grant Repay Guide/ %_
GRANTREPAY.csv

(SFP Only) Use this
workbook to define the
repayment fund code that
should be used to indicate
a grant overpayment
repayment in the SAFI.

Fund Priority, FAS Fund
Config

No

Notifications Common Process
Messaging Guide/ %_
CCM.csv

Use this workbook to define
message content that
should be populated in
outbound messages for
defined processes; for
example, ISIR Verification.

N/A No

Notifications Trigger Guide/ %_
TRIGGER.csv

Use this workbook to
define criteria and student
messaging for financial
aid notifications' for
example, when a Master
Promissory Note or
Entrance Counseling
Completion is required.

N/A No

Notifications Letter Guide/ %_
LETTER.csv

Use this workbook to
associate letter codes
that have been defined
in the reporting tool, to
the appropriate message
triggering action.

N/A No

Notifications Exit Counseling Guide/ %_
EXIT_COUNSELING.csv

(SFP Only) Use this
workbook to define criteria
and student messaging
for exit counseling
notifications.

N/A No

Reviewing Your Configuration
You can download an exact copy of your current Configuration directly from the FAS user interface on the Configuration
Administration page. This download is a compressed file containing every .csv and Groovy script that makes up your
institution's latest Configuration.
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Note:
• If the Configuration files change structure from one release to the next, the structure is automatically updated

when you download the current Configuration.

• It’s important to look at updates to Baseline Configuration in the release notes to determine how you may want
to implement the new Configuration for your institution; for example, new fields.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management to complete the manual
processing steps:

• Administration

• Configuration Administration

See Set General Permissions Matrix for additional information.

Annual Award Year Configuration Updates
Anytime ED rolls out new or updated guidelines, Oracle automatically updates the Baseline Configuration as part of the
product updates. Here are the Configuration Workbooks that require annual updates:

Here's how you update Configuration Workbooks that require annual updates:

1. Download the latest configuration from the Configuration Administration page in the Student Financial Aid user
interface.

2. Open the .csv file.
a. Copy each row of the latest Aid Year.
b. Take note of the last row, before pasting the copied rows.
c. Paste the copied rows after the last entry and do not leave any empty rows.
d. Within each of the newly pasted rows, if there is an ID column, update the values in the ID column so that

all IDs are unique and in order. For example, if the 2016 Aid Year ends with ID 450, then begin the 2017
Aid Year IDs with 451.

e. Within each of the newly pasted rows, update all necessary column values to the new Aid Year values.
This usually means updating the Aid Year and Program Start Date columns if they exist, but each work
book is different. Any column that includes Aid Year specific information should be updated to the new
Aid Year values. For example:

i. Update the Aid Year column from 2016 (Old Aid Year) to 2017 (New Aid Year).
ii. Update the Program Start Date column from the 2016 values (for example, 01/01/2016) to the 2017

values (for example, 01/01/2017).
iii. Update any other columns that are Aid Year specific. This varies by workbook.

Additional Tips for Updating Configuration
1. Baseline Configuration is uploaded to your environment during the provisioning process.
2. At a minimum, you must update the following .csv files for your school:

a. SCHOOL.csv.
i. Federal School Code.

ii. OPEIDs.
iii. COD Routing ID,

b. COA.csv.
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i. COA Breakdown.
3. The Configuration Administration page only accepts compressed files with a ".zip" file extension.
4. You must strictly adhere to the .csv naming standard in the Configuration File Guide for the application to

recognize and accept the request to load the Configuration.
a. You can add data where the percent (%) symbol exists.

5. All dependent .csv files and Groovy directories must be included in the compressed file being uploaded.
6. Don't compress a parent folder. Select only the .csv files and Groovy directories you want to upload, and only

compress those files. Compressing a parent folder will break the path to the Groovy script that is documented in
the .csv file.

7. Don't remove Groovy scripts from their directory, change the directory name, or directory structure. This breaks
the path to the Groovy script that is documented in the .csv file.

8. You can't upload just a .csv file that references Groovy files. You must also provide all the relevant Groovy
directories with the .csv file in the compressed folder.

9. You can't upload just an updated Groovy file. The compressed file must contain the associated .csv file that
references the Groovy script in the full Groovy directory.

10. When you open a .csv file, some columns are automatically reformatted by Microsoft Excel. The format must
be updated before you attempt to upload the Configuration or an error will be returned, and the upload will fail.
Known data impacted by auto formatting:

a. Number values with leading zeros (for example, C-Codes, Reject Codes, OPEIDs).
b. Dates.

11. All Date columns in the .csv files must be converted to YYYY-MM-DD. Example .csv files:
a. FAS_FUND_CONFIG.
b. FUND_PRIORITY.
c. NFR_ATTRIB.

12. The CODE_NUMBER in these .csv files must be converted to 3 digits in length, or the application returns an
Invalid code length for entry error:

a. ISIR_C_CODES.
b. ISIR_C_CODES_TO_FIELDS.
c. ISIR_REJECT_TO_C_CODES.

13. These .csv files contain a CODE_NUMBER, but don't update the format to a 3-digit value:
a. ISIR_REJECT_CODES.
b. ISIR_VERIFICATION_CODES.
c. ISIR_REJECT_CODES_TO_FIELDS.

14. If you copy or type any data onto a new blank line in the .csv file and then clear the field/row contents, you
must delete the entire row. Even if the .csv shows a blank record, Microsoft Excel stores hidden data within that
row, which can result in an error.

15. If you want the latest Baseline Configuration, download it from the latest Product Release Notes > Latest
Release > Baseline Configuration Release Extract. See Document ID 2613016.1 on My Oracle Support.

16. Don't upload the Baseline Configuration you download from the release notes in a Production environment, as
it will overwrite important institutional data contained in your SCHOOL.csv. Extract the data or script from the
baseline .csv or Groovy you want to implement and update your local Configuration files downloaded from the
Configuration Administration screen.

17. In the SCHOOL.csv, provide your school's OPEID. If your school has multiple OPEIDs, it is important that your
main OPEID is listed first as it sets the SCHOOL_CONFIGURATION.

a. In the csv provide all OPEIDs in the following format: opeid main~opeid2~opeid3 and so on.
b. Make sure the main OPEID is first and then enter all other OPEIDs; understanding that the first one on

the list has additional significance, and the SCHOOL_CONFIGURATION.
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Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Navigate to Administration > System Management  > Configuration Administration.
2. Click the Download tab.
3. Click the Generate Configuration ZIP File button. When the compressed file is generated, a Download

Current Configuration button is displayed. You may need to refresh the page.
4. Click the Download Current Configuration button.
5. Extract the downloaded file.
6. Open the .csv files you want to update.
7. Update fields as needed.
8. Format columns with Dates as instructed in Step 11 of Additional Tips for Updating Configuration.
9. Confirm columns that reference Groovy files have the correct file path.

10. Save the .csv file according to the CSV Naming Convention and File Structure as explained earlier in this topic.
11. Open the Groovy files you want to update.
12. Update the Groovy script as needed.
13. Save the Groovy file.

Note:  The file name and path need to match the .csv file.

14. Select all updated .csv files and all folders that contain dependent Groovy files.
15. Compress files to a file with a .zip file extension.

Note:  Don't compress the parent folder.

16. Select Files to Upload or drag and drop the compressed file on the drop here box.
17. Click Submit.
18. Enter a Comment.
19. Click Save to proceed and upload the Configuration files.
20. Click the Load History tab to view process status, Errors, and Successes.

Note:  If one file errors out, none of the .csv or Groovy files are uploaded to the environment.

21. Click View Details to details by status: Failed, Skipped, or Successful.
22. Correct any Errors as needed.
23. Repeat steps 6-19 until the Configuration is uploaded successfully.
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5  Using the Student Record

Student Record  
The Student Record provides you with pertinent information about the student, such as Student Information, Program
Information, Satisfactory Academic Progress (SAP), Leave of Absence (LOA) Information, Enrollment Information, and
details about letters and notifications to the student.

Student Summary  
The Student Summary screen provides a snapshot view of current student information.

Overview
Key student record and financial information is grouped into relevant sections which displays their current values and
allows a user to link directly to the source screen for additional details.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management to view the Student
Summary screen.

• Student Summary

• V3 UI

See Set General Permissions Matrix for additional information.

Student Summary Snapshot - Left Side Bar
The left side bar is expanded when the screen is loaded. Clicking the upward facing double carrot will collapse the left
side bar. Clicking the downward facing double carrot will expand the left side bar. Each section provides a snapshot of
the source screen. Hover over the segment title and click the link to the navigate to the source screen.

Student Record Hold

If the student is on a student record hold, the following is displayed:

• Type of Hold

• Date and Time student was put on hold

• Indicator:

◦ Green - If student is not on a Student Record Hold

◦ Red - If student is on a Student Record Hold

LOA and Breaks (SFP only.)

107



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 5
Using the Student Record

Details for the Next scheduled break are displayed:

• Start Date of Break

• Total Days on Break

• End Date of Break

• Indicator:

◦ Green - If scheduled LOA is in the future or in the past

◦ Red - If student is currently on an LOA

SAP Status (SFP only.)

If SAP has been evaluated, the following is displayed:

• SAP Status

• SAP evaluation Date

• Academic Year associated with the SAP Evaluation

• Payment Period associated with the SAP evaluation

• Indicator:

◦ Green - If SAP Status is RG - Regular

◦ Yellow - If SAP Status is NULL

◦ Yellow - If SAP Status is FW - Financial Aid Warning

◦ Red - If SAP Status is FP - Financial Aid Probation

◦ Red - If SAP Status is FD - Financial Aid Disqualification

ISIR

When an ISIR has been received, the following is displayed:

• Award Year

• FPS/CPS Transaction Number

• Status

• Original Name ID

• Received Date

• Primary SAI/EFC Amount

• Indicator:

◦ Green - If an ISIR has been received, regardless of status

◦ Red - if NULL

Student Summary Snapshot - Right Side Bar
The right side bar is collapsed when the screen is loaded. Pending Actions and Activities are displayed in sets of 5. If
there are more than 5 Pending Actions or Activities, use the arrow buttons to navigate through the pages. Clicking the
downward facing double carrot will expand all Pending Actions and Activities. Clicking the upward facing double carrot
will collapse all Pending Actions and Activities. You can also expand and collapse each segment individually by clicking
on the title bar of the segment.
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Pending Actions
Hover over the segment title and click the link to navigate to the source screen.

The number of pending actions is displayed in a bubble in the header of the segment to the right of the source link.

Doc Requests

Link to source page: Pending Documents

Information displayed:

• Document Name

• Owner

• Award Year

• Date Requested

• Number of Days elapsed since opened

Tasks

Link to source page: View Student Tasks (pop-out dialog box)

Information displayed:

• Task Queue

• Owner

• Status

• Date Created

The system loops through all the different types of task queues and finds all tasks that are not in Completed status (i.e.
Assigned, Unassigned and In Progress) and displays them in no particular order.

Notifications

Link to source page: Student Notifications

Information displayed:

• Notification Type

• Date Notification was sent

QC Holds (SFP only.)

Link to source page: QC Holds

Information displayed:

• QC Hold Name

• FAS Process

• Hold Date

Fund Acceptance  (SFP only.)

Link to source page: Packaging

Information displayed:

• Pending update
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Activities
Letters

Link to source page:

Information displayed: Student Letters

• Pending update

Comments

Link to source page: Comments

Student History

Link to source page: Student History

Information displayed:

• Category

• Description

• Date

Common Record Information (SFP only.)

Link to source page: Common Record Information

Information displayed:

• Inbound/Outbound Message Type

• Effective Date

• Created Date

MPN Information (SFP only.)

Link to source page: MPN Information

Information displayed:

• Award Year Inbound MPN Response

• Effective Date

• Created Date

Entrance Counseling (SFP only.)

Link to source page: Entrance Counseling

Information displayed:

• Award Year Inbound Entrance Counseling

• Effective Date

• Created Date

Student Summary Snapshot - Middle Section
This entire section is SFP only.
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Package Summary

Link to source page: Packaging

Information displayed:

• Cost of Attendance

• Fund in Package

• Tuition and Fees

• Living and Other Expenses

• Covered Tuition and Fees and Expenses

• Remaining Living and Other Expenses

Credit Balances

Link to source page: Credit Balances

Information displayed:

• Credit Balance Amount

• Recipient

• Status

• Triggering Action

• Create Date

• Effective Date

Disbursement Summary

Link to source page: Disbursing

Information displayed:

• Fund Type

• Amount

• Date

• Status

• Academic Year (AY)

• Disbursement Number (D)

• Sequence Number (S)

• Payment Period Number (P)

Fund Eligibility

Displays information associated with the Fund Eligibility Screen.

• Number of criteria found on Fund Eligibility screen equal to Not Met

• Indicator:

◦ Green - All criteria = Met

◦ Yellow - Not all criteria = Met, but Disbursement Date is in the future

◦ Red - Not all criteria = Met, but Disbursement Date is in the past
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Navigation to the Student Financial Aid (SFA) User Interface Functionality
To View the Student Summary  SFA User Interface > Student > Student Summary
The Student Summary is the default screen when you log into the SFA User Interface (UI)

Enrollment Information  
Student Enrollments are part of accurately packaging and processing financial aid awards for a student’s specific
Academic Careers and Academic Programs.

Overview
When a student enrolls in a new Academic Program, a new Enrollment is created that takes into account any existing
Enrollments, as they impact how the new Enrollment is created. Then, financial aid awards are packaged depending on
whether the Academic Program is Term-based or Non-Term-based.

Enrollments are created and updated via the Student Academic Financial Information (SAFI) integration message.
Subsequent messages, such as Fund Acceptance, also impact specific Enrollments. The system processes data
pertaining to the student at either a student or enrollment level. Data that’s stored at the Student level, for example, an
ISIR, is used across all of a student’s Enrollments.

This table shows at what level different types of data and processes are managed.

Financial Aid System (FAS) Area Student Level Enrollment Level

ISIR Yes No

NSLDS Yes No

Common Origination and Disbursement (COD)
(Includes CRPN, CRCS, CRSP, CRIB message
classes)

Yes No

Documents Yes No

Letters & Notifications Yes No

Leaves of Absence (LOA) Yes Yes

Note:
For Non-Term Academic Programs, the
same Program Code can be used across
Enrollments and can apply at the Program
Code level.
 

Satisfactory Academic Progress (SAP) No Yes
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Financial Aid System (FAS) Area Student Level Enrollment Level

Note:
For Non-Term Academic Programs, the
same Program Code can be used across
Enrollments and can apply at the Program
Code level.
 

Packaging (including Awarding and Fund
Acceptance)

No Yes

Disbursing No Yes

Credit Balances No Yes

Return to Title IV Aid Calculations (R2T4) No Yes

New student Enrollments are assigned a unique Enrollment ID that is used to communicate information to other
systems and display information by each Enrollment. The user interface displays a student’s current Enrollment by
default, but you can switch the view to prior or future Enrollments.

All Enrollments have an Enrollment Status which comes from the Student Information System and is used in Financial
Aid processing. For descriptions of Enrollment Statuses, see Status Definitions.

Term-based Enrollments
For Term-based Academic Programs, a new Enrollment and Financial Aid Package are created each time a new
Academic Program Code is received for a student.

Financial Aid award packaging and processing is allowed for a student’s future Enrollment while another Enrollment is
still active, as long the student is not attending both Enrollments at the same time with overlapping Academic Years.
When additional information is received for a student (for example, SAFI, Fund Acceptance, and so on), the system
updates the correct Enrollment even when there is more than one active Enrollment associated to the student.
Financial Aid award packaging logic considers the Financial Aid awards from the prior Enrollment to determine what the
student is eligible for. If more than one Enrollment is active, Packaging is done for the student’s initial Enrollment and
limits the Financial Aid Awards Package for subsequent Enrollments to prevent the student from being over-awarded.

Non-Term-based Enrollments
When a new Program Code for a Non-Term program is received, the system automatically determines whether and how
a new Enrollment should be created.

Enrollment Types are used when processing Financial for Non-Term-based Academic Programs and denote the nature
of a new Enrollment in relation to existing Enrollments at the school, if any. The Enrollment Type determined by
the system when a student first enrolls at a school and when they transfer from one Academic Program to another
internally. In addition to setting the Enrollment Type, the start and end dates of the first Academic Year are adjusted
as needed when a student enters the institution as an external transfer, changes programs, or advances degrees.
Enrollment Types are used in determining eligibility for Financial Aid and reporting to the U.S. Department of Education
(ED).

This table explains Enrollment Types for Non-Term-based students.

Enrollment Type Description
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Original Enrollment The Enrollment Type is being set for the first time and student is not an External Transfer or
 
Student does have a prior enrollment, but the Enrollment Type is not any of the following:
 

• Advancing Degree

• Re-Entry within 180 Days

• Re-Entry after 180 Days

• Change of Program - Same Payment Period

• Change of Program - New Academic Year

External Transfer Student does not have any prior enrollment within the system and student has an overlapping loan
period from a different school.

Change of Program - Same Payment
Period

Student changed Academic Programs and met all conditions required to remain in the same payment
period.

Change of Program - New Academic Year Student changed Academic Programs, did not meet all conditions required to remain in the same
payment period, and is not re-entering the same Academic Program within 180 days.

Advancing Degree Student has a prior enrollment (internally) that overlaps their current enrollment and the Enrollment
Status of the prior Enrollment is Graduated.

Re-Entry within 180 days Student is not an External Transfer and is re-entering into the same program equal to or less than 180
days from the latest Official Last Date of Attendance (OLDA).

Re-Entry after 180 days Student is not an External Transfer and is re-entering into the same program greater than 180 days
from the latest Official Last Date of Attendance (OLDA).

External Transfers
Students whose student loan period dates from another institution overlap with their Academic Year Program Start Date
are considered External Transfers. When the NSLDS Financial Aid History is received, the latest Academic Year End Date
from the prior institution is compared to the student's new Academic Program Start Date. If the Academic Year End Date
of the prior institution is equal to or greater than their new Academic Program Start Date, the Academic Years overlap,
and the student is considered an External Transfer.

The NSLDS record includes the COD Academic Year Start Date of the prior enrollment. The system reports the Start
Date of the student's first course that begins on or after their Program Start Date as the new Academic Year Start
Date to COD. To determine the Academic Year End Date, the prior institution's Academic Year End Date is compared
to Course End Dates in the new Academic Program. If a Course in the new Program ends after the prior institution's
Academic Year End Date, the first academic year of their new program is extended to the end of the overlapping course.
The end date of the last course in the new Program is reported to COD as the Academic Year End Date.

The number of credits required to be completed in the first academic year is based on the courses mapped to the first
academic year. The student is required to complete these credits before advancing to the next Academic Year.

You can have an optional configuration for External Transfers. When an External Transfer student has received loans
at a prior institution, you can configure Student Financial Planning to identify the enrollment as an External Transfer,
but map a full academic year (for example, 24 credits/30 weeks) instead of reducing the first Academic Year. However,
the system reduces the student's loan eligibility by the amount they received during their prior Enrollment/Academic
Program. This configuration also allows the school to set an effective date. Once an effective date is set, Student
Financial Planning only uses the optional logic if the student's Program Start Date or Packaging Start Date is greater
than the set effective date.
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Changes of Program
Students in Non-Term-based Academic Programs who withdraw from an Academic Program and enroll in a new
Academic Program have a Change of Program Enrollment Type. These students are evaluated to see if they meet ED
standards to remain in the Same Payment Period or if they must begin a New Academic Year, and their Enrollment Type
is updated appropriately.

There are two exceptions to students who have an Academic Program change but are not evaluated for an Academic
Program change for Federal payment periods:

• Students who do not withdraw but switch to a similar Academic Program with the same Start Date. Since these
students do not withdraw from their prior Programs, there is no new Enrollment or update to the Enrollment
Type. These students are simply repackaged using updated SAFI data.

• Students who change Academic Programs prior to the Start Date. If the institution sends an active SAFI for a
new Program without first sending a withdrawn SAFI for the prior Program, it is assumed the student has not
completed an Academic Related Activity (ARA), and they have changed Programs prior to the student's official
Start Date. If the student does not withdraw from the prior Program, the student is simply repackaged with the
updated SAFI data. The Change of Program logic isn’t run, no new enrollment is created, and the Enrollment
Type is not updated.

Evaluating Changes of Program for Federal Payment Periods
Students who have a Change of Program require evaluation to determine if they can remain in the Same Payment
Period or start a New Academic Year Payment Period.

A student must meet six conditions to remain in the Same Payment Period; otherwise, they must begin a New Academic
Year Payment Period with reset Financial Aid eligibility. The evaluation of the conditions begins automatically when any
Change of Program information is received from the receipt of a SAFI or other message.

The first condition, evaluating Leaves of Absence, must be met before considering the remaining five conditions which
are based on ED guidelines. Of the remaining five, there are three conditions are also automatically considered. If the
student meets those three conditions, then Evaluate Student Change of Program tasks are automatically created to
consider the final two conditions. These final two conditions must evaluated manually.

These are the conditions to remain in the Same Payment Period:

First, the system automatically evaluates for this condition:

• Is the student’s Leave of Absence End Date the same as the Start Date of the first Course of the new
Academic Program? If YES, they cannot remain in the Same Payment Period and must begin a New Academic
Year Payment Period based on the new Academic Program.

SAFI data is used to evaluate this condition; there is no configuration.

Note:  If YES, the System does not evaluate for any additional conditions.

• For more information, see Student was not on LOA During Program Change.

Then, system automatically evaluates for these three conditions based on Federal guidelines:

• Was the student continuously enrolled in the Payment Period that the Change of Program occurs in?

◦ In addition to SAFI data, this condition uses the configured "Change of Program Continuous Enrollment
Max Days" in the School Configuration Workbook to determine whether the student has been out of
attendance longer than the maximum allowed period to be considered continuous enrolled.

◦ The school can configure the maximum number of days a student can be Out of Attendance (for
example, 14 days) and still be considered continuously enrolled.
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◦ Student Financial Planning calculates the total number of days between the student's Official Last Date
of Attendance (OLDA) in the prior Academic Program and the start date of the first Course in the new
Academic Program and then subtracts any approved LOA days.

◦ For more information, see Student is Continuously Enrolled.

• Is the coursework in the Payment Period that the student is transferring out of substantially similar to
the coursework in the student’s new Academic Program?

◦ The first course in the new Academic Program was a Scheduled course in the prior Academic Program
and in the Payment Period the student withdrew or transferred out of.

◦ SAFI data is used to evaluate this condition; there is no configuration.

◦ Course equivalencies are determined by comparing the Comments sections of the Courses in the SAFI.
This is not visible in the UI.

- If equivalent Courses are found for the first Course in the new Academic Program, they are checked
against the prior Academic Program to see if any of them are in the Payment Period the student
withdrew or transferred out of.

- The SAFI message lists the equivalent courses (for example, Course A, Course B, Course C).
- The new Academic Program’s courses are compared to the prior Academic Program (for example,

Course A, Course B, Course C).

◦ For more information, see Coursework Substantially Similar.

• Are the credits from the Payment Period the student is transferring out of accepted toward the new
Academic Program? SAFI data is used to evaluate this condition; there is no configuration.

For more information, see Credits from prior are accepted in new program.

If the answer to any of these three conditions is NO, the student cannot remain in the Same Payment Period and must
begin a New Academic Year Payment Period based on the new Academic Program.

Note:  If NO is the answer to any one of these three conditions, the System does not evaluate for any additional
conditions. No Evaluate Student Change of Program tasks are created.

If the student has met all previous conditions, then two Evaluate Student Change of Program tasks are automatically
created to evaluate the final two conditions based on Federal guidelines. These must be cleared manually:

• Are the payment periods are substantially equal in length in weeks of instructional time and credit hours
or clock hours, as applicable?

• Are there are little or no changes in school charges associated with the payment period?

If the Evaluate Student Change of Program tasks are not manually completed 28 days from the Date of Determination
(DOD), it is assumed the student did not meet all of the conditions to remain in the same payment period and requests
the Return to Title IV Funds (R2T4) SAFI. On the 30th day from the DOD, R2T4 calculation is completed.

If the student meets all conditions for remaining in the Same Payment Period, the student's Enrollment Type is set to
Change of Program - New Academic Year, and the Change of Program Start Date from the SAFI message is displayed
on the student’s Program Information page.

Note:  When a student changes Academic Program, processing of the student’s financial is paused until the Change
of Program is completed and it has been determined if the student has met all conditions to remain in the Same
Payment Period or if the student will be enrolled in a New Academic Year.

For more information about Changes of Program, see Evaluate Student Change of Program.
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Adjusting the First Academic Year Dates for Students That Change Programs
For students with an Enrollment Type of Changing Programs - Same Payment Period, all courses that were completed
in the last Borrower-Based Academic Year (BBAY) of the prior Academic Program are counted towards the First
Academic Year.

• All credits and weeks that were completed for these courses count toward completing the First Academic Year.

For example, for a student who has completed two courses (6 credits and 10 weeks) in the last Academic
Year for their prior enrollment, these courses transfer into the new program. If the program's academic year
definition is 24 credits and 30 weeks, the student only need 18 credits and 20 weeks more to complete the First
Academic Year. The First Academic Year length remains 24 credits and 30 weeks.

• If the student is Changing Programs in the second Payment Period, the system ensures that all courses from
the prior program are included in the first Payment Period. If there are any courses that are not applicable to the
program in the first Payment Period, Student Financial Planning does not count the associated credits toward
the Total Program Credits Needed.

Students with an Enrollment Type of Changing Programs - New Award Year, are packaged based on the student's
Official Last Day of Attendance (OLDA) in the prior Academic Program.

Closing Out Prior Enrollment for a Change of Program within the Same Payment Period
Students with an Enrollment Type of Changing Programs - Same Payment Period are automatically checked for
pending Return to Title IV (R2T4) calculations and cancels them. Pending disbursements associated with the prior
Academic Program and re-instates them in the new Academic Program.

Advancing Degrees
Students who are graduated and enrolling in a new program have an Enrollment Type of Advancing Degree.

Determining Whether an Overlapping Academic Year Exists for Student that Are Advancing Degrees
The prior Enrollment's Academic Year End Date is calculated based on the school's Academic Year definition. This is
compared to Start Date of the new Enrollment to determine if there is an overlapping Academic Year. If the calculated
Academic Year End Date of the prior Enrollment is greater than the new Enrollment's Academic Program Start Date,
there is an overlapping Academic Year. When this occurs, the system shortens the first Academic Year of the new
Academic Program.

Adjusting the First Academic Year for Advancing Degrees
The Academic Year Start Date of the student's prior Enrollment received in the NSLDS from COD is updated to use
the Start Date of the first course of the student's new Enrollment. This date is reported to COD as the new Enrollment
Academic Year Start Date.

The first Academic Year of the student's new Academic Program Enrollment is adjusted by taking the prior Enrollment's
Academic Year definition and subtracting the number of credits and weeks the student completed. For example, the
prior Enrollment Academic Year Definition (24 credits and 30 weeks) minus the Prior Enrollment Completed Credits and
Weeks (8 credits and 10 weeks) equals the number of Credits Required in First Academic Year (16 credits and 20 weeks).

Optional Configuration
When a student advances Degrees and has received loans in their prior program, you can configure Student Financial
Planning to identify the Enrollment as Advancing Degree, but map a full academic year (for example, 24 credit hours/30
weeks) instead of reducing the first academic year. However, the system reduces the student's loan eligibility by the
amount they received during their prior enrollment/program. This configuration also allows the school to set an
Effective Date. Once an Effective Date is set, Student Financial Planning only uses the optional logic if the student's
Program Start Date or Packaging Start Date is greater than the set effective date.
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Triggering NSLDS Requests for Change of Program or Advancing Degree
A request for the latest Financial Aid History (FAH) from NSLDS is triggered when a student is changing programs
or advancing degrees and they are not staying within the Same Payment Period. To ensure new Academic Programs
are packaged correctly, the student is not packaged based on their new enrollment until the FAH record is received
after the new Academic Program's Start Date. This ensures that the previous Academic Program is closed out and the
information is reflected on NSLDS when the new Academic Program is packaged.

Re-Entry to an Academic Program
Students who withdraw and are returning to the same Academic Program have one of two Enrollment Types;

• Re-Entry within 180 days.

• Re-Entry after 180 days.

Students who have withdrawn and are returning to the same Academic Program are evaluated to determine which Re-
Entry Enrollment Type is appropriate. Students re-entering the same Academic Program within 180 days can return to
the same Payment Period and all pending Return to Title IV calculations can be cancelled according to ED guidelines.

For more information, see Re-Entry Packaging.

Overriding Enrollment Information
You can override Enrollment Information in the FAS User Interface. You can select:

• Which Enrollment is the active Enrollment for a student. Only one Enrollment Record can be Default.

• Whether an Enrollment is hidden or displayed. At least one Enrollment record must be displayed, and you
cannot hide a Default Enrollment. Before selecting or deselecting an Enrollment for Display, ensure that
the Enrollment is closed out; including updating funds in the package and fully canceling and returning
disbursements.

• The current status for each Enrollment record. When you update the current status for an Enrollment record,
the system will use the updated status for the Enrollment record when processing future Student Academic and
Financial Information (SAFI) messages.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Enrollment Overrides

See Set General Permissions Matrix for additional information.

Manual Processing Steps to View or Override Enrollment Information
Log into the FAS User Interface (UI).

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student Record > Enrollment Information
3. Select the Enrollment link in the student header for the Enrollment record you want to view.
4. If desired, override Enrollment information:

a. Update the Current Status for any Enrollment Record.
b. Select at least one of the Enrollment Records to be the Default Enrollment.
c. Uncheck the box under Display to hide an Enrollment Record.
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Note:  You cannot hide a Default Enrollment.

Sending an Enrollment Web Service Request
When a web service request is received, the system returns all available Enrollment IDs and associated Academic
Programs for student record including the following attributes:

• Enrollment ID.

• Enrollment Start and End Dates.

• External Program ID.

• Program Code.

• Program Description.

Evaluate Student Change of Program  
This topic offers further detail to the Changes of Program section of the Enrollment Information topic.

Overview
The Evaluate Change of Program task is created after Student Financial Planning automatically determines the
following conditions are all met.

Evaluated Criteria to Determine if the Student will remain in the Same Payment Period

Number Conditions & Evaluated Criteria Met Auto

1 Student was not on LOA during
Program Change

• Student does not have an
LOA End Date that equals
the Start Date of the New
Program

Yes

The first condition must be met for Student Financial Planning to evaluate conditions 2 - 4.

2 The student is continuously
enrolled at the school

• Student must be continuously
enrolled based on the
institution's configuration

• The school can configure
the maximum number of
days a student can be Out
of Attendance (i.e. 14 days)
and still be considered
continuously enrolled

• Student Financial Planning
calculates the total number
of days between the
student's Official Last Date
of Attendance (OLDA) in the
prior program and the start
date of the first course in
the new program and then
subtracts any approved LOA
days

Yes
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3 The coursework in the payment
period the student is transferring
out of is substantially similar to
the coursework the student will be
taking when he or she first transfer
into the new program

• Student Financial Planning
confirms that the first course
in the new program was a
Scheduled course in the prior
program, in the payment
period the student withdrew/
transferred out of

• Student Financial Planning
uses the course equivalencies
in the SAFI when comparing
the courses (visible only in
the Comments Section of the
Course in the SAFI, not in the
UI)

◦ Student Financial Planning
looks at the first course
and finds the equivalent
courses, then checks the prior
program to see if any of them
are in the payment period the
student withdrew/transferred
out of

◦ SAFI would list the equivalent
courses (i.e. A, B, C courses)

◦ Student Financial Planning
checks for courses A, B, or C

Yes

4 The credits from the payment
period the student is transferring
out of are accepted toward the new
program

• Student Financial Planning
determines if all completed
and passed coursework
in the payment period the
program change is occurring
in, transfers into and is
accepted as credits for the
new program

Yes

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Dashboard > Task Overview (default screen upon login) > Evaluate Student Change of
Program task queue

2. Click the Start button for the task associated student

Based on your school's standard operating procedures determine if the student has met the conditions
necessary to remain in the same payment period

3. Based on your school's standard operating procedures choose whether the student should remain in the same
payment period, (Yes or No).

4. Complete Task

Student was not on LOA During Program Change  
This topic offers further detail to the Changes of Program section of the Enrollment Information topic.
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Overview
When a student changes programs, if any condition is not met, the enrollment type updates to Change of Program -
Within New Academic Year. Below are the steps to review the student record for the first condition, Student was not on
LOA during Program Change.

LOA is a configurable pre-condition. If your school has configured this for review, it is the 1st condition evaluated. If it
passes the other conditions are evaluated. If it does not pass, none of the other conditions are reviewed.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's name, external student ID number or social security number in the search field located in
the upper right-hand corner

◦ Because Student Financial Planning returns results for any data entered, the student search can be based
on complete or partial information

◦ Select the Student Record from the Student Search Results pop-out dialogue box

2. Click the Enrollment link in the student header and choose the Original Enrollment (or prior enrollment)
3. Navigate to Student > Student Record > LOA Information
4. Review the LOA(s) End Date(s)

a. To meet this condition: the student cannot have an LOA end date that equals the first-course start date
on or after the program start date

b. If the student has an LOA end date that equals the first-course start date in the new program, the student
cannot remain in the same payment period

Student is Continuously Enrolled  
This topic offers further detail to the Changes of Program section of the Enrollment Information topic.

Overview
When a student changes programs, if any condition is not met, the enrollment type updates to Change of Program -
Within New Academic Year. Below are the steps to review the student record for the second condition, The student is
continuously enrolled.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student
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See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's name, external student ID number or social security number in the search field located in
the upper right-hand corner

◦ Because Student Financial Planning returns results for any data entered, the student search can be based
on complete or partial information

◦ Select the Student Record from the Student Search Results pop-out dialogue box

2. Navigate to Student > Financial Information > Packaging > 1st Packaging Version in Historical Packages

◦ Always choose the first package of the new enrollment because courses and start/end dates may have
changed in subsequent packaging versions

3. Click the Academic Year Summary table
4. Review and take note of the payment period 1, first-course start date
5. Navigate to the Prior Enrollment
6. Navigate to Student > Student Record > Program Information
7. Review and take note of the Official Last Date of Attendance (OLDA)
8. Calculate the total number of days between the students OLDA in the prior program and the first-course start

date in the new program and then subtract any approved LOA days (if applicable)

◦ If the result of this calculation is greater than the maximum number of days a student can be Out of
Attendance (i.e. 14 days) and still be considered continuously enrolled, this criterion will be equal to Not
Met

- Student must be continuously enrolled based on the institution's configuration
- The school can configure the maximum number of days a student can be Out of Attendance (i.e. 14

days) and still be considered continuously enrolled

Coursework Substantially Similar  
This topic offers further detail to the Changes of Program section of the Enrollment Information topic.

Overview
When a student changes programs, if any condition is not met, the enrollment type updates to Change of Program
Within New Academic Year. Below are the steps to review the student record for the third condition, The coursework in
the payment period the student is transferring out of is substantially similar to the coursework the student will
be taking when he or she first transfers into the new program.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

See Set General Permissions Matrix for additional information.
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Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's name, external student ID number or social security number in the search field located in
the upper right-hand corner

◦ Because Student Financial Planning returns results for any data entered, the student search can be based
on complete or partial information

◦ Select the Student Record from the Student Search Results pop-out dialogue box

2. Navigate to Student > Financial Information > Packaging
3. Click the 1st Packaging Version

◦ Take Note of the Date of the 1st Packaging Version

4. Click the Academic Year Summary
◦ Take note of the 1st Course

◦ Example: MHA/520

5. Navigate to the Student History UI
◦ Search by Category: Packaging

◦ Review Entry Type: Student Academic and Financial Information message received for the student

◦ Find the 1st Active “F” SAFI for the New Program (MHA/INF)

◦ Compare Dates: Compare the Date of the 1st Packaging Version and the Date of 1st F SAFI Student
History message

6. Find the W SAFI for the Prior Enrollment (MHA/GER) in the Student History
◦ Should be just above the F SAFI for the new program

7. Navigate to Prior Enrollment > Student > Financial Information > Packaging
8. Start by clicking on the Packaging version that matches the date of the 1st W SAFI

◦ Make sure the packaging version trigger is for a SAFI

◦ Make sure the Enrollment Status is W to ensure you are looking at the W SAFI

◦ System uses the first W SAFI received and Subsequent SAFIs may not contain the same data

9. Click the Academic Year Summary Table
◦ Confirm that the first Scheduled, Enrolled or Passed course in the new program was included the prior

program, in the payment period the student withdrew/transferred out of
◦ Student Financial Planning uses the course equivalencies in the SAFI (visible only in the comments

section of the course in the SAFI, this information is not in the UI)
- Student Financial Planning looks at the first course and finds the equivalent courses, then checks

the prior program to see if any of them are in the payment period the student withdrew/transferred
out of

- SAFI would list the equivalent courses (i.e. A, B, C courses)
- Student Financial Planning checks for courses A, B, or C

◦ If a course in the program (or any of its course equivalencies) was not included in the payment period the
student withdrew from, the condition is not met.

Credits from prior are accepted in new program  
This topic offers further detail to the Changes of Program section of the Enrollment Information topic.
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Overview
When a student changes programs, if any condition is not met, the enrollment type updates to Change of Program
Within New Academic Year. Below are the steps to review the student record for the fourth condition, The credits from
the payment period the student is transferring out of are accepted toward the new program.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's name, external student ID number or social security number in the search field located in
the upper right-hand corner

◦ Because Student Financial Planning returns results for any data entered, the student search can be based
on complete or partial information

◦ Select the Student Record from the Student Search Results pop-out dialogue box

2. Navigate to Original Enrollment (or prior enrollment)
3. Navigate to Student > Student Record > Program Information
4. Take note of all the course that was passed/completed prior to the start date of the new enrollment
5. Navigate to Student > Financial Information > Packaging (prior enrollment)
6. Click the Academic Year Summary table
7. Take note of the courses in Payment Period 1 (the payment period the program change occurs in)
8. Click the Enrollment link and choose the new enrollment
9. Navigate to Student > Student Record > Program Information

10. Review completed/passed courses and confirm if the completed/passed courses from prior program are in the
schedule prior the new program start date

11. Determine if all completed and passed coursework in the payment period the program change is occurring in,
transfers into and is accepted as credits for the new program

a. If yes, this criterion is Met
b. If no, this criterion is Not Met

Program Information  
The Program Information screen provides many details included in the Student Academic and Financial Information
(SAFI) message.
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Overview
It is on this screen you can view details about the student's program, course dates, scheduled instruction, grades, GPA
and more. This is also one of the screens you can view the student's Last Date of Attendance (LDA) in a course, the
student's Official Last Date of Attendance (OLDA) in a program and the Date of Determination (DOD).

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Leave of Absence  
You can evaluate a student's eligibility for financial aid when you receive notice of an approved Leave of Absence (LOA).

Overview
An LOA is a temporary interruption in a student’s program of study and refers to the specific time period when a
student isn't in attendance. An LOA isn't required if a student isn't in attendance only for an institutionally scheduled
break. However, a scheduled break may occur during an LOA.

You may disburse the following funds: Pell, TEACH, IASG, or FSEOG to a student on an LOA. However, you may not
disburse Direct Loan funds to a student on an LOA. Because a Federal Student Aid (FSA) credit balance has funds that
have already been disbursed, a school must pay an FSA credit balance to a student on an LOA.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Receives the LOA Information from the Institution's Student Information
System (SIS)
The application is able to receive an inbound LOA message from the institution's SIS. The message should include
the start and end dates of the LOA, type of LOA, the status of the LOA and the total number of days on break. The
application records and displays this information on the LOA Information page of the student record and begins the
LOA process.

Re-Evaluates the Academic Year and Disbursements During an LOA period
Upon receipt of an Approved LOA, the application reschedules every disbursement that can't be disbursed during an
LOA until the LOA period has elapsed. The application repackages the student and updates the Academic Year and
Payment Period based on the student's updated course schedule. If an LOA is canceled, the application resets the
disbursement date to, "No longer considered an LOA period" and updates the disbursement dates as necessary.
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Determines if any Funds Disbursed During an LOA Period and if Any of
Those Disbursements Should Be Returned
If an inbound LOA message is received that has occurred in the past, the application with either ignore or return
those disbursements based on the institutions configuration. If the "Configure LOA Institutional Preferences, Return
loan funds disbursed during backdated LOA" is true, the application returns any disbursement that isn't allowed to
be disbursed during an LOA period and reschedules the returned amount for a date that is after the LOA end date,
following the logic for setting the disbursement date. If however, the "Configure LOA Institutional Preferences, Return
loan funds disbursed during backdated LOA" is false, the application will not trigger the disbursement refund process.

Configurable Attributes
Configure LOA Institutional Preferences

The institution can configure preferences regarding how Leave of Absences are validated in the application. Preferences
can be configured to validate the number of break days and if the application should return loan funds that have a
disbursement date that overlaps an LOA period, for example, a backdated LOA.

Navigation to the Student Financial Planning User Interface Functionality
To View the LOA and Break Information Student Financial Planning User Interface > Student > Student Record >
LOA Information

Note:  A snapshot of the LOA information is also visible on the Student Summary Screen.

Student Financial Planning User Interface > Student > Student Summary

Satisfactory Academic Progress  
Satisfactory Academic Progress (SAP) is determined using the student's academic record to measure qualitative and
quantitative standards based on US Department of Education (ED) guidelines.

Overview
Student Financial Planning accepts data from the institution's student record system to determine the student's SAP.
Student's must meet SAP standards to continue receiving Federal Student Aid (FSA). Students may appeal any SAP
decision, and you can update the SAP status accordingly.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Initiates the SAP Evaluation
You can configure when to initiate an SAP evaluation for a student using a Groovy script in the
Sap_Evaluation_Period_Determination_Script column of the School Guide. The configuration can reference different

126

https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=u30005713


Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 5
Using the Student Record

program data values to specify unique SAP evaluation periods by program code, career, and so on. As part of the
output, the script defines an SAP evaluation period of:

• Academic Year.

• Payment Period or Term.

However, if a student's SAP status is:

• FP (Probation)

• FD (Disqualified),

SAP is evaluated at the end of the next Payment Period or Term, regardless of configuration.

Calculates Pace of Completion
Note:  Non-term schools aren't required to evaluate Pace of Completion; however. they must still evaluate Grade Point
Average (GPA) and Maximum time frame SAP requirements. Whether to perform a Pace of Completion evaluation is
controlled by a Groovy script in the Disable_Pace_of_Completion field in the School Guide.

Quantitative Measure

The student's Pace of Completion is calculated using the Student Academic and Financial Information (SAFI) message.
The student's Pace of Completion is calculated by dividing the total number of earned or completed credits (including
any accepted transfer credits and/or assessed credits) by the sum of all attempted credits (including repeats). The
pace of completion can't exceed the configured percentage set by the institution; for example, 67%. The application
compares the calculated completion rate against the minimum value set by the institution at completion of each
payment period, to ensure completion is equal to or greater than the configured percentage to pass the SAP evaluation.

To determine the number of attempted credits, the application sums the total units for each, course completed with
an SAP Applicable indicator equal to true (including repeat courses) from the beginning of the program through the
end of the payment period being evaluated. If the course has a Passed, Failed, Withdrawn, or Incomplete scheduling
status, the application adds up the units. However, if the scheduling status is Withdrawn and the student has not met
attendance requirements, then the application doesn't include the units for that course in the SAP calculation. If the
scheduling status is anything other than Passed, Failed, Withdrawn, or Incomplete, Student Financial Planning doesn’t
include the associated course credits as attempted credits. The application also calculates and includes the total number
of Assessed units, which are units the student passed out of and the total number of transfer credits applied to the
student's program.

Pace of Completion

Cumulative number of credit hours the student successfully completed (earned) divided by Cumulative number of credit
hours the student attempted equals Pace of Completion.

Example:

1. Earned Credits (24)
a. Passed Course (12)
b. Failed Course (n/a)
c. Failed Course (n/a)
d. Failed Course (n/a)
e. Withdrawn Course (n/a)
f. Passed Course (12)
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2. Credits Attempted (63)
a. Passed Course (12)
b. Failed Course (15)
c. Failed Course (12)
d. Failed Course (12)
e. Withdrawn Course (n/a)
f. Passed Course (12)

Calculated Pace (38.10%)

• 24 divided by 63 equals 38.10%

• 38.10% < configured percentage (67%) equals Fail

View Pace of Completion Details by clicking on the icon from the SAP Information Screen

Withdrawn Course Not Included In Calculation

In this example, the student has not met attendance requirements for the Withdrawn course, therefore the course is not
counted in the calculation. Withdrawn courses that have an Academic Related Activity (ARA) indicator equal to False in
the SAFI message are identifiable in the application User Interface (UI) through the Program Information screen (Status
equals Withdrawn, Grade equals N/A).

1. Navigate to the Student Record greater than Program Information Screen.
2. Identify the Course with a Scheduling Status of Withdrawn:

◦ If the Grade is N/A, it is not counted in the calculation.

◦ If a Letter Grade is present, it is included in the calculation.

Calculates Maximum Program Time Frame
Quantitative Measure

The application uses the Student Academic and Financial Information (SAFI) message to determine the student's total
program length. The student's total attempted program length is calculated by dividing the sum of all attempted credits
(including repeats) by the total required credits for the student's program. The time frame to complete a program can't
exceed 150% of the required length of the program measured in the proper units; for example, credits or clock hours, for
undergraduate and graduate students. Therefore, the application compares the calculated attempted program length
against the maximum value set by ED at the completion of each payment period, to ensure completion is within 150%.

To determine the number of attempted credits, the application sums the total units for each, course completed with
an SAP Applicable indicator equal to true (including repeat courses) from the beginning of the program through the
end of the payment period being evaluated. If the course has a scheduling status that is Passed, Failed, Withdrawn, or
Incomplete, the application adds up the units. However, if the scheduling status is Withdrawn and the student has not
met attendance requirements, then the application doesn’t include the units for that course in the SAP calculation. If
the scheduling status is anything other than Passed, Failed, Withdrawn, or Incomplete, the application doesn’t include
the associated course credits as attempted credits. The application also calculates and includes the total number
of Assessed units, which are units the student passed out of and the total number of transfer credits applied to the
student's program.

Maximum Time Frame Calculation

Cumulative number of credits the student attempted divided by Cumulative number of credits required for the program
equals Max Time Frame.
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Example:

1. Attempted Credits (63)
2. Total Credits Required (48)
3. Calculated Time Frame (131.25%)

◦ 63 divided by 48 equals 131.25%

◦ 131.25% < 150% equals Pass

View Maximum Time Frame Details by clicking on the icon from the SAP Information Screen.

In this example, the student has not met attendance requirements for the Withdrawn course, therefore the course is not
counted in the calculation. Withdrawn courses that have an Academic Related Activity (ARA) indicator equal to False in
the SAFI message are identifiable in the application User Interface (UI) through the Program Information, Course Detail
screen (Status equals Withdrawn, Grade equals N/A).

See the information in the previous section: Withdrawn Course Not Included In Calculation.

Determines Program Grade Point Average (GPA)
Qualitative Measure

The application determines the Grade Point Average (GPA) for the student's program through data received in the
Student Academic and Financial Information (SAFI) message to determine the student's cumulative GPA up to the end
of the course. The course with the latest end date associated with the payment period that is Financial Aid eligible is
included when calculating the student's GPA. However, if the student retakes a course, only the first passing grade
is counted as a completion when calculating the qualitative component. The application compares the program GPA
against the minimum value required for the program.

GPA Analysis

Program GPA equalls greater than Minimum Required GPA equals Pass.

Example:

1. Program GPA at SAP Evaluation Date (3.00).
2. Program Required GPA (2.00) (Configurable per Institution/Program).
3. GPA Status equals Pass:

◦ 3.0 greater than 2.0 equals Pass.

Determines SAP Status
The application records the appropriate SAP status based on the result of the SAP evaluation for the following
components: GPA, Pace of Completion, and Maximum Time Frame. The status of each SAP component is recorded for
each evaluation.

The application records the following for all SAP evaluations:

• Program Information.

• Academic Year Dates Information.

• Payment Period Dates Information.

The SAP status has a value corresponding to the current SAP evaluation. (See Status Definitions)

• When an Academic Year is created for a new student, the SAP status is set to RG - Regular.
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• When the GPA, Pace of Completion, and Maximum time frame evaluations all pass, the SAP status is set to RG -
Regular.

• If the GPA or Pace of Completion evaluation fails when evaluating a Payment Period, the SAP status is set to
FW - Financial Aid Warning.

• If the GPA or Pace of Completion evaluation fails when evaluating an Academic Year, the SAP status is set to
FD - Financial Aid Disqualification.

• If the Maximum time frame evaluation fails, the SAP status is set to FD - Financial Aid Disqualification.

• If the student appeals an SAP review and is granted one payment period, the SAP status is set to FP - Financial
Aid Probation.

• If the GPA or Pace of Completion evaluation fail while in a Warning status, the SAP status is set to FD - Financial
Aid Disqualification.

• If the GPA or Pace of Completion evaluation fail while in a Probation status, the SAP status is set to FD -
Financial Aid Disqualification.

• If the GPA and Pace of Completion evaluation pass while in a Warning, Probation, or Disqualification status, the
SAP status is set to RG - Regular.

Creates the SAP Evaluation and SAP Appeal tasks
When exceptions have been configured for manual review, the application creates a Review SAP Evaluation task when
that configured criterion is met. In addition to configured exceptions, if a student is placed in an FD - Financial Aid
Disqualification SAP status, the application creates a Review SAP Appeal task when the document configured by the
institution to initiate the appeals process is received. These two manual tasks allow an authorized user to review the
SAP evaluation or requested appeal and make final decisions.

Initiates the SAP Appeals Process
The application begins the SAP Appeals process when the document configured by the institution to initiate the appeals
process is received. Although, if the maximum number of appeals has already been met (configured by the institution),
the application terminates the SAP appeals process.

Sends Outbound Message to Communicate SAP Results
The application sends an Outbound Message to communicate the outcome of the SAP evaluation when the SAP Status
changes from it's current value and throughout different states of the SAP Appeals process to communicate SAP
Appeals information once a decision is made:

Resets SAP Status for Program Changes
The application sets the appropriate SAP status when a student undergoes a program change.

RG - Regular

• Student's Program changed.

• Student doesn’t remain in the same payment period.

RG - Regular

• Student advances degrees.

• The SAP status is reset to Regular since the student's program has changed.
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Previous SAP Status

• Student changes back to an old program.

• The SAP status is updated to reflect the most recent SAP status the student had the last time the student was
active in the old program.

Re-Evaluates SAP at Completion of a Re-Opened Payment Period
When a payment period is completed the application completes a single SAP evaluation for the payment period.
However, if a program or course update result in a payment period being re-opened, the application triggers a new
SAP evaluation when that payment period is again updated to a completed status. This is the only scenario that the
application processes multiple SAP evaluations for a single payment period.

When multiple SAP evaluations are completed for a single payment period, the results for each are saved and can be
viewed on the SAP Information screen.

Calculates the SAP Status when previous SAP Statuses have been
Converted
The application calculates the student's SAP status at the student's SAP evaluation if the previous status was converted
on the student's record so that the status is valid. The application calculate first SAP evaluation using the SAP status of a
converted value. The Previous SAP status will not be associated to an Academic Year /Payment Period.

The Current SAP status for the converted student will be based on the converted value and this status will not be
displayed in the User Interface (UI).

The SAP status will always have a value corresponding to the current SAP evaluation:

• If the student fails the GPA or Pace of Completion evaluation while in a Warning or Probation status, the student
will be placed in an FD - Financial Aid Disqualification status.

• If the student passes the GPA and Pace of Completion evaluation while in a Probation, Disqualified or Warning
status, the student will be placed back in an RG - Regular status.

Configurable Attributes
SAP-related configuration is done using the School Guide using these fields:

• Disable_Pace_of_Completion.

• Minimum_Pace_of_Completion.

• Maximum_Approved_SAP_Appeals.

• SAP_Appeals_Initiating_Doc.

• Count_Repeat_Courses_in_SAP_Pace_of_Completion.

• Count_Repeat_Courses_in_SAP_Max_Time_Frame.

• Sap_Evaluation_Period_Determination_Script.

SAP letters configuration is done using the Letter Guide creating a unique Letter_Code that uses the Message_Class
field value of FasSapAcademicInformationEvent for each SAP Status. Baseline Configuration includes letters for these
SAP Statuses:

• RG - Regular Notification.
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• FW - Financial Aid Warning.

• FD - Financial Aid Disqualification.

Navigation to the Student Financial Planning User Interface Functionality
To view SAP Information
Navigate to Student > Student Record > SAP Information

Update The Manual SAP Indicator  
Student Financial Planning consumes the SAFI message which contains a Manual SAP Indicator and a value of True or
False and displays it in the Student Financial Planning User Interface, but you can override the indicator if necessary.

Overview
If you Override the Manual SAP Indicator, Student Financial Planning uses the manually updated value upon
completion of future SAP evaluations and when determining whether or not to create a Review SAP Evaluation task.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Updating Manual SAP Indicator

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's External Student ID Number in the Search Field

◦ Navigate to Student Record > SAP Information

2. Click the student name/student id link to expand the Student Header.
3. Click the Override Manual SAP Indicator link.
4. Select a status from the list of values.
5. Click Save.
6. Confirm the new Manual SAP Indicator status is displayed.

You can Override the Manual SAP Indicator from any screen in the Student Financial Planning User Interface as the
button is in the student header.

If the Manual SAP Indicator is updated to YES, Student Financial Planning will create a Review SAP Evaluation task for all
future SAP evaluations.

Update The SAP Status  
You can update the SAP Status.
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Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps listed below.

• Student

• At Will Sap Status Update

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI).

1. Enter the student External Student ID in the search field.
2. Navigate to Student Record > SAP Information .
3. Click the Payment Period you want to review.
4. Click the Current SAP Status Change link.

Note:  Only the last completed SAP evaluation displays the Change link.

5. Select a new SAP Status.
6. Click Save.
7. Confirm the new Current SAP Status is displayed.

Update Number of SAP Appeals on File  
You can override the Number of Approved SAP Appeals on File.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Sap Appeals Override

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI).

1. Enter the student External Student ID in the search field.
2. Navigate to Student Record > SAP Information .
3. Click the Payment Period you want to review.
4. Click the Number of Approved Appeals on File Change link.

Note:  Only the last completed SAP evaluation displays the Change link.

5. Enter a new SAP Number of Appeals.
6. Click Save.
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7. Confirm the new Number of Approved Appeals on File is displayed.

Related Topics
• Review SAP Appeal - Task

• Review SAP Evaluation - Task

Trigger Or Re-Trigger A SAP Evaluation  
Through the Student Financial Planning user interface, you can manually Trigger a New SAP Evaluation or Re-Trigger a
SAP Evaluation for an existing payment period.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Re-Trigger SAP Evaluation

Manual Processing Steps
Trigger a New SAP Evaluation

Log into the Student Financial Planning User Interface (UI).

1. Enter the student External Student ID in the search field.
2. Navigate to Student Record > SAP Information
3. Click the Trigger New SAP Evaluation button.
4. Select a Sap Period To Evaluate.
5. Click Evaluate.
6. Review the new SAP EvaluationCurrent SAP Status is displayed.

Re-Trigger a SAP Evaluation

Log into the Student Financial Planning User Interface (UI).

1. Enter the student's external student ID number in the search field.
2. Navigate to Student > SAP Information.
3. Click the Payment Period you want to review.
4. Click the Re-Trigger SAP Evaluation button.
5. Click Evaluate to confirm you want to re-evaluate the period.
6. Review the SAP Information. The latest evaluation is first.

Review SAP Evaluation - Task  
Based on the institution's configuration for exceptions to the automated SAP evaluation process, Student Financial
Planning creates a Review SAP Evaluation task if configured criteria have been met to require manual review.
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Overview
If SAP is manually reviewed through a Review SAP Evaluation task, you can review all SAP information, including the
inputs used to determine SAP results, and update Student Financial Planning to reflect the appropriate SAP status.

Upon completion of the SAP evaluation, Student Financial Planning sends an Outbound Message to communicate the
outcome of the manual SAP evaluation.

If necessary you can request additional documentation (see Request Documents ) to complete the task. While
documents associated with the SAP Evaluation Process are Pending the Review SAP Evaluation task is placed on hold
and removed from the manual task queue. Once all requested documents are received, the manual task will be re-
created for user review.

Required Role Permissions
The user must have a role with the following General Permission(s) and Document Permission(s) through Roles
Management in order to complete the manual processing steps listed below.

• Student

• SAP Review Task (General Permission)

• SAP Related Documents (Document Permission)

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner

◦ Navigate to Student Record > SAP Information

◦ Review the results of previous SAP evaluations for Academic Year 1, Payment Period 1 and 2

◦ Review any other information required to complete the SAP evaluation

2. Navigate to Dashboard  > Review SAP Evaluation task queue

◦ Claim Task

3. Start Task
4. Confirm the SAP Status, Update the SAP status or Override the SAP calculation
5. Choose a new status if relevant
6. Navigate to Student > Student Record > SAP Information and confirm update

Review SAP Appeal - Task  
When a student submits the document configured by the institution to initiate the SAP appeal process, Student
Financial Planning (SFP) creates a Review SAP Appeal task. You can review all received SAP documentation, previous
SAP information, and course information used to determine the results of a manual SAP evaluation.

Overview
To complete the SAP Appeal, you need to approve or deny the appeal.

• The SAP status is updated to FP - Financial Aid Probation  status if you approve the appeal
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• The SAP status isn't updated and remains in FD - Financial Aid Disqualification status if you deny the appeal.

Note:  If necessary, you can request additional documentation, See Request Documents. While documents associated
with the SAP Appeal Process are Pending, the Review SAP Appeal task is placed on hold and removed from the
manual task queue. Once all requested documents are received, the manual task is re-created for user review.

Required Role Permissions
The user must have a role with the following General and Document Permissions through Roles Management in order to
complete the manual processing steps:

• SAP Appeal Review Task (General Permission)

• Sap Appeals Override (General Permission)

• SAP Initiating Document (Document Permission)

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI).

1. Enter the student's external student ID number search field:
◦ Navigate to Student Record > SAP Information .

◦ Click the Payment Period you want to review.

2. Click the View Student Tasks link in the Student Header.
3. Claim the Review SAP Appeal Task by selecting the check box.
4. Click Claim 1 of # button
5. Navigate to Dashboard > Review SAP Appeal task queue.
6. Start Task.
7. Choose Approve or Deny.
8. If Approved, update the SAP Status.
9. Click Complete Task.

Based on your school's configuration, you may be required to complete additional tasks (for example, Review
SAP Evaluation or Review Professional Judgment) before the SAP Information page updates.

10. Navigate to Student Record >  > SAP Information .
◦ Choose the Payment Period being appealed.

11. Confirm the Number of Approved appeals on file has updated (when applicable).
12. Confirm the Status updated and is displayed (when applicable).
13. Click the View Appeal button to review the Appeal.
14. Review the Appeals section.
15. Click the Documents button to view associated documents SAP Appeal Documents.
16. Review Appeal Documents.

Override SAP Calculation  
You can Override the SAP Calculation inputs. When a SAP input is overridden, Student Financial Planning completes a
new SAP evaluation and makes updates to the SAP status and components as necessary.
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Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• At Will Sap Status Update

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student > Student Record > SAP Information
3. Choose SAP evaluation period
4. Override SAP Calculation
5. Update Inputs
6. Save
7. Review the latest SAP Evaluation
8. Review SAP Status in the latest SAP Evaluation
9. Review the component impacted in the latest SAP Evaluation

The latest evaluation will be at the top of the list, per payment period

FAS Historical SAP Data Event Message  
Use the FasHistoricalSapDataEvent message to determine Satisfactory Academic Progress (SAP) statuses for programs
processed outside of Student Financial Planning (SFP) at their current SAP level. Converting students from a legacy
application to SFP for processing is an example.

Overview
Using this message, the application can revert the SAP status back to the prior program; for example, when student
returns to a previous program. When a Historical SAP Data Event message is received and matches the current
program, the historical SAP data is displayed in the SAP Information UI.

The Prior SAP Record is displayed after a Student Academic and Financial Information (SAFI) message is received and
the student's current program matches the student's prior program.

Confirm the FasHistoricalSapDataEvent in these database tables:

• SIS_SAP_PERIOD.

• SIS_SAP_APPEAL.

The Prior SAP Record is also displayed on the Student Summary page. If a FAS Historical Event Message isn't received
for a student, the Prior SAP Record defaults to Regular.
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Required Role Permissions
The user must have a role with these General Permissions through Roles Management to complete the associated
Evaluate Change of Program task.

• Student

• Transfer Change of Program Evaluator. Use this permission to View and complete the Evaluate Change of
Program task.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Here are suggested steps for reviewing a student record based on various scenarios:

New Student in SFP
When a student is new to the institution and SFP, they won't have any prior SAP evaluations in the legacy application or
in the SFP application. Therefore, the Prior SAP Record displays an SAP status of RG - Regular.

1. Sign into the Student Financial Planning User Interface (UI).
2. Enter the student's external student ID number in the search field.
3. View the SAP Status from the default Student Summary page.
4. Navigate to Student > Student Record >  SAP Information.
5. Review Prior SAP Record details:

◦ The Academic Year, Payment Period (PP), PP Start/End Dates are N/A due to no prior SAP evaluations
in the application.

◦ The default SAP Status for a new student with no prior evaluations is RG - Regular.

◦ The Program Code should match the student's current program code.

Conversion from Legacy System to SFP
To convert a student from a legacy application to SFP, the institution can send a FasHistoricalSapDataEvent message to
communicate the student's latest SAP status and Appeals information. In this example, the student is converted from
the legacy application to SFP while enrolled in the same program with a Prior SAP Status of FW - Financial Aid Warning.
After the student completes their first payment period in SFP, the system evaluates them for SAP, and they fail one of
the SAP components. Because the student fails an SAP component, their SAP Status is updated from FW - Financial
Aid Warning toFD - Financial Aid Disqualification. With this status, the student isn't eligible for Title IV funds unless they
submit an appeal and are approved. From the SAP Information page in the UI, you can see if the student has any prior
appeals on file and the maximum number of appeals allowed.

1. Sign into the Student Financial Planning User Interface (UI).
2. Enter the student's external student ID number in the search field.
3. View the Prior SAP Record and Current SAP Status from the default Student Summary page.
4. Navigate to View the Prior SAP Record and Current SAP Status from the default Student Summary page.
5. Review Prior SAP Record details:

◦ The prior SAP status is based on the FasHistoricalSapDataEvent message (FW).

◦ Number of Approved Appeals is based on the FasHistoricalSapDataEvent message (1).

◦ The Program Code should match the student's current program code (JTA1).

6. Review Latest SAP Record details:
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◦ Current SAP Status (FD).

◦ Maximum Number of Appeals Allowed.

◦ Failed SAP component.

Note:  For Academic Year SAP, the system doesn't consider historical SAP evaluations with a FW - Financial Aid
Warning status.

Conversion from Legacy System with Prior SAP Record, then Changes Program in a
New Academic Year
To convert a student from a legacy application to SFP, the institution can send a FasHistoricalSapDataEvent message
to communicate the student's latest SAP status and Appeals information. In the example below, the student's latest
SAP status in the legacy application is FW - Financial Aid Warning. When the student completes their first payment
period in SFP, they fail one of the SAP components resulting in an SAP Status of FD - Financial Disqualification. In this
example, the student decides to change programs to something more suitable. When they change programs, their SAP
status is updating to RG - Regular for the new program of study.

1. Sign into the Student Financial Planning User Interface (UI).
2. Enter the student's external student ID number in the search field.
3. View the SAP Status from the default Student Summary Screen (current/new program, RG).
4. Navigate to Student > Student Record >  SAP Information (for the current/new program of study).
5. Review Prior SAP Record details:

◦ The Academic Year, Payment Period (PP), PP Start/End Dates are N/A due to no prior SAP evaluations
in the application for this program code (BSB/A).

◦ The default SAP status for a new student with no prior evaluations is RG - Regular.

◦ The Program Code should match the student's current program code.

6. Navigate to Original Program: Click the Program of Study Link in the Student Information bar and choose the
Original Enrollment record.

7. Review Prior SAP Record details:

◦ The prior SAP status is based on the FasHistoricalSapDataEvent message (FW) for the matching Program
Code (JTA1).

◦ Number of Approved Appeals is based on the FasHistoricalSapDataEvent message (1).

◦ The Program Code should match the student's current program code (JTA1).

8. Review Latest SAP Record details:

◦ Current SAP Status (FD).

◦ Maximum Number of Appeals Allowed (based on configuration).

◦ Failed SAP component.

Conversion from Legacy System with Prior SAP Record, then Re-enters After 180
Days
To convert a student from a legacy application to SFP, the institution can send a FasHistoricalSapDataEvent message
to communicate the student's latest SAP status and Appeals information. In this example, the student converted from
the legacy application with a Prior SAP Status of RG - Regular. When they completed their first Payment Period in SFP,
they failed one SAP component and their SAP Status updated from RG - Regular to FW - Financial Aid Warning. The
student then withdrew and later re-entered after 180 days into the same program of study. The application uses the
latest SAP evaluation for that program which is FW - Financial Aid Warning. When the student has an SAP evaluation
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in the SFP for a program of study, the school doesn't have to send a FasHistoricalSapDataEvent message even if the
student withdraws.

1. Sign into the Student Financial Planning User Interface (UI).
2. Enter the student's external student ID number in the search field.
3. View the SAP Status from the default Student Summary Screen (current/program or latest enrollment record)

◦ Prior SAP Status (FW is the latest SAP Status from Original Enrollment).

◦ Latest SAP Status for the current "Re-entry" enrollment (FD).

4. Navigate to Student > Student Record >  SAP Information (to view more info for the current/re-entry
enrollment record).

5. Review Prior SAP Record details:

◦ The Academic Year, Payment Period (PP), PP Start/End Dates are available because the student has
prior enrollment record in SFP with a completed SAP evaluation.

◦ The last SAP status for student is displayed (FW).

◦ The Program Code should match the student's current program code.

6. Review Latest SAP Record details:

◦ Current SAP Status (FD) is because the Prior SAP Record was FW, due to the last SAP evaluation in SFP
before the student withdrew from the same program.

◦ Failed SAP component resulted in SAP status change FW to FD.

7. Navigate to Original Program: Click Program of Study in the Student Information bar and choose the Original
Enrollment record.

8. Review Prior SAP Record details:

◦ The prior SAP status is based on the FasHistoricalSapDataEvent message (RG) for the matching Program
Code (JTA1).

◦ Number of Approved Appeals is based on the FasHistoricalSapDataEvent message (1).

◦ The Program Code should match the student's current program code (JTA1).

9. Review Latest SAP Record details:

◦ Current SAP Status (FD).

◦ Failed SAP component resulted in SAP status change from RG to FW.

Conversion from Legacy System with Prior SAP Record, then Re-enters Within 180
Days
To convert a student from a legacy application to SFP, the institution can send a FasHistoricalSapDataEvent message
to communicate the student's latest SAP status and Appeals information. In this example, the student converted
from the legacy application with a Prior SAP Status of FW - Financial Aid Warning. When they completed their first
Payment Period in SFP, they failed one SAP component and their SAP Status updated from FW - Financial Aid Warning
to FD - Financial Aid Disqualification. The student then withdrew and later re-entered within 180 days into the
same program of study. The application uses the latest SAP evaluation for that program which is FD - Financial Aid
Disqualification. When the student has an SAP evaluation in the SFP for a program of study, the school doesn't have to
send a FasHistoricalSapDataEvent message even if the student withdraws.

1. Sign into the Student Financial Planning User Interface (UI).
2. Enter the student's external student ID number in the search field.
3. View the SAP Status from the default Student Summary Screen
4. Navigate to Student > Student Record >  SAP Information.
5. Review Prior SAP Record details:
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a. The details for the prior SAP record is based on the FasHistoricalSapDataEvent message for the matching
Program Code (JTA1).

b. Maximum Number of Appeals Allowed is based on configuration.
6. Review SAP Record details for SFP Academic Year 1, Payment Period 1.

Current SAP Status (FD) due to Prior SAP Record SAP Status (FW) and a failed SAP component.
7. Review SAP Record details for SFP Academic Year 1, Payment Period 2.

Current SAP Status (FD) due to Prior SAP Record SAP Status (FD) and another failed SAP component.

Student Information  
Student Financial Aid (SFA) supports integration with the institution’s Student Information System (SIS). The SIS initiates
the Student Record and Financial Aid Process and manages updates to the SFA student record.

Overview
The institution's SIS sends a FasStudentInitiationEvent message to SFA when a student completes required Admission
documentation to create the Student Record. If the message indicates that the student intends to apply for Federal
Student Aid, the application automatically requests that the student complete a Free Application for Federal Student
Aid (FAFSA) for the appropriate award year. The application automatically matches the resulting Institutional Student
Information Record (ISIR) to the Student Record when received.

What Student Financial Aid Does Automatically
SFA automatically does the following things:

Receives and Creates New Student Records
The application creates a student record and displays it in the UI when the application receives a
FasStudentInitiationEvent message.

Based on the FasStudentInitiationEvent message, the application can determine if the student intends to apply for
financial aid. If the student intends to apply for financial aid, the application attempts to match ISIR, MPN, or any other
SAIG files to the student record and sends the appropriate configured outbound student notifications (for example,
award year FAFSA needed) to request additional required information.

Error Message

The application returns an outbound integration error message and doesn't create a new Student Record if the
student’s unique institutional External Student ID or Social Security Number matches another student's information.

Updates the Student Record
SFA updates existing student records upon receipt of a FasStudentUpdateEvent message from the institution's Student
Records System. The application uses the creation date and time to validate the FasStudentUpdateEvent message.
The application updates the student record if the creation date and time is after the creation date and time of the
FasStudentInitiationEvent message or after the current FasStudentUpdateEvent message. Using the External Student
ID number, the application matches the FasStudentUpdateEvent message to an existing Student Record and then
determines what data has been updated (for example, student identifier information, demographic data, and so on).
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The application accepts the inbound FasStudentUpdateEvent message and updates the demographic data, program
information, program enrollment status, or contract dates appropriately.

If student identifiers (for example, Last Name, SSN, or DOB) have been changed, the application determines if the
Student Record matches an ISIR or not. If the Student Record matches an ISIR, the information is updated. However, if
the Student Record doesn't match an ISIR, the application creates a Student Notification to alert users that a discrepancy
exists so they can determine if any corrections should be made for each award year ISIR.

If the student changes a request for financial aid, the application updates the student record appropriately:

• Change from "No" to "Yes", student record proceeds through the FAFSA process.

• Change from "Yes" to "No", student record proceeds to the packaging process.

Error Message

The application returns an outbound integration errors message if:

• It can't match the External Student ID to an existing Student Record.

• The creation date and time is before the current FasStudentUpdateEvent message.

Configurable Attributes
Configure if student record updates are sent to the institution's student record system.
You can configure whether the application sends student record information after any updating the student record.

Required Role Permissions
The user must have a role with the following General Permission through Roles Management to view the following
information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Aid User Interface Functionality
To view the Student Information Page:
Student Financial Aid User Interface > Student > Student Record > Student Information

Student Letters  
Use delivered Letters to comply with US Department of Education (ED) notification and document requirements.

Overview
This topic primarily discusses delivered Letters. Delivered Letters are used to comply with ED notification and document
requirements. Letters are produced in PDF format that are available in both the FAS and Student Self-Service UIs.

Note:  In Student Self-Service, Letters are found in the Messages tab.
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See Overview of Letters in the Implementation Guide for information about Triggering actions, integration events, At-
Will letters, and the Letter process.

Letter Triggering
The Letter process starts when a triggering action occurs; for example, a student’s Fund Status changing to Awarded
or Enrollment Status changing to Withdrawn. Triggering Events are associated with Letters using the Letter
Configuration Workbook. Here is a list of Triggering Events and their Schedule Keys:

Note:  Trigger Events that are applicable to Student Financial Planning (SFP) only are noted.

Triggering Event Schedule Keys

FasCreditBalanceInformationEvent (SFP
only)

externalStudentId/letterCode

FasDisbursementAcceptanceInformationEvent
(SFP only)

externalStudentId/letterCode

FasDisbursementAcceptanceInformationV2Event
(SFP only)

externalStudentId/letterCode

FasDisbursementCancelEvent (SFP only) externalStudentId/letterCode

FasDisbursementInformationEvent (SFP
only)

externalStudentId/letterCode

FasDocumentRejectedEvent externalStudentId/letterCode

FasDocumentRequestCanceledEvent externalStudentId/letterCode

FasDocumentRequestEvent externalStudentId/letterCode

FasFinancialPlanOutboundEvent (SFP
only)

externalStudentId/letterCode

FasGrantOverpaymentReferralEvent (SFP
only)

externalStudentId/letterCode

FasProfessionalJudgementProcessOutboundEventexternalStudentId/letterCode

FasReturnToLenderEvent (SFP only) externalStudentId/letterCode/enrollmentId

FasSapAcademicInformationEvent (SFP
only)

externalStudentId/letterCode

FasSapAppealsProcessInformationEvent
(SFP only)

externalStudentId/letterCode

FasStudentAwardInformationEvent (SFP
only)

externalStudentId/letterCode
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Triggering Event Schedule Keys

FasStudentAwardInformationV2Event
(SFP only)

externalStudentId/letterCode

FasStudentNotificationEvent externalStudentId/letterCode

FasStudentRecordHoldPlacedEvent externalStudentId/letterCode

FasValidIsirProcessStatusInformationEvent externalStudentId/letterCode/awardYear

TeachEligibilityCheckFailed (SFP only) externalStudentId/letterCode

TitleIvEligibilityCheckFailed (SFP only) externalStudentId/letterCode

When the Letter Batch Job is run, PDF versions of the letters are available in the FAS and Student Self-Service UIs.

Letter Configuration
Use the Letter Configuration Workbook to configure Letter generation by Letter Code. A Baseline Configuration for
Letters is delivered with each release.

Navigation to Letters in FAS
Query a student and navigate to Student Financial Planning User Interface > Student > Student Record > Student
Letters.

Click Print to view the PDF letter file.

Navigation to Letters/Messages in Student Self-Service
Note:  Letters are referred to as Messages in Student Self Service.

Query a student and navigate to Student Self-Service User Interface > Messages.

Delivered Letters  

Letter Code 108: Student Record Hold Letter  
Letter Code 108: Verification Letter is intended to notify the student of a Student Record Hold being placed on their
financial aid application.

Overview

• Letter is called when the FasReleaseStudentRecordHoldEvent is triggered. To trigger the
FasReleaseStudentRecordHoldEvent, you must query the student and navigate to Student > Student
Holds > Student Record Hold and activate the Trigger Fraud Letter switch. If this switch isn't enabled, the
FasReleaseStudentRecordHoldEvent won't be triggered.

• The Configured Interval (for example, 1 minute) between Triggering Action and letter generation must elapse
before the LetterTriggerJob runs.
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• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval.

• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs.

Required Role Permissions
To enable this letter, the user must toggle the "Trigger Fraud Letter" button in the Student Record Hold UI. The user
must have a role with this General Permission through Roles Management.

• Student Letters

See Set General Permissions Matrix for additional information.

Letter Code 110: Verification Letter  
Letter Code 110: Verification Letter is intended to notify the student they have been selected for verification based on
the ISIR received. Request for additional information is required from the student.

Overview

• Letter is called when the following message is triggered: FasValidIsirProcessStatusInformationEvent

◦ FasValidIsirProcessStatusInformationEvent is triggered after an ISIR is received and has C-Code 170 or 171

• The Configured Interval (i.e. One Minute) between Triggering Action and letter generation must elapse before
the LetterTriggerJob runs

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval

• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management.

• Student Letters

See Set General Permissions Matrix for additional information.

Letter Code 200: Exit Interview Letter  
Letter Code 200: Exit Interview Letter is intended to notify the student of the Exit Interview process and to inform
students of actions they must take to receive financial aid and provide them with informative messages as to their
financial aid status.

Overview

• Letter is called when the following message is triggered: FasStudentNotificationEvent

◦ FasStudentNotificationEvent  is triggered after the enrollment status updates to Withdrawn or Graduated

• The Configured Interval (i.e. One Minute) between Triggering Action and letter generation must elapse before
the LetterTriggerJob runs

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval

• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs
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Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management.

• Student Letters

• Student Holds

• Student Holds Modify

See Set General Permissions Matrix for additional information.

Letter Code 310: Right to Cancel  
Letter Code 310: Right to Cancel Letter is intended to provide the student a summary of federal financial aid
disbursements processed by the University and their Right to Cancel.

Overview
• Letter is called when the following message is triggered: FasDisbursementInformationEvent

◦ FasDisbursementInformationEvent is triggered after a fund is Disbursed and the disbursement status
updates to Disbursed

• The Configured Interval (i.e. One Minute) between Triggering Action and letter generation must elapse before
the LetterTriggerJob runs

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval

• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management.

• Student Holds

• Student Holds Modify

• Student Letters

See Set General Permissions Matrix for additional information.

Letter Code 325: Late Disbursement Notification Letter  
Letter Code 325: Late Disbursement Notification Letter is intended to notify the student that they are eligible to receive a
late disbursement. The student must respond to this letter in order to receive any eligible funds.

Overview
• Letter is called when the following message is triggered: FasDisbursementAcceptanceInformationEvent

◦ FasDisbursementAcceptanceInformationEvent  is triggered after:
- The Late Disbursement Indicator is equal to Yes
- All Disbursement Criteria and Late Disbursement Criteria equal Met

• The Configured Interval (i.e. One Minute) between Triggering Action and letter generation must elapse before
the LetterTriggerJob runs

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval
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• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management.

• Student Letters

• Student Summary

• Student History

See Set General Permissions Matrix for additional information.

Letter Code 520: Cancellation FA Notification Letter  
Letter Code 520: Cancellation FA Notification Letter is intended to notify the student their Financial Aid has been
canceled.

Overview

• Letter is called when the following message is triggered: FasDisbursementCancelEvent

◦ FasDisbursementCancelEvent is triggered after:
- A disbursement updates to a status of Disbursement Canceled

• The Configured Interval (i.e. One Minute) between Triggering Action and letter generation must elapse before
the LetterTriggerJob runs

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval

• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management.

• Student Letters

See Set General Permissions Matrix for additional information.

Letter Code 610: SAP RG Notification Letter  
Letter Code 610: SAP RG Notification Letter is intended to notify the student they have met the University requirements
to continue receiving Financial Aid.

Overview

• Letter is called when the following message is triggered: FasSapAcademicInformationEvent

◦ FasSapAcademicInformationEvent is triggered after:
- SAP evaluation has been completed and SAP status has changed

◦ Example: Value updated from FP - Financial Aid Probation to RG - Regular

• The Configured Interval (i.e. One Minute) between Triggering Action and letter generation must elapse before
the LetterTriggerJob runs

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval
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• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management.

• Student Letters

• SAP Review Task (If applicable)

• SAP Appeal Review Task (If applicable)

• SAP Appeals Override (If applicable)

• Professional Judgement Review Task (If applicable)

See Set General Permissions Matrix for additional information.

Letter Code 620: SAP FA Warning Letter  
Letter Code 620: SAP FA Warning Letter is intended to notify the student that they have been placed on Financial Aid
Warning due to not meeting criteria for SAP.

Overview
• Letter is called when the following message is triggered: FasSapAcademicInformationEvent

◦ FasSapAcademicInformationEvent is triggered after:
- SAP evaluation has been completed and SAP status has changed

◦ Example: Value updated from RG - Regular to FW - Financial Aid Warning

• The Configured Interval (i.e. One Minute) between Triggering Action and letter generation must elapse before
the LetterTriggerJob runs

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval

• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management.

• Student Letters

• SAP Review Task (If applicable)

• SAP Appeal Review Task (If applicable)

• SAP Appeals Override (If applicable)

• Professional Judgement Review Task (If applicable)

See Set General Permissions Matrix Set General Permissions Matrix for additional information.

Letter Code 625: SAP FA Disqualification Letter  
Letter Code 625: SAP FA Disqualification Letter is intended to notify the student they have been placed on Financial Aid
Disqualification status due to not meeting criteria for SAP.

Overview
• Letter is called when the following message is triggered: FasSapAcademicInformationEvent
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◦ FasSapAcademicInformationEvent is triggered after:
- SAP evaluation has been completed and SAP status has changed

◦ Example: Value updated from FW - Financial Aid Warning to FD - Financial Aid
Disqualification

• The Configured Interval (i.e. One Minute) between Triggering Action and letter generation must elapse before
the LetterTriggerJob runs

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval

• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management.

• Student Letters

• SAP Review Task (If applicable)

• SAP Appeal Review Task (If applicable)

• SAP Appeals Override (If applicable)

• Professional Judgement Review Task (If applicable)

See Set General Permissions Matrix for additional information.

Letter Code 725: Post Withdrawal Notification Letter  
Letter Code 725: Post Withdrawal Notification Letter is intended to notify the student they may be eligible for a Post
Withdrawal Disbursement for Loan and/or grants.

Overview

• Letter is called when the following message is triggered: FasDisbursementAcceptanceInformationEvent

◦ FasDisbursementAcceptanceInformationEvent is triggered after:

• The PWD Disbursement Indicator is equal to Yes

• All Disbursement Criteria and PWD Criteria equal Met

• The Configured Interval (i.e. One Minute) between Triggering Action and letter generation must elapse before
the LetterTriggerJob runs

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval

• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management.

• Student Letters

• Student Summary

• Student History
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See Set General Permissions Matrix for additional information.

Letter Code FN1: Award Letter  
Letter Code FN1: Award Letter is intended to notify the student that funds have been awarded.

Overview
• Letter is called when the following message is triggered: FasStudentAwardInformationEvent

◦ FasStudentAwardInformationEvent is triggered after:
- A fund is updated to Awarded AND
- Associated Award Amounts Determined QC Hold is Released (if applicable)

• The Configured Interval (i.e. One Minute) between Triggering Action and letter generation must elapse before
the LetterTriggerJob runs

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval

• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management.

• Student Holds

• Student Holds Modify

• Student Letters

See Set General Permissions Matrix for additional information.

Letter Code PO1: Provisional Aid Offer Letter  
Letter Code PO1: Provisional Aid Offer is intended as a pre-cursor to the Offer letter enabling students to view
potential funding prior to being officially awarded

Overview
• Letter is called when the following message is triggered: FasFinancialPlanOutboundV2Event.

• FasFinancialPlanOutboundV2Event is automatically generated with every package. If you want to manually
trigger the event, navigate to Student > Financial Information > Packaging > Repackage.

• The Configured Interval (for example, One Minute) between Triggering Action and letter generation must
elapse before the LetterTriggerJob runs.

• The letter triggered will include data from the last triggering action for that letter code that occurred within the
interval.

• The letter is displayed in the Student Letters User Interface (UI) after the LetterTriggerJob runs

Required Role Permissions
The user must have a role with the following General Permission through Roles Management.

• Student Letters

See Set General Permissions Matrix for additional information.
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Student Notifications  
Students receive automated notifications throughout the financial aid lifecycle.

Overview
Students receive Notifications throughout the Financial Aid lifecycle regarding their FAFSA applications, offered
financial aid awards, and requirements to receive or return Federal financial aid funds. This topic discusses Student
Notifications that are displayed in Notification tab of Student Self-Service and the Student > Student Record > Student
Notifications navigation of the FAS UI.

Student Notification Types

Note:  Notifications that are applicable to Student Financial Planning (SFP) only are noted.

Notification Type Description Initiating Event Workbook

FAFSA Request Notifies the student that an ISIR is
not on file for an Academic year
that is eligible for Title IV funding.

Continuing Students: If the
Payment Period falls into a new
Award Year without an ISIR on file.
 
New Students: FAFSA requested
for the Award Year in which the
program start date or end date
falls.
 

N/A

TEACH Grant Counseling Notifies the student if TEACH Grant
Counseling is needed or not. SFP
only)

Configurable TRIGGER.csv

TEACH ATS Notifies the student if a TEACH
ATS (Agreement to Serve) is
needed or not. (SFP only)

Configurable TRIGGER.csv

Entrance Counseling Notifies the student if loan
Entrance Counseling is needed or
not. (SFP only)

Configurable TRIGGER.csv

Annual Student Loan
Acknowledgment

Notifies the student of their Annual
Loan Acknowledgement is needed
or not. (SFP only)

Configurable TRIGGER.csv

MPN Notifies they student if the need to
complete their Master Promissory
Note (MPN) or not.  (SFP only)

Configurable TRIGGER.csv

Credit Decision Notifies the student that a credit
decision for PLUS loan is needed or
not. (SFP only)

Configurable TRIGGER.csv

PLUS Application Notifies the student that they do
not have a PLUS application on file.
(SFP only)

Configurable TRIGGER.csv
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Notification Type Description Initiating Event Workbook

Exit Counseling Notifies the student that exit
counseling is required or not. (SFP
only)

Configurable EXIT_COUNSELING.csv

R2T4 Refund Required Notifies the student if a refund is
due based on the Return To Title IV
funds calculation. (SFP only)

A return amount greater than $0
is calculated during the Return to
Title IV process.

N/A

Grant Overpayment Notifies the student a Grant
Overpayment is due based on the
Return To Title IV funds calculation.
(SFP only)

A grant overpayment was
calculated, and the school's
configured deadline for the student
to repay the overpayment has
elapsed.

SCHOOL.csv (configured
notification text)
 

Student Financial Aid (SFA) Automatically
Creates Student Notification Record
SFA creates and sends outbound based on the Initiating Action and configuration as appropriate. Each created
Notification is logged.

Each notification contains the following details:

• Notification Type

• Notification Text (labeled Message in the FAS UI).

• Status:

◦ Open: Requires student or borrower action.

◦ Closed: Does not require student or borrower action.

• Date created.

Required Role Permissions
You must have a role with these General Permissions through Roles Management to view Student Notifications.

• Student.

See Set General Permissions Matrix for additional information.

Navigation to Student Notifications in FAS
Query a student and navigate to SFA User Interface > Student > Student Record > Student Notifications

You can filter the Student Notifications based on the Student Notification Status (e.g. Open, Closed, All). On the Student
Notification screen, the user will select the desired option from a drop-down menu.

Navigation to Student Notifications in Student Self-Service
Query a student and navigate to Student Self-Service User Interface > Notifications.
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Search for Student Record  
You can search for a student record using the Quick Search field in the main navigation bar or by clicking the
magnifying glass in the Menu Bar to perform an Advanced Search.

Overview
Student Financial Aid (SFA) returns results for exact or partial matches. However, if you search based on a partial search,
you must use the wildcard operator in your search appropriately. Below are important notes about searching for the
student record.

Search Student (Main Navigation Bar)

1. A spinner icon replaces the magnifying glass while SFA is searching for student results.
2. Use the Enter/Return key after entering the searchable data (for example, External Student ID) in the Search

Field on the Main Navigation screen.
3. If the user attempts a partial search without using the * wildcard operator, the UI will return a "No student's

Found" message.
4. If you are attempting to search for a student record using partial information, you must use the * where the

information will not match.
a. Example 1: Student Name Johnny, Partial search = John*
b. Example 2: Student Name Elisabeth, Partial search = *beth

Advanced Search (Pop-out Dialog Box)

1. The pop-out dialog box has a quick search field. This field works the same as the search field in the main
navigation found in the menu bar.

2. Use the Search Button or click "Enter/Return" to initiate the search for entered data.
3. The application returns "No student's Found" if you don't use the * wildcard operator appropriately on any of

the advanced search data fields.

Note:  AND / OR Clause SFA uses an OR clause on the main navigation page. Therefore, if you type a full name
without a prefix or a wildcard, for example, "John Smith", the application returns results for John OR Smith in either
the first or last name. However, if you enter firstname:John lastname:Smith the application returns results that
match first name John AND last name Smith. Using either method on the main navigation page may return results
that exceed the number of visible matches. This may prevent you from accessing the student record that you looking
for. In that case, you should use the Advanced Search option. The advanced search pop-out dialog box enables you
to enter multiple data fields such as First Name, Last Name, SSN, External Student ID, and DOB. The advanced search
fields use an AND clause and search only for students that match the entered data. You may also use the wildcard
operator while using the advanced search option.

Required Role Permissions
The user must have a role with the following General Permission through Roles Management in order to complete the
manual processing steps:

• Student

See Set General Permissions Matrix for additional information.
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Manual Processing Steps
Main Navigation Search
Log into the Student Financial Aid User Interface (UI)

1. In the Search field, enter any of the following into the search field using exact and partial searches without
adding a prefix:

a. External Student ID.
b. First Name.
c. Last Name.
d. Social Security Number.

Note:

◦ You must use the Enter/Return key on your keyboard to initiate the student search.

◦ When SFA is searching, a Spinner icon replaces the magnifying glass.

2. In the search field, enter an exact or partial search, but, this time, add a prefix .

Optimized Search

When you enter data without a prefix in the search field, SFA attempts to match on the External Student ID,
First Name, Last Name and/or Social Security Number. To increase the efficiency of your search, use one of the
prefixes:

◦ id:

◦ firstname:

◦ lastname:

◦ ssn:

Do NOT enter a space after the colon. When you put a space after the colon search results may vary. For
example, if you enter firstname: john* SFA returns results for first and last names.

Advanced Search
Log into the Student Financial Aid User Interface (UI)

1. Click the Magnifying glass
2. Use the data fields to search based on Exact Match
3. Search based on Partial Match
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6  Using Documents

Documents  
You can manage requested documents from students as part of the financial aid application process.

Overview
Documents are collected from students during all phases of a student’s life cycle. Student Financial Aid (SFA) provides a
framework where many different types of documents can be collected and approved.

You can request and receive any documentation required to proceed with the financial aid application review process,
including the ISIR Review and ISIR Verification processes. These include documents the U.S. Department of Education
(ED) and the institution require and have configured to clear assumptions, reject codes, ISIR data discrepancies,
professional judgments, and verification to make Title IV Funds available to students.

These are the types of document data that are managed by SFA:

Document Type Definition

Document An official paper or computer file that provides information or proof about a student/spouse/parent
borrower.

Metadata Data that provides information about other data, for example, First Name, Date of Birth, Social Security
Number, and so on.

Document Sub-Type A document that requires multiple documents under one document name because each version
contains different information or proof about a student/spouse/parent borrower, for example, W2s,
 Tax Returns, Student Statements, and so on.

You can use the delivered Student Self-Service or build your own portal to an external Document Management System
(DMS) of your choice to meet your document application processing needs.

Document Statuses
These document statuses are used throughout the document management process.

Status Description

Requested Document request has been sent to the student or appropriate party/system.
 
Document continues to be displayed in the Pending Requests screen unless you cancel the Document
Request.
 

Received Document message has been received and has not been accepted or rejected by SFA.
 
Manual Review Required (either based on configuration or due to failing metadata acceptance logic).
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Status Description

 
Document Remains in a required state and is only be updated to No Longer Required if the Manual
Review results in the document being Approved or Canceled.
 
Document continues to be displayed in the Pending Requests screen until Manual Review is complete
and removed only if the Manual Review results in the document being Approved or the document
request is Cancelled.
 

Acceptable Document has been received and has passed validation and all acceptance criteria.
 
Document does not require manual review (manual review may have been required, but has been
completed and document was approved).
 
Document is updated to No Longer Required
 
Document is no longer displayed in the Pending Requests screen.
 

Unacceptable Document Management System determined the document was Unacceptable upon receipt or the
document has been manually rejected.
 
Document is still required.
 
Document continues to be displayed in the Pending Requests screen unless the document request is
Canceled.
 

Inactive Document has passed its expiration period (e.g. only active for their associated award year).
 
Example: If a FAFSA for a closed award year is received after the configured Award Year ISIR Deadline
Date, the document status is updated to Inactive.
 

Requesting Documents
Documents are requested based on system configuration. For example, in several of the ISIR-related Configuration
Workbooks, there is a Documents Required field. This field is populated with a Groovy script containing logic that
makes document requests. When an ISIR is received, the configuration creates the document request. You can view
what documents have been requested automatically or manually on the Financial Aid System (FAS) administrative UI
Pending Documents page. Based on your configured messaging, the student is notified of the document request with
the related configured message.

To prevent duplicate document requests, Received Documents are checked before sending any requests. If the
document status is Requested or Acceptable, the document isn't requested again. However, if the you configure a
reminder notification to be sent after a defined number of days has passed, another request is sent at the appropriate
time.

If the Document Status is Unacceptable:

• With Student Self-Service, the student can review the Documents page and make necessary changes.

• With an external DMS, another document request is sent automatically. You can manually request or re-request
a document any time and an another notification is automatically sent.

SFA uses the configured document expiration date as metadata. If the document is configured as a Lifetime document,
for example, a Social Security Card, the document isn't required if it is already saved to the student record, unless
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the document effective date has passed. If the document expires every award year, then a new document is required
annually, for example, income tax information.

Receiving Documents, Document Metadata, and Document Sub-Types
You can use the delivered Student Self-Service or integration with an external DMS to receive and display documents,
document metadata, and document sub-types:

• When using delivered Student Self-Service, you can view documents, document metadata, and document
subtypes on the Received Documents page in the FAS UI when the student completes or uploads the
document using the delivered Student Self-Service UI. You can review and approve documents using the
Review Document for Approval task in the FAS UI.

• When using an external DMS, you can view documents, document metadata, and document subtypes on the
Received Documents page when the external document ID is used in combination with a configured DMS
URL address. When the student provides the document, the external DMS transforms the document into a
FasDocumentReceiptEvent message and sends it to SFA.

You configure rules to accept documents, document metadata, and document sub-types. When documents are
received, additional actions may be required upon examination of the document, document metadata, and document
sub-type attributes. SFA automatically assigns documents, document metadata, and document sub-types to an
appropriate document category and appropriate tasks using student identifier information:

• Documents: SFA uses the External Student ID Number to match the document to a student record. After
evaluating the document name, document code, category, and data fields, related tasks are created. If you have
configured the document to be manually reviewed, the document metadata is inaccurate, or the document is
Unacceptable, SFA creates a Review Document for Approval task.

• Metadata: Metadata is captured and extracted from a document automatically through the delivered Student
Self-Service or integration with the external DMS intake process. SFA validates the metadata received against
Acceptance Criteria for all required metadata parameters and creates a Review Document for Approval task
when metadata does not pass validation of the acceptance criteria.

• Document Sub-Types: If configured to do so, documents and metadata are evaluated to see if they should
be stored with multiple versions as a document Sub-Type; for example, W2s for multiple employers, different
Student Statements used to resolve different tasks, and so on.

Validating the Document Status and Assigning the Document Owners
Once a document is received, SFA evaluates the document to determine the document status and route it through
configured Acceptance Criteria to determine if it is Acceptable or Unacceptable. If the document is considered
Unacceptable, it's rejected, and SFA requests a new document from the student or appropriate party.

If the document is Acceptable, SFA evaluates the document to determine the Document Owner by checking the
document receipt message. If a document receipt message is not available, SFA evaluates configured rules to establish
the Document Owner. If it cannot be determined who the Document Owner is, the field is updated to Unknown. When
the Document Owner is Unknown, SFA saves the document and doesn't replace or overwrite any existing document
until the Document Owner field has been properly updated.

SFA uses the ISIR logic to determine if the Document Owner is assigned to the:

• For the 2024-2025 and future Aid Years:
◦ Student

◦ Student Spouse

◦ Parent
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◦ Parent Spouse

• For the 2023-2024 and prior Aid Years:

◦ Student

◦ Spouse

◦ Parent 1

◦ Parent 2

If a document is received by SFA with a student's name and there is no ISIR, the student is assigned as the Document
Owner. If the document is received and does not match the student's name and there is no ISIR on file, the Document
Owner can't be assigned and is updated to Unknown.

If the Document Owner value is Unknown, SFA determines if an ISIR has been matched to the student record. If an
ISIR has not yet been matched, SFA waits until the appropriate award year ISIR has been received, saved, and matched
to the student record before creating a Review Document for Approval task to make sure ISIR corrections are made
appropriately. If the document is not award year specific, any ISIR award year matched to the student record fulfills this
criterion. Upon matching of the ISIR, SFA checks for any other documents without a Document Owner that are pending
a manual review and create task queue alert for manual review.

Within the Review Document for Approval task, the Document Owner field is editable. SFA flags the Document
Owner field as a required update. If a Document Owner value is set to a valid value from Unknown, SFA updates the
document on the student record. SFA determines if the document should replace an existing document on the student
record based on the award year/lifetime value, document code, sub-type, and document owner or if it should be stored
as a new version of the document.

Once a Document Owner value is set, SFA can use the document to fulfill any required Financial Aid Processing, for
example, Valid ISIR Process - ISIR Code Clearing rules.

Assign Multiple Document Owners to a Document

When a document is received and SFA requests the same document for two Document Owners, for example, student
and spouse, SFA saves the document for multiple owners based on your selection. For example, if a married couple file
a joint return, only one tax document is received, but can be assigned to both the student and spouse in the FAS UI.

Evaluating Document and Document Metadata Acceptance Criteria
When a document is received, SFA uses the configured document and document metadata Acceptance Criteria to
determine if all required parameters have been received:

• When using delivered Student Self-Service, documents are validated when submitted by the student to see
that all metadata has been entered. If so, the document can be submitted and you can view the document and
associated metadata fields.

• When using an external DMS, SFA creates a Review Document for Approval task if document or metadata
information is missing. You can then view the source document, and update the associated metadata fields.

SFA takes appropriate action, for example, creating Student Notifications depending on if you select Approve or Reject
upon completing the task.

If additional document requests are required, the document that caused the need for additional documentation is
stored as a Primary document and SFA create a request for additional documents. All additional document requests are
added to any associated processes of the Primary document; therefore, holding up a process from continuing until the
Secondary documentation is received.
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Once Secondary documentation has been Requested and SFA is pending receipt of requested Secondary
documentation, the Primary document continues through the document collection life cycle. If the Primary document
does not pass the Acceptance Criteria and there are no Secondary documentation requests the Primary document
causes SFA to create a Review Document for Approval task.

Automatic Document Approval

SFA is configured to automatically approve or reject documents received. SFA updates the document status to
Acceptable or Unacceptable. Based on configuration, documents are automatically be considered Acceptable when all
required metadata fields have been received, and the document status is Acceptable. If the document has additional
Acceptance Criteria, the criteria must also be met before SFA updates the document status to Acceptable.

If a document is not automatically accepted, SFA creates a Review Document for Approval task.

Providing Visibility to Documents, Metadata, and Document Sub-Types
The student record contains all documents and the document metadata that have been assigned to the student,
regardless of method, internal or external. All document metadata is saved to the appropriate field. For example, a
student's Social Security Number (SSN) is always be associated with the metadata field for the student's SSN, and
similarly for the parent's SSN. SFA checks the metadata configuration and determines if the metadata value should
be encrypted. If the attribute is flagged to be encrypted, for example, SSN, the value is stored appropriately in the
Repository.

If a document contains all required metadata fields and has a status of Acceptable, the document metadata is saved to
the Document Repository. If there are multiple submissions of the same document or there is an expiration date/period,
the document and metadata with the most recent received date is considered active.

Note:  If a subsequent version is received, the associated metadata is saved and overwrites the existing metadata, as
applicable. If a document has an associated metadata attribute configured as a Document Sub-Type, SFA is able to
store multiple documents with the same document name/code, either associated with a specific award year or to all
award years, based upon the expiration date/period.

Managing Unsolicited Documents
When a document is received, SFA determines if the document is associated to a pending request. If the document
hasn't been specifically requested and is not associated to a pending request, the document is considered to be an
unsolicited document. Unsolicited documents and their associated metadata are held to the standard Acceptance
Criteria for the Document Code. SFA checks the configuration to determine if the unsolicited document requires a
Review Document for Approval task or can be automatically cleared.

Managing Unrecognized Documents
When using an external DMS, if a Document Code is not recognized or an unknown metadata attribute is received, the
document is rejected and an integration validation error is returned.

If configured rules require a document to undergo supervisor approval, the document goes through a two-step process.
The first step requires a non-supervisor to review and approve the document from the Review Document for Approval
task queue. Once the non-supervisor user approves the document and completes the task, the document advances
to the second step in the process. In the second step, the document is routed to a supervisor's task queue as a Review
Document for Approval task to complete the secondary review and final approval.

SFA does not update the status of a document to Acceptable until all required document approvals are completed, for
example, automatic, manual, supervisor.
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Adding the Effective Dates of Documents
SFA adds an effective start date and end date to documents to inform you the student's documentation is valid and up-
to-date.

Canceling Pending Document Requests based on Receipt of Related
Documents
SFA cancels pending document requests when a requested document is no longer needed or the document has met a
configured expiration date/period.

Once a document is received and updated to Acceptable, either automatically or manually, SFA evaluates configurable
rules to determine if any other pending document requests should be canceled. SFA determines if any related
document requests are pending on the student record and triggers the document cancellation process if the document
request is no longer valid based on the configuration rule. Canceled documents are removed from any pending
application processes and the process is triggered to move forward.

Note:  All rules are based on the defined configuration.

Saving All Document Versions
All documents that are received are saved. The student record displays a historical view of all documents, metadata,
and document sub-types for audit purposes. If the document has a Subtype defined in the Document Metadata
configuration, it displays on the Received Documents page. Only the most recent version of the document is displayed.
To see historical docs, go to Student History, find the message that created the document, and manually pull the
message ID in the student entry.

Sending Outbound Student Notification Messages
Requested Documents

When a document is required from a student, SFA sends an Outbound Student Notification Message to inform the
student what is needed and why. For example, if an institution configures SFA to request a Marriage Certificate when
an ISIR is received for a married student, and there is a discrepancy with the student's last name. The student receives a
notification when SFA initially determines the document is required, reminders based on a configured intervals, and if a
document request is canceled.

Rejected Documents

Once a document is rejected, all comments entered during the Review Document for Approval task are included in the
Student Notification. Documents in an Unacceptable status can't fulfill any pending tasks.

Overdue Documents

SFA creates and sends configured notifications when documents have been requested and are considered overdue.

Cancelled Documents

SFA creates and sends the appropriate Outbound Student Notification Message to inform the student when documents
are no longer required as a result of receiving the document or a subsequent ISIR. Any document that was received prior
to the cancellation is saved to the student record with the appropriate document status.
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Configurable Attributes
Configure Acceptance Criteria for Documents Received

Authorized users can configure the Acceptance Criteria used by SFA to receive documents. Here are the configurable
criteria:

• The Document Name, Document Code, and Category.

• Metadata associated to all documents.

• If the document can be Requested "At-Will" or not.

• If the document requires a Review Document for Approval task.

• The Acceptance Criteria that allows SFA to automatically approve a document.

• Document request messages.

• A URL used to display document images when using an external DMS.

Document configuration can be modified as the institution's policy changes.

Configure Student Notifications

The institution is able to configure the message sent to the student when a document is required, overdue, or canceled.
Configuration for messaging is managed on a per Document Code basis.

If a document is manually reviewed and you determine the document is Unacceptable or as a result of the document
review, the student is required to provide additional documents, you can re-request the document or request additional
documents as needed, but SFA notifies the student.

Required Role Permissions
The user must have a role with the following general permissions through Roles Management in order to view
documents within the SFA FAS UI.

• Dashboard

◦ Required if you are working Review Document for Approval tasks associated with a document.

• Document Review Task

◦ Required if you are working Review Document for Approval tasks associated with a document.

• NFF Forms Task Review

◦ Required if you are working Process an NFF Document tasks associated with a Non-Federal Funds
document.

The user must have a role with the following document permissions through Roles Management in order to view
documents within the SFA FAS UI.

• View Document

◦ Required for any document you need to be able to view.

◦ You can request documents even if you don't have permission to view the document once received.

• Document Review Task

◦ Required for any document you need to complete an associated Review Document for Approval task.

• NFF Forms Task
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◦ Required for any Non-Federal Funds document you need to complete Process an NFF Document tasks.

See Set General Permissions Matrix for additional information.

Pending Document Requests  
All pending document requests are visible on the student record so that you can see why certain tasks cannot be
completed.

Overview
You can view the following information:

• Document Name

• Award Year

• Status

• Owner

• Requested Date

• Days since Request (total days since document was Requested)

Requested/Pending documents are displayed in the following order:

• Doc Name (Ascending)

◦ Award Year (Ascending)
- Owner (Student first, then other owners Ascending)

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps listed below.

• Student

The user must have a role with the following Document Permissions through Roles Management in order to complete
the manual processing steps listed below.

• View Document: Required for any document code you need to be able to view

You must have the specific document "View" permission under Document Permissions through Roles Management to
see a document. Some documents are award year specific and need to be updated each award year.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid Financial Aid System (FAS) UI.

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
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◦ Navigate to Student > Documents > Pending Requests.

2. View the documents that have been requested per institutional configuration.

Related Topics
• ISIR

• Cancel Pending Document Requests

• Received Documents

• Add, Edit And Delete Comments

• Update Document Metadata

• Review Document For Approval

Cancel Pending Document Requests  
To prevent students from providing documents that are no longer required, you can cancel pending document requests.

Overview
When you cancel a pending document request, you must provide a reason. The application warns you if there are any
pending tasks that require the document before you cancel the pending document request.

Required Role Permissions
The user must have a role with these General Permissions and Document Permissions through Roles Management to
complete the manual processing steps:

• Document Request Canceller (General Permission).

• View (Document Permission) for any document you are required to view.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid Financial Aid System (FAS) UI.

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student > Documents > Pending Requests.
3. Click Cancel for the document request you want to cancel.
4. Confirm or Cancel the cancellation request.

Note:  Student Financial Planning displays a warning message if the document is attached to an open
process.

5. Enter a Comment.
6. Confirm Cancellation.
7. Confirm that the Document Request is canceled and no longer present.
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Related Topics
• Pending Document Requests

• Received Documents

• Add, Edit And Delete Comments

• Update Document Metadata

• Review Document For Approval

Request Documents  
You can start the document collection process and request documents from the student as needed.

Overview
A document request can be sent even if the document already exists on the student record and regardless of the
current document status. Outbound student notifications can be configured to include standard messaging and
the comments you enter upon making the request to effectively communicate additional information or specific
instructions with the student.

Note:  You can request one or multiple documents, filter the list of documents by category, or type the document
name in the search field to find and select documents to request from the student.

Required Role Permissions
The user must have a role with this General Permission through Roles Management to complete the manual processing
steps:

• Document Requester.

The user must have a role with this Document Permission through Roles Management to complete the manual
processing steps:

• View Document

◦ Required for any document the user will need to be able to view.

◦ The user can request documents even if they do not have permission to view the document once
received.

• Doc Review Task

◦ Required for any document the user will need to complete an associated Review Document for
Approval task.

• NFF Forms Task

◦ Required for any Non-Federal Funds document the user will need to complete a Process an NFF
Document tasks.

See Set General Permissions Matrix for additional information.

164



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 6
Using Documents

Manual Processing Steps
Log into the Student Financial Aid Financial Aid System (FAS) UI.

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
◦ Navigate to Student > Documents

- Pending Requests or
- Received Requests.

2. Click the Request Document(s) button.
The Request Document(s) button is visible on both the Pending Requests screen and the Received Documents
screen.

3. Select a Category to reduce the search results.
4. Enter a document Name to search for a specific document.
5. Click the button to add a document to the request.
6. Choose whether you want to:

◦ Request all of these documents (every document will be required).

◦ Request any one of these documents (only one of the documents will be required).
7. Attach To Process (if applicable).
8. Update Award Year (if necessary).
9. Update Document Owner type (if necessary).

10. Enter a Comment.
Comments are included in the outbound notification sent to the student.

11. Click the Send Document Request button.
12. Navigate toStudent > Documents > Pending Requests > .

◦ Confirm document(s) are in a Requested status and At-Will Task Comments match.

Related Topics
• Pending Document Requests

• Cancel Pending Document Requests

• Received Documents

• Add, Edit And Delete Comments

• Update Document Metadata

• Review Document For Approval

Received Documents  
You can review the document metadata and an image of a received document for any document you have permission
to view.

Overview
Documents are displayed in this order:

• Doc Name (Ascending)
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• Award Year (Ascending)

Required Role Permissions
The user must have a role with the following general permissions through Roles Management to view documents within
the Review Document for Approval and/or Process an NFF Document tasks:

• Dashboard (optional)
◦ Required if the user will be working tasks associated with a document.

• Document Review Task (optional)
◦ Required if the user will be working Review Document for Approval Tasks associated with a document.

• NFF Forms Task Review (optional)
◦ Required if the user will be working Process an NFF Document Tasks associated with a Non-Federal

Funds document.

The user must have a role with the following document permissions through Roles Management to complete the
manual processing steps:

• View Document
◦ Required for any document the user will need to be able to view.

• Doc Review Task
◦ Required for any document the user will need to complete an associated Review Document for

Approval task.

• NFF Forms Task
◦ Required for any Non-Federal Funds document the user will need to complete Process an NFF

Document tasks.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid (SFA) Financial Aid System (FAS) UI.

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student > Documents > Received Documents.

◦ The most current version of each received document matched to the student record is displayed.
3. Click the View Details button to view additional details and/or the document image.
4. Click the View Image button to see an image of the physical document.

◦ Document Images are stored in the institution's Document Management System.

◦ Document Images are displayed through a URL provided by the institution.

◦ A new web page is displayed with the scanned image of the physical document.

◦ Close the web page that displays the document image once you complete viewing the image.
5. Click the Close button to return to the Received Documents screen.

Note:  When a document is in a Received status, it requires manual review. Click the View Student Tasks link in the
student header to view the associated Review Document For Approval. You can review or claim the task if you have the
role permissions to work a document review task.
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Related Topics
• Pending Document Requests

• Cancel Pending Document Requests

• Add, Edit And Delete Comments

• Update Document Metadata

• Review Document For Approval

Add, Edit And Delete Comments  
You can add, edit, and delete comments for Document Requests.

Overview
To properly notate student records, you can add comments to documents. Whether the document task is re-routed or
completed, the comments remain associated with the document. You can view all comments associated to a document
and Student Financial Planning separates current and historical comments from previously received documents. Also,
for Document Requests with an Unacceptable status, the comments are also displayed in the Documents page in
Student Self-Service.

Required Role Permissions
The user must have a role with these general permissions through Roles Management to view documents within the
Review Document for Approval and/or Process an NFF Document tasks.

• Dashboard (optional)

◦ Required if the user will be working tasks associated with a document.

• Document Review Task (optional)

◦ Required if the user will be working Review Document for Approval Tasks associated with a document.

• NFF Forms Task Review (optional)

◦ Required if the user will be working Process an NFF Document Tasks associated with a Non-Federal
Funds document.

The user must have a role with the following document permissions through Roles Management in order to complete
the manual processing steps listed below.

• View Document

◦ Required for any document the user will need to be able to view.

• Doc Review Task

◦ Required for any document the user will need to complete an associated Review Document for
Approval task.

• NFF Forms Task

◦ Required for any Non-Federal Funds document the user will need to complete Process an NFF
Document tasks.

See Set General Permissions Matrix for additional information.
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Manual Processing Steps
Log into the Student Financial Aid Financial Aid System (FAS) UI.

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student > Documents > Received Documents.

◦ The most current version of each document that has been received and matched to the student record is
displayed.

3. Click the View Details button to view additional details and/or the document image.

◦ You can also click Edit Details to view and update document metadata.

4. Click the Add Comments button.
5. Enter Comment.
6. Save Comment.
7. Confirm new comment.
8. Click the Edit icon to edit the comment.

You can only edit comments you entered.
9. Confirm edited comment.

10. Click the Delete icon to delete the comment.
You can only delete comments you entered.
Confirm you want to delete the comment.

11. Confirm the comment has been deleted.
12. Click Close to return to the Received Documents screen.

Related Topics
• Pending Document Requests

• Cancel Pending Document Requests

• Received Documents

• Update Document Metadata

• Review Document For Approval

Update Document Metadata  
If necessary, you can manually update document metadata.

Overview
If you click on the Update Fields within the Review Document for Approval task, the data is saved even if you don't
complete the task. Student Financial Aid (SFA) saves the current information entered by the user on the student record.
SFA doesn't trigger any resulting automated processes until the task is completed because you may need to make
additional manual updates to other information based on the document, for example, At Will ISIR corrections.

Note:  If a subsequent document is received and document metadata has been updated manually, the new document
is run through the Document Receipt Process and may overwrite any manual updates made to previously received
documents.
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If the Document Owner field is unknown, you can update it to the proper value, for example, Student, Spouse, Parent
1. If the document has more than one Document Owner, select multiple document owners so it properly reflects the
correct owners.

Required Role Permissions
The user must have a role with the following general permissions through Roles Management in order to view
documents within the Review Document for Approval and Process an NFF Document tasks.

• Dashboard (optional)

◦ Required if the user will be working tasks associated with a document.

• Document Review Task (optional)

◦ Required if the user will be working Review Document for Approval Tasks associated with a document.

• ◦ Required if the user will be working Process an NFF Document Tasks associated with a Non-Federal
Funds document.

The user must have a role with these document permissions through Roles Management to complete the manual
processing steps:

• View Document

◦ Required for any document the user will need to be able to view or edit.

• Doc Review Task (optional)

◦ Required for any document the user will need to complete an associated Review Document for
Approval task.

• NFF Forms Task (optional)

◦ Required for any Non-Federal Funds document the user will need to complete a Process an NFF
Document task.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the SFA Financial Aid System (FAS) UI.

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student > Documents > Received Documents.

◦ The most current version of each document that has been received and matched to the student record is
displayed.

3. Click the Edit Details.
4. Make updates in any editable field, for example, free form fields, check boxes, drop-down menus, and so on.
5. Click Save after all updates are complete.

Related Topics
• Pending Document Requests

• Cancel Pending Document Requests

• Add, Edit And Delete Comments

• Review Document For Approval
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Review Document For Approval  
If Student Financial Aid (SFA) receives an unsatisfactory file format or an unrecognizable document code, the document
may need to be reviewed for approval.

Overview
• When using delivered Student Self-Service, once the student uploads the document with the allowed file type,

for example, pdf, jpeg, gif, or png, SFA receives the document, and creates a Review Document for Approval
task based on configuration for manual review.

• When using an external Document Management System (DMS), SFA receives documents through the
FasDocumentReceiptEvent message. Based on the data sent in the message and corresponding configuration,
a Review Document for Approval task may be created for users to manually review the document.

SFA can't approve the document automatically; therefore, SFA creates a Review Document for Approval task. Once the
task is created, you can manually review the document for acceptance so it can be determined if the document satisfies
any pending tasks in SFA.

Required Role Permissions
The user must have a role with these general permissions through Roles Management to view documents within the
Review Document for Approval and/or Process an NFF Document tasks:

• Dashboard.

• Document Review Task.

• NFF Forms Task Review.

The user must have a role with the following document permissions through Roles Management to complete the
manual processing steps:

• View Document

◦ Required for any document the user will need to be able to view.

• Doc Review Task

◦ Required for any document the user will need to complete an associated Review Document for
Approval task.

• NFF Forms Task

◦ Required for any Non-Federal Funds document the user will need to complete a Process an NFF
Document tasks.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the SFA Financial Aid System (FAS) UI.

1. Enter the student's External Student ID Number in the Search Field
2. Navigate to Student >  Documents > Received Documents.
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3. Click the View Student Tasks link in the Student Header.

Note:  When a document is in the status Received the document did not pass the document validation criteria
and requires manual review and a Review Document for Approval task is created.

4. Check box for the Review Document for Approval task.
5. Click the Claim # of #.
6. Navigate to Dashboard >  Review Document for Approval.
7. Start task.
8. Confirm/Update data as needed:

◦ Approve or Reject task.

◦ Update field if you make changes to document metadata.

9. Complete task.
10. Confirm status updates correctly, for example, Approved/Acceptable or Rejected/Unacceptable.

Related Topics
• Pending Document Requests

• Cancel Pending Document Requests

• Received Documents

• Add, Edit And Delete Comments

• Update Document Metadata
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7  Using Student History and Comments

Student History and Comments  
You can document notes, conversations or other details on the Comments screen. You can view comments from other
users and add comments. When you add a comment you can later edit or delete the comment.

Overview
The Student History section presents a chronological record documenting the sequence of activities that have occurred
on the student record over the course the Financial Aid Process at the school. Individual entries provide you visibility
into the action that was performed by providing relevant detail information, such as including whether the action was a
result of an automated process or manual user.

What Student Financial Aid Does Automatically
Student Financial Aid automatically does the following things:

Logs a Student History Entry
When specific events occur, Student Financial Aid automatically creates a student history entry. Detailed information is
included in the entry.

Displays the Student History
Student Financial Aid displays each Student History Entry in the user interface. The following columns are displayed:

Student History Entry Category Date and Time Stamp Username

A new student record has been
added

Student Initiation 11/21/2017 10:44:45AM UTC-7 admin

Configurable Attributes
There are no configurable features.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

• Student History

• Edit Comments

See Set General Permissions Matrix for additional information.
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Navigation to the Student Financial Aid User Interface Functionality
To view Comments screen

Student Financial Aid User Interface > Student > Student History/Comments > Comments
To view Student History screen

Student Financial Aid User Interface > Student > Student History/Comments > Comments

Add, Edit, Delete Comments  
You can Add, Edit, and Delete Comments "At-Will" in order to provide additional details on the actions performed
regarding the student.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Edit Comments

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student > Student History/Comment > Comments
3. Add Comment
4. Enter Comment
5. Save Comment
6. Review comment in Student Financial Aid user interface

• Click the Edit icon to edit the comment.

• Click the Delete icon to delete the comment.

Student History  
By reviewing the Student History you can view a chronological record of activities that have occurred on the Student
Record over the course of the Financial Aid Process.

Overview
You can also filter Student History Entries by selecting a Category, entering a Date Range, and/or User ID parameters.
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Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Student History

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student  > Student History/Comments > Student History
3. Click All to review a list of all entries
4. Click None to search for a specific category
5. Select a specific Category
6. Review reduced list of results
7. Click the Entry Name to view additional details
8. Click the icon to hide the left sidebar
9. Click the icon again to reveal the left sidebar

10. Enter Start Date to search for entries with a date and time stamp => than the selected date
11. Enter End Date to search for entries with a date and time stamp <= than the selected date
12. Enter a User ID to search for entries triggered by a manual override by a user

Student History Category Filter  
You can further reduce the number of returned Student History Entries by selecting specific parameters under the
Student History Category Filter.

Overview
You can reduce results by selecting a specific Academic Year, Award Year, Enrollment Type, Fund Code, Payment Period,
or Student History Entry Type. Click the specific category to expand the selection box and select the parameter(s) you
want returned.

Select Multiple Parameters

To select multiple parameters, hold down the Shift (PC) or Command (Mac) key and click additional parameter.

Filter parameters are only displayed if present for the student (i.e. 2015 is displayed under Award Year only if the student
attended in 2015)

Note:  Award Years are in both 4 digit (YYYY) and 4-4 digit (YYYY-YYYY) format. Make sure to select the correct
format based on the results you want returned.
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Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Student History

SeeSet General Permissions Matrix for additional information.

Manual Processing Steps
Log into the FAS User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner

◦ Navigate to Student > Student History/Comments > Student History

2. Select all under Student History Category

◦ Take note of total number of pages

3. Click a link under Student History Category Filter to expose additional parameters for selected filter (i.e.
Academic Year)

4. Click a parameter (use the Shift/Command key to select multiple parameters)

◦ An asterisk appears when a parameter is selected

◦ If you collapse the category filter, the system searches by all available additional parameters regardless if
you selected specific options

5. Review reduced list of results
6. Repeat to reduce by additional filters (Award Year, Payment Period and so on).
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8  Using Student Holds

QC Holds  
The Quality Control (QC) Holds are utilized to analyze and validate automated financial aid processing in an ongoing
effort to promote better service to students, compliance, and continuous improvement to business processes and
application functions.

Overview
If errors are identified, those errors are escalated to the proper department to resolve the error.

Note:  The QC Hold Reason feature has been deprecated. Ignore these fields when you see them in the UI.

QC Hold Statuses

Status Description

On Hold Status when a QC Hold for a FAS process is in progress

Released Status when a QC Hold has been either released by a user or auto-released by the FAS (in the instance
the QC Hold is replaced via a repackage)

Replaced by Updated Hold Status when hold has been replaced by an updated amount for that particular hold level for that FAS
process

Hold No Longer Valid Status when a hold has become outdated, but the replacement hold has not yet been created due to
sequence of the FAS processing

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Initiates QC Holds
Student Financial Planning initiates a QC Hold at defined holding points in order for the Quality Control (QC) process to
be completed prior to the completion of other critical financial aid processes to prevent system and/or manual errors.

When a student record has a QC Hold, subsequent processing actions are prevented from being completed and future
tasks are not initiated until the QC Hold is Released. Student Financial Planning automatically documents the date the
hold is initiated and displays the type of hold placed on the Student Record.

QC Hold Types

Process Hold Type QC Hold Trigger Process Triggered when Hold is
Released
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Awarding • Award Amounts Determined • Awarding processing
determined award amount(s)

• Award amount is updated

• Award Outbound Message

Credit Balance • Credit Balance Amount
Determined

• Credit Balance amount is
determined

• Credit Balance amount is
updated

• Credit Balance Information
Outbound Message

• Ready to be Disbursed • All disbursement criteria
is equal to Met for a
disbursement

Title IV Funds (Excluding IASG AND
Campus-Based Funds):
 

• COD Disbursement File

Non-Federal Funds, IASG, &
Campus-Based Funds:
 

• Disbursement Status updates
to Disbursed

• Disbursement Information
Outbound

• Read to be Returned • Disbursement is to be
returned

Title IV Funds (Excluding IASG AND
Campus-Based Funds):
 

• COD Disbursement File

Non-Federal Funds, IASG, &
Campus-Based Funds:
 

• Disbursement Status updates
to Disbursement Returned

• Return to Lender Outbound
Message

• Ready to be Canceled • Disbursement is to be
canceled

Title IV Funds (Excluding IASG AND
Campus-Based Funds):
 

• COD Disbursement File

Non-Federal Funds, IASG, &
Campus-Based Funds:
 

• Disbursement Status Updates
to Disbursement Canceled

• Cancel Disbursement
Outbound Message

• Late Disbursement
Acceptance for Grant
Determined

• Late disbursement
acceptance status for a grant
is determined

• Disbursement Acceptance
Information Outbound
Message

Disbursement

• Late Disbursement Request
for Disbursement Acceptance
for Loan Determined

• Late disbursement
acceptance status for a loan is
determined

• Disbursement Acceptance
Information Outbound
Message

R2T4 • R2T4 Calculation Complete • R2T4 calculation is
determined to not be required
OR

• Reduction of Funds Process
OR
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• R2T4 calculation is complete
(subsequent actions are
paused until the hold is
released)

• PWD Process OR

• Grant Overpayment Process
OR

• Cancellation of Future
Disbursements

• R2T4 Amount is Fully Earned

Grant Overpayment • Grant Overpayment
Determined

• Grant Overpayment is
determined OR

• Grant Overpayment is
updated

• Grant Overpayment Student
Notification Outbound
Message

• PWD Disbursement
Acceptance for Grant
Determine

• PWD acceptance status for a
grant is determined

• Disbursement Acceptance
Information Outbound
Message

Post-Withdrawal Disbursement

• PWD Request for Acceptance
for Loan Determined

• PWD acceptance status for a
loan is determined

• Disbursement Acceptance
Information Outbound
Message

Triggers QC Hold information
When a QC Hold is initiated, Student Financial Planning generates the appropriate QC Hold Information and then
triggers the QC Hold Outbound Message to external systems. The QC Hold Message is specific for each hold type.

Displays QC Hold information
Student Financial Planning displays the specific QC Hold Information details, per QC Hold Type.

Triggers an Automatic Release of Holds
To prevent the QC Hold process from creating compliance and/or processing complications, Student Financial Planning
automatically releases a QC Hold when either of the following occurs:

• The configured hold deadline has been met

• The student's external student ID is included in an inbound QC Hold Release message

Sets specific QC Holds on targeted student populations
Student Financial Planning utilizes the QC Holds Type Configuration Initiation (Inbound) Message to turn specific hold
types On, Off, or to the system Default (global) settings for students contained in the message. On the student QC Hold
screen, the details include the comments column as to why the hold was turned on or off.

Responds to QC Hold information web service request
When a QC Hold Information Web Service Request is received Student Financial Planning triggers the QC Hold
Information (Outbound) Message to provide details on QC Holds currently initiated for the requested student including
the hold type, ID, status, date, and associated academic year (if applicable).

Student Financial Planning sends the information when one of the following occurs:

• QC Hold Status is updated to, On Hold, Released, Replaced by Updated Hold, or Hold No Longer Valid
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• Receipt of the QC Hold Information Web Service Request has been received

Configurable Attributes
Configure and Set the QC Holds Selection Indicator

Authorized users can configure the QC Holds Selection Indicators (i.e. True, False, Default).

Authorized users can set the QC Holds selection indicator per QC Hold Type globally (via QC Holds Management), for
a targeted student population (via FasQcHoldInitiationConfigEvent message), or individually (via QC Holds UI) on the
student record.

When the QC Hold Selection Indicator is set to:

• Default: Student Financial Planning uses the global setting found in the QC Management UI under the
Administration settings

• True or On Hold: Student Financial Planning turns on the QC Hold Type indicated for the student

◦ This will override the global setting

• False or No Hold: Student Financial Planning turns off the QC Hold Type indicated for the student

◦ This will override the global setting

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

• Student Holds

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To View the QC Holds Screen
Student Record > Student > Student Holds > QC Holds

Related Topics
• Enable and Disable QC Holds via UI

• Enable and Disable QC Holds via Event Message

• Release QC Hold via Event Message

View And Release QC Holds via UI  
You can view and release a QC Hold at the student level on the QC Holds screen in the Student Financial Planning User
Interface (UI).

Overview
Visible Fields Per Process
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Click the Hold Name (active link) to view additional details about each hold type on the student record.

• QC Hold Name

• FAS Process

• QC Hold ID

• Hold Date

• Hold Status

• Comment

• Release Indicator (check box, to release hold)

QC Holds on the Current and Prior Enrollment

When a student Changes Programs, both the prior program and the current program may have pending QC Holds.

• It is important to release Ready to be Canceled QC Holds on prior enrollments within same Payment Period (PP)
immediately upon Change of Program.

• If you fail to do so, it may result in COD Rejects (i.e. 039, 167: Prior Enrollment Cancellation Holds for COP within
same PP need to be released before a new program can be originated)

Suggested Order to Release Pending QC Holds

• Release holds in the prior program before the current enrollment

• Release Ready to be Returned QC Holds prior to Ready to be Canceled QC Holds

◦ This allows any returns to be completed prior to cancellation of funds (if applicable)

• If you release cancel holds before return holds, it may result in rejected disbursements

Don't leave QC Holds stay On Hold too long

Note:  There are downstream impacts to not releasing QC Holds.

• When there is a QC Hold, all downstream processing is prevented

• If QC Holds for prior enrollments are not released before releasing QC Holds for the current enrollment
disbursements may not disburse correctly and may get Rejected

• Student may become ineligible for funds if QC Holds are not released when an award year becomes closed

Releasing "Ready to be Canceled" QC Holds on "Closed Award Years"

If you release a Ready to be Canceled QC Hold after an Award Year has closed, the system attempts to Originate those
disbursements.

Note:  You should not Originate Pell Funds after an Award Year has closed.

• Use Disbursement Administration to prevent the origination from being sent out

• Before releasing the QC Hold, confirm if the Disbursement in question has been reduced to zero on the
Common Originations and Disbursements (COD) website

◦ If the amount has been reduced to Zero, release the hold
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◦ Before the Originations Batch Job is triggered, update the disbursement. See:Disbursement
Administration

- Update Disbursement Number and Sequence Number: Disbursement Sequence should be equal to
66 or greater, but should match COD

- Update the Disbursement Status: Disbursement Canceled
- Update The Cancellation Reason And Date: Date should match the date the cancellation occurred
- Delete a Disbursement: Delete any extra disbursement that is created as a result of the QC Hold

being released
- Update the Disbursement Status from Ready to Send to COD to Disbursement Canceled or other as

appropriate

Note:  You should not release Ready to be Canceled holds on funds associated with a closed award year if you do not
have permissions to view disbursements on COD and/or to use.

See: Disbursement Administration

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student Holds

• Student Holds Modify

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student Record > Student > Student Holds > QC Holds
3. Check the Release Indicator box for the QC Holds you want to release
4. Click Save

Configure QC Holds - Student Level Only  
At the student level, you can Configure QC Holds and add a comment.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student Holds

• Student Holds Modify

See Set General Permissions Matrix for additional information.
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Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

Navigate to Student > Student Holds > QC Holds

1. Click Configure Hold Types
2. Select a QC Hold Type (i.e. Award Amounts Determined)
3. Enter Comment
4. Click Save

Student Record Holds  
A Student Record Hold can be applied to a student's record in order to prevent certain financial aid processing from
happening until the hold is released.

Overview of Student Financial Aid (SFA) Student Record Holds
Types of holds are Fraud Holds, Conversion Holds, and so on. Student Record Holds can be placed or released manually
for an individual student record through the Student Record Hold page in the FAS user interface or for a group of
student records with event messages.

Note:  Holds that are relevant to Student Financial Planning (SFP) only are indicated.

Processes that are prevented with a Student Record Hold

• Satisfactory Academic Progress (SAP) Evaluations (SFP only)

• Packaging (SFP only)

• Originations (SFP only)

• Disbursing (SFP only)

• Credit Balance (SFP only)

• Enrollment/Program Information Updates. Course updates from a Student Academic and Financial Information
(SAFI) message are displayed in the UI does not trigger packaging. (SFP only)

Processes that are allowed with a Student Record Hold

• ISIR Processing

• R2T4 Processing (SFP only)

• National Student Loan Data System (NSLDS) Processing (SFP only). The updated NSLDS data is visible in the
UI but does not trigger Packaging.

What Student Financial Aid Does Automatically
SFA automatically does the following things:
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Completes the following actions when a Student Record Hold is initiated:
• Records the user ID that initiates the student record hold.

• Records the date and time when the student record is placed on hold.

• Follows processing rules for each financial aid process, including message processing. Both Document
Collection and, for (SFP only), the Return to Title IV (R2T4), Post-Withdrawal, and Grant Overpayment
processes continue.

• Allows comments for the hold.

• Triggers the Student Record Hold Student Notification (Outbound) Message.

Note:  If the Student Record Hold Type is Conversion, all FAS processing and processing of MPG Messages is stopped.

Adds a student record hold to all new student records (if configured)
If the school sends a FasOnStudentInitiationRecordHoldConfigEvent message through the Message Processing
Gateway (MPG) for a specific type of student record hold, SFA automatically applies the defined hold to all new student
records when they are initiated.

You can reset the SFA configuration that automatically adds a Student Record Hold to all new student records. The
configuration is re-set when an updated FasOnStudentInitiationRecordHoldConfigEvent message is sent through the
MPG. For SFA to stop adding the Student Record Hold the HoldOnInitiation tag should be equal to false.

Adds a student record hold to a single student record upon receipt of an
event message
If the school sends a FasPlaceStudentRecordHoldEvent message through the Message Processing Gateway (MPG) a
Student Record Hold, SFA automatically applies the defined hold to a single student.

Releases a student record hold to a single student record upon receipt of
an event message
SFA automatically releases a Student Record Hold for a single student when a FasReleaseStudentRecordHoldEvent
message is received through the MPG.

Financial Aid processes are affected by Student Holds and release of student holds as indicated in this table.

Note:  All SAFIs with a status of Withdrawal or Deceased are processed when received while a student is on a Student
Record Hold. All SAFIs with statuses other than Withdrawal or Deceased are held and not processed while a student
is on a Student Record Hold. When the Student Record Hold is released, the first Active SAFI and the last Active SAFI
received while the student was on hold are processed.

Note:  Processes that are relevant to SFP only are indicated.
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Financial Aid Process Processing While On Hold Processing After Release Hold

Document Collection • Allow document collection process to
continue.

• Allow at will document requests.

Document processing continues.

ISIR Processing If Student Hold configuration indicates FALSE
for valid ISIR processing:

• Holds the ISIR and prevents Valid ISIR
processing.

• Closes any pending Valid ISIR processing.

If Valid ISIR Process was canceled or ISIR was
received during the hold, the system uses the
latest ISIR received and triggers the Valid ISIR
process.

Professional Judgment (PJ) Process • PJ process continues (document requests
and task queue).

• At-will corrections or codes to be cleared
in task queue.

PJ process continues.

Academic Year/Payment Period (PP) Engine
(SFP only)

• Instructional weeks batch job still runs.

• End of PP could be met if credits for PP
were already met prior to hold.

• Repackaging is locked so Academic Year/
PP engine isn't triggered.

First and last active SAFI trigger repackaging.

Satisfactory Academic Progress (SAP) (SFP
only)

• Prevents Repackaging SAP status trigger.

• SAP appeals process continues.

SAP is triggered at end of next Payment Period.

Student Academic and Financial Information
(SAFI) Processing (SFP only)

• Hold processing of SAFIs and prevent
SAFI repackaging trigger except for R2T4
processing.

• If the student doesn't have an Enrollment
on record, system creates the Enrollment
but the student is not packaged.

First and last active SAFI trigger repackaging.

Packaging Engine (SFP only) Prevent Packaging and Repackaging. First and last active SAFI trigger repackaging.

Awarding (SFP only) • Awarding engine is not triggered.

• Awarding batch job runs but student is
skipped.

First and last active SAFI trigger repackaging.

Non-Federal Funds (NFR/NFF) (SFP only) • Re-Evaluate Task Queue continues.

• NFR Process Document Task Queue
continues.

N/A

Fund Acceptance (SFP only) • Fund Acceptance Due Date batch job runs
as is.

• If fund acceptance is received, the
fund acceptance status is updated,
 but the student isn't repackaged and
disbursements aren't updated.

First and last active SAFI trigger repackaging
using the latest received fund acceptance.

Credit Balance (SFP only) • Prevent Credit Balances from releasing.

• Prevent Repackaging (doesn't trigger
updates to credit balances).

First and last active SAFI trigger repackaging.
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Financial Aid Process Processing While On Hold Processing After Release Hold

Common Origination and Disbursement (COD)
(SFP only)

Allow COD files to continue processing if
the last SAFI has a Withdrawn or Deceased
Enrollment Status, disbursements are
originated.

First and last active SAFI trigger repackaging.

NSLDS (SFP only) Hold all NSLDS files received and prevent
repackaging trigger.

Trigger Repackage based on latest NSLDS file.

G5 Status (SFP only) If a Disbursement is updated to Disbursed and
is G5 ready, you can still drawdown funds even
if the student is on hold.

First and last active SAFI trigger repackaging.

Disbursements (SFP only) • Disbursements are not released.

• Disbursements can be decreased (returns
or cancellations).

Disbursement criteria is re-run.

Late Disbursements (SFP only) Disbursement Acceptance Communication not
sent to student.

• Disbursement criteria is re-run.

• Determine if LD is still valid and continue
processing or cancel.

Transfers (SFP only) Run transfer logic and prevent SAFI
repackaging triggers.

First and last active SAFI trigger repackaging.

Return to Title IV Funds, Post-Withdrawal
Disbursements, and Grant Overpayment
Calculations (SFP only)

Allow processes to continue. N/A

Quality Control (QC) Holds (SFP only) QC process continues but processing are still
subject to Student Record Holds.

N/A

Loan Fee Update (SFP only) Prevent the loan fee processing update. Loan fee processing update is triggered.

Follows messaging rules per financial aid process
This table describes holds related to MPG Messages that are not covered in the Student Record Holds for Processing
table.

Note:  Messages related to (SFP only) are indicated.

Message Processing while on Hold Processing After Release

Student Demographic Information • Message is held.

• Doesn't trigger repackaging.

• Doesn't trigger resulting notifications.

• Triggers matching processes but no
actions are taken.

Trigger repackage with latest message.

Authorization to Hold for Credit Balances (CB)
(SFP only)

• Message is held.

• Doesn't trigger CB calculation.

Trigger repackage and CB calculation with latest
message.

Leave of Absence (LOA) and Breaks in
Attendance (SFP only)

• Message is held. Trigger repackage with latest message.
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• Process disbursement updates.

• Doesn't trigger repackage.

Document Receipt Triggers the document collection process. N/A

Document Rejection Trigger message. N/A

Document Request Trigger message. N/A

FAFSA Trigger message. N/A

Professional Judgement Process Trigger message. N/A

Award Information (SFP only) Message not triggered. N/A

Cancel Disbursement Message (SFP only) Trigger message. N/A

Cancel Fund Award Message (SFP only) Message not triggered. N/A

Credit Balance (SFP only) Message not triggered. N/A

Disbursement Information (SFP only) Message not triggered. N/A

Financial Plan (SFP only) Trigger message when decreasing
disbursements.

First and last active SAFI trigger repackaging.

Disbursement Acceptance Information  (SFP
only)

Message not triggered. N/A

MPN & Borrower Information  (SFP only) Trigger message. N/A

SAP Appeals Process Information (SFP only) Trigger message. N/A

SAP Information (SFP only) Trigger message. N/A

Deceased Student Notification (SFP only) Trigger message. N/A

Exit Counseling Messages (SFP only) Trigger message. N/A

G5 Information Message (SFP only) Trigger message for returns. Trigger message once draw down for
disbursements is completed.

Grant Overpayment Referral  (SFP only) Trigger message. N/A

Grant Overpayment Student Notification (SFP
only)

Trigger message. N/A

Letters Message Trigger message. N/A

Notification for R2T4 Refund (SFP only) Trigger message. N/A

QC Hold Information  (SFP only) Message not triggered. N/A

Return to Lender  (SFP only) Trigger message. N/A

Document Metadata Web Service Trigger message. N/A

Document Process Status Web Service Trigger message. N/A

FA History Information Web Service (SFP only) Trigger message. N/A

ISIR Information Web Service Trigger message. N/A

Professional Judgment Process Web Service Trigger message. N/A
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Valid ISIR Process Web Service Trigger message. N/A

Awarding Information Web Service (SFP only) Trigger message. N/A

Credit Decision Information Web Service (SFP
only)

Trigger message. N/A

Disbursement Information Web Service (SFP
only)

Trigger message. N/A

Entrance Counseling Information Web Service
(SFP only)

Trigger message. N/A

Financial Plan Web Service (SFP only) Trigger message. N/A

MPN Information Web Service (SFP only) Trigger message. N/A

PLUS Application Information Web Service (SFP
only)

Trigger message. N/A

Student History and Comments Web Service Trigger message. N/A

Letters Web Service Trigger message. N/A

SAP Information Web Service (SFP only) Trigger message. N/A

SAP Appeals Process Information Web Service
(SFP only)

Trigger message. N/A

QC Hold Information Web Service (SFP only) Trigger message. N/A

Configurable Attributes
Configure Student Record Hold Types

The school can configure the titles of the types of Student Record Holds using the STUDENT_HOLD.csv configuration
workbook.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student Holds

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Aid User Interface Functionality
To view the Student Record Hold page, Student Record > Student > Student Holds > Student Record Holds.

Place or Release Student Record Hold Via Event Message  
By sending a FasPlaceStudentRecordHoldEvent message or FasReleaseStudentRecordHoldEvent message to the
Message Processing Gateway (MPG) a Student Record Hold can be placed or released on a student record.
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Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management to view the following
information.

• Student Holds

See Set General Permissions Matrix for additional information.

Place or Release Student Record Hold via UI  
You can Place Student on Hold and Release Student Hold through the Student Financial Aid User Interface (UI).

Overview
You can also trigger a Fraud Letter. When the Trigger Fraud Letter indicator is set to Yes, and a letter is configured, a
Student Record hold letter is triggered when the letter batch job runs.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student Holds

• Student Holds Modify

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Place Student Record Hold via UI
Log into the Student Financial Aid User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student Record > Student > Student Holds > Student Record Holds
3. Click Place Student on Hold.
4. Choose Student Record Hold Type.
5. Enter Comments.
6. Click Save.
7. Confirm Student Record Hold has been placed .

Processes that are prevented with a Student Record Hold

• SAP Evaluations

• Packaging

• Originations

• Disbursing

• Credit Balance
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Processes that are allowed with a Student Record Hold

• ISIR Processing

• R2T4 Processing

• Enrollment/Program Information Updates

◦ Course updates are displayed in the UI, but a SAFI will not trigger packaging.

• NSLDS Processing

◦ The NSLDS is visible in the UI, but will not trigger packaging.

Release Student Record Hold via UI
Log into the Student Financial Aid User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.

Navigate to Student Record > Student > Student Holds > Student Record Hold.
2. Click Release Student Hold.
3. Add Comment.
4. Click Save.
5. Confirm Student Record Hold is Released.

Place a Student Record Hold for All New Students  
By sending a FasOnStudentInitiationRecordHoldConfigEvent message the Message Processing Gateway (MPG) a
Student Record Hold will be placed on every new student record when it is initiated.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student Holds

See Set General Permissions Matrix for additional information.
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9  Using USDE

USDE  
You can manage integration with the U.S. Department of Education (USDE or ED).

Overview
Student Financial Aid (SFA) manages data exchange with ED using your Student Aid Internet Gateway (SAIG) mailbox.
Processes and data processed by Student Financial Planning (SFP) only are noted.

Student Aid Eligibility (SAE) manages Institutional Student Information Records (ISIRs) as they are received and
completes the Valid ISIR Process with ED's Central Processing System (CPS)/FAFSA Processing System (FPS).

In addition to the SAE features, SFP integrates with ED's Common Origination and Disbursement (COD) system to
import and export Common Record files. Student files such as the Master Promissory Note (MPN), Entrance Counseling,
PLUS Application, and Origination/Disbursement response and request records are automatically imported and
exported. SFP also automatically requests and re-requests the National Student Loan Data System (NSLDS) Financial
Aid History (FAH) file and submits the student to the Transfer Student Monitoring (TSM) list, based on configuration.

What Student Financial Aid Does Automatically
SFA automatically does the following things:

Creates Student Notifications
SFA creates a Student Notification when a student requires:

• Free Application for Federal Student Aid (FAFSA).

• Master Promissory Note (MPN) (SFP only).

• Entrance Counseling (SFP only).

• PLUS Application/Credit Decision (SFP only).

• Credit Decision Override (SFP only).

• TEACH Grant Counseling Acknowledgement (SFP only).

• Agreement to Serve (ATS) Note Acknowledgement (SFP only).

• Annual Student Loan Acknowledgement (SFP only).

These notifications inform students what student or borrower information is required to apply for and receive Federal
student aid. Student notifications are sent when student or borrower information is required and again when it is
received. When required responses are received, the Student Notification status is updated from Open to Closed. You
can review Student Notifications to see what is required, when it was requested, and when it is received.

Records a Student History Entry
When borrower information is required, received, or no longer required, SFA logs an entry in Student History.

• Example Student History Entry for SFA (SAE or SFP):
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◦ Student History Category: Free Application for Federal Student Aid (FAFSA).

◦ Triggering Entry Action: SFA has identified that a FAFSA required for a student.

◦ Default Text Entry: A FAFSA is required to be completed for the student.

◦ Entry Details:

- Notification Instance ID.
- Message ID.
- Notification Status.
- Notification Type.
- Outbound message sent to the student, if configured.

• Example Student History Entry for SFP only:

◦ Student History Category: Master Promissory Note (MPN)

◦ Triggering Entry Action: SFA identified that a Subsidized/Unsubsidized MPN is required for a student

◦ Default Text Entry: A Subsidized/Unsubsidized MPN is required to be completed for the student.

◦ Entry Details:

- Notification Instance ID
- Message ID
- Notification Status
- Notification Type
- Outbound message sent to the student (if configured)

Receives SAIG File Types
When a student or borrower completes documentation required by ED, a response file is generated. When a response
file is generated with a designation to be routed to the SAIG Mailbox that SFA has access to, SFA imports the file from
the destination point mailbox on configured intervals. SFA recognizes and accepts each response file, matches it to a
student record, removes any associated flags, and updates the student record.

The following files are imported into SFA:

FPS/CPS Files

CORRXXIN Outbound ISIR Corrections

IDAPXXOP Inbound Daily Electronic Application ISIRs

IDSAXXOP Inbound Daily ISIR

IGCOXXOP Inbound FPS/CPS Daily ISIRs – ISIRs generated by
institutional corrections

IGSGXXOP Inbound FPS/CPS Pushed ISIRs – System-Generated

IGSAXXOP Inbound FPS/CPS Pushed ISIRs

COREXXOP Inbound ISIR Errors - Electronic Correction Errors
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EAPRXXOP Inbound ISIR Errors - Electronic Application Errors (not
a valid inbound file - do not support associated
outbound file)
 

• Related outbound file is FAFSA Application
Export Record Layout (EAPSXXIN), which
is currently not supported

SIGAXXOP Inbound ISIR Errors - Signature Record Errors (not a
valid inbound file - do not support associated
outbound file)
 

• Related outbound file is Signature Record
Export Record Layout (SIGSXXIN), which is
currently not supported

NSLDS Files (SFP only)

File Name Direction Description

TRNINFIN Outbound TSM/FAH Batch Inform File

TRNINFOP Inbound TSM/FAH Error/Acknowledgment File

FAHEXTOP Inbound Financial Aid History File

TRALRTOP Inbound TSM Alert File

EXTC05 Inbound Scheduled Completion Report File (NSLDS/
Direct Loans)

EXTDP1 Inbound Scheduled Completion Report File (TEACH)

COD Files (SFP only)

COMRECIN Outbound Common Record for Pell and Teach awards

CRDLXXIN Outbound Export Common Record for Direct Loans

CRPNXXOP Inbound Master Promissory Note Response

CRECMYOP Inbound Entrance Counseling Response

CRSPXXOP Inbound PLUS Application Acknowledgement

CRCOXXOP Inbound Credit Decision Override

CRCSXXOP Inbound Credit Status Response

PGLEXXOP Inbound Pell Lifetime Eligibility Used 20XX-20XX Report
(CommanDelimited)

PGMRXXOP Inbound Pell Multiple Reporting Record (Fixed-length,
Flat File Format)

PGVRXXOP Inbound Pell Grant Verification Status Report (Comma,
 Delimited)

CRACXXOP Inbound TEACH Grant Counseling Acknowledgement
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CRATXXOP Inbound ATS Note Acknowledgement

COMRECOP Inbound Common Record for Pell and Teach awards

CRDLMYOP Inbound Common Record for Direct Loans

PGRCXXOP Inbound Pell Reconciliation Report

DSDFXXOP Inbound Direct Loan School Account Statement (Fixed-
Length, Disbursement Level Loan Detail)

DSRFXXOP Inbound Direct Loan School Account Statement
Disbursement Detail On-Demand (Date Range,
Fixed Length)

THSMXXYYOP Inbound TEACH Grant School Account Statement
(Monthly)

PGASXXOP Inbound Pell Grant Electronic Statement of Account
(ESOA), YTD

CRIBXXOP Inbound Annual Student Loan Acknowledgement
(Informed Borrower)

When ED makes changes to any of the record file layouts, Oracle updates SFA to support the new file layout.

Exports the Common Record File to COD (SFP Only)
When an origination or disbursement file is triggered in SFP, a Common Record file is generated for the student. SFP
includes all required data fields specified in the Common Record layout based on the fund that is being originated or
disbursed. Once the Common Record file is generated for a student, SFP exports the file to COD via the SAIG mailbox so
that it can be validated by COD.

Receives Origination and Disbursement Response Codes from COD (SFP
only)
SFP saves the Common Record response files and displays the origination/disbursement details including the status of
Accepted or Rejected.

Import the Pell Lifetime Eligibility Used (LEU) Message (SFP only)
When a Pell Lifetime Eligibility Used Report (PGLE) message class for a Pell LEU report file is generated by COD with a
designation to be routed to an SAIG Mailbox that SFP has access to, SFP recognizes and accepts the PGLE message to
retrieve LEU data for a student record.

Configurable Attributes
Configure when Borrower Information is required
The institution can configure when information for FAFSA, ISIR, and, for SFP only, NSLDS FAH, MPN, Subsidized/
Unsubsidized Entrance Counseling, PLUS Entrance Counseling, PLUS Application/Credit Decision, TEACH
Grant Counseling Acknowledgement, Agreement To Serve (ATS) Acknowledgement, and Annual Student Loan
Acknowledgement (Informed Borrower) is required.
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Required Role Permissions
The user must have a role with these General Permissions through Roles Management in order to view ED information:

• Student

• XML Viewer (to view the Common Record XML file)

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Aid User Interface Functionality
To view ED information:
Student Financial Aid User Interface > Student > USDE

Common Record Information  
Student Financial Planning's Integration with TD Client enables Student Financial Planning to import and export
common record files to COD.

Overview
The system Creates and transmits Common Record Files and receives common record data by communicating
through the school's SAIG Mailbox. Files are in the format of an XML file which is validated against the current schema
recognized by the U.S. Department of Education for COD files.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Creates/Exports Common Record Data to COD
Student Financial Planning automatically creates a Common Record file when an origination or disbursement is
triggered and includes all required data fields specified in the Common Record layout based on the fund type. The
system then exports the Common Record file to COD through the school's SAIG Mailbox.

Validates/Imports Common Record Data from COD
When COD generates COMRECOP and/or CRDLMYOP Common Record Response files and transmits them through
the SAIG Mailbox, Student Financial Planning recognizes, accepts and imports the files and displays them in the user
interface. The system is designed to automatically receive the files at configured intervals.

Student Financial Planning is updated each award year according to the common record layout schema issued by the
U.S. Department of Education. If the schema is updated, Student Financial Planning is updated to support the new
layout.

Configurable Attributes
This is not a configurable feature.
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Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

• SSN viewer

• XML viewer

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view Common Record Information
Student Financial Planning User Interface > Student > USDE > Common Record Information

Manual Functionality
View Complete COD XML

1. Enter the student's External Student ID Number in the Search Field

◦ Navigate to Student > USDE > Common Record Information

2. Choose Origination/Disbursement Request/Response > Fund Type > Award Year (i.e. Disbursement
Response, Unsubsidized Loan, 2019-2020)

3. Click the View Complete COD XML button.
View SSN/Financial Award ID

1. Enter the student's External Student ID Number in the Search Field

◦ Navigate to Student  > USDE > Common Record Information

2. Choose Origination/Disbursement Request/Response > Fund Type > Award Year
3. Click the View link next to a SSN or Financial Award ID.

Credit Status Response  
Student Financial Planning's integration with the Student Aid Internet Gateway (SAIG) Mailbox allows the student's
Credit Status Response file to be automatically imported and displayed on the user interface.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Validates/Imports Credit Status Response
When COD generates CRCS message class for a completed Credit Status Response file and transmits it through the
SAIG Mailbox, Student Financial Planning recognizes, accepts and imports the files and displays the CRCS data in the
user interface. The system is designed to automatically receive the files at configured intervals.
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Configurable Attributes
Configure when Borrower Information is required
This is not a configurable feature.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the Credit Status Response
Student Financial Planning User Interface > Student > USDE > Credit Status Response

Entrance Counseling  
Student Financial Planning's integration with the Student Aid Internet Gateway (SAIG) Mailbox allows the student's
Entrance Counseling to be automatically imported and displayed on the user interface.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Validates/Imports Entrance Counseling
When COD generates CREC message class for a completed online Entrance Counseling and transmits it through the
SAIG Mailbox, Student Financial Planning recognizes, accepts and imports the files and displays them in the user
interface. The system is designed to automatically receive the files at configured intervals.

Sends a Student Notification
Student Financial Planning automatically sends a student notification when Entrance Counseling is required based on
Trigger configuration.

Closes Student Notification
Student Financial Planning automatically closes the open Student Notification after the Entrance Counseling is received
or if the Entrance Counseling is no longer be required:

• The Subsidized/Unsubsidized Entrance Counseling file clears the Subsidized/Unsubsidized Entrance
Counseling Requirement Notification.

• The Grad PLUS Entrance Counseling file clears both the Subsidized/Unsubsidized Entrance Counseling
Requirement Notification and the Grad PLUS Entrance Counseling Requirement Notification.
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The Notification framework evaluates the clearing conditions every time the configured Required Trigger event is
completed, for example, repackaging.

Creates Student History Entry
Student Financial Planning creates a Student History Entry when an Entrance Counseling is required, no longer required
and when an Entrance Counseling response is received.

Configurable Attributes
Configure when Borrower Information is required
The institution can configure when an Entrance Counseling is required.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management:

• Student.

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the Entrance Counseling, navigate to: Student Financial Planning User Interface > Student > USDE >
Entrance Counseling .

Related Topics
• Trigger Guide

ISIR  
The application (SFA) manages Institutional Student Information Records (ISIRs) from the U.S. Department of Education
(ED). The application validates ISIRs with the ISIR Review Process and the ISIR Verification Process.

Overview
The application reads key fields on the ISIR to determine whether there are any assumptions, highlights, reject codes,
comment codes, c-codes, and/or data discrepancies that require resolution. The application also reads key fields
to determine if the ISIR is flagged for Verification and for which verification group. After the ISIR Review Process is
complete, the application determines if the ISIR has to be verified.

Each process is launched independently based on codes, flags and discrepancies within the ISIR. When an ISIR is
received, the application determines if all information and documentation is available to automatically validate the ISIR.
If either process cannot be automatically cleared, the application creates tasks for manual review for each applicable
process. If the ISIR Review and ISIR Verification Process require manual review the  Compete ISIR Verification  task isn't
created until a user finishes the  Complete ISIR Review  task.

Combining these two processes allows the application to consolidate common tasks. For example, instead of sending
two separate document requests for Review and Verification, the requests are sent in one Student Notification message.
Another example of a common task is when ISIR corrections are required. The application transmits only one ISIR
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correction file to the Central Processing System (CPS)/FAFSA Processing System (FPS) via the Student Aid Internet
Gateway (SAIG) instead of two.

The Valid ISIR Process also controls when a subsequent ISIR is received. The subsequent ISIR may contain corrections
to the previous ISIR or changes that originated elsewhere. The application evaluates all changes to determine if they
are material changes; in other words, changes that affect the student’s financial aid eligibility. If corrections or material
changes are contained in the subsequent ISIR, it replaces the previous active ISIR. The application sends a configured
outbound Student Notification Message when a subsequent ISIR transaction is made Valid.

What The application Does Automatically
The application automatically does the following things:

Matches the ISIR to a Student using Student Identifiers
The application automatically matches incoming ISIRs to student records using ISIR identifiers; Social Security Number,
Date of Birth, and Name. If the matching student record doesn't exist , the ISIR remains in a hold status until the receipt
of a student record with a given award year. When a student record is created, the automated ISIR matching process
matches the student to the correct ISIR from the unmatched queue.

If only a partial ISIR identifier matches, you can review unmatched ISIRs in the Unmatched ISIRs UI.

Determines whether a Subsequent ISIR Should Be Used or Not
When an ISIR is received for the same award year with an increased FPS/CPS Transaction Number, the application
compares the subsequent ISIR against the current ISIR to determine if there are any changes. If the application
determines there are any material changes, new ISIR codes and verification flags to clear, or the previous ISIR is pending
corrections, the subsequent ISIR automatically becomes the active ISIR.

If a subsequent ISIR doesn't contain any new ISIR codes, flags, discrepancies or any material changes (as configured
by the institution), the subsequent ISIR doesn't become the active ISIR. If the school doesn't configure subsequent ISIR
rules, every ISIR received by the application with a higher FPS/CPS Transaction Number is selected as the active ISIR
and requires review.

Anytime a subsequent ISIR replaces a current ISIR, the application evaluates the Complete ISIR Review - Task and
Complete ISIR Verification - Task and determines if the tasks should remain pending or be closed.

Monitors the Valid ISIR Deadline
The application tracks the number of days an ISIR is in a pending status for students that have not withdrawn. If the ISIR
doesn't complete the Valid ISIR Process by the configured deadline, the application automatically updates eligible funds
in packaging and disbursing. When the ISIR becomes valid, the application re-evaluates the funds and makes necessary
updates to the canceled disbursements.

The application also tracks the number of days an ISIR is in a pending status from the Date of Determination (DOD)
for students that have withdrawn. This is so eligible funds are updated properly in packaging and disbursing prior to
starting the Return to Title IV Process. Once the configured deadline has been met, the application repackages the
student and cancels any future disbursements dependent upon a valid ISIR for a specific award year. Once the student is
repackaged, the application begins the Return to Title IV Process.

Requests Required Documents
The application automatically begins the Financial Aid Documentation Collection Process when an ISIR is received
and has any assumptions, highlights, reject codes, comment codes, c-codes, ISIR data discrepancies, or is flagged for
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verification. Financial Aid Documentation Collection is based on the institution's configuration and is in accordance with
the ED regulations. The application automatically sends student notification requesting required documents unless
the document is already on the student record in a Requested, Received, or Acceptable status. If the document is in an
Unacceptable status or still pending after a configured amount of time, the application requests the document again.

If a subsequent ISIR is received and replaces the current ISIR, the application re-evaluates to determine what documents
are required. If a pending request for a document is no longer required, the application cancels the request and notifies
the student. However, if required documents are still pending, the application re-requests the documents, based on
configuration.

The list of required documents for ISIR review and ISIR verification are merged into one list and are requested from the
student in one outbound Student Notification message.

Reviews Unsolicited Documents
If an unsolicited document is received from a Document Management System (DMS), the application validates whether
the document is associated to a pending request to determine if it is pending or unsolicited. If the document isn't
associated to a pending request, the document is considered an unsolicited document and proceeds through the
document receipt and acceptance process.

Upon completion of the Financial Aid Document Collection Process, the application evaluates the document to
determine if there are any ISIR discrepancies for any open ISIR award years. If any discrepancies exist, the application
determines if the ISIR can be automatically corrected or if the discrepancy requires manual review. If automated ISIR
corrections can be made, the application creates an ISIR correction file. If it requires manual review, the application
creates a Complete ISIR Review task or adds the discrepancy review to an existing, open task for manual user review.

Resolves Assumptions, Highlights, Reject Codes, Comment/C-Codes and
Data Discrepancies
If assumptions, highlights, reject codes, comment codes, c-codes and data discrepancies exist when the application
evaluates the ISIR, it uses your configured rules to determine what requires resolution and what can be automatically
cleared or overridden. The application displays a description and related ISIR fields required for manual review. If
documentation is required, the application requests the required documents and sends the appropriate student
notification to inform the student of resolution requirements.

If any configured rules fail to resolve assumptions, highlights, reject codes, comment codes, c-codes and data
discrepancies, the application creates a Complete ISIR Review task.

Holds the ISIR Review Process if ISIR codes Require Student Follow-up
When an ISIR is received and flagged for Student Follow-up based on ISIR code configuration, the application doesn't
require a user to manually review the file unless the ISIR also contains codes that require manual review. When the ISIR
contains codes that require manual user review and codes flagged for Student Follow-up, the application triggers a
Complete ISIR Review task, but doesn't require the codes flagged for Student Follow-up to be cleared. Upon completion
of the task, if the codes that require Student Follow-up are still pending, the ISIR Review Process is put on hold, and ISIR
corrections aren't triggered. This is regardless if queued from automated ISIR discrepancy rules or made manually by a
user in the task queue.

The ISIR remains in a pending state until codes flagged for Student Follow-up are cleared. Then, any queued ISIR
corrections are triggered.
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Checks Verification Completion Period
If the ISIR is within the Verification completion period, ISIR Verification is completed. However, if the ISIR is outside the
verification completion period, the ISIR is updated to a status of Unverified, and the application doesn't complete the
ISIR Verification Process or request a manual Complete ISIR Verification task.

Resolves ISIR Verification Flag
The application resolves verification and verification-related c-codes on a student’s ISIR, based on configuration. If any
configured rules fail to clear the verification flag or verification-related c-codes, the application creates a Complete ISIR
Review task.

Completes ISIR Corrections and Transmits to FPS/CPS
To clear and validate an ISIR, the application launches the ISIR Corrections Process in accordance with your configuration
and ED. The application stores all ISIR corrections in a pending status that result from the  Complete ISIR Review  task
and  Compete ISIR Verification  task until both have been completed or canceled. After all tasks have been completed or
canceled, the application consolidates corrections into one ISIR correction file to send to FPS/CPS via the SAIG Process.
If an authorized user cancels the  Compete ISIR Verification  task, the application still sends an ISIR correction file for the
completed  Complete ISIR Review task.

The Valid ISIR Process remains active waiting for a new ISIR with the corrected values, and the current ISIR is updated to
a status of Corrected.

Sets the ISIR status
If the ISIR is successfully reviewed and verified and there are no corrections, its status is updated to Valid. If review
and verification weren't needed, the ISIR status is updated to Valid. If the ISIR is in an Unverified status outside the
Verification Completion Period, it remains in Unverified status.

Sends Student Notifications
The application sends a student notification when the student's ISIR has any assumptions, highlights, reject codes,
comment codes, c-codes, data discrepancies or has been flagged for verification. The notification provides clarification
and rationale to complete the ISIR Review and ISIR Verification Processes, the status of each document, and a list of any
documents required to resolve ISIR issues, based configuration. The application also sends a notification to the student
when the ISIR becomes valid, based on configuration.

Sends the ISIR Information Message via Web Service
The application sends the ISIR Information Message when triggered. However, the institution can request the
information using their Web Service as desired.

Configurable Attributes
Configure ISIR Matching Rules
The application automatically matches an ISIR to the student record using ISIR identifiers in the ISIR Matching Criteria
Combination field of the School.csv Configuration Workbook.

These are the parameters for the 2023-2024 and prior Aid Years:
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Student Matching Parameter Related ISIR Matching Field

SSN Social Security Number

DOB Student’s Date of Birth

LAST_NAME Student's Last Name

FIRST_NAME Student's First Name

MIDDLE_INITIAL Student's Middle Initial

EMAIL_ADDRESS Student’s E-mail Address

ZIP Student Permanent Zip Code

PHONE_NUMBER Student’s Permanent Phone Number

N/A SSN Match Flags 1 - 8

These are the parameters for the 2024-2025 and future Aid Years:

Student Matching Parameters Related ISIR Matching Field

SSN Student’s Current Social Security Number

DOB Date of Birth

LAST_NAME Last Name

FIRST_NAME First Name

MIDDLE_NAME Middle Name

EMAIL_ADDRESS Student’s Email Address

ZIP Zip Code

PHONE_NUMBER Phone Number

N/A Student SSA Match Status 1 - 8

FAFSA_UUID FAFSA UUID

PERSON_UUID Person UUID

Combine at least one of these criteria with any other criteria to create a Matching Criteria combination:

• SSN

• LAST_NAME

• DOB

• PHONE_NUMBER

• EMAIL_ADDRESS

The expression is composed of a list of combinations separated by the | symbol. Each combination is composed of a list
of fields separated by the ~ symbol.
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Examples:

• SSN~LAST_NAME~FIRST_NAME|SSN~DOB|SSN

• SSN~LAST_NAME~FIRST_NAME|SSN_MATCH_FLAG_3|SSN_MATCH_FLAG_2|SSN|

Unmatched ISIRs are stored in a database table and automatically matched to a student record if a new or updated
FasStudentEvent message is received that matches the configured ISIR match parameters.

You are also able to manually match Unmatched ISIRs using the Unmatched ISIRs UI.

Configure Valid ISIR Deadlines
You can configure how may days after the receipt of an ISIR the Award Package considers funds that are dependent
upon a Valid or Verified ISIR for students that have withdrawn and those that have not.

Configure ISIR Correction Completion Periods
You can configure ISIR Correction Completion Periods to define when ISIR corrections can be submitted and prevent the
application from launching a Complete ISIR Review task before or after these configured dates. Once configured for an
award year, you can't submit ISIR Corrections before the start date or after the end date.

You need to select dates that fall within the dates regulated by ED. You can configure dates for each award year;
however, if you don't configure dates, the application uses the dates defined by ED.

Configure Rules to Resolve ISIR Review and ISIR Verification
You can configure rules by Award Year that the application should follow if an ISIR contains any assumptions, highlights,
reject codes, comment codes, c-codes, data discrepancies or has been flagged for verification. Configurations may
include:

• Resolution required or not.

• Can be automatically confirmed or overridden.

• Descriptions to display to users during manual review.

• ISIR fields to display when manual review is required.

• Documents or Metadata required to resolve.

• Association to any comment codes, c-codes.

• Clearance date/period (lifetime clearance or each award year).

• Student notifications required to be sent to the student.

Configure ISIR Verification Deadlines
You can define the start and end dates by Award Year for when ISIR Verification can be completed. This ensures that
the application doesn't complete the ISIR Verification process before or after defined dates. Although you can configure
rules related to completing Verification, the configured dates must fall within the dates released per award year by ED.

If you don't configure the start and end dates, the application uses the start and end dates for ISIR Verification
completion released by ED per award year.

If an ISIR is received outside of the time frame configured, the status is updated to Unverified and the ISIR Verification
Process isn't completed.

Navigation to View ISIR Fields and Codes
To view the ISIR
Navigate to Student  > USDE > ISIR.

To View ISIR Fields
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Navigate to Student  > USDE > ISIR > ISIR Codes (tab).

To View ISIR Codes
Navigate to Student  > USDE > ISIR > ISIR Codes (tab).

FAFSA Management  
You can configure FAFSA Management to control notifications to students about the FAFSA (Free Application for
Federal Student Aid) completion process.

Overview
To apply for Federal financial aid from the U.S. Department of Education (ED), students must complete the FAFSA. All
required applications and documents must be completed and validated by the institution before a financial aid award
can be made to the student. The FAFSA collects financial and other information used to calculate the student's Student
Aid Index (SAI)/Expected Family Contribution (EFC) and to determine a student’s eligibility through computer matches
with other agencies.

All data entered into the FAFSA is processed by ED's Central Processing System (CPS)/FAFSA Processing System (FPS)
and other validating agencies that perform data matches and validations for each application to determine eligibility for
Federal financial aid. These agencies include: Social Security Administration, Department of Homeland Security (DHS),
National Student Loan Data System (NSLDS), Department of Defense (DOD), Department of Justice (DOJ), Selective
Service, and Veterans Affairs. Once FAFSA data is processed by FPS/CPS and other agencies, output documents are
created:

• Student Aid Report (SAR)//FAFSA Submission Summary (FSS), which is a student output version of the FAFSA
response from FPS/CPS.

• Institutional Student Information Record (ISIR), which is an output product for schools. It contains the student's
SAI/EFC, FPS/CPS comments, assumptions, eligibility, and the applicant's Financial Aid History (FAH).

The FAFSA application processing cycle spans 18 months. For every award year, applications are accepted during a
specific established period of time by ED.

Further information about FAFSA completion can be found in the "Application and Verification Guide" section of ED's
Federal Student Aid Handbook.

What Student Financial Aid Does Automatically
Student Financial Aid automatically:

Determines when a FAFSA is required
For new students, the application (SFA) recognizes if the student needs to complete an award year FAFSA. For
continuing students that have payment periods that fall into the next award year, the application determines if the
student is required to complete a renewal FAFSA for the subsequent award year, too. When the student needs a new
or renewal FAFSA, the application determines which award year FAFSA is required based on the funds the student is
eligible to receive. The student is required to complete all FAFSAs for all open award years, based on his enrollment
period.

The enrollment period for students is determined in one of the following three ways:

1. The application assumes the program length is one year from the start date of the program. This method is
used when the primary program or end date of the program is unknown.

2. The application uses the actual program length if the primary program and the start/end dates are known.
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3. For continuing students, when a student has a payment period that falls into a new award year without an ISIR
on file, the application classifies the student as requiring a renewal FAFSA.

Example:

• Start Date is 05/01/2022.

◦ Start date falls between 07/01/2022 and 06/30/2023.

• End Date is 5/01/2023

◦ End date is based on the assumption that the program length will be 1 year.

◦ End date falls between 07/01/2022 and 06/30/2023.

The student is required to complete the following FAFSAs because the student’s enrollment period crosses over both
award years:

• 2021-2022

• 2022-2023

In the application's UIs, the award year is displayed in a 4 digit format; for example, 2022-2023 is displayed as 2023.

Determines when a FAFSA is no longer required
Received ISIRs are automatically matched to a student record and displayed for you in the application UI. If multiple
award year ISIRs are received, they are displayed in order by FPS/CPS ISIR Transaction Number. After the ISIR is
matched to the student record, the application requests other borrower information like Master Promissory Notes, PLUS
Applications, and Entrance Counseling based on the your business process.

Creates FAFSA required / FAFSA no longer required Student History Entries
When a student is required to complete a FAFSA application (new or renewal), the application creates a student history
entry in the "FAFSA" category. You can view student history entries in the Student History/Comments UI.

Sends Student Notifications to communicate FAFSA completion requirements
FAFSA Required

When a student is required to complete a FAFSA, the application creates a student notification via Student Self-Service
to complete the specific award year FAFSA.

If a FAFSA is required, the notification is displayed in the "Open" list on the Student Notifications page in the FAS UI.

FAFSA is No Longer Needed

When the student's ISIR for an associated award year is received or the configured FAFSA completion period for the
award year has passed, the application creates a student notification via Student Self-Service that the requested FAFSA
is no longer needed. In the Student Notifications screen, the FAFSA required notification status is updated from open to
closed.

The Notification Type and Message do not change upon receipt of the ISIR, only the Status. You can opt to view open,
closed, or all notifications.
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Configurable Attributes
The application is delivered with FAFSA Management logic. Using this delivered logic, the only configurable option is
FAFSA Completion Period. This delivered logic doesn't automatically close FAFSA Completion Request notifications.

Alternatively, you can choose to configure FAFSA Management using the Trigger Configuration Workbook. This
offers the option to define how to create and close FAFSA completions requests using groovy scripts, define FAFSA
Completion notification messages used in Student Self-Serve, and so on. The Baseline Configuration is delivered with a
completed Trigger Configuration Workbook for FAFSA Management and can be modified to meet your business needs.

FAFSA Completion Period
Both the delivered FAFSA Management logic and configured FAFSA Management option using the Trigger
Configuration Workbook use the separately-configured FAFSA Completion Period. The FAFSA Completion Period can be
figured using the Regulatory Management page in the FAS UI or the Regulatory Deadlines Configuration Workbook.

The FAFSA processing cycle lasts 18 months for every award year; for example, January 1, 2023 through June 30, 2024.
The FAFSA completion period start and end dates define when the FAFSA application must be completed and sent to
the FPS/CPS by award year. You can configure the completion period to be less than the ED 18 month cycle. However, if
you don't,the application configures the completion period using ED published guidelines for the award year.

All FAFSA messaging is based upon the configured FAFSA completion period for the award year and the student's
enrollment period.

Navigation to Student Notifications in FAS
Query a student and navigate to Student Financial Aid User Interface > Student > Student Record > Student
Notifications

You can filter the Student Notifications based on the Student Notification Status (for example, Open, Closed, All). On
the Student Notification screen, the user will select the desired option from a drop-down menu.

Navigation to Student Notifications in Student Self-Service
Query a student and navigate to Student Self-Service User Interface > Notifications.

Load An ISIR  
An authorized user can Manually Load an ISIR through the Student Financial Aid User Interface (UI).

Overview
Loading ISIRs manually is primarily used for testing purposes. To view an ISIR that is manually uploaded, you need to
load the student initiation event message (also known as the Student Demographic Information (SDI) message. The SDI
message should be loaded prior to loading the ISIR file(s).

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Administration

• System Management
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See Set General Permissions Matrix for additional information.

Manual Processing Steps
Make sure that a student record exists prior to loading ISIR files. You can check to see if a student record exists by
entering the student's External Student ID Number in the Search field in the upper right-hand corner of the Student
Financial Aid Menu Bar.

Note:  When loading an ISIR file larger than 1024KB, use the Vocado U.S. Dept of Ed Gateway (VUG) application. See
Vocado US Department of Education Gateway.

Log into the Student Financial Aid User Interface (UI)

1. Navigate to Menu Bar  > Administration > System Management > Load ISIRs
2. Click Choose File.

◦ Select ISIR files to load.

◦ Maximum upload file size: 1MB.

Note:  The ISIR file can contain one or multiple records.

3. Confirm file is selected.
4. Click Send.

Confirm the correct number of "Records Parsed".
5. Confirm ISIRs loaded successfully:

◦ Navigate to Student > USDE > ISIR

◦ Repeat for each student

Note:  When you manually load an ISIR, these DOE File Management setup validity checks are bypassed:
1. Message Class changes by Award Year.
2. File Processing Start Date and Time.

The Message Class must be enabled for automatic or manual ISIR loading. For more information, see DOE File
Management.

Related Topics
• FAFSA Management

• ISIR

View ISIR  
Users are able to View the ISIR and all data fields within the current and previous ISIRs. Student Financial Aid stores all
ISIR data for multiple award years in order to allow users to view all ISIRs associated with a student.
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Overview

Note:  For 2023-2024 and prior Aid Year ISIRs, there is no specific General Permission via Roles Management required
to view the ISIR. To view the entire ISIR for the 2024-2025 and future Aid Years, a user must have the Federal Tax
Information (FTI) Viewer permission to see all IRS data fields within the ISIR.

Required Role Permissions
The user must have a role with these General Permissions through Roles Management to complete the manual
processing steps:

• Student.

• FTI Viewer (for 2024-2025 and future Aid Years).

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI).

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student > USDE > ISIR.
3. Select the Award Year (if multiple Award Year ISIRs exist).
4. Review ISIR Fields (default view).
5. ◦ For 2023-2024 and prior Aid Years, click any of these sections to review ISIR data:

- General Student Info
- Student Financial Info
- Dependency/Military Info
- Parent's Info
- Student Household Info
- School Choice Info
- Signature Info
- Office Info
- FAA Info
- NSLDS Info

◦ For 2024-2025 and future Aid Years, click any of these sections to review ISIR data:
- ISIR Info
- Student Info
- Student Financial Info
- Student Spouse Info
- Student Spouse Financial Info
- Parent and Parent Spouse Info
- Parent and Parent Spouse Financial Info
- FPS Info
- Correction, Highlight, Verify Flags
- NSLDS Info
- School Choice Info
- Signature and Preparer Info
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6. Click the View Codes tab to review Comment Codes.

Note:  When navigating to Student > USDE > ISIR and viewing ISIR fields or ISIR codes, the Verification Tracking
Group displays the tracking group number and description, for example, V1: Standard Verification Group.

Related Information
• FAFSA Management

• View ISIR

Change The Status Of An ISIR  
You can manually Change the Status of an ISIR.

Overview
ISIR statuses that have been manually overridden are flagged as overridden by an asterisks displayed to the right of the
ISIR status. Subsequent ISIRs received replace the current ISIR based on configured rules regarding material changes
and proceed through the Valid ISIR process as defined, which may replace any manual overrides.

Status Definitions

ISIR Statuses

Status Description

Inactive ISIR is not the active ISIR for the student. Either a subsequent ISIR has replaced the current one, or it
was received before/ after the end of the ISIR Review - corrections period.

Pending ISIR is selected as the active ISIR and is pending the ISIR Review and/or ISIR Verification process

Unverified ISIR has been cleared of any required resolution for ISIR Review but has not been verified due to being
received outside of the ISIR Verification period.
 
Also could be set if a user cancels the ISIR Verification process (Future At Will Action)
 

Invalid • User has elected to cancel ISIR Review (Future At Will Action)

• The ISIR has been manually updated to an invalid status by an authorized user (At Will Action)

Corrected ISIR has been corrected based on ISIR Review and/or ISIR Verification

Valid ISIR has been cleared of any required resolution for ISIR Review, has been verified (if required) and can
be used to determine eligibility for all Title IV funding for the student

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student
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• ISIR Status Override

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Enter the student's External Student ID Number in the Search Field

◦ Navigate to Student > USDE > ISIR
2. Select the Award Year
3. Click the edit icon next to the ISIR Status
4. Choose the appropriate ISIR status
5. Check the Set ISIR Active for this award year box if this ISIR Should be the "Active" ISIR.

The ISIR status does not need to change if you only need to update the ISIR to the Active Award Year ISIR
6. Click Save.

A * appears to the right of the ISIR status to indicate the ISIR status has been manually overridden by a user.

A Student History Entry is logged in Student History/Comments. To view this entry, navigate to Student History/
Comments > Student History and filter for the ISIR Review Category. Click the "Student's ISIR status has been updated
for the award year" entry. Details related to the update of the ISIR status are contained within the entry.

Related Information
• FAFSA Management

• ISIR

• Pending Requests

Change The Status Of An ISIR Code  
You can manually Change the Status of an ISIR Code on a student record.

Overview
Once the ISIR code status is updated, you can view it in the FAS UI, and it is returned in any related Valid ISIR Process
web service reply. Updating the status of an ISIR Code doesn't trigger a re-package, and subsequent ISIRs are subject
to the Valid ISIR process. The ISIR status isn't automatically updated to Valid as a result of a manual ISIR Code status
update, and associated Requested and Pending documents remain pending unless a user manually cancels them.

Status Definitions

ISIR Code/Discrepancy Statuses

Status Description

Auto Cleared Any configured statements for automatic resolution have been evaluated

Clearance Not Required The code/discrepancy has been configured to not require clearance (e.g. comment code) and is strictly
informative
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Manually Cleared Any configured statements for automatic resolution have been evaluated, but could not automatically
clear the code/discrepancy
 
The code/discrepancy has been cleared from the manual review task
 

Processing The code/discrepancy is not clear, but is processing based on configured rules or within the manual
review task

Student Follow Up The code/discrepancy has been configured to require a follow-up student action to resolve the issue
 
The code/discrepancy is pending an update to be made via FAFSA on the Web
 

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps.

• Student.

• Role ISIR Code Updater.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid FAS User Interface (UI).

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student > USDE > ISIR.Choose the Award Year ISIR to review
3. Click the ISIR Codes tab.
4. Click the Change link next to the ISIR Code you want to update.
5. Choose a new status.
6. Click Save.
7. Scroll down and review the Resolved Codes. Manually and automatically resolved codes are displayed in this

section of the "View ISIR Codes" page.

Related Information
• FAFSA Management

• ISIR

Change the Verification Status Code  
You can override the configured U.S. Department of Education (ED) ISIR Verification Status Code.

Within the ISIR page you can override the configured Verification Status Code value on a student and award year basis.
When you override the value, a new student history entry is created showing both the old and the new values.
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Verification Status Override Values

Verification Status Code Description

V The student completed Verification. This includes students selected by the Central Processing System
(CPS) and by your school using your own criteria.
 

W The student is selected for Verification, and you chose to pay a first disbursement of Pell Grant without
Documentation. This code must be updated once Verification is complete, or ED will reduce the Pell
Grant to zero in the Common Origination and Disbursement (COD) system.
 

S CPS selected the student for Verification, but you didn't verify then because they satisfied a Verification
exclusion other than the post-enrollment exclusion.
 

blank Report a blank if you haven't performed Verification for other reasons. For example:

• The student wasn't selected for Verification

• The student was selected for Verification by CPS after ceasing enrollment at your school and all
disbursements, including late disbursements, were made.

• You disbursed aid on an initial ISIR transaction not selected for Verification, a later ISIR transaction
is selected, and the student didn't complete Verification.

 

Tips and Considerations
• Once the Verification Status Code has been manually overridden, it can only be updated manually for the

remainder of that Award Year.

• After manually overriding the Verification Status Code, you must manually re-trigger originations to
communicate the new value to CPS.

• The Effective Date configured in the ISIR Verification Codes configuration worksheet should be based on your
institution's policy of when you began waiving their verification requirements.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management to complete the manual
processing steps:

• Student.

• ISIR Status Code Override.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid FAS User Interface (UI).

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student > USDE > ISIR.
3. Choose the Award Year ISIR to review.
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4. Click the ISIR Codes tab.
5. Click the Change link next to the ISIR Verification Status Code you want to update.
6. Choose a new ISIR Verification Status.
7. Click Save.
8. Scroll down and review the Resolved Codes.

Manually and automatically resolved codes are displayed in this section of the "View ISIR Codes" screen.

Related Information
• FAFSA Management

• ISIR

Make ISIR Corrections  
Authorized users are able to Make ISIR Corrections even after the ISIR has completed the valid ISIR process. However,
only the active, valid ISIR with the highest FPS/CPS Transaction Number can be modified.

Overview
To prevent a user from attempting to submit corrections on an ISIR that has pending corrections, Student Financial Aid
does not display the make corrections button until the active ISIR is valid (i.e. payable).

Once a user modifies an ISIR, Student Financial Aid transmits the ISIR corrections to FPS/CPS via the SAIG process.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• ISIR Corrector

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
◦ Navigate to Student  > USDE > ISIR.

2. Select the Award Year (if multiple Award Year ISIRs exist).
3. Click the Make Corrections button.
4. Identify and update data fields (for example, drop-down menu, free-form text, and so on).
5. Click the Continue button (after all corrections have been entered).
6. Review the Corrections Summary
7. Click Finish to save corrections

◦ Click Cancel to exit the corrections summary pop-out dialogue box without saving any corrections.

◦ Click Back to return to the corrections pop-out dialogue box.

8. Confirm the corrections are pending.
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9. Confirm the ISIR Status updated to Corrected.

A red asterisk * indicates that corrections are pending and the Before Corrections column populates the data that was
on the ISIR prior to the correction.

Related Information
• FAFSA Management

• ISIR

Complete ISIR Review - Task  
Complete ISIR Review tasks are created based on institutional policy when it is determined that the student's active ISIR
contains C-Codes, Reject Codes, Highlights or Assumptions that have been configured by the institution to be manually
reviewed by a user.

Overview
You can view comment codes, c-codes, reject codes, assumptions, highlights, data discrepancies and ISIR corrections
(when applicable) in the Student Financial Aid user interface on the within a Complete ISIR Review task.

You can view and/or request additional documents from the student, spouse, or parent if necessary and associate them
to the Valid ISIR Process. You can also make/submit ISIR corrections while completing a manual ISIR review task and
view associated Student Notifications and/or Student History Entries.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management to complete the manual
processing steps:

• Student

• Dashboard

• Task

• ISIR Review Task

• Document permissions are required to view and complete the Review Document for Approval tasks

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner

◦ You can review the student record prior to starting the task

2. Navigate to Menu Bar > Dashboard > Task Overview > Complete ISIR Review (task queue) for Approval task
queue

3. Start/Resume task for student
4. Show only Codes/Fields that Require Clearance

◦ Check to review only codes that need to be cleared
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◦ Uncheck to review all codes on the ISIR that do not require clearance or are already resolved

5. Review the following Tabs:

◦ Comment Codes

◦ Assumptions and Highlights (for 2023-2024 and prior Aid Years)

◦ Highlights (for 2024-2025 and future Aid Years)

◦ Discrepancies

◦ ISIR Fields

6. Update the Student Record as necessary based on information presented within each tab

◦ You can review supporting documents from within the task queue

7. Choose an option for making ISIR updates

◦ Click Save ISIR Changes for Later if you do not have the documentation on file to clear the code

◦ Click Clear Code if you have the information on file necessary to clear the code

8. Choose an option for completing the ISIR Review task

◦ Complete Task to clear all ISIR codes
- The ISIR is updated to a Corrected status, the associated Valid ISIR process continues, and any

corrections that are queued as a result of automation or from the task queue are transmitted to
FPS/CPS

◦ Complete Task With Open Codes to close the task with unresolved codes because student follow up is
required

- If all codes that the user is able to clear have been cleared; this option provides the user a way to
remove the task from their workflow

- When a user chooses this option, a message is returned to verify that the task is being completed
without all codes being cleared

- The ISIR remains in a Pending status, the associated Valid ISIR process remains open, and any
corrections that are queued as a result of automation or from the task queue are not transmitted to
FPS/CPS until all codes are cleared

The Complete ISIR Review task is created only after all pending document requests have been received, reviewed (if
required) and are in an Acceptable status.

Related Information
• FAFSA Management

• ISIR

• Review Document for Approval (Task)

Complete ISIR Verification - Task  
Complete ISIR Verification tasks are created based on institutional policy when it is determined that the student's active
ISIR is flagged for Verification and cannot be automatically cleared based on configured rules.

Overview
Before creating the Complete ISIR Verification task, Student Financial Aid determines if any documents are required, if
required documents have been requested, received, and if they are in an acceptable status.
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You can view and/or request additional documents from the student, spouse, or parent if necessary and associate them
to the Valid ISIR Process. You can also make/submit ISIR corrections while completing a manual ISIR verification task and
view associated Student Notifications and/or Student History Entries.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Dashboard

• Task

• ISIR Verification Task

• Document permissions are required to view and complete the Review Document for Approval tasks

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Navigate to Menu Bar > Dashboard > Task Overview > Complete ISIR Verification (task queue)
2. Start/Resume button
3. Review and complete the task as instructed within the task.

◦ Review Comment Codes tab

◦ Review ISIR Fields tab

◦ Review Pending Corrections tab

◦ Make ISIR Corrections if necessary

◦ Request Documents if necessary

◦ Review information outside the task if necessary

4. Choose an option for completing the ISIR Verification task.
◦ Complete Task and Clear Verification.

The ISIR is updated to a Corrected status, the associated Valid ISIR process continues, and any
corrections that are queued as a result of automation or from the task queue are transmitted to FPS/CPS.

◦ Complete Task Without Clearing Verification.
- Closes the task with unresolved codes because student follow up is required
- When a user chooses this option, a message is returned to verify that the task is being completed

without all codes being cleared
- The ISIR remains in a Pending status, the associated Valid ISIR process remains open, and any

corrections that are queued as a result of automation or from the task queue are not transmitted to
FPS/CPS until all codes are cleared

Related Information
• FAFSA Management

• ISIR

• Make ISIR Correction(s)
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• Request Document(s)

• Review Document for Approval (Task)

Manually Match Students To ISIRs  
Student Financial Aid automatically matches an Institutional Student Information Record (ISIR) to the student record
using ISIR identifiers in the ISIR Matching Criteria Combination field of the School.csv Configuration Workbook.

Overview
For ISIRs that are not matched, you may manually match ISIRs to students using the Unmatched ISIRs UI. Here are some
features of the UI:

• List of ISIR Records by Award Year

• Student Search/Results

• Manual ISIR Matching

• Consolidated matching of multiple ISIR transactions

• Aging of unmatched ISIR records

For more information, see ISIR.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps listed below.

• Match Unmatched ISIRs

• View Unmatched ISIRs

See Set General Permissions Matrix for additional information.

Configurable Data
There is no configurable data for this feature. The logic used to present a list of possible students for the purpose of
MANUALLY matching ISIRs is hard-coded.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI).

1. Navigate to Menu Bar > Administration > FAS Management > Unmatched ISIRs.
2. Use the Search Box to filter the displayed list of Unmatched ISIRs as needed.
3. Click Match ISIR to view potential matches for a student. The potential matches are populated by matches

between student records and ISIRs with matching First Name and one of the following: Last Name, DOB, or
SSN. The logic that determines the list of students who are potential matches is delivered with the system and
not is configurable.

4. View potential matches and click Select Student for the record you determine is a match.
5. Click Search if no record appears to be a match, and you want to use the Global Search function to search the

student database.
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6. Click Yes to confirm a student match.

Related Information
• FAFSA Management

• ISIR

Reopen Valid ISIR Process  
You may need to reopen the Valid ISIR Process if additional documents are required.

Overview
You can attach an at-will document request to a new Valid ISIR process for an open award year where the Active ISIR
is Valid or Unverified. The application creates a new Valid ISIR process for that Award Year, updates the ISIR status to
Pending, and tracks next steps in the process. After receiving the requested documents, the application evaluates all
configured ISIR code clearing and discrepancy rules to determine if the ISIR can be set to Valid or if any task queues are
needed.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete
tasks related to the Valid ISIR Process:

• Dashboard

• Document Requestor

• ISIR Review Task

• ISIR Verification Task

• SAP Appeal Review Task

• SAP Review Task

• Task

• Professional Judgement Review Task

The user must have a role with the following Document Permissions through Roles Management in order to complete
the manual processing:

• View Document for associated documents (for example, Tax Transcripts).

• Doc Review Task for associated documents (for example, Tax Transcripts).

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Enter the student's external student ID number in the search field.
2. Navigate to Student > Documents > Pending Requests or Received Documents.
3. Click Request Documents.
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4. Choose a document and click the Plus icon (for example, Tax Transcript).
5. Click the Attach to Process drop-down list and choose the VALID_ISIR - 20XX (valid) option.
6. Enter a comment.
7. Click Send Document Request.
8. Navigate to Student > Student Record > Student SummaryStudent > Student Record > Student Summary.
9. Confirm that the ISIR status to Pending.

10. Confirm that the Document is requested.

Claim any associated Document, ISIR Review or Verification tasks,Work/Complete tasks per business procedures. Once
all requested documents have been received and updated to Acceptable associated tasks have been completed the ISIR
should update to Valid.

Review the student summary and confirm the ISIR status updated to Valid. If not, select View Student Tasks to ensure
there are no associated Document, ISIR Review or Verification tasks to complete.

Origination File Update  
Student Financial Planning triggers the Origination File Update task when one of the defined triggers occur.

Overview
Triggering Actions

• The ISIR field HS Diploma or Equivalent is equal to GED/State Equivalent Test (2), None of the above (4), or
blank.

• The borrower's permanent address on the CRSP is foreign and requires a user to input a temporary address.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Origination File Update Review

• Permissions associated with making ISIR Corrections (i.e. ISIR Corrector)

• Document Permissions associated with ISIR field HS Diploma or Equivalent

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Dashboard > Task Overview > Origination File Update
2. Start Task

Note:  Choose the value to report on the COD Origination File. Review the ISIR and any associated
documentation. Request additional documents if necessary and/or make ISIR corrections based on standard
operating procedures and continuing working the task when you have the information necessary to complete
the task.

219



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 9
Using USDE

3. Update the Student Eligibility Code as necessary
4. Complete task

MPN Information  
Student Financial Planning's integration with the Student Aid Internet Gateway (SAIG) Mailbox allows the student's MPN
Information to be automatically imported and displayed on the user interface.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Validates/Imports MPN
When COD generates CRPN message class for a completed MPN and transmits it through the SAIG Mailbox, Student
Financial Planning recognizes, accepts and imports the files and displays them in the user interface. The system is
designed to automatically receive the files at configured intervals.

Sends a Student Notification
Student Financial Planning automatically sends a student notification when an MPN is required based on Trigger
configuration.

Closes Student Notification
Student Financial Planning automatically closes the open Student Notification after an MPN is received or if an MPN is
determined to no longer be required.

The Notification framework evaluates the clearing conditions every time the configured Required Trigger event is
completed, for example, repackaging.

Creates Student History Entry
Student Financial Planning creates a Student History Entry when an MPN is required, no longer required and when an
MPN response is received.

Configurable Attributes
Configure when Borrower Information is required.
The institution can configure when an MPN is required.

Required Role Permissions
The user must have a role with the following General Permission through Roles Management:

• Student.

• SSN Viewer.

See Set General Permissions Matrix for additional information.
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Navigation to the Student Financial Planning User Interface Functionality
To view the MPN, navigate to Student Financial Planning User Interface > Student > USDE > MPN Information.

Manual Functionality
View the MPN Identification Number
Student Financial Planning encrypts the first 5 digits of the student's social security number on the MPN Information
screens, but you can view the full MPN ID number if you have a Role with the SSN Viewer general permission enabled.

1. Enter the student's External Student ID Number in the Search Field.

◦ Navigate to Student  > USDE > MPN Information.

2. Choose to review the Sub/Unsub MPNs or PLUS/GRAD PLUS MPNs.
3. Click the View link next to the MPN ID number you want to review.

NSLDS  
To ensure your students are being packaged based on the most current information, Student Financial Planning
automatically requests and re-requests the National Student Loan Data System (NSLDS) Financial Aid History (FAH) file
and submits the student to the Transfer Student Monitoring (TSM) list.

Overview
Note:  Please ensure your school has elected to receive NSLDS Alert information via "Web and Batch File" in your
School Transfer Profile on the NSLDS website. For more information, see the U.S. Department of Education NSLDS
Transfer Monitoring Guide.

Information regarding NSLDS field mapping and other information related to the NSLDS Record Types is available on
the U.S. Department of Education website.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Requests the Financial Aid History (FAH) File
When an ISIR is matched to the student’s record Student Financial Planning requests a National Student Loan Data
System (NSLDS) Financial Aid History file. There is a configured amount of time between requests to prevent duplicate
requests. If a request has been sent and you attempt to request another FAH file, Student Financial Planning confirms
that the configured amount of time has passed before submitting your request. If the configured time has not
passed, Student Financial Planning prevents you from manually requesting the FAH file. Student Financial Planning
continuously runs to monitor when the FAH file expires and automatically request a new file from NSLDS once the
configured time has passed.

Once Student Financial Planning has requested the FAH, the file is generated with the proper FAH flag. The file is sent to
the NSLDS transmission queue via the Student Aid Internet Gateway (SAIG) Process – NSLDS. When Student Financial
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Planning receives the FAH from NSLDS it is matched to the student record and then each FAH Detail Batch Record Type
(1-5) is displayed on the associated NSLDS tab within the Student Financial Planning user interface.

SFP will stop triggering the NSLDS requests for students that have Graduated and there is an academic completion date.

For all requests of the NSLDS (TRNINFIN), Student Financial Planning provides the institution's school code in both the
Header and the Detail Batch Records, per student.

Requests the Transfer Student Monitoring (TSM) File
Student Financial Planning automatically submits the student to the Transfer Student Monitoring (TSM) list once the
Student Demographic Information message is received in combination with the student’s Social Security Number.

Once Student Financial Planning requests the student be added to the TSM list, the file is generated with the proper
TSM flag. The file is sent to the NSLDS transmission queue via the SAIG Process – NSLDS. When the file is received from
NSLDS it be matched to the student record and displayed in the NSLDS screen of the user interface.

For all requests of the NSLDS (TRNINFIN), Student Financial Planning provides the institution's school code in both the
Header and the Detail Batch Records,per student.

Separate the FAH/TSM requests
Student Financial Planning uses request indicator “B” for the first NSLDS request and then uses request indicator
“H” for all subsequent requests. If it is necessary to add the student the TSM more than once, an authorized user can
manually add the student the TSM through the Student Financial Planning User Interface.

Request Indicator Description

B Requests the FAH file and adds the student to the TSM list

H Requests the FAH only

T Adds the student to the TSM only

Automatically Match the FAH/TSM File to the Student
Student Financial Planning uses student identifiers to match a file to a student record; primarily the student's Social
Security Number (SSN).

Sometimes, the student record SSN, received via the Student Demographic Information or Student Update events,
can be blank or contain a filler SSN value. One reason for this is institutional policy to not request the SSN during the
admissions application process. In this example, the student record SSN won't match the SSN on the NSLDS file. When
this happens, a secondary SSN match is attempted against the student ISIR SSN.

Once the SAIG Process - NSLDS is complete, SFP recognizes when an FAH/TSM file has been received from NSLDS and
updates the student record, making the FAH/TSM information available for review. If no match can be made, the file is
sent to an SAIG Errors queue.

If a subsequent FAH/TSM file is received from NSLDS, it replaces the existing version on the student record.
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Receive Acknowledgment File, process errors, and notify user of errors
When Student Financial Planning receives the TSM/FAH Error/Acknowledgment file from NSLDS, it automatically
documents the receipt of the FAH/TSM request. If the Error/Acknowledgment file received contains any errors, Student
Financial Planning notifies users by creating an SAIG Error task and an authorized user can review the error.

Student Financial Planning recognizes any errors and/or warnings in the TSM/FAH Error/Acknowledgment file and
routes the error through the SAIG Error Handling Process. Once the error has been corrected, Student Financial Planning
automatically re-submits the file via the SAIG Process - NSLDS.

Financial Aid History Information Web Service message
Student Financial Planning sends the NSLDS FAH information out to appropriate system(s) at configured intervals,
however the institution can request the information using their Web Service as desired. To request the FAH information
from the Web Service, an authorized user needs to use the Student External ID Number.

Configurable Attributes
When to request an FAH file from NSLDS and/or submit a student file to the NSLDS TSM list
The institution can configure the parameters used to determine when an FAH file is required or when a student should
be submitted for TSM, after the receipt of the initial ISIR.

Additional configuration may include the amount of time between requests so that Student Financial Planning does
not request a new FAH/TSM file when a current request already exists. If the configured time frame has not passed,
Student Financial Planning will not re-request a new FAH record from NSLDS until the configured time frame has
passed. However, a user can re-request an FAH/TSM file as needed.

Navigation to the Student Financial Planning User Interface Functionality
View NSLDS Information
Navigate to Student > USDE > NSLDS

View the NSLDS Overview Tab: TSM/FAH Detail Batch Record Layout Type
2 and 3
Navigate to Student > USDE > NSLDS > Overview (tab)

• Record Type 2: Name History Record

• Record Type 3: Overpayment Record

View the NSLDS Aggregate Tab: TSM/FAH Detail Batch Record Layout
Type 1
Navigate to Student > USDE > NSLDS > Aggregate (tab)

• Record Type 1: Aggregates, Perkins, and Flags Record

Snapshots of Direct Stafford Loans and Grants are grouped together at the top of the screen and the remaining data
fields are displayed below in a linear fashion in Alphabetical order. The NSLDS Record received from the SAIG does not
contain special characters such as commas, dollar signs, decimal points, or percentage symbols. The data has been
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modified to include these special symbols and reformatted in an effort to make it easier to for users to read and is
displayed on the Student Financial Planning User Interface.

View the NSLDS Grant Payment Tab: TSM/FAH Detail Batch Record Layout
Type 4
Navigate to Student > USDE > NSLDS > Grant Payment (tab)

View the NSLDS Loan Detail Tab: TSM/FAH Detail Batch Record Layout
Type 5
Navigate to Student > USDE > NSLDS > Loan Detail (tab)

Loan Type Codes Identify the Loan Type
Direct Loan Types

Code Loan Type

D0 Direct Stafford Subsidized (SULA Eligible)

D1 Direct Stafford Subsidized

D2 Direct Stafford Unsubsidized

D3 Direct Graduate PLUS

D4 Direct Parent PLUS

D5 Direct Consolidation Unsubsidized

D6 Direct Consolidation Subsidized

D7 Direct PLUS Consolidation

D8 Direct Unsubsidized TEACH Loan (converted from TEACH Grant)

D9 Direct Consolidation Subsidized (SULA Eligible)

FFELP Loan Types

Code Loan Type

CL FFELP Consolidation

GB FFELP Graduate PLU

PL FFELP Parent PLUS

RF FFELP Refinanced

SF FFELP Stafford Subsidized

SU FFELP Stafford Unsubsidized
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SL Supplemental Loan

Add a Converted Student to the NSLDS Transfer Student
Monitoring List  
Adding a Converted Student who to the National Student Loan Data System (NSLDS) requires manual intervention.

Overview
Students who are added to Student Financial Planning application from a legacy financial aid application require manual
intervention to ensure they are added to the NSLDS Transfer Student Monitoring list. This is done by scheduling an
external batch job run at defined intervals to add converted students to Transfer Student Monitoring. When the external
batch job runs, converted students are added to the fahTsmBatchInformSenderScheduledBean(award year) batch job
and sent to NSLDS via the Student Financial Planning US Department of Education Gateway (VUG).

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Triggers the External Batch Job
Student Financial Planning automatically triggers the External Batch Job during conversion at defined intervals.

Triggers the NSLDS Batch Job
Student Financial Planning automatically triggers the NSLDS Batch job, fahTsmBatchInformSenderScheduledBean, at
defined intervals.

Test Steps
Identify student population for conversion.

1. Enter the student's External Student ID Number in the Search Field

◦ Select the student record from the Student Search Results dialogue box

2. Navigate to Student Record  > Financial Information > Disbursing
3. Click the Seq. # (sequence number) for any disbursement that requires the following Disbursement Criterion,

for example, Direct Loan Subsidized:

◦ The transfer monitoring request to NSLDS was made more than 7 days prior.

4. Confirm the Disbursement Criteria is equal to Not Met.
5. Manually trigger the External Batch Job.
6. Manually trigger the NSLDS Batch Job (fahTsmBatchInformSenderScheduledBean).
7. To confirm the UI, navigate to Student Record > Student History/Comments > Student History.

◦ Under Student History Category, click None.

◦ Scroll down and select the NSLDS Transfer Monitoring/ FA History check box.

◦ Review the entries.

8. Confirm the TRNINFIN file generated.

Note:  For testing purposes, this can also be confirmed through the VUG server for a specific environment: /
tmp/saig/backup.
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9. Confirm the TRNINFOP (Error/Acknowledgement) and the FAHEXTOP (Financial Aid History) files are received
from the request.

10. Manually update Requested_Date to be greater than 7 days from the current system date.

update VM.FAS_TRNINFIN_REQUEST_VIEW set SENT_DATE = curdate() - INTERVAL 8 DAY
 where EXTERNAL_STUDENT_ID = 'External_Student_ID'

11. Manually trigger the Disbursement Criteria Evaluation Batch Job
(studentDisbursementCriteriaEvaluationScheduledBean).

12. Wait for the Disbursement Criteria Evaluation Batch Job to complete.
13. Navigate to Student Record  > Financial Information > Disbursing
14. Click the Sequence number for any disbursement that requires the following Disbursement Criteria; for

example, Direct Loan Subsidized.
◦ The transfer monitoring request to NSLDS was made more than 7 days prior.

15. Confirm the Disbursement Criteria is equal to Met and Overridden column is equal to No.

Add a Student to the NSLDS Transfer Student Monitoring List  
You can manually add a student to the NSLDS Transfer Student Monitoring List.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
Navigate to Student > USDE > NSLDS

2. Click the Request NSLDS File tab
3. Choose TSM from the drop-down menu
4. Choose an Award Year from the drop-down menu
5. Click the New Request button
6. Click Submit.

If you click Close, you will exit the screen without submitting the request.

Note:  Student Financial Planning prevents you from submitting another request until the initial request is fulfilled.
The New Request button is faded in color and inactive until the request is complete.

Request An NSLDS Financial Aid History File  
You can manually request a Financial Aid History (FAH) file.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• FA History Request
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See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner

◦ Navigate to Student  > USDE > NSLDS

2. Click the Request NSLDS File tab
3. Select FA History from the drop-down menu
4. Select the Award Year from the drop-down menu
5. Click the New Request button
6. Click Submit

◦ If you click Close, you will exit the screen without submitting the request

Student Financial Planning prevents you from submitting another request until the initial request is fulfilled. The New
Request button is faded in color and inactive until the request is complete.

Related Information
• NSLDS

• Add a Student to the NSLDS Transfer Student Monitoring List

PLUS Application  
Student Financial Planning's integration with the Student Aid Internet Gateway (SAIG) Mailbox allows the student's PLUS
Applications to be automatically imported and displayed on the user interface.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Validates/Imports PLUS Application
When COD generates CRSP message class for a completed PLUS Application and transmits it through the SAIG Mailbox,
Student Financial Planning recognizes, accepts and imports the files and displays them in the user interface. The system
is designed to automatically receive the files at configured intervals.

Sends a Student Notification
Student Financial Planning automatically sends a student notification when an MPN is required based on Trigger
configuration.

Closes Student Notification
Student Financial Planning automatically closes the open Student Notification after a PLUS Application is received or if
a PLUS Application is no longer required. The Notification framework evaluates the clearing conditions every time the
configured Required Trigger event is completed, for example, repackaging.
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Creates Student History Entry
Student Financial Planning creates a Student History Entry when a PLUS Application(s) Default Overpay Code is
overridden.

Configurable Attributes
Configure when Borrower Information is required
The institution can configure when a PLUS Application is required.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information:

• Student

• Override Plus Application Default Overpay Code

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the PLUS Application
Navigate to Student > USDE > PLUS Application.

Override the PLUS Default Overpay Code  
You can override the Default Overpay Code on the PLUS Application to Yes (Y), No (N) or Overridden by School (Z). The
associated code is then sent to COD in the Origination Request file.

Overview
Tips for Overriding the PLUS Default Overpay Code

If a PLUS disbursement is rejected due to Reject Code 996, PLUS E Code, Not Returned from NSLDS (PLUS Application
only) (E), updating the Default Overpay Code should resolve the reject. However, you must override the correct PLUS
Application. The system saves all of the received PLUS Applications, but you must select the correct application
to override or Student Financial Planning will continue to send COD an E value (Not returned from NSLDS) in the
origination file which will result in a reject.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Override Plus Application Default Overpay Code

See Set General Permissions Matrix for additional information.
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Manual Functionality
Override Default Overpay Code

1. Enter the student's External Student ID Number in the Search Field

◦ Navigate to Student > USDE > Plus Application

2. Choose to review the Parent PLUS Application or Grad PLUS Application
3. Click Override Default Overpay Code
4. Choose a New Default Overpay Code
5. Enter Comment
6. Save
7. Confirm updates

TEACH Agreement To Serve  
Student Financial Planning's integration with the Student Aid Internet Gateway (SAIG) Mailbox allows the student's
TEACH Agreement-to-Serve file to be automatically imported and displayed on the user interface.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Validates/Imports TEACH Agreement-to-Serve
When COD generates CRAT message class for a completed TEACH Agreement-to-Serve file and transmits it through the
SAIG Mailbox, Student Financial Planning recognizes, accepts and imports the files and displays the CRCS data in the
user interface. The system is designed to automatically receive the files at configured intervals.

Creates Student History Entry
Student Financial Planning creates a Student History Entry when a TEACH Agreement-to-Serve file is received.

Configurable Attributes
Configure when Borrower Information is required
This is not a configurable feature.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the TEACH Agreement-to-Serve:
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Student Financial Planning User Interface > Student > USDE > TEACH Agreement-to-Serve

TEACH Grant Counseling  
Student Financial Planning's integration with the Student Aid Internet Gateway (SAIG) Mailbox allows the student's
TEACH Grant Counseling file to be automatically imported and displayed on the user interface.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Validates/Imports TEACH Grant Counseling
When COD generates CRAT message class for a completed TEACH Grant Counseling file and transmits it through the
SAIG Mailbox, Student Financial Planning recognizes, accepts and imports the files and displays the CRCS data in the
user interface. The system is designed to automatically receive the files at configured intervals.

Creates Student History Entry
Student Financial Planning creates a Student History Entry when a TEACH Grant Counseling file is received.

Configurable Attributes
Configure when Borrower Information is required
This is not a configurable feature.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the TEACH Grant Counseling:

Student Financial Planning User Interface > Student > USDE > TEACH Grand Counseling

Annual Student Loan Acknowledgement  
Student Financial Planning's integration with the Student Aid Internet Gateway (SAIG) Mailbox allows the student's
Annual Student Loan Acknowledgement file to be automatically imported and displayed on the user interface. The
feature is also known as Informed Borrower.
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Overview
Note:  The disbursement criterion for this feature is delivered as “Disabled”. In order to enable it, you must
submit a Service Request to Oracle Support to enable the "Title IV loan disbursement has an Informed Borrower
acknowledgment" disbursement criterion. Once enabled, you may also submit a Service Request to disable the
disbursement criterion, needed.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Validates/Imports Annual Student Loan Acknowledgement

When COD generates CRIB message class for a completed Annual Student Loan Acknowledgement file and transmits
it through the SAIG Mailbox, Student Financial Planning recognizes, accepts and imports the files and displays the CRIB
data in the user interface. The system is designed to automatically receive the files at configured intervals.

Creates Student History Entry

Student Financial Planning creates a Student History Entry when an Annual Student Loan Acknowledgement file is
received.

The Notification framework evaluates the clearing conditions every time the configured Required Trigger event is
completed.

Configurable Attributes
Configure when Borrower Information is required
This is not a configurable feature.

Required Role Permissions
The user must have a role with the following General Permission through Roles Management:

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view Annual Student Loan Acknowledgement information:

Student Financial Planning User Interface > Student > USDE > Informed Borrower
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10  Using Financial Information

Financial Information  
Specific student details such as the student's package, disbursements, credit balances, returns and professional
judgments are found in the Financial Information section of the Student Financial Planning (SFP) UI.

Overview of Financial Information
The majority of the features accessed in the Financial Information UI are for managing financial aid programs
authorized by the Title IV (TIV) of the Higher Education Act and administered by the U.S. Department of Education (ED).
The exception is the Non-Federal Funds (NFF) section which describes features for managing private and other non-
Federal sources of financial aid, including private loans that use CommonLine Loan standards and protocol.

Required Role Permissions
The user must have a role with this General Permission through Roles Management to view Financial Information:

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
Student Financial Planning User Interface  > Student > Financial Information

Credit Balance  
You can manage student credit balances.

Overview
A Federal Student Aid (FSA) Credit Balance occurs whenever the total amount of FSA is credited to a student’s
account and the total amount exceeds the student’s allowable charges. When FSA disbursements to a student’s account
create a Credit Balance, it must be paid directly to the student or parent as soon as possible, but no later than 14 days.
Institutions are permitted to hold Credit Balances if a voluntary authorization form is obtained from the student (or
parent, in the case of PLUS). If an Authorization to Hold form has been obtained, the institution must identify the
amount of funds it is holding for the student or parent in a subsidiary ledger account designated for that purpose.

A Non-FSA Credit Balance occurs whenever there are Non-FSA funds on a student’s account, but there are no open-
charges the Non-FSA funds can be applied toward.

Student Financial Planning receives Authorization to Hold information from both the student and/or parent and uses
the information to calculate the Credit Balance. Student Financial Planning triggers the Credit Balance calculation to
occur each time a Student Academic and Financial Information (SAFI) message is received and a payment or discount
that is flagged to be included in the Credit Balance calculation has an open-balance or an FA eligible charge has an
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open-balance. Additionally, a Credit Balance calculation is triggered if the Authorization to Hold information is received
for either the student or parent and is updated, or after a Return to Title IV and Grant Overpayment calculation is
complete.

The Credit Balance calculation evaluates whether the open balances of the student's funding exceeds the student's
open balance of the current year allowable charges plus the prior year's outstanding balance (limited to $200). If there
is a Credit Balance, Student Financial Planning determines the associated fund and correct recipient and triggers an
outbound message to inform the institution to cut a check to the student, parent, or lending source.

The institution can manually create or adjust a Credit Balance within the Student Financial Planning User Interface (UI).

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Receives and Displays the Student/Parent's Authorization to Hold
Elections
Student Financial Planning receives the student and/or parent's initial and subsequent elections and saves them to
apply Credit Balances appropriately while the student is enrolled at the institution. Student Financial Planning always
uses the most recent ATH decision when determining whether to include projected charges for the Credit Balance
calculation.

Effective July 1, 2016, additional authorization is required to apply financial aid to Resource Fees. Student Financial
Planning accepts the student and/or parent's authorization to hold for resource fees and uses their elections to
determine the correct Credit Balance amount. The ATH for Resource Fees is only displayed on the Credit Balance
screen if the student and parents elections are different. Note, the authorization date is the date of the authorization for
resource fee.

If the student/parent's Authorization to Hold Resource Fee election is false or has not been received, Student Financial
Planning should not include discounts that are being applied to Resource Fees when determining the credit balance.
In order to determine whether a discount is being applied to a Resource Fee, a Resource Fee Indicator is used in the
Student Academic and Financial Information message (SAFI).

Include Actual Discounts in AcYr and Estimated Discounts in PP when:

• Authorization to Hold Election is True

• Authorization to Hold Resource Fee Election is True

Not applicable for Resource Fee Indicator

Include Actual Discounts in AcYr and Estimated Resource Discounts in PP when:

• Authorization to Hold Election is Null or False

• Authorization to Hold Resource Fee Election is True

• Resource Fee Indicator is True

Include Actual Non-Resource Discounts in AcYr and Estimated Non-Resource Discounts in PP when:

• Authorization to Hold Election is True

• Authorization to Hold Resource Fee Election is Null or False

• Resource Fee Indicator is Null or False
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Include Actual Non-Resource Discounts in AcYr and No Estimated Discounts in PP when:

• Authorization to Hold Election is Null or False

• Authorization to Hold Resource Fee Election is Null or False

Not applicable for Resource Fee Indicator

Note:  If the Resource Fee Indicator is not in the SAFI Message, Student Financial Planning determines the outcome
as if the indicator were False. For Parent PLUS loans, Student Financial Planning looks at the Parent's Authorization to
Hold Resource Fee Election in combination with the Resource Fee Indicator in the SAFI.

Determines Between the Prior and Current Award Year
An institution may use up to $200 from the Current Year Credit Balance to pay Prior Year charges for tuition, fees, room,
or board (and with permission, educationally related charges). If configured, Student Financial Planning calculates the
prior award year Credit Balance and determines which Award Year to apply the Credit Balance. If not configured, Student
Financial Planning calculates the current award year Credit Balance only.

Completes and Displays the Credit Balance Calculation
Student Financial Planning completes a Credit Balance calculation when new information is received from the Student
Information System (SIS) and/or the Student Accounting System (SAS) via the Student Academic Financial Information
(SAFI) message or a new ATH decision is received to determine whether a Credit Balance exists. If student level charges
are included in the SAFI message, Student Financial Planning determines if they are FA eligible and includes them in
the Credit Balance calculation. The charge date is used to determine which year the charge is associated to. If there
is a pending Credit Balance, Student Financial Planning holds the Credit Balance Calculation because the un-applied
amount has not been updated yet.

After the Credit Balance is posted in the student's ledger, the Student Accounting System sends the amount to Student
Financial Planning via the Student Financial and Academic Information (SAFI) message. This amount is saved to the
database and displayed on the Student Financial Planning User Interface and used in reports as needed.

Displays the Credit Balance Trigger:

• Return to Title IV (R2T4): Credit Balance was calculated while the student was in a Withdrawn status

• Disbursement: Credit Balance was created within 14 days of any TIV Disbursement Date

• Excess Funds: Credit Balance occurs when the student is not in a Withdrawn status and no TIV disbursements
occurred within the past 14 days

Note:  If the credit balance meets the criteria for an R2T4 and a Disbursement, the R2T4 takes precedence and the
trigger type will be R2T4.

Zero Credit Balance Calculations
Each time the SAFI is received, Student Financial Planning calculates whether a Credit Balance occurred. If the SAFI
contains the "Accounting Updates Indicator" and it is equal to true, Student Financial Planning displays the Credit
Balance calculation and the respective data used even if the amount is $0. If a QC hold for Credit Balances is configured,
Student Financial Planning holds the $0 Credit Balances for QC Review if the SAFI triggering the calculation included the
"Accounting Updates Indicator" as true. However, Student Financial Planning does not send an Outbound Message to
the Student Accounting System if the calculated Credit Balance is $0.00.
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Applies a Credit Balance Calculation Hold (If Applicable)
Hold Credit Balance Calculation until all Pending Credit Balances have been Resolved
If there are any pending Credit Balance calculations that have not fully processed, Student Financial Planning does not
perform a new Credit Balance Calculation. If the recipient of the Credit Balance is Student or Parent and the status of
the Credit Balance is Pending, the Credit Balance calculation is held until the status updates to Cut to Recipient. If the
recipient of the Credit Balance is Return to Lender, the Credit Balance calculation is held until the associated payment is
returned and the return is posted to the student's ledger.

Hold Credit Balance Calculation until all Pending Returns have been
Resolved
Student Financial Planning holds the Credit Balance calculation, if there are any disbursements with a status equal to
Disbursement, Returned associated to the student/program the Credit Balance calculation is for and the return has not
posted to the student's ledger. When the Return to Title IV calculation (R2T4) is complete, the refund was processed and
has posted to the student ledger, Student Financial Planning will proceed with the triggered Credit Balance calculation.

Hold Credit Balance Calculation prior to the R2T4 being completed for
Withdrawn/Deceased Students
If the student's enrollment status is Withdrawn or Deceased and an R2T4 calculation is required, but incomplete Student
Financial Planning does not complete the Credit Balance calculation until the R2T4 calculation is complete.

Calculates the Prior Year Outstanding Balance
Student Financial Planning calculates the Prior Year's Outstanding Balance by adding all of the open balances for
allowable charges (including all FA eligible charges) associated with the prior year and then subtracts the sum of all un-
applied amounts for all payments and discounts associated with the prior year.

Calculates the Current Year Credit Balance
To calculate the current year Credit Balance Student Financial Planning adds all of the open balances for the current
year's allowable charges and then subtracts the un-applied amounts for the current year's discounts and the un-applied
amounts for the current year payments. If the un-applied amount for the current year payments exceeds the open-
balance for the current year charges minus the un-applied amounts for the current year discounts, then a Credit Balance
has occurred.

If there is a Prior Year Outstanding Balance, and there is a Credit Balance in the current year, Student Financial Planning
subtracts up to $200 from the current year and applies it toward the Prior Year's Outstanding Balance.

Authorization to Hold = True

If the student/parent has elected to have the institution hold the Credit Balance to pay for future charges, Student
Financial Planning takes into account both projected and actual allowable charges and discounts in the current year/
payment period.

Authorization to Hold = False

If the student/parent does not elect for the school to hold the Credit Balance to pay for future charges, Student Financial
Planning only takes into account the actual allowable charges and discounts in the current year. If the Authorization to
Hold election is not present for the student/parent, it is assumed that the Authorization to Hold election is False.
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Student and Parent's Authorization to Hold Elections Differ

If the student has Direct Plus Loan disbursed in the current year with an un-applied amount, Student Financial Planning
determines, whether the Authorization to Hold election for the parent, is different from the student. When the elections
differ Student Financial Planning completes two different calculations, one based on the Authorization to Hold being
True and the other based on the Authorization to Hold being False.

The two Credit Balance amounts are calculated and associated with the appropriate funds. If the Direct Plus Loan
is associated to the Credit Balance, Student Financial Planning uses the parent's Authorization to Hold election, to
determine the associated amount for the Direct Plus Loan and any remaining Credit Balance is associated with other
funds with un-applied amounts using the student's Authorization to Hold election.

Determine the Fund Source Associated to the Credit Balance
Each time a Credit Balance occurs, Student Financial Planning uses the Fund Refund Priority order configured by the
institution to determine which disbursed fund(s) that have an un-applied amount to associate the Credit Balance with.
The Credit Balance amount associated with the fund depends on how much has been disbursed and applied in the
current year.

Example

Fund Source Amount Priority Disbursed Amount Un-applied Amount

Pell 4 $5,550 $0

DLSUB 3 $3,500 $0

DLUNSUB 2 $2000 $0

DLPLUS 1 $1000 $1000

If the student has a $1,500 Credit Balance and Student Financial Planning follows the institutions Fund Refund Priority,
$1,000 is associated with the Direct PLUS Loan and the remaining $500 is associated to the Direct Unsubsidized Loan.

Determine the Credit Balance Recipient
Each time a Credit Balance occurs, Student Financial Planning first determines the fund source and then determines the
Credit Balance Recipient. If the student/parent did not make an election, the recipient defaults to the borrower. If the
student is deceased, the Credit Balance recipient will be the lender.

If any portion of the Credit Balance is associated with a Direct PLUS Loan, Student Financial Planning determines the
recipient using information provided on the PLUS Application.

Send a Credit Balance Notification to the Student Accounting System (SAS)

Once Student Financial Planning has identified the Credit Balance Recipient, it sends the Student Accounting System
(SAS) a notification so the Credit Balance is sent to the correct recipient and updates the payment un-applied amounts.

What happens if the student/ parent returns the Credit Balance check?

If the student or parent are the recipients of the Credit Balance and they return a check, the SAS notifies Student
Financial Planning. Upon notification that a check has been returned by the student/parent Student Financial Planning
determines which disbursement the Credit Balance is associated with, the fund source, and returns the fund(s) to the
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lender. As a result of decreasing the disbursement or a reduction in funds Student Financial Planning updates Common
Origination & Disbursements (COD) and the next G5 drawdown will net out the returned amount.

After repackaging the student, Student Financial Planning updates the Credit Balance Recipient from Student or Parent
to Return to Lender.

Returning Credit Balances as a Result of the Check Being Returned
Upon receiving the Student Financial and Academic Information (SAFI) message, Student Financial Planning checks
whether any previous Credit Balance(s) were returned. If any Credit Balances were returned, Student Financial Planning
returns the Credit Balance to the lender. This results in decreasing the disbursement that is associated with the specific
Credit Balance and updates the Credit Balance recipient to Returned to Lender. The Credit Balance status updates to
Check Returned.

Student Financial Planning determines the disbursement associated with the Credit Balance, then determines the
fund associated with the disbursement, and reduces the disbursement in the academic year associated with the
disbursement by the Credit Balance amount. Reducing the Credit Balance triggers the common record files to be sent to
COD as applicable, the Return to Lender Outbound Message to be triggered, and the next G5 draw down to net out the
returned amount.

After reducing the disbursement, Student Financial Planning updates the Credit Balance Recipient to Return to Lender
and the Credit Balance status to Check Returned. However, the Credit Balance ID and the Credit Balance amount remain
the same. Lastly, Student Financial Planning triggers a new Credit Balance Outbound Message with the updated
recipient information.

Note:  This process also applies to checks returned as a result of a stale dated check.

Applies the Credit Balance to resolve a Grant Overpayment
If a Grant Overpayment exists, Student Financial Planning applies the Credit Balance toward the Grant Overpayment
before it begins associating the Credit Balance to any fund source. Student Financial Planning decreases the associated
disbursements.

If there is a remaining Credit Balance amount after resolving all Grant Overpayments, Student Financial Planning applies
the remaining amount to the funds using the normal process and sends the Credit Balance to the student, parent or
lender appropriately.

If the student is Withdrawn, Student Financial Planning follows normal procedures and returns any resulting Credit
Balances to the student or parent depending on the fund.

If the student is Deceased, and a Credit Balance exists, Student Financial Planning returns any resulting Credit Balance
to the appropriate Title IV Fund source and reduces/returns these funds using the Reduction of Funds process and
upon completion, updates the recipient of the Credit Balance from Student to Return to Lender.

Sends an outbound message upon Completing the Credit Balance
Calculation
Student Financial Planning sends an Outbound Message once the Credit Balance is calculated. The message includes
the Fund Source, Amount, Payment Period, Sequence Number and Payment ID Number. Once delivered, Student
Financial Planning receives a new SAFI message with a Credit Balance ID Number.
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Cancels the Credit Balance
When a Credit Balance is canceled in the Student Accounting System, it is sent to Student Financial Planning via the
SAFI message in a Canceled status. Once the SAFI is received, Student Financial Planning updates the status and the
Credit Balance to zero.

Configurable Attributes
Configure whether to include the Prior Year Outstanding Balance when determining the Credit Balance
You can configure whether Student Financial Planning will include prior year charges up to $200 in the Credit Balance
calculation. Student Financial Planning will look at this configuration when determining whether to calculate the Prior
Year Outstanding Balance and subtract the amount from the Credit Balance calculated if the configuration is set to
include the Prior Year Outstanding Balance (up to $200).

Navigation to the Student Financial Planning User Interface Functionality
To View the Credit Balance
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's name, external student ID number or social security number in the search field located in
the upper right-hand corner

◦ Because Student Financial Planning returns results for any data entered, the student search can be based
on complete or partial information

◦ Select the Student Record from the Student Search Results pop-out dialogue box

2. Hover over the Financial Aid Tab
3. Click Credit Balance
4. Click Credit Balance (default view)
5. Review the Credit Balance(s)

◦ Credit Balance Trigger (See information about credit balance trigger earlier in this topic)

◦ Click any link to view the Charge, Discount and Payment Details

6. Charge, Discount and Payment Details

To View Authorization to Hold Elections
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's name, external student ID number or social security number in the search field located in
the upper right-hand corner

◦ Because Student Financial Planning returns results for any data entered, the student search can be based
on complete or partial information

◦ Select the Student Record from the Student Search Results pop-out dialogue box

2. Hover over the Financial Aid Tab
3. Click Credit Balance
4. Click Authorization to Hold
5. Review the Authorization to Hold Elections (Student and/or Parent)
6. Review the Authorization to Hold Resource Fee Election (Student and/or Parent)
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Adjust A Credit Balance  
If the student or parent does not cash a Credit Balance check within 180 days, the institution can Adjust the Credit
Balance.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Credit Balance Modifier

◦ Can modify the credit balance amount, recipient, and date at any point

• Credit Balance Not Sent Modifier

◦ Can modify the credit balance amount, recipient, and date only if the credit balance event outbound
message has not been sent

See Set General Permissions Matrix for additional information.

Manual Processing Steps
An authorized user can modify the Credit Balance Amount (up to the un-applied amount associated to the payment) per
fund source, per disbursement and add comments as to why the credit balance is being manually adjusted.

Log into the Student Financial Planning User Interface (UI)

1. Enter the students name, external student ID number or social security number in the search field located in the
upper right hand corner

◦ Because Student Financial Planning returns results for any data entered, the student search can be based
on complete or partial information

◦ Select the Student Record from the Student Search Results pop-out dialogue box

2. Hover over the Financial Aid Tab
3. Click Credit Balance
4. Click Credit Balance (default view)
5. Review editable fields available for update

◦ Credit Balance Amount
i. Credit Balance Created On (date)

ii. Status Effective As Of (date)
iii. Recipient

6. Click Save
7. Add Comment
8. Click Save Comments
9. Click Close

Note:  Student Financial Planning saves this information along with the existing Credit Balance ID associated to the
Payment ID.
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Related Topics
• Create A Credit Balance

• Credit Balance

Create A Credit Balance  
You can Create a Credit Balance on a student account, if necessary. For example, a student or parent who has
authorized the institution to hold their Credit Balance may request a portion of it.

Overview
You can enter the recipient, date of occurrence, comments, and the Credit Balance amount (per academic year, per fund
type, per disbursement). However, you can only enter an amount for payments that have already disbursed and only up
to the un-applied amount associated to the payments.

Note:  Student Financial Planning will save the Credit Balance amount as a new Credit Balance with a unique Credit
Balance ID associated to the Payment ID.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Credit Balance Creator

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the students name, external student ID number or social security number in the search field located in the
upper right hand corner

◦ Because Student Financial Planning returns results for any data entered, the student search can be based
on complete or partial information

◦ Select the Student Record from the Student Search Results pop-out dialogue box

2. Hover over the Financial Aid Tab
3. Click Credit Balance
4. Click Credit Balance (default view)
5. Click the Create Credit Balance Button
6. Select Payment (per fund type)

◦ Click the [ + ] next to the Charge, Discount and Payments to see additional details

7. Enter the Credit Balance Details

◦ Incremental Credit Balance Amount

◦ Credit Balance Created On Date

◦ Status Effective as Of Date
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◦ Recipient

8. Click Save
9. Enter a comment

◦ You will need to click the Add Comments button prior to entering the comment (not displayed in the
graphic)

◦ You should always enter a comment and enter details as to why the Credit Balance is being created
manually

10. Click Save Comment
11. Click Close

Related Topics
• Credit Balance

• Adjust A Credit Balance

Disbursing  
Before a student can receive any Title IV Disbursements, all funds the institution considers awardable must meet
eligibility criteria in addition to being acknowledged by Common Origination and Disbursements (COD).

Overview
Once all Disbursement Criteria is met for all eligible Title IV funds, Student Financial Planning triggers the disbursement
data to COD using a Common Record format. The Disbursement file communicates disbursement details to COD.
A Disbursement file with records that have been flagged as ready to be disbursed must follow specific rules for any
updates made in the student's fund eligibility and award amounts after the file is acknowledged by COD.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Creates disbursement schedules
Student Financial Planning creates Title IV Disbursement Schedules to disburse funds when the Anticipated
Disbursement Date (ADD) is reached and all Disbursement Criteria is met. You can configure Title IV disbursement
schedules by using Groovy scripts in the optional Disbursement Dates field of the FAS_FUND_CONFIG.csv
Configuration Workbook. You can create as many disbursements as needed for each payment period. Using this
configuration supersedes all default system logic for Title IV disbursement schedules with the following exceptions:

• Disbursement date system logic related to Leaves of Absence.

• If script returns a new ADD that is in the past, the disbursement is scheduled for the current system date.

• If an existing ADD is in the future and the script returns an ADD that is in the past, the ADD is scheduled for the
current system date.

• If an existing ADD is in the past, it’s not updated.

If you choose not to use the FAS_FUND_CONFIG.csv configuration option, default system logic determines ADDs for
Title IV funds based on Payment Period Start Dates and Loan Payment Period Start Dates.
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Fund Type Anticipated Disbursement Date Based On

Direct Loan Loan Payment Period Start Date

Other Title IV Loan Payment Period Start Date

Title IV Grant Payment Period Start Date

Direct Loan for First-Time First-Year
Borrower

Program Start Date plus 30 Days

Campus Based Fund (FSEOG) After the associated Award Year Start Date

If the institution has an internal policy to delay a disbursement, you can configure that using the Number of Days delay
to Determine Disbursement Dates field in the School.csv Configuration Workbook. If SFP is setting the ADD and the
date is less than the current system date, the system sets the ADD as the current system date.

Non-Federal Fund (NFF) disbursement dates are determined by configuring the NFR Fund Disbursement Dates field in
the NFR_ATTRIB.csv Configuration Workbook.

Once an ADD is determined, if there are Direct Loans in the student's package, SFP runs the Leave of Absence (LOA)
Engine to determine if any if the ADDs should be updated due to being scheduled during an LOA period or if the current
system date is in an LOA period and the disbursement is still not disbursed.

Updates the disbursement status
When scheduling the disbursement, Student Financial Planning sets the appropriate disbursement status for each fund.

Status Description Trigger

Projected Disbursement Amount and Anticipated
Disbursement Date has been determined,
 but the fund has not yet been awarded or if
awarded requires acceptance.

The student has been packaged and the
disbursement amount and anticipated
disbursement date is set, however, the fund
status is Projected or Estimated.

Disbursement Scheduled Anticipated Disbursement Date and
Disbursement Amount is determined but the
Disbursement has not met the Origination
Criteria (if applicable).

Fund has been Awarded and Accepted and
Origination Criteria (i.e. acceptable enrollment/
admissions status).

Pending COD Origination Start Date For non-campus based Title IV funds (excluding
IASG), fund is pending COD origination start
date.

Fund has met configurable Origination Criteria,
 but COD is not open for the award year.
 
Origination Criteria is evaluated in the
Origination Batch Job
 
.

Origination Ready to be Sent to COD For non-campus based Title IV funds (excluding
IASG), fund is ready to be originated/re-
originated.

Fund has met configurable Origination Criteria.
 
Origination Criteria is evaluated in the
Origination Batch Job
 
.

Origination Sent to COD For non-campus based Title IV funds (excluding
IASG), Origination/Re-origination file has been
generated and is staged for TDClient to pick up.

An origination request has been sent to COD.
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SFP does not know if/when TDClient has picked
up a file.

Origination Rejected For non-campus based Title IV funds, COD has
rejected the origination for the disbursement.

COD returned a response of Rejected to the
origination request.

Origination Accepted For non-campus based Title IV funds, COD has
accepted the origination for the disbursement.

COD returned a response of Approved to the
origination request.

Disbursement On Hold For NFR Funds where the funds aren't yet ready
to be disbursed.

A user has manually placed a disbursement On
Hold.

Disbursement Canceled Disbursement hasn't been disbursed and is
being canceled.

Disbursement has not disbursed and is being
canceled.
 
(See Cancellation Reasons)
 

Disbursement Ready to be Sent to COD For non-campus based Title IV funds (excluding
IASG), disbursement is ready to be sent to COD.

All Disbursement Criteria for the disbursement
has been Met.
 
Disbursement Criteria is evaluated in a
Disbursement Criteria batch job.
 

Disbursement Sent to COD For non-campus based Title IV funds (excluding
IASG), disbursement has been generated and
is staged for TDClient to pick up. SFP does not
know if/when TDClient has picked up a file.

The disbursement request has been sent to
COD.

Disbursement Rejected For non-campus based Title IV funds, COD has
rejected the disbursement

COD returned a response of Rejected to the
disbursement request.

Disbursement Ready for Review School can configure a Non-Federal Fund to
require user review after disbursement criteria
is evaluated and met

A Non-Title IV disbursement meets all
Disbursement Criteria but requires user review.

Disbursed For non-campus based Title IV funds, COD has
accepted the fund
 
For all other funds, the fund has met the
disbursement criteria
 

COD returned a response of Approved to the
disbursement request OR
 
A Non-Title IV disbursement that required
review, has been reviewed and approved by a
user.
 

Disbursement Returned Disbursement has been disbursed and a part of
all of the disbursement is being returned

Disbursement requires to be returned:
 

• Eligibility amount changed (reduced).

• Student requested to return a portion of
the funds.

• A credit balance check was returned.

• Return to Title IV calculation resulted in a
return.

Held for QC Review Disbursement is On Hold due to a QC Hold Disbursement is subject to a disbursement
related QC Hold.

QC Reviewed Disbursement is no longer On Hold and will
subsequently be disbursed, canceled, or
returned

A disbursement related QC Hold has been
released.

Pending Re-opened Award Year System has created a negative disbursement
for an Award Year that has been closed-out

There is a return or a disbursement required for
an Award Year that has been closed out.
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Pending Previous Financial Award ID
Cancellation

This status is used when a student is converted
with more than one Financial Award ID for a
single loan period. Student Financial Planning
holds all originating and disbursing for the
latest financial award ID until all non-disbursed
disbursements are canceled.
 
In order to ensure that the newly created
Financial Award ID is used moving forward,
 Student Financial Planning displays this status
until the old (converted) IDs are fully canceled.
 

Student is converted and has more than one
Financial Award ID for a single loan period.

Pending COD Acceptance of Stafford Loan When the award amount changes for
Subsidized and Unsubsidized funds in the same
academic year, Student Financial Planning
prevents re-originating the fund with the
increased amount until the decreased amount
has been fully accepted by COD.

One Stafford Loan has been increased while
the other has a decreased amount and
communication with COD is pending.

Pending Loan Fees Update When the loan fee and rebate amount
associated to a fund changes, the existing
award needs to be canceled with COD prior to
originating the new amounts. This status will be
used on the newly created disbursements while
waiting for the prior amount to be canceled.

Loan Fee Percentage Period has changed.

Pending Previous Award Year Cancellation
 

When a disbursement is associated with
multiple award years, Student Financial
Planning waits until the award year being
canceled is fully canceled prior to originating
the current year disbursement. The current year
disbursement remains in a Pending Previous
Award Year Cancellation status until the award
year being canceled is fully canceled.

Disbursement for a previous award year is
being canceled.

Updates disbursement schedules
For each Title IV fund and Non-Federal Fund, SFP updates the Anticipated Disbursement Date based on system
configuration. Each time the student is packaged, SFP determines if the Borrower-Based Academic Year (BBAY) or Non-
Federal Fund (NFF) Period Dates changed and updates the Anticipated Disbursement Dates as needed. However, a
disbursement date is not updated if the academic year has ended, the scheduled disbursement has already disbursed,
been returned, or canceled, or a new Anticipated Disbursement Date is in the past and further in the past than the
currently scheduled disbursement date.

Calculates initial disbursement amounts
Student Financial Planning sets the student's initial disbursement amounts based on the total amount the student is
eligible to receive and the fund type.

For Title IV Grants and Direct Loans, Student Financial Planning sets the disbursement to the maximum amount the
student can receive for a payment period based on the eligible amounts determined by the package, and the system
limits the final disbursement in the academic year based on the packaging limit. Additionally for Direct Loans packaged
in a term academic model, the amount is prorated for graduating undergraduate students when their final enrollment
period is less than the academic year definition. The proration is triggered regardless of the enrolled credit amount
within the final term of their program. Graduating undergrad students only attending a partial academic year will have
direct loans prorated based on the number of credit hours they are enrolled.
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For Non-Federal Funds, since there is only one disbursement per period, the system sets the disbursement to the
maximum amount the student can receive for that Non-Federal Fund period based on the amount awarded and the
packaging limit.

Creates initial disbursement numbers and sequence numbers
Student Financial Planning sets the student's initial disbursement amounts based on the total amount the student is
eligible to receive and the fund type.

For Title IV Grants and Direct Loans, Student Financial Planning sets the disbursement to the maximum amount the
student can receive for a payment period based on the eligible amounts determined by the package, and the system
limits the final disbursement in the academic year based on the packaging limit. Additionally for Direct Loans packaged
in a term academic model, the amount is prorated for graduating undergraduate students when their final enrollment
period is less than the academic year definition. Graduating undergrad students only attending a partial academic year
will have direct loans prorated based on the number of credit hours they are enrolled.

For Non-Federal Funds, since there is only one disbursement per period, the system sets the disbursement to the
maximum amount the student can receive for that Non-Federal Fund period based on the amount awarded and the
packaging limit.

Creates subsequent disbursement numbers and sequence numbers
Student Financial Planning creates subsequent Disbursement Numbers and Sequence Numbers when disbursements
are updated or if the fund is being re-originated so that the Disbursement record will be properly tracked and processed
in the COD system.

Student Financial Planning creates additional Disbursement Numbers per fund based on the fund type:

• Title IV Direct Loans: if a new Disbursement needs to be added to the Loan Payment Period, Student Financial
Planning increment the Disbursement Number based on the last Disbursement Number used for the fund in
the loan period.

• Title IV Grants: if a new Disbursement needs to be added to the Grant Payment Period, Student Financial
Planning increment the Disbursement Number based on the last Disbursement Number used for the fund in
the award year.

• NFR Funds: if a new Disbursement needs to be added to the NFR period, Student Financial Planning increment
the Disbursement Number based on the last Disbursement Number used for the fund in the academic year.

Student Financial Planning creates additional Disbursement Sequence Numbers per Disbursement Number:

• The Number is calculated sequentially.

• The Disbursement Sequence Number is only incremented if a previously reported disbursed Disbursement
needs to be updated.

Creates disbursement payment IDs
Student Financial Planning creates a unique Payment ID (fixed character length between 8-12 characters) for each
transaction associated with the Disbursement so that the Student Accounting System (SAS) can record and use this
identifier for further communication needed between the system and SAS.

Once the Disbursement is disbursed, Student Financial Planning create a unique Payment ID for each new Sequence
Number that is created for a Disbursement where the incremental amount is not less than or equal to zero, since all
negative disbursements will have a unique Return to Lender ID and all updates to dates where the incremental amount
is zero will be associated to the original Payment ID. This unique Payment ID will be used to communicate between the
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system and SAS in the Disbursement Outbound Message, Credit Balance Outbound Message, and Student Academic
and Financial Information Inbound Message.

Triggers disbursements
Student Financial Planning triggers the disbursing of funds when the Anticipated Disbursement Date has been reached
so that the student can receive their disbursement when eligible.

Student Financial Planning also triggers the disbursing process when an authorized user manually resolves a rejected
disbursement (refer to SAIG Errors for further details).

After the Disbursement process has been triggered, Student Financial Planning determines if all Disbursement Criteria
has been met. Once all Disbursement Criteria has been met, Student Financial Planning determines if the Award Year
associated to the Title IV Grant has been closed, or if the Loan Period associated to the Title IV Direct Loan has been
completed. If the Award Year or Loan Period has been closed or completed, the disbursement will be considered a Late
Disbursement and the student may need to accept the Late Disbursement amount prior to disbursing the fund.

If the student has not completed the Academic Year, Student Financial Planning disburses the fund appropriately. The
Disbursement Date will be set for (TODAY's) date and the Disbursement Status will be updated based on whether the
Common Record File will be required to be sent to COD. The Disbursement Status for Campus-Based Title IV funds,
IASG, and NFR funds will be set to Disbursed. The Disbursement Status for all Non-Campus Based Title IV funds
(excluding IASG), will be set to Disbursement Ready to be Sent to COD and will trigger the Disbursement File to be sent
COD.

Evaluates disbursement criteria
Student Financial Planning checks a number of conditions once the Disbursement process has begun so that the fund
will only be disbursed when all conditions have been met.

Fund Type Disbursement Check

Title IV Funds • Package is not Pending Repackage.

• Current ISIR for Award Year associated with Disbursement is Valid or Unverified.

• Student has Academic Related Activity in the Payment Period that the fund is being disbursed for.

• Fund has been Awarded.

• Fund is not Pending Fund Acceptance (if required)

• Fund is not "Fund Not Accepted".

• Disbursement is not "Canceled".

• Student's Satisfactory Academic Progress (SAP) calculation has been run for the most recent
Payment Period and the Student's SAP is not in a Disqualified status.

• Student is Active.

Non-Campus Based Title IV Funds
(excluding IASG)

• COD has accepted fund origination.

Non-Campus Based Title IV Loans • The transfer monitoring request to NSLDS was made more than 7 days prior.

Unsubsidized Loans • Subsidized Loan Fund Acceptance Status must not be Pending Acceptance or Pending Additional
Acceptance.

• Student has completed Annual Student Loan Acknowledgement (CRIB file).
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PLUS Loans • The PLUS Counseling requirements have been met if the PLUS Loan Final Credit Decision Status
is based on the CRCS

• Student has completed Annual Student Loan Acknowledgement (CRIB file).

Campus Based Title IV Funds • Fund allocation is ready to be disbursed

Need-Based Title IV Funds • Current ISIR for Award Year associated to Disbursement is Valid

Non-Federal Funds • Package is not Pending Repackage

• Fund has been Awarded

• Fund is not Pending Fund Acceptance if required

• Fund is not Fund Not Accepted

• Disbursement is not Canceled

• Disbursement is not Disbursement on Hold

• Fund is not Pending Re-Evaluation

All Funds • Configured Fund Disbursing Criteria has been met

Note:  You add, edit, or disable disbursement criteria using the Disbursements Guide.

Creates disbursement files
Student Financial Planning creates a disbursement file and includes all required data so that the Non-Campus Based
Title IV Disbursement is processed correctly through the COD system. For all Non-Campus Based Title IV Funds
(excluding IASG), Student Financial Planning creates the proper Common Record file once triggered in the FAS. All
required data fields specified in the Common Record layout based on the fund that is ready to be disbursed will be
included in the file.

Receives the disbursement response
Student Financial Planning processes a Disbursement Response so that the student's package can be confirmed or
updated as necessary. The system performs these tasks:

• Match the Common Record File to the Student's Record using the student's Social Security Number (SSN).

• Verify that the Disbursement File has been accepted by COD.

• Follow the error handling process for any Disbursement files that haven't been accepted.

• Not send the Disbursement Outbound Message until the Disbursement has been accepted.

• Display all Disbursement Responses on the student record.

Evaluates disbursement amounts after repackaging
Student Financial Planning determines the Payment Period Maximum Disbursement Amounts based on the total
amount of funding the student is eligible to receive similar to setting the Disbursement Amounts initially.

If the Payment Period Maximum Disbursement Amount is increasing, Student Financial Planning takes additional steps
to determine whether the disbursements will be updated. If the fund has not previously received Fund Acceptance from
the student or does not require Fund Acceptance, Student Financial Planning increase the Disbursement(s) based on

248

https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=u30005654


Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 10
Using Financial Information

the increased Payment Period Maximum Disbursement Amount. Else, Student Financial Planning does not update the
Disbursement until Fund Acceptance for the increased award is received.

If the Payment Period Maximum Disbursement Amount is decreasing, Student Financial Planning decreases the
disbursement and does not require additional acceptance.

Updates disbursement amounts when receiving fund acceptance
When Fund Acceptance is received, Student Financial Planning update Disbursement Amounts to reflect the same,
increased, or reduced amount accepted by the student and disburse the correct amounts. If the accepted amount is the
same, the disbursement amounts aren't required to be updated and will disburse as is.

If the accepted amount is more than the current amount, then the Disbursement Amounts will be increased. Title IV
Direct Loans are increased evenly over both Payment Periods. Title IV Grants will be increased to the maximum amount
the student will be eligible to receive the first disbursement and the second disbursement will be adjusted to equal the
remaining amount. Any Non-Federal Funds or Non-Federal Fund (NFF) Loan or Grant Payment Period Disbursement
Amount(s) will be adjusted to equal the Accepted Amount.

If the accepted amount is less than the current amount, then the Disbursement Amounts will be decreased. Student
Financial Planning determines the Right to Cancel Deadline and if the deadline has passed, Title IV Direct Loan or
TEACH Disbursements associated with the Payment Periods affected by the Fund Acceptance are only decreased to the
amount that hasn't already been applied to charges.

• Title IV Direct Loan Disbursements will only decrease that are disbursed less than 120 days from the system
date.

• After determining the Payment Period Disbursement Amount, Student Financial Planning needs to decrease
the Disbursements.

If the Disbursement Amounts are being adjusted for an NFR fund, Student Financial Planning needs to check whether
the fund is a manual NFR and requires the user to communicate the adjustment to an outside FAS.

• If it does, Student Financial Planning creates a task in the Re-Evaluate NFR Fund task queue and set the reason
to indicate the student's accepted amount caused the disbursements to be increased or decreased.

If the fund is not accepted, Student Financial Planning cancels future disbursements.

Increases disbursements
Student Financial Planning increases disbursements appropriately based on what has been disbursed so that the
disbursement amounts are updated and disbursed correctly.

After increasing the Payment Period Disbursement Amounts, the individual disbursement amounts will require
appropriate updates based on whether the disbursements in the Payment Period have already been disbursed. If none
of the disbursements associated with the Payment Period have disbursed, the disbursement amount will be increased,
and the existing Disbursement and Sequence Numbers will be saved.

If all disbursements have disbursed in the Payment Period, Student Financial Planning creates a new Disbursement
Number for the difference of the increased amount and associate that disbursement to the Payment Period in which
the original Disbursement is in. The new Disbursement Number will be the next Sequential Number for the Award Year/
Loan Period depending on the fund type.

If some disbursements in the Payment Period have been disbursed, Student Financial Planning needs to increase the
Disbursement Amount of the Disbursement that is not disbursed for the difference of the increased amount and what
has already previously been disbursed.
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For all new disbursements created, Student Financial Planning set the Anticipated Disbursement Date to the current
date.

For Non-Campus Based Title IV Funds (excluding IASG), Student Financial Planning triggers a new origination to be sent
to COD and begin the Re-Origination Process.

Decreases disbursements
Student Financial Planning deceases disbursements appropriately so that the Disbursement Amounts are updated and
disbursed correctly.

After decreasing the Payment Period Disbursement Amounts, Student Financial Planning updates the individual
Disbursement Amounts appropriately based on whether the disbursements in the Payment Period have already been
disbursed. If none of the disbursements associated with the Payment Period have been disbursed, Student Financial
Planning decreases the Disbursement amount and doesn't need to create a new Disbursement Number or Sequence
Number.

If all the disbursements have already been disbursed in the Payment Period, Student Financial Planning creates a new
Sequence Number associated with the highest Disbursement Number for the difference of the decreased amount. The
new Sequence Number will be the next Sequential Number associated with the Disbursement Number. If the amount
of the highest Disbursement Number is less than the amount that needs to be decreased, Student Financial Planning
evaluates the next highest Disbursement Number and continues to decrease the amounts until the total Disbursement
Amount is equal to the decreased Payment Period Disbursement Amount.

If some of the disbursements in the Payment Period have been disbursed, Student Financial Planning needs to
decrease the highest non-disbursed Disbursement Amount and will not need to create a new Disbursement Number
or Sequence Number. If the amount of the highest Disbursement Number is less than the amount that needs to be
decreased, Student Financial Planning evaluates the next highest Disbursement Number and continues to decrease
the amounts until the total Disbursement amount is equal to the decreased Payment Period Disbursement Amount.
Student Financial Planning creates new Sequence Numbers to adjust these amounts only if the Disbursement has been
disbursed.

For Non-Campus Based Title IV funds (excluding IASG), Student Financial Planning triggers the Common Record
updates to be sent to COD.

For all disbursements that have been disbursed and are being decreased, the Disbursement Process is triggered and
Student Financial Planning does not include the total award amount in the file. Once the Disbursement File is accepted,
Student Financial Planning triggers the Re-Origination Process Origination Management with the total award amount.

For all Disbursements that have not been disbursed and are being decreased, Student Financial Planning triggers the
Re-Origination Process.

Begins the disbursement refund process

Upon the completion of Repackaging or a Return to Title IV (R2T4) Calculation, if a fund needs to be reduced Student
Financial Planning begins the disbursement refund process. Additional circumstances that result in this process include
when a student denies a fund, accepts less than the amount disbursed, or a user manually repackages a student in
order to cancel or decrease a disbursement. If Non-Title IV funds require a reduction of funds, you can manually adjust
the fund amounts.

Once a fund has been requested to be reduced Student Financial Planning communicates with COD and then the G5
Process includes any refunded amounts in the net drawdowns for the fund source.

Sends a return to lender message
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Student Financial Planning sends a message to external systems as necessary when a previously disbursed payment
needs to be returned and/or a Refund Information Web Service Request is received. The Return to Lender Message
includes the following information:

• Program Information

• Fund Information

• Academic Year/Payment Period Information or Loan Period /Loan Payment Period Information or Non-Title IV
Period Information

• Associated Disbursement/Payment Information

• Refund Information

Updates the loan period date for reduced or canceled funds

Student Financial Planning updates the loan period if the student reduces their second disbursement to zero, in order to
update COD accordingly.

Re-opens an award year for returns if granted administrative Relief

Student Financial Planning creates a Task and includes the students with late returns that require an award year to be
opened for a closed payment period in order to return funds after the closeout deadline. Once alerted and the request
to reopen the award year is granted from COD you can update the closeout date configuration to re-open the award
year. After an award year is re-opened, Student Financial Planning repackages the student.

Cancels disbursements
Student Financial Planning cancels future Anticipated Disbursements appropriately so that the disbursement amounts
and statuses are updated.

If the Disbursing Engine is being triggered to cancel a future Anticipated Disbursement, Student Financial Planning
document the cancellation reason based on the triggering event.

When canceling the disbursement, Student Financial Planning determines whether the fund will be allowed to be
subsequently increased. Student Financial Planning allows the fund to be subsequently increased if the system canceled
the fund due to the following reasons:

• When the fund is not accepted by the student and was previously not disbursed since the student is allowed to
update the Accepted Amount as long as they accept or decline the fund prior to the Fund Acceptance due date.

• When the Award Year is closed prior to the fund being disbursed, since the student may be eligible to receive
the fund in the next award year.

• When an R2T4 is calculated or a Post-Withdrawal Disbursement (PWD) is not accepted, since the R2T4
calculation may be subsequently re-ran causing updates to the canceled Disbursements.

When canceling the Disbursement, Student Financial Planning updates the Disbursement Status based on whether the
fund requires a COD response. If the fund does not require a COD response, Student Financial Planning updates the
Disbursement Status to Disbursement Canceled. Otherwise, Student Financial Planning originates the fund and update
the Disbursement Status to Disbursement Canceled once the origination has been accepted.

Sends the cancel future disbursement outbound message

Student Financial Planning send an Outbound Message with all the relevant disbursement information when an
awarded fund has a future disbursement and it is canceled. Student Financial Planning includes Disbursement
information and the reason that the Disbursement was canceled.
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Updates COD
Student Financial Planning creates an updated Common Record file and includes all required data when there are any
changes made in a student's package that affect previous Disbursement Amounts or Dates so that Non-Campus Based
Title IV funds are processed correctly through COD. Depending on the amount of the total award that was disbursed and
whether the amount is being reduced, Student Financial Planning triggers the Disbursement File to include the updated
Disbursement Amounts prior to the Origination File with the total awarded amount updated.

Student Financial Planning includes all required data fields specified in the Common Record Layout based on the fund
that is being re-originated or included in an updated Disbursement Report. Student Financial Planning includes the
updated Disbursement amounts in the Origination and Disbursement Files.

Student Financial Planning populates any updated dates based on date changes in the student's package. the system
cannot include updates to Disbursement Dates and the amounts in the same complex element in the Disbursement Tag
of the COD Report.

Receives disbursement information web service request
Student Financial Planning receives the Disbursement Information Web Service Request so that Student Financial
Planning triggers an Outbound Message with information regarding the student's disbursements:

• Student Financial Planning accepts the Disbursement Information Web Service Request.

• The Disbursement Information Web Service Request will indicate the requested student's IRN.

• For the student listed in the request, Student Financial Planning triggers the Disbursement Information
Outbound Message and include all associated Disbursements.

Sends disbursement information outbound message
Student Financial Planning sends a Disbursement Information Outbound Message when any of the following conditions
are met and the fund has been configured to send a Disbursement Outbound Message:

• A Disbursement Information Web Service Request is received

• Disbursement Status has been updated to Disbursed

• Disbursement Date is updated

• Anticipated Disbursement Date is updated

• Incremental Disbursement Amount is updated

If the Disbursement Information Outbound Message is triggered due to a Disbursement being disbursed or updated,
Student Financial Planning only sends the information related to the specific payment. However, if a Web Service
Request is received, Student Financial Planning sends all of the information for all disbursements associated with the
student.

Reconciles disbursement dates based on the ledger posting date
Every time a Student Academic and Financial Information (SAFI) message is received, Student Financial Planning
reconciles the Disbursement Date with the student's Ledger Posting Date. If the Disbursement Date does not match the
Ledger Posting Date, Student Financial Planning updates the Disbursement Date. Student Financial Planning creates
a new Sequence Number associated with the disbursement and triggers the updated Disbursement Information to be
sent to COD.
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Generates disbursement student history entries
Student Financial Planning generates a Student History Entry based upon configured events occurring within the
Disbursement Engine in order to provide a historical record of all disbursement activity within the Student Record.

Evaluates loan payment periods for active disbursements
Student Financial Planning evaluates each Loan Payment Period for each Direct Loan Type (Sub/Unsub/PLUS) to
see if it can be considered active by checking if there are any disbursements with a Disbursement Status not equal to
Disbursement Cancelled. Student Financial Planning communicates which Loan Payment Periods are active for each
Direct Loan Type (Sub/Unsub/PLUS) and sends the appropriate Loan Period Dates to the COD system.

Configurable Attributes

Configure Disbursement Dates
You can configure one or multiple anticipated disbursements dates based on the desired schedule for each payment
period/term of an academic year.

Configure Disbursement Delays

You can configure how many days the Disbursement will be scheduled after the Payment Period/Loan Period so that
the system can update the Disbursement Schedule as necessary. If the institution would like to delay the disbursement
as a result of their internal policy, Student Financial Planning ensures all Title IV disbursements are scheduled after
this period. The institution can configure the number of days that will be added to the Payment Period/Loan Period to
determine the Disbursement Dates for Title IV funds.

Configure Disbursement Criteria
You can configure Disbursement Criteria per fund, and specify student record data, required documents, and conditions
dependent on other funds when configuring conditional logic so that the funds will not disburse until all conditions
have been met.

Configure and Evaluate Disbursement Criteria Deadline
You can configure a deadline for when all Disbursement Criteria must be met and specify the Number of Days after the
Anticipate Disbursement Date for each fund code for the Disbursement. If the Disbursement Criteria is not met after
the deadline has passed, Student Financial Planning cancels the disbursement and sends an outbound message to
communicate the disbursement has been canceled.

Configure the Right to Cancel Deadline
You can configure the time frame allowed for a student to fully cancel or decrease a Title IV Direct Loans and/or TEACH
fund after the Outbound Disbursement Message has been sent without considering any of the conditions in decreasing
the award after the deadline has been reached.

The user can set the number of days from when the Outbound Disbursement Message is sent for the fund in which
the student can accept a decreased amount or cancel the fund without considering any Right to Cancel conditions.
The institution cannot configure less than 14 days since the U.S. Department of Education requires that the student
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will be able to cancel all funds within 14 days of the Disbursement Date. After that deadline, it is up to the institution's
discretion.

Student Financial Planning determines the Right to Cancel Due Date based on the Disbursement Date and the Number
of days configured.

Configure the Disbursement Information Outbound Message
You can configure whether Student Financial Planning sends a Disbursement Information Outbound Message to each
fund or not. If the user does not configure whether the Disbursement Information Outbound Message will be sent to the
fund, Student Financial Planning assumes a Disbursement Information Outbound Message should be sent.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view Disbursements
Student Financial Planning User Interface > Student > Financial Information > Disbursing

Origination Management  
Before a student can receive any Title IV disbursements, all funds the institution considers awardable must be
acknowledged by Common Origination and Disbursements (COD). After the student is packaged with eligible Title IV
funds, Student Financial Planning triggers all Award and Disbursement data to the COD System using the “Common
Record” format. An origination file establishes a new award and projected disbursement with the COD system. An
origination file can be updated for any changes in dates or award eligibility amounts that are modified for any projected
disbursements.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Triggers originations
Student Financial Planning triggers originations for Title IV funds when the student is packaged and includes the full
amount the student is eligible to receive up to the institutions configured packaging limit and the fund amount is based
on actual data. Originations are triggered for funds with a fund status of Estimated or Awarded and a disbursement
status of Projected or Disbursement Scheduled.

If a fund is being originated prior to the award year's Origination Start Date, Student Financial Planning stores the
origination in a queue until the Origination Start Date is met. If a fund is being originated after the award year's
Origination Start Date, the disbursement status updates to Origination Ready to be Sent to COD and Student Financial
Planning creates an origination request file.

Once the origination file is sent, Student Financial Planning updates the disbursement status to Origination Sent to
COD.
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Creates origination file(s)
Student Financial Planning creates an origination file or updates the origination file and includes all required data in
order to process the Title IV award(s) correctly through COD. Once the origination file is triggered, Student Financial
Planning creates the Common Record File and includes all required data fields specified in the Common Record layout
based on the fund(s) being originated. Information in the origination file includes the correct awards per award year, the
academic year and loan period dates based on the academic year the funds are being originated.

Student Financial Planning creates an updated origination file and includes updated award amounts and date changes
in the student's package for all anticipated awards.

Triggers re-originations
Student Financial Planning triggers Re-Originations if the disbursement amount, academic year and/or loan period
dates change.

The funds included in the re-originations depends on whether the disbursement disbursed and whether the amount is
increasing, decreasing, or being removed or whether the dates are being updated.

Re-originates and zeroes out funds
Student Financial Planning creates an updated origination file and zeroes out future award funds when there are
anticipated disbursements that need to be canceled so that the Title IV award processes correctly through COD.

Once the origination job is triggered, the proper Common Record file is created. Student Financial Planning includes all
required data fields specified in the Common Record layout based on the fund that is being originated and the updated
award amounts in the origination file. If future award funds are no longer valid in the student's package, they are zeroed
out.

Receives the origination response file
Student Financial Planning process an origination response in order to confirm the student's package. Using the
Document ID, the Common Record file is matched to the student record. The origination response is displayed on the
student record.

Student Financial Planning verifies that the origination file has been accepted by COD and for any origination files that
have not been accepted and follows the SAIG Error Handling process.

Updates direct loan disbursement fee and interest rebate amounts
Student Financial Planning updates the Direct Loan disbursement fee and interest rebate amounts for each loan period
when the U.S. Department of Education releases a change that affects a loan that already originated so that the Direct
Loan award includes the appropriate disbursement fees and interest rebate amounts. Student Financial Planning
updates the disbursement fee and interest rebate amounts when the U.S. Department of Education releases a change
that affects a Subsidized Loan, Unsubsidized Loan, or PLUS Loan. The existing loan fee is canceled and the loan is re-
originated with the updated loan fee.

Triggers the new award year originations batch job
Student Financial Planning runs a batch job once the Origination Start Date for the new Award Year occurs.

The system should trigger a batch job once the system date equals the Origination Start Date for the new Award Year.
Student Financial Planning updates the Disbursement Status and triggers the creation of the Origination File for all
queued items. Once the Disbursement Statuses have been updated, the queue is wiped out.
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Configurable Attributes
This feature does not have any configurable features.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

• XML Viewer (to View Complete COD xml)

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view Originations
Student Financial Planning User Interface > Student > USDE > Common Record File

COD Student Identifier Updates  
You can track and act on COD Student and Borrower Identifier changes.

Overview
In regards to Student Identifier Changes, Student Financial Planning needs to be able to recognize when a student
identifier update is made to an ISIR, trigger a common record message to the COD, cease transmitting info to COD until
Student Financial Planning confirms the update is accepted or rejected, review the reason why the data is rejected (if
applicable) and use the new or old Student Identifier for future COD transmissions depending if the data is accepted or
rejected, respectively.

In regards to Borrower Identifier Changes, Student Financial Planning needs to be able to determine if the borrower is
a parent or student, recognize when a borrower identifier update is made to an ISIR, trigger a common record message
to the COD, cease transmitting info to COD until Student Financial Planning confirms if the update is accepted or
rejected, review the reason why the data is rejected (if applicable) and use the new or old Borrower Identifier for future
COD transmissions depending if the data is accepted or rejected, respectively.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Updates student identifier information
When the student or institution submits an ISIR Correction and updates a Student Identifier field (SSN/Last Name/Date
of Birth) a subsequent Central Processing System (CPS)/FAFSA Processing System (FPS) transaction occurs. Student
Financial Planning recognizes when an update is made to a Student Identifier field and stops transmitting information
to COD until it is confirmed the update is accepted or rejected.

Note:  Student Financial Planning consumes the SSN/Last Name/Date of Birth Change Reports saved in the
institution's Student Aid Internet Gateway (SAIG) mailbox on a weekly basis to confirm if the Student Identifier update
is accepted or rejected by COD.
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If COD accepts the updated Student Identifier, Student Financial Planning uses the new Student Identifier information
for future COD transmissions and determines if a Common Record Message with the updated Student Identifier needs
to be sent. If the old student identifier information was used in prior communications with COD, Student Financial
Planning prepares and sends the Common Record Message to communicate the updated information.

However, if COD rejects the Student Identifier update, Student Financial Planning uses the old Student Identifier
information for future COD transmissions. When Student Identifier updates are rejected, Student Financial Planning
receives a warning/error/reject edit code, and that information is displayed in the Student Financial Planning user
interface, based on configuration, and follows the Exception Handling process to resolve all reject edit codes.

Updates borrower identifier information
When the student, borrower, or institution submits an ISIR Correction and updates a Borrower Identifier field (SSN/
Last Name/Date of Birth) a subsequent Central Processing System (CPS)/FAFSA Processing System (FPS) transaction
occurs. Student Financial Planning recognizes when an update is made to a Borrower Identifier field upon receipt of
a new ISIR or PLUS Application. When the new ISIR or PLUS Application is received, the first step is to confirm if the
update is applicable to a Graduate Student applying for a Graduate PLUS loan or a Parent/Step-Parent applying for a
Parent PLUS loan. Until it is confirmed that COD has accepted or rejected the update, Student Financial Planning stops
transmitting information to COD.

Note:  To confirm if the Borrower Identifier update is accepted or rejected by COD, Student Financial Planning
consumes the SSN/Last Name/Date of Birth Change Reports saved in the institution's Student Aid Internet Gateway
(SAIG) mailbox on a weekly basis.

When changing Borrower Identifier Information for a Parent PLUS loan, it is important to ensure that the borrower
information (SSN/DOB) does not match the student's identifier (SSN/DOB) information. When changing Borrower
Identifier Information for a Graduate PLUS loan, it is important to ensure all changes made to the Borrower Identifier
Information are reflected in the Student Identifier Information changes.

A PLUS Borrower's SSN update is allowed for only the following scenarios:

• If the PLUS award was disbursed within the past 24 hours

• If the PLUS loan is inactive

• If the PLUS disbursements have not been disbursed

• If the PLUS disbursement was only partially disbursed

If the Borrower is not the student, Student Financial Planning sends a Common Record message to the COD system
relaying the Borrower Identifier update. If the Borrower is the student, Student Financial Planning confirms if the
Student Identifier update was previously sent and if the update was accepted or rejected.

• If the Student Identifier update was sent and accepted, Student Financial Planning sends the Common Record
message to the COD system, relaying just the Borrower Identifier change.

• If the Student Identifier update was not sent, Student Financial Planning sends the Common Record message to
the COD system, relaying both the Borrower and Student Identifier changes.

If COD accepts the updated Borrower Identifier, Student Financial Planning uses the new Borrower Identifier information
for future COD transmissions. If COD rejects the Borrower Identifier update, Student Financial Planning uses the old
Borrower Identifier Information for future COD transmissions. When Borrower Identifier updates are rejected, Student
Financial Planning receives a warning/error/reject edit code, displays that information based on configuration, and
follows the Exception Handling process to resolve all reject edit codes.
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Configurable Attributes
This feature does not have any configurable features.

Late Disbursement Management  
Student Financial Planning triggers the Late Disbursement process when a student meets all Disbursement Criteria for
a prior Award Year or Loan Period that has a fund amount that did not disburse. Prior award years are evaluated for
grants, and loan periods are evaluated for loans.

Overview
Once a student is eligible for a Late Disbursement, an Outbound Disbursement Acceptance Message is sent to
the student to request confirmation for any loan funds and notify them of the grant late disbursement. Grants
disburse without a disbursement acceptance, but the student must accept or reject loan funds through disbursement
acceptance. The student can accept the full eligible amount, a reduced amount, or reject 100% of the eligible funds. If
the student accepts the full amount, the student does not require a repackage, and the funds are disbursed. When a
student accepts a reduced amount, the student record is repackaged according to the reduced accepted amount before
disbursing. If the student rejects 100% of the eligible funds, the funds are reduced to zero, and the funds are zeroed out
in the Common Origination and Disbursement (COD) system.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Determines late disbursements for active students
Student Financial Planning determines when an active student is eligible to receive a Late Disbursement so that the
student can be notified of the potential disbursement and can accept or reject the disbursement as part of the Federal
Student Aid (FSA) package. Student Financial Planning checks if the student has posted attendance in the payment
period for the current year to ensure that the student is still in attendance and use the Academic Year End Date to
determine when a disbursement becomes a Late Disbursement.

Evaluates late disbursement criteria for active students
Student Financial Planning evaluates and makes sure the following Late Disbursement Criteria has been met for active
students prior to the Award Year/Loan Period End Date:

• All Fund Types: The department processed an ISIR with an official SAI/EFC.

• FSEOG/TEACH: The Grant was awarded.

• Subsidized/Unsubsidized/PLUS Loans: The Loan was originated.

Student Financial Planning evaluates and makes sure the following Late Disbursement Criteria has been met for active
students prior to making the Late Disbursement:

• Pell & TEACH: A Valid ISIR has been received.

• Subsidized/Unsubsidized/PLUS Loans: Second disbursements require the student to complete the period for
which the loan is intended. This means an Enrollment Status for the period equaling one of the following:

◦ AC - Academic Complete.

◦ A - Approved Leave of Absence.
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◦ F - Full Time.

◦ H - Half-time or more, but less than full-time.

◦ L - Less than half- time.

Note:  You add, edit, or disable disbursement criteria using the Late Disbursement PWD Criteria Guide.

Student Financial Planning uses the Award Year/Loan Period End Date to determine when the student becomes
ineligible and creates the Late Disbursement no later than 180 days from that date.

Once the system determines that the disbursement is a Late Disbursement and the student is eligible to receive the
disbursement, the system:

• Stores an indicator showing that it is a Late Disbursement.

• Determines the Total Outstanding Charges.

• Checks whether the fund is a Title IV Loan in order to determine if Late Disbursement Acceptance is required.
Student Financial Planning changes the Disbursement Acceptance status when a Late Disbursement is
identified.

• Begins the disbursement process if it is a Title IV Grant.

Determines late disbursements for withdrawn/graduated students
Student Financial Planning determines when a Withdrawn/Graduated student is eligible to receive a Late Disbursement
so that the student can be notified of the potential Late Disbursements and can accept or reject the disbursement as
part of the FSA package. Student Financial Planning determines when the student Withdrew or Graduated from the
institution and make sure the disbursement is associated with a completed payment period.

Evaluates late disbursement criteria for withdrawn/graduated Students
Student Financial Planning evaluates and makes sure the following Late Disbursement Criteria has been met for
Withdrawn/Graduated students prior to the date the student became ineligible (withdrawal/graduation date):

• All Fund Types: The department processed an ISIR with an official SAI/EFC.

• FSEOG: The Grant was awarded.

• Subsidized/Unsubsidized/PLUS Loans: The Loan was originated.

• TEACH: The Grant was originated.

Student Financial Planning ensures the following conditions occur prior to making the late disbursement.

• Pell & TEACH: A Valid ISIR has been received.

• Subsidized/Unsubsidized/PLUS Loans: A First-Time-Borrower must complete 30 days of the program.

• Subsidized/Unsubsidized/PLUS Loans: Second disbursements require that the student to graduated in the
period for which the loan is intended.

Student Financial Planning uses the Withdrawal/Graduation Date to determine when the student becomes ineligible
and will create the Late Disbursement no later than 180 days from that date.

259

https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=u30005679


Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 10
Using Financial Information

Once the system determines that all of the conditions have been met, Student Financial Planning determine if the
payment period associated with the disbursement has already been completed and will:

• Follow the Post-Withdrawal Disbursement process, if the disbursement is associated with the payment period
that the student is withdrawing from.

• Store an indicator showing that it is a late disbursement.

• Determine the Total Outstanding Charges.

• Check whether the fund is a Title IV Loan in order to determine if Late Disbursement Acceptance is required.
Student Financial Planning changes the Disbursement Acceptance status when a Late Disbursement is
identified.

• Begin the disbursement process if it is a Title IV Grant.

Sends the disbursement acceptance information outbound message
Student Financial Planning creates and sends an Outbound Disbursement Acceptance Information Message to
communicate Late Disbursement information when a Late Disbursement is determined for a grant or loan. The
Disbursement Acceptance will be tracked and the Disbursement Acceptance will be updated appropriately when the
notification is sent and received. The Disbursement Acceptance Due Date will be determined using the configured
Acceptance Date.

However, Student Financial Planning does not accept a Disbursement Acceptance if 180 days have elapsed since:

• the completion of the Award Year/Loan Period for an Active student

• the Date of Determination (DOD) for a Withdrawn student

• the Graduation Date for a Graduated student

Receives the inbound disbursement acceptance message
Upon receiving a student's Disbursement Acceptance Message for a Late Disbursement, Student Financial Planning
updates the Accepted or Rejected Amount, updates the Disbursement Status and disburses funds accordingly. Student
Financial Planning accepts the Disbursement Acceptance Message up to the Late Disbursement Acceptance Due Date,
but will not accept it once that date has passed unless an authorized user has extended the deadline.

Updates the student package if disbursement acceptance is not received by due date
Student Financial Planning runs a batch job daily to identify all funds with an Acceptance Due Date. If the Disbursement
Acceptance Message is not received by the Due Date, the Disbursement Acceptance Status will be updated to
Disbursement Not Accepted by Due Date. Upon the Disbursement Acceptance Status update, the disbursement process
will begin and cancel associated disbursement(s).

When a disbursement is canceled, Student Financial Planning sends an Outbound Student Notification to communicate
to the student that the Late Disbursement has been canceled.

Configurable Attributes
Configure late disbursement acceptance due date
The institution can configure the Inbound Disbursement Acceptance Message deadline for each specific fund. If the
deadline is reached and the student has not responded to accept or reject the Late Disbursement, Student Financial
Planning cancels the Late Disbursement.

260



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 10
Using Financial Information

The Disbursement Acceptance Due Date must be configured to be no more than180 days past:

• the completion of the Award Year/Loan Period for an Active student

• the Date of Determination (DOD) for a Withdrawn student

• the Graduation Date for a Graduated student

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view Disbursements
Student Financial Planning User Interface > Student > Financial Information > Disbursing

Post-Withdrawal Disbursements  
When a student is eligible for a Post-Withdrawal Disbursement (PWD), Student Financial Planning notifies the student/
parent, consumes the fund amounts in the fund acceptance message received by the student/parent, determines if the
fund acceptance is acceptable based on configured due dates and updates, disburses or cancels funds as necessary.

What Student Financial Planning Automatically
Student Financial Planning automatically does the following things:

Evaluates post-withdrawal disbursement criteria
Student Financial Planning evaluates the student's record when a Return to Title IV (R2T4) calculation is completed.
Student Financial Planning determines specific PWD information, including: Total Outstanding Charges, Total PWD
Amount per fund, PWD Amount Applied to Open Charges, and PWD Amount Over Open charges.

PWD/LD Disbursement Criteria

Number Criterion Funds Required to Meet Criteria

1 Student has ISIR containing an SAI/EFC
processed on or prior to OLDA (PWD Criteria
has been evaluated within the R2T4 Process
following rules for Late Disbursements for
Withdrawn and Graduated Students).

All Title IV Funds must meet this criterion.

2 Date is less than 180 days past the OLDA (PWD
Criteria has been evaluated within the R2T4
Process following rules for Late Disbursements
for Withdrawn and Graduated Students).

All Title IV Funds must meet this criterion.

3 Student has the ISIR Status required (PWD
Criteria has been evaluated within the R2T4

All Pell, IASG, and TEACH must meet this
criterion.

261



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 10
Using Financial Information

Process following rules for Late Disbursements
for Withdrawn and Graduated Students).

4 Grant Payment Periods are required to be
completed prior to moving forward to a
subsequent payment period.

Note:  Description will not be displayed on
the UI.

All Pell, IASG, and TEACH must meet this
criterion.

5 Grant is awarded on or prior to OLDA (PWD
Criteria has been evaluated within the R2T4
Process following rules for Late Disbursements
for Withdrawn and Graduated Students).

AND FSEOG disbursements must also meet this
criterion.

6 Loan originated on or prior to OLDA (PWD
Criteria has been evaluated within the R2T4
Process following rules for Late Disbursements
for Withdrawn and Graduated Students).

AND Direct Loans must also meet this criterion.

7 First-Time, First-Year Borrower, student
completed 30 days of the program. Anticipated
Disbursement Date will never be set prior to 30
days for first-time borrowers.

Note:  Description will not be displayed on
the UI.

AND Direct Loans must also meet this criterion.

8 For a second disbursement, the student
graduated or completed the period for which
the loan was intended. (PWD Criteria has been
evaluated within the R2T4 Process following
rules for Late Disbursements for Withdrawn and
Graduated Students).

AND Direct Loans must also meet this criterion.

9 For a first disbursement, the student has
met at least half-time enrollment. For a first
disbursement, the system determines if the
student has begun attendance in enough
courses to establish half-time enrollment and
has the appropriate tag to meet the special
PWD criteria.

AND Direct Loans must also meet this criterion.

10 Grant originated on or prior to OLDA. (PWD
Criteria has been evaluated within the R2T4
Process following rules for Late Disbursements
for Withdrawn and Graduated Students).

AND TEACH disbursements must also meet this
criterion.

Note:  You add, edit, or disable disbursement criteria using the Late Disbursement PWD Criteria Guide.

Determines if fund acceptance: received by due date
The PWD Fund Acceptance can be received from the student/parent if they return documentation to the institution in
person, fax or email, via the student portal or from an external system up to the PWD Acceptance Due Date.
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Determines if fund acceptance: not received by due date
If the PWD Fund Acceptance is not received by the PWD Acceptance Due Date, Student Financial Planning removes
the PWD amount from the student's package and the disbursement is canceled. When the disbursement is canceled
Student Financial Planning notifies the student/parent.

Re-evaluates the PWD due to a new R2T4 calculation
If a new R2T4 calculation is completed and the PWD amount has changed, Student Financial Planning re-evaluates the
PWD. Student Financial Planning increases or decrease funds as necessary and notifies the student/parent the amount
has been adjusted.

Uses an extended PWD acceptance due date
If an authorized user extends the PWD Acceptance Due Date, Student Financial Planning uses the updated date to
determine if the PWD Disbursement Fund Acceptance is acceptable.

Configurable Attributes
Configure the PWD acceptance due date

You can configure the PWD Fund Acceptance Due Date for each specific fund so that the PWD is canceled if the PWD
Fund Acceptance is not received by the configured deadline. The time frame in which the student/parent is given to
make a decision must be 14 days or greater.

Extend the PWD acceptance due date

You can extend the PWD Acceptance Due Date for a specific student.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the R2T4 calculated PWD Student Financial Planning User Interface > Student > Financial Information >
R2T4 Information > Step 4

To view the Post-Withdrawal Disbursement
Student Financial Planning User Interface > Student > Financial Information > Disbursing

To view the Post-Withdrawal Disbursement Details
Student Financial Planning User Interface > Student > Financial Information > Disbursing > PWD Indicator

To view the Post-Withdrawal Disbursement Criteria
Student Financial Planning User Interface > Student > Financial Information > Disbursing > Sequence #
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Manual Overrides: Disbursing  

Overview of Disbursing Overrides for Title IV Funds  
This is a general overview of information to help you effectively override Title IV financial aid awards as needed using
the Student > Financial Information >  Disbursing UI.

You are able to manually override fund disbursements as needed. This is a summary of actions and impacts.

Edit the Anticipated Disbursement Date

• How: See Override Anticipated Disbursement Date.

• Impact: Once edited, the Anticipated Disbursement Date needs to be manually managed if further updates
are required as the system won't re-calculate the Anticipated Disbursement Date for that disbursement going
forward.

• Future Automation Impact: Yes.

Edit Disbursement Amounts for the Period

• How: See Override Disbursement Payment Period Amounts.

• Impact: The disbursements for the period are adjusted to reflect the total amount you override. The amount
for the period needs to be manually managed if further updates are required as the application won't re-
calculate the amount. The application will continue to automate the fund amounts within the package, but the
disbursements for that period won't be updated. The eligible amount in the package won't be automatically
adjusted based the disbursement amount overrides, so if the eligible fund amount isn't correct in the package,
use Packaging UI to make the edits instead. See Add, Edit, or Remove a TIV Fund.

• Future Automation Impact: Yes.

Override Disbursement Criteria

• How: See Override Disbursement Criteria.

• Impact: The disbursement criteria will be set to “met”, and the application will stop evaluating the criteria for
that disbursement.

• Future Automation Impact: Yes.

Override or Remove G5 Disbursement Information

• How: See Update G5 Details on a Single Disbursement.

◦ Use the Override button to adjust G5 fields.

◦ Use the Remove button to remove the G5 Control Number.

• Impact: G5 details will be updated based on user’s overrides and further downstream impacts will be adjusted.

• Future Automation Impact: No.

264



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 10
Using Financial Information

Using the Disbursement Administration UI versus the Disbursing UI
You are also able to update disbursement information using the Disbursement Administration UI in the FAS:
Administration > System Management  > Disbursement Administration.

When an authorized user updates disbursement information through the Disbursement Administration UI, the update
is a one-time manual override. The disbursement isn't put into manual mode; therefore, future automation is not
interrupted. Future automation or manual updates may override the one-time manual override a user made using the
Disbursement Administration tool. A common scenario for making updates using the Disbursement Administration UI
is to update the system to match changes that were made directly in the COD system, being careful to match the COD-
generated sequence number.

When updates are made through the Disbursing UI (Student > Financial Information > Disbursing), the disbursement
that is updated is put into manual mode and must be monitored throughout the duration of the payment period. If only
one fund type for one payment period is manually overridden, only that fund type for that payment period is put into
manual mode. If a disbursement is increased or reduced and it results in a need for additional disbursement sequence
numbers, Student Financial Planning will create any required additional sequence numbers, complete any related
math for that disbursement, set the disbursement status correctly. For more information on using the Disbursement
Administration UI, see Disbursement Administration.

Override Disbursement Criteria  
You can override the Disbursement Criteria status, on any disbursement per academic year, per fund in order to release
a student's disbursement if necessary.

Overview
You are able to view all disbursement information including each criterion that must be met in order to disburse and
whether the criterion status is Met or Not Met.

When Disbursement Criteria is overridden, Student Financial Planning requires you to enter a comment.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Override Disbursing Criteria

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's External Student ID Number in the Search Field
◦ Navigate to Student > Financial Information > Disbursing >

You will need to wait for the following batch jobs to run
◦ Origination File Delivery

◦ Student Disbursement Criteria Evaluation

◦ Disbursement File Delivery

2. Click the Sequence Number
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3. Click the Override All button if you want to override every criterion
4. Click the Override button next to an individual criterion to override just one criterion
5. Confirm or correct the answer to the question: Is the Disbursement Criteria Met? Yes/No
6. Enter Comment
7. Override the criteria
8. Close (once you finish overriding criteria)
9. Refresh screen, re-open the dialog box and confirm the Disbursement Criteria is overridden

Override Anticipated Disbursement Date  
You can update the Anticipated Disbursement Date.

Overview
To update the Anticipated Disbursement Date, use the date picker and select date equal to the current date or a future
date and enter a comment. Once the user has overridden the Anticipated Disbursement Date, Student Financial
Planning makes future updates automatically.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Override Anticipated Disbursement Date

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
Navigate to Student > Financial Information > Disbursing

2. Click the icon to update the Anticipated Disbursement Date

Note:  If the disbursement has already disbursed, you will see this icon in both the Date column
(Disbursement Date) and the Anticipated Disbursement Date column. If you try to update the Anticipated
Disbursement Date for a Disbursed, disbursement, the following error is returned by the system: Anticipated
Disbursement Date can't be overridden for that disbursement because it is in a status of DISBURSED.

3. Pick a Date (On or after Today's date)
4. Enter a Comment
5. Save
6. Confirm the Anticipated Disbursement Date updated

Override Disbursement Date  
You can update the Disbursement Date for any disbursed payment.

Overview
To update the Disbursement Date, use the date picker and select date equal to the current date or a future date and
enter a comment. Once the user updates the Disbursement Date, Student Financial Planning creates a new sequence
number and triggers the updated disbursement information to be sent to COD.
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Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Override Disbursement Date

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner

◦ Navigate to Student > Financial Information > Disbursing

2. Click the icon in the Date column to update the Disbursement Date

Note:  If the disbursement has already disbursed, you will see this icon in both the Date column
(Disbursement Date) and the Anticipated Disbursement Date column. If you try to update the Anticipated
Disbursement Date for a Disbursed, disbursement, the following error is returned by the system: Anticipated
Disbursement Date can't be overridden for that disbursement because it is in a status of DISBURSED.

3. Pick a Date (On or after Today's date)
4. Enter a Comment
5. Save
6. Confirm the Disbursement Date and the Anticipated Disbursement Date was updated

COD Updates: When the Disbursement Date changes, Student Financial Planning automatically triggers
communication to COD

7. Navigate to Student > USDE > Common Record File
8. Confirm Disbursement 1, Sequence 2 is the re-origination for the disbursement amount of Disbursement 1,

Sequence 1, with the updated Disbursement Date.

Override Disbursement Payment Period Amounts  
You can override the total disbursement amount a student should be getting in the Payment Period (PP).

Overview
You can select the award year associated to the PP to update, the updated amount, and the reason for the override. The
application updates remaining disbursement information according to logic to increase or decrease disbursements. This
includes:

• Create accurate disbursement and sequence numbers.

• Calculating incremental and total disbursement amounts.

• Setting appropriate disbursement statuses.

The PP disbursement amount is flagged as manually overridden, and the application won't update the amount in future
actions.

The application doesn't allow an update to the PP disbursement amounts when the disbursement status is Origination
Sent to COD (US Department of Education Common Origination and Disbursement process) or Disbursement Sent to
COD.
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When overriding the Payment Period Disbursement Amounts:

• Make sure to select the correct award year.

• Make sure to enter the correct dollar amount.

• Double check the amount if you are updating both PPs and make sure that the combination doesn't exceed the
amount the student is eligible to receive.

Note:  If you do not enter the Award Year or Dollar Amount values correctly, COD rejects the disbursement.

Required Role Permissions
The user must have a role with these General Permissions through Roles Management to complete the manual
processing steps:

• Student

• Disbursement Override

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Sign into the Student Financial Planning User Interface (UI).

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student > Financial Information > Disbursing.
3. Click Edit Disb Amts.
4. Confirm or update the Award Year.
5. Enter new PP Disbursement Amount.
6. Enter a comment.
7. Click Save.
8. Confirm updates on Disbursing page.
9. Repeat for additional PPs as needed.

Downstream Impact
Once you override the PP amount, monitor and manually update the disbursement as needed for that PP.

If any of these events occur, review the disbursement to determine if additional manual adjustments are required:

• Funds Acceptance.

• Repackage with fund amounts changing.

• Subsequent ISIRs.

• New NSLDS.

• Subsequent SAFIs that cause some cost of attendance change.

• Disbursement acceptance.

• Return to Title IV.

• Stale Dated Credit Balance Checks.

• Grant Overpayment Repayments.
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Example Scenario
A PP Disbursement Amount is overridden and increased. The student either completes the academic year, graduates,
withdraws, or dies prior to the increased funds disbursing. At that point, the application determines that the student
is eligible for a Late Disbursement and creates a new Disbursement Number. When the Late Disbursement Criteria
isn't Met by the Late Disbursement deadline, the application cancels the late disbursement amount and a Ready to be
Canceled QC Hold is placed on the Student Record. If that hold is automatically or manually released without the PP
Disbursement Amount being adjusted, the application creates another Disbursement Number each time the student is
repackaged.

Cycle of Events When Manually Updating a Payment Period Disbursement Amount

1. PP Disbursement Amount manually updated.
2. Student completed the academic year.
3. The application determines the Disbursement Amount doesn't match the overridden PP Disbursement

Amount.
4. The application creates a new disbursement and determines it is a Late Disbursement.
5. Late Disbursement Criteria isn't Met.
6. The application cancels the Late Disbursement.
7. The Ready to be Canceled QC Hold associated with the Late Disbursement is released. The cycle repeats if the

Ready to be Canceled QC Hold is released and the PP Disbursement Amount isn't adjusted.
8. Student is Repackaged and the application determines the disbursement amount doesn't match the overridden

PP Disbursement Amount.
9. The application determines the Disbursement Amount doesn't match the overridden PP Disbursement

Amount.
10. The application creates a new disbursement and determines it is a Late Disbursement.
11. Late Disbursement Criteria isn't Met.
12. The application cancels the Late Disbursement.
13. The Ready to be Canceled QC Hold associated with the Late Disbursement is released.
14. Student is Repackaged, and the application determines the disbursement amount doesn't match the

overridden PP Disbursement Amount.

How to Avoid Repeating the Cycle

To prevent this cycle from continuously repeating, when you are reviewing the Ready to be Canceled QC Hold, you
should take one of two paths:

1. Determine the student is eligible for a Late Disbursement and take steps to disburse the funds:
a. Update the PP Disbursement Amount if needed.
b. Update the Late Disbursement Criteria to Met from the disbursing screen.
c. Remove the Cancellation Reason & Date through the Disbursement Administration page.
d. Re-Originate through the Disbursement Administration page.

2. Determine the student isn't eligible for a Late Disbursement and take steps to stop disbursing the increased
amount:

a. Update the PP Disbursement Amount.
b. Release the Ready to be Canceled QC Hold.
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Update Fund Award Year Close Out  
When the award year close-out date is met for a fund type, Student Financial Planning cancels any remaining pending
disbursements and limits updates to awarding, packaging, and disbursing. Canceling non-disbursed funds prevents
funds from being disbursed and drawn down in the closed-out award year.

Overview
If a return or a re-entry within 180 days creates a disbursement in a closed-out award year, Student Financial Planning
creates an Update Fund Award Year Closeout Date task for manual review and you will be able to determine if the
award year needs to be re-opened so processing can continue within the Student Financial Planning system. Once you
complete the task to re-open an award year, Student Financial Planning triggers the repackage with the re-opened
award year.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Cancels disbursements in closed-out award year
When the Student Financial Planning system date is equal to a configured award year close-out date for a fund type,
Student Financial Planning cancels all pending disbursements associated to the closed-out award year for Title IV and
non-federal fund types. If the institution re-opens an award year by extending the configured close-out date for the
fund type, Student Financial Planning will re-trigger the process to cancel any pending disbursements once the new/
updated award year close-out date has been reached.

Updates award year for cross-over periods
Student Financial Planning evaluates all periods for a given fund type that have closed-out to determine whether the
award year can be updated for the period. If the award year can be updated for a period, Student Financial Planning
calculates the student's fund eligibility for that period using the updated award year. When the award year for a period is
updated due to an award year close-out, Student Financial Planning does not create any new disbursements under the
new award year, until all disbursements from the closed-out award year are canceled.

Once an award year has been updated for a period due to the award year close-out, Student Financial Planning does
not revert the period to the previous award year even if the award year is re-opened. If the student re-enters, Student
Financial Planning ensures that the award year is not updated for the period in which the student has re-entered, even
if the award year has closed-out and all award year update criteria have been met. Student Financial Planning evaluates
whether the award year close-out date has occurred each time eligibility has been calculated for a period (e.g. payment
period, loan period).

Student Financial Planning only updates the award year for Title IV fund types.

Limits updates to disbursements in closed-out award years
Once the award year has closed-out for a fund type, Student Financial Planning ensures that disbursements are not
updated/processed within the closed-out award year for both Title IV and non-federal fund types. Student Financial
Planning limits disbursement amounts from being created within the closed-out award year. However, returned
disbursements can be created for a closed-out award year (e.g. due to R2T4 calculation) and disbursements can
potentially be created in a closed-out award year if the academic year evaluated is part of a re-entry within 180 days.

Student Financial Planning only allows disbursements to be processed if the award year is open for the fund type.
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Limits awarding of funds in close-out award years
After the configured award year close-out date for a fund type has passed, Student Financial Planning ensures that
funds are not awarded or updated within the close-out award year.

Configurable Attributes
Configure the award year close-out date
The institution can configure the award year close-out date.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps:

• Student

• Update Fund Award Year Closeout

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Dashboard > Task Overview > Update Fund Award Year Close Date
2. Start Task
3. Review Student Records within the task
4. Enter the student's external student ID number in the search field located in the upper right-hand corner

◦ Navigate to Student > Financial Information > Disbursing
5. Click the Sequence Number to review the cancellation reason
6. Review the Cancellation Reason
7. Close
8. Navigate back to the Task (click the Task in the menu bar or use the following path: Dashboard > Task

Overview > Update Fund Award Year Close Date > Resume task)
9. Complete task to re-open the award year for all students/funds contained in the task

Troubleshooting Stuck Disbursements  
You troubleshoot disbursement issues.

Disbursing
To utilize manual features, you must have the associated Role Permissions. Disbursement Administration Role
Permissions should be limited to users with extensive knowledge of the Student Financial Planning system and its
data exchange interactions. Manual mode should be used by experienced users with an in-depth knowledge of the
downstream impacts.

Note:  Manual updates should be made where it will have the most impact on downstream processing.

For example, if a Disbursement Amount is inaccurate, the user must determine if the update should be made at the
Fund Level (Packaging Screen) or at the Disbursement Level (Disbursing Screen). If the Fund Amount (Packaging
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Screen) is updated, future re-packages will not impact Disbursements downstream. However if the Disbursement
Amount is updated (Disbursing Screen), future re-packages could cause the Disbursement Amount to be updated,
resulting in an inaccurate Disbursement Amount due to new information.

Troubleshooting disbursements that have remained in a "Ready to be Sent to COD" or
"Sent to COD" status
An authorized user can update the disbursement status through the Disbursement Administration tool. A user may
want to do this if they feel the disbursement has gotten stuck on a specific status and needs to be picked up in the next
origination or disbursing batch job and re-sent to COD.

Origination Ready to be Sent to COD or Origination Sent to COD
If an origination has been in a status of Origination Ready to be Sent or Origination Sent to COD status check the
following:

1. Make sure the student meets Origination Criteria
a. Anticipated Disbursement Date has been set
b. Disbursement Amount has been set
c. Student must have an acceptable enrollment status (based on configuration)
d. Student must have an acceptable admissions status (based on configuration)

2. If the student's disbursement has an Anticipated Disbursement Date, Disbursement Amount and has met
Origination Criteria, update the disbursement status using the Disbursement Administration Tool

3. Update the Disbursement Status to Disbursement Scheduled
a. Click the Save Disbursement Records button
b. Click the Re-Originate link, (not the Send Originations to COD button)

Disbursement Ready to be Sent to COD or Disbursement Sent to COD
If a disbursement has been in a status of Disbursement Ready to be Sent or Disbursement Sent to COD status check the
following:

1. Review the Common Record Information screen and make sure the disbursement has an Accepted origination
record

2. Review the Disbursement Criteria and make sure all Disbursement Criteria have been met
3. If the disbursement has an Accepted origination and all Disbursement Criteria have been met, update the

disbursement status using the Disbursement Administration Tool
4. Update the status to Origination Accepted

a. Click the Save Disbursement Records button
b. Click the Re-Originate link, (not the Send Originations to COD button)

QC Reviewed (Title IV funds only)
If a disbursement has been in a status of QC Reviewed status check the following:

1. Check the QC hold(s) for the disbursement has been Released.
2. If the hold(s) have been released check the following:

a. Student has met all Disbursement Criteria.
b. Student has an Accepted origination record for the disbursement in question.

3. Update the status to Origination Accepted.
a. Click the Save Disbursement Records button.
b. Click the Re-Originate link, (not the Send Originations to COD button).
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Fixing multiple disbursements
If there are multiple disbursements that are stuck, you may need to update them one at a time based on status and
sequencing.

Related Topics
• Disbursing

Fund Eligibility  
You can view a summary of fund eligibility for selected Federal student financial aid programs.

Overview
The Fund Eligibility page provides a consolidated view of all criteria required for a student's current disbursements by
fund type for these Federal programs:

• Pell Grant (PELL).

• Direct Loan - Subsidized (DSUB).

• Direct Loan - Unsubsidized (DUNSUB).

• Iraq and Afghanistan Service Grant (IASG).

• Parent Loan for Undergraduate Students (PLUS).

• Graduate PLUS (GPLUS).

• Supplemental Economic Opportunity Grant (FSEOG).

• Teacher Education Assistance for College and Higher Education Grant (TEACH).

This page is a read-only consolidated view of data that is displayed across other pages in the UI. You can't add, edit, or
delete any data on this page.

Note:  The page logic loops through the disbursement payments in order of Disbursement Number then Sequence
Number and returns the first disbursement that isn't in Disbursed status. Therefore, if Payment Period 1 and 2
aren't disbursed, Disbursed Student Financial Planning displays the disbursement for Payment Period 1 until it is
disbursed. When the Payment Period 1 disbursement is disbursed, the Fund Eligibility page displays results for the
next disbursement.

Navigation to the Student Financial Planning User Interface Functionality
To View the Fund Eligibility Screen
Student Financial Planning User Interface > Student > Student Record > Financial Information > Fund Eligibility

Required Role Permissions
You must have a role with the following General Permissions through Roles Management to view the Fund Eligibility UI.

• Fund Eligibility Viewer
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Set General Permissions Matrix

Eligibility Matrix
The page displays an eligibility matrix with the columns representing the Fund Types and the rows representing fund
criteria.

There are tabs to select different Award Years labeled Year 1, Year 2, and so on.

For each Fund Type, the Award Year, Next Disbursement for Fund (a date), and Disbursement Amount are displayed.

The Fund Criteria are grouped by:

• ISIR Criteria

• Eligibility Criteria

• Awarding Criteria

• Remaining Actions needed to Disburse

Each row displays:

• a fund criterion.

• a criterion Owner. This is the party responsible for meeting the criterion and is hardcoded to the criterion:
◦ University.

◦ Student.

• Whether the criterion is:
◦ Met.

◦ Not Met.

◦ N/A.

Note:  Not all Eligibility Criteria are applicable to each Fund Type. If a specific criterion isn't applicable
to a Fund Type, the cell displays N/A. For example, a completed TEACH Agreement to Serve is only
applicable for the TEACH fund type; for every other Fund Type, the criteria displays N/A.

Note:  You can configure custom criteria to display on this page. See Disbursements Guide. Custom criteria are only
displayed if the applicable Fund Type has been awarded to the student.

ISIR Criteria
• All requested documents have been received by the student:

◦ The student doesn't have any documents in a Requested or Received status.

• ISIR Review has been completed:
◦ The ISIR process is complete and the ISIR is Valid.

◦ The student doest not have a pending Complete ISIR Review task.

• ISIR Verification has been completed:
◦ If the ISIR status is Valid, this updates to Met.

◦ If the ISIR status isn't Valid, the system checks the latest ISIR "Student Is Selected For Verification" flag:
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- If the "Student Is Selected For Verification" flag is "Selected", the Verification criteria isn't Met.

• ISIR received for the student for Award Year and ISIR is Valid/Unverified and Active:

◦ Student Financial Planning evaluates the Required ISIR Status in order to Award and/or Disburse funds.

Fund Required ISIR Status for Estimating/
Awarding/Disbursing Fund

Required ISIR Status for Projecting Fund

Pell Valid Unverified

IASG Valid Unverified

FSEOG Unverified or Valid The system never projects FSEOG.

TEACH Unverified or Valid Based on the latest Unverified or Valid ISIR for
the award year, the system always deems the
fund eligible for estimation/awarding; however,
 there may be other inputs into the fund that
may cause the fund to be "projected".

Sub Valid Unverified

Unsub Unverified or Valid Based on the latest Unverified or Valid ISIR for
the award year, the system always deems the
fund eligible for estimation/awarding; however,
 there may be other inputs into the fund that
may cause the fund to be "projected".

PLUS Unverified or Valid Based on the latest Unverified or Valid ISIR for
the award year, the system always deems the
fund eligible for estimation/awarding; however,
 there may be other inputs into the fund that
may cause the fund to be "projected".

Grad PLUS Unverified or Valid Based on an Unverified or Valid ISIR, the system
always deems the fund eligible for estimation/
awarding; however, there may be other inputs
into the fund that may cause the fund to be
"projected".

Eligibility Criteria
• Student is Eligible for the Fund:

◦ The Fund Type is greater than $0.00.

• PLUS Credit Decision is received and accepted:

◦ If a student/parent is applying for PLUS loan a PLUS Application with an approved/accepted Credit
Decision must be received.

◦ If a student/parent is requires an endorser, an approved/accepted Credit Decision must be received.

• TEACH Agreement to serve has been completed:

◦ If a student is eligible for TEACH, the TEACH Agreement-to-Serve documentation is required.

• TEACH Counseling Acknowledgement has been completed:

◦ If a student is eligible for TEACH, the TEACH Counseling Acknowledgement is required.
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Awarding Criteria
• NSLDS Loan History has been received:

◦ An NSLDS Financial Aid History (FAH) file is required for funds to be packaged.

◦ An NSLDS FAH file has been received:
- For funds to update from Projected/Estimated to Awarded, the NSLDS must have been received

within the past 30 days.
- However, this criteria is Met if any FAH file has been received.
- Note:  Awarded funds should not be removed if the NSLDS has been received and then 30 days

elapses.

• Student has an acceptable Admissions Status:

◦ RG - Regular

◦ AM - Admitted

◦ PV - Provisional

• Student has an acceptable Enrollment Status:

◦ F - Full Time.

◦ H - Half-time or more, but less than full-time.

◦ L - Less than half- time.

◦ A - Approved Leave of Absence.

◦ X - Never Attended.

◦ G - Graduated.

◦ W - Withdrawn (voluntary or involuntary).

◦ AC - Academic Complete.

◦ AM - Admitted/Not Started.

• Student has an acceptable Academic Status:

◦ RG - Regular.

◦ AP - Academic Probation.

• Student within 30 Days of Academic Year Start Date:

◦ The current date must be within the configured time frame (for example, 30 days) from the start date of
the Academic Year for funds to be Awarded.

• Student within 30 Days of Enrolled/Scheduled Class:

◦ The student's first course in the Academic Year must be in an Enrolled/Scheduled status and be
scheduled to start within the configured time frame (for example, 30 days) for funds to be Awarded.
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Remaining Actions needed to Disburse
• Academic Related Activity (ARA) has Posted in First Course of NFR Term:

◦ Student must post attendance in the first course of the NFR term for any Non-Federal Fund type to
disburse.

Note:  This is a delivered Disbursements.csv configuration.

• Awarding QC Hold doesn't exist for Loan Payment Period associated to the fund:

◦ The Award Amounts Determined can't be in an On Hold status for loan funds to disburse.

• Awarding QC Hold doesn't exist for NFR (NFF) Period associated to the fund:

◦ The Award Amounts Determined can't be in an On Hold status for non-federal funds to disburse.

• Awarding QC Hold doesn't exist for Payment Period associated to the fund:

◦ The Award Amounts Determined can't be in an On Hold status for grant funds to disburse.

• COD has accepted an origination of the fund:

◦ The fund must have been in a Disbursement Status of Origination Accepted.

◦ You can validate this on the Common Record Information page.

• Disbursement hasn't been canceled:

◦ If the fund has been canceled, funds aren't disbursed.

• Disbursement isn't on hold:

◦ If a COD Request has been "Sent", funds don't disburse if there is an associated Packaging Hold.

◦ If there is an associated QC Hold in an On Hold status for the fund type, the funds aren't disbursed.

• Disbursement Acceptance is Received and Status is Set:

◦ If the student is eligible for a Late Disbursement or Post Withdrawal Disbursement, the funds don't
disburse until Disbursement Acceptance has been received, and the status is Accepted

• Disbursement Acceptance is Set:

◦ If the student is eligible for a Late Disbursement or Post Withdrawal Disbursement, the funds don't
disburse until Disbursement Acceptance has been received, and the status is Accepted

• Fund Allocation is ready to be disbursed:

◦ If the fund is part of a Fund Allocation, for example, FSEOG, the Allocation Period must be ready to be
disbursed.

◦ Funds Ready for Disbursement indicator must be equal to True.

• Fund has been Accepted by Student if Required:

◦ If Fund Acceptance is required, funds won't disburse until Fund Acceptance is received

◦ Fund Acceptance status should be equal to Accepted or Pending Additional Acceptance Awarded funds
shouldn't be removed if the NSLDS has been received and then 30 days elapses.

Note:  Students are required to accept 100% of any eligible Subsidized funds before Unsubsidized
funds disburse.

• Fund has been Awarded:

◦ Funds don't disburse while in a Fund Status of Projected or Estimated .

• Fund isn't pending Re-evaluation:
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◦ Non-Federal Funds don't disburse if they are pending Re-evaluation.

• PLUS Credit Requirements Have been met:

◦ Student must have an approved/accepted Credit Decision, if applicable.

◦ If the file type associated to the Final Credit Decision Status is CRSP or CRCS for the academic year
associated to the PLUS disbursement, then the <CreditRequirementsMet> tag must be equal to True.

• Student has Academic Related Activity in the Payment Period that the fund is being disbursed for:

◦ Student must have at minimum one Academic Related Activity (ARA) for the Payment Period.

◦ You can validate this by reviewing the Program Information.

• Student is Active and not on LOA:

◦ If the student is on an approved Leave of Absence (LOA), any pending disbursement is paused, and the
Anticipated Disbursement Date is updated to be the day after the student returns from the LOA.

• Student is Active or on LOA:

◦ Student must be in an Active Status for funds to disburse.

• Student isn't on LOA:

◦ Student isn't on an approved LOA.

Note:  This is a delivered Disbursements.csv configuration.

• Student isn't on hold:

◦ The Student Record Hold indicator must be equal to FALSE for fund to disburse.

• Student's "Entrance Counseling" has been Completed and isn't "Disqualified":

◦ Student is required to complete Entrance Counseling.

Note:  This is a delivered Disbursements.csv configuration.

• Student's ISIR needed for disbursement is in eligible status:

◦ Status must be equal to Valid or Unverified, depending upon Fund Type, for funds to disburse.

• Student's Package isn't Pending Manual Review:

◦ The student's packaging status isn't equal to Pending Repackage.

• Student's SAP has been completed and isn't "Disqualified":

◦ SAP status cannot be in a status of FD - Financial Aid Disqualification.

◦ SAP status can be in any of the following statuses:
- RG- Regular.
- FW - Financial Aid Warning.
- FP - Financial Aid Probation .

• Student has fully accepted their Subsidized Loan if awarded.

• Transfer monitoring request to NSLDS was made more than 7 days prior to the system date:

◦ Because the student is submitted to the Transfer Monitoring List, the student's NSLDS FAH file must be
requested a minimum of 7 days prior to the funds disbursing.
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Grant Overpayments  
Student Financial Planning automatically notifies the student when a Grant Overpayment exists in order for the student
to resolve the overpayment and remain eligible for Title IV funds.

Overview
If the student does not resolve the overpayment, the system triggers a Review Grant Overpayment and Notify NSLDS
and DRS task so an authorized user can report the overpayment to NSLDS and Debt Resolution Services (DRS).

Note:  Amounts less than $50 are not considered a Grant Overpayment and will not be required to be returned.

Status Definitions

Status Description

Not Reported: Grant Overpayment exists on the student record, but the overpayment has not been reported to
NSLDS or referred to DRS

Reported: Grant Overpayment exists on the student record and the overpayment has been reported to NSLDS or
referred to DRS

Resolved: Grant Overpayment on the student record has been resolved and set to zero

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Determines if there is a grant overpayment
Student Financial Planning determines if a Grant Overpayment exists in Step 10 of the R2T4 process. Overpayments are
tracked at an aggregate and fund specific level. If the Grant Overpayment is less than $50, it is not considered a Grant
Overpayment.

If the student has a Credit Balance it is applied to the Grant Overpayment as long as the Grant Overpayment was created
due to automation. If an existing Credit Balance is in a Pending status, the Grant Overpayment process is placed on hold
until the status of the Credit Balance is no longer Pending.

The student remains eligible for the Title IV funds during the allowable time frame subsequent to the Grant
Overpayment Student Notification sent date (based on configuration).

Sends student notification(s) when there is a grant overpayment
Student Financial Planning sends a notification to the student and institution to communicate a Grant Overpayment
exists and the next steps required to resolve the overpayment. Notifications are sent no later than 30 days from the Date
of Determination (DOD).

Note:  Notifications are sent when an overpayment is identified, updated, or when a payment is applied.
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Receives the payment information
When Student Financial Planning receives payment information for a Grant from an external system (i.e. Student
Information System), the student's record is updated based on repayment priority.

Sends the return to lender message for grant overpayment returns
Student Financial Planning communicates with external systems by sending a Return to Lender message after a grant
overpayment, payment is received to return funds to either the lender or DRS, (depending on the overpayment status of
Reported or Not Reported). Grant overpayment payments are applied based on a defined repayment priority.

Triggers a task so a user can review the student's payment record before
reporting an overpayment to NSLDS/DRS
If the student does not resolve an overpayment within the allowable time frame, Student Financial Planning triggers a
Review Grant Overpayment and Notify NSLDS and DRS task. An authorized user can report the overpayment to NSLDS
and Debt Resolution Services (DRS) if the student's payment record does not reflect that the overpayment has been
resolved. Likewise, if a student has been reported to NSLDS and DRS, if the student makes a payment in an effort to
resolve the overpayment, Student Financial Planning triggers a Report Grant Overpayment Resolution to NSLDS and
DRS task. The user can then report to NSLDS and DRS that the student has resolved the Grant Overpayment.

Sends outbound message(s) to update NSLDS/DRS
When either the Review Grant Overpayment and Notify NSLDS and DRS task or the Report Grant Overpayment
Resolution to NSLDS and DRS task is completed, the system sends an outbound message and letter to DRS so that the
Department of Education is updated on the current state of the Grant Overpayment.

Configurable Attributes
Configure the outbound student notification
The Institution can configure the notification message that is utilized to inform students of a Grant Overpayment, the
next steps to take and the time line to resolve the overpayment.

The notification should communicate the following (based on 2013-2014 regulations):

• The student owes an overpayment of Title IV funds

• The student’s eligibility for additional Title IV funds will end if the student fails to take positive action by the
45th day following the date the school sent notification to the student.

• There are two positive actions a student can take to extend eligibility for Title IV funds beyond 45 days:

◦ Repay the overpayment in full to the institution

◦ Sign a repayment agreement with the Department of Education

• If the student fails to take one of the preceding positive actions during the 45-day allowable period, the
student’s overpayment will be reported immediately to NSLDS and referred to Debt Resolution Services for
collection

The student can contact the school to discuss options

Navigation to the Student Financial Planning User Interface Functionality
To View the Grant Overpayment Screen
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Student Financial Planning User Interface > Student Record > Student > Financial Information > Grant Overpayment

Student Financial Planning User Interface > Student Record > Student > Financial Information > Grant
Overpayment

To View the Grant Overpayment from the R2T4 Screen
Student Financial Planning User Interface > Student Record > Student > Financial Information > R2T4
Information > Step 10

Report Grant Overpayment Resolution to NSLDS and DRS  
If a student has been reported to NSLDS and DRS due to an unresolved Grant Overpayment, if the student makes a
payment in an effort to resolve the overpayment or re-enters the institution, Student Financial Planning triggers a
Report Grant Overpayment Resolution to NSLDS and DRS task.

Overview
You can complete the task in order to report to NSLDS and DRS that the student resolved the Grant Overpayment.

When the Report Grant Overpayment Resolution to NSLDS and DRS task is completed, the system sends an
outbound message and letter to DRS so that the Department of Education is updated on the current state of the Grant
Overpayment.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Grant Overpayment Resolution Task Review

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Dashboard > Review Grant Overpayment and Notify NSLDS and DRS
2. Start task
3. Complete task

Resolve Grant Overpayment

Review the student record for payments to ensure they have resolved the Grant Overpayment and complete the
task if the overpayment is resolved.

Review Grant Overpayment And Notify NSLDS and DRS  
If the student does not resolve an overpayment within the allowable time frame, Student Financial Planning triggers a
Review Grant Overpayment and Notify NSLDS and DRS task.
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Overview
You can report the overpayment to NSLDS and Debt Resolution Services (DRS) if the student's payment record does
not reflect that the overpayment has been resolved. Likewise, if a student has been reported to NSLDS and DRS, if the
student makes a payment in an effort to resolve the overpayment, Student Financial Planning triggers a Report Grant
Overpayment Resolution to NSLDS and DRS task. The user can then report to NSLDS and DRS that the student has
resolved the Grant Overpayment.

When the Review Grant Overpayment and Notify NSLDS and DRS task is completed, the system sends an outbound
message and letter to DRS so that the Department of Education is updated on the current state of the Grant
Overpayment.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Grant Overpayment Task Review

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Dashboard  > Review Grant Overpayment and Notify NSLDS and DRS task queue
2. Start task
3. Complete task

Resolve Grant Overpayment

Review the student record for payments to ensure they have resolved the Grant Overpayment and complete the
task if the overpayment is resolved.

Non-Federal Funds  
Non-Federal funds can be added through the Student Academic and Financial Information message or the Student
Financial Planning (SFP) FAS UI. CommonLine Loans are managed by uploading and processing CommonLine files.

Campus Funds: Non-Federal Funds
Provides a Non-Federal Funds Workflow
Student Financial Planning provides a workflow to assist the user in making the final determination whether a student is
eligible for a state grant and the amount the student is eligible to receive.

Determines Non-Federal Funds periods
Student Financial Planning displays the Non-Federal Funds period(s) and additional detailed information in the Non-
Federal Funds workflow based on the period start and end dates in order to determine how much to award the student
during the period.
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A list of all periods is displayed and Student Financial Planning automatically determines the period start and end dates
(based on configuration) in the fund configuration engine. The maximum number of consecutive days the student is on
a break within the Non-Federal Funds period start and end dates, excluding institutional breaks and exemptions made
by the institution because of inclement weather or an administrative error are also displayed.

Awards or Estimates an amount per period
Student Financial Planning automatically calculates the student's Non-Federal Fund period award amount (if
configured) or allows a user to manually set the award amount so that the packaging engine can package the Non-
Federal Fund. Student Financial Planning allows the user to manually modify the Non-Federal Fund period award
amount and updates the status to Estimated or Awarded.

Adds Non-Federal Funds to the academic year
Once a user determines the student is eligible for the fund, Student Financial Planning adds the fund to the appropriate
academic year within the student's package.

Student Financial Planning determines which Borrower-Based Academic Year (BBAY) to package the award is based on
the Non-Federal Fund period start date. If the user is modifying a Non-Federal Fund, Student Financial Planning verifies
the fund is added to the appropriate academic year again. Student Financial Planning sets the maximum projected
award amount for each academic year being Estimated or Awarded by completing a summation of all Non-Federal Fund
period award amounts within the academic year.

If the fund has an associated configured fund allocation, Student Financial Planning makes sure there are sufficient
funds prior to adding the award to the student's package.

Student Financial Planning disburses the Non-Federal Fund as one disbursement equal to the maximum Non-Federal
Fund projected award amount and sets or updates the disbursement dates for each Non-Federal Fund period being
awarded. If the fund has already been disbursed, Student Financial Planning does not update the disbursement dates.

Student Financial Planning creates a Re-Evaluate NFF Fund task
Student Financial Planning creates a Re-Evaluate NFF Fund task at various points in the financial aid process that
requires a user to review the student's award. A separate alert is created for each Non-Federal Fund that has been
reduced by the packaging engine due to an over award situation and when the fund amount accepted does not equal
the maximum projected award up to packaging limit.

Student Financial Planning creates a Process an NFF Document task
When a Non-Federal Fund document with a configured document code is received for a student that requires review for
Non-Federal Fund to be packaged, Student Financial Planning creates a Process an NFF Document task and requires a
user to review the document. When the document/document code is received it's required to complete the Financial Aid
Documentation Collection process. Once it has completed the document collection process, Student Financial Planning
creates a new Process an NFF Document task for each configured Non-Federal Fund document received for the student.

Campus Funds: Student Resources
Determines which academic year to apply Student Resources
Student Financial Planning determines how to associate a fund from the student resource tag in the Student Academic
and Financial Information (SAFI) message by the academic year associated with the course the student resource is tied
to. If the student resource fund is not tied to a course, Student Financial Planning uses the academic year found in the
ledger posting date.

If Student Financial Planning is unable to associate a student resource fund to the student's academic year or the
correct fund configuration is not in place in the fund configuration engine, Student Financial Planning utilizes the
exception handling process.

Sets the fund amount and fund status
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Student Financial Planning sets the actual fund amount and fund status after the fund is associated to an academic
year. The actual fund amount is equal to the student resource amount and the fund status is updated to Awarded. If a
SAFI message is received for a student and it contains more than one student resource that shares the same fund code,
these student resources are listed as separate entries in the student's package.

Triggers a repackage if Student Resources affect the package
Student Financial Planning determines whether the addition of a student resource fund (or updated information) affects
the student's current package for the associated academic year and automatically repackages the student with the
updated information upon receiving a new student resource.

CommonLine Loans
See CommonLine Loans.

Configurable Attributes
Configure Fund Attributes
The institution can configure certain attributes in order for funds to be awarded properly.

Configure Student Resource Funds
Student Financial Planning is able to account for funding that has been provided to the student outside of Student
Financial Planning through the student resource tag within the SAFI Message. In order to ensure that Student
Financial Planning understands how to handle the received fund amount, the fund has to be configured in the Fund
Configuration Engine. Configuration for the fund within the Fund Configuration Engine allows Student Financial
Planning to understand what Borrower Based academic year (BBAY) to place the fund in, if the fund goes towards
funding up to the COA, and other such items that help Student Financial Planning on the packaging and advisory side.

It should be noted that any received fund amounts through the student resource tag should not be adjusted by Student
Financial Planning in the student's package, even if the fund is lower in priority than a Title IV fund. (e.g. if Student
Financial Planning is packaging a student up to COA and they've hit COA without accounting for the student resource
fund, the Packaging Engine reduces the funds that are higher in priority within the Fund Configuration Engine to
account for all of the student resource funds).

If the fund is unknown to Student Financial Planning because it is not configured via the Fund Configuration Engine,
Student Financial Planning does not process the fund and the fund goes through the Student Financial Planning
exception handling process.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
Student Financial Planning User Interface > Student > Financial Information > Non-Federal Funds

Student Financial Planning User Interface > Student > Financial Information > Non-Federal Funds

284



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 10
Using Financial Information

Add Non-Federal Fund  
You can manually add Non-Federal Funds to the student's package through the Student Financial Planning user
interface.

Overview
Simply select the type of non-federal fund and the associated award year. Upon the request to add the non-federal fund
to the student's package, Student Financial Planning runs an initial eligibility check (based on configuration). You are
able to immediately see if student record fails any of the configured eligibility checks. It is important that you also check
any eligibility criteria that is not configured to be checked by the system before certifying the fund is eligible. If the user
fails any of the eligibility items, you can bypass the configured system check and continue by certifying the student is
eligible for the fund.

When you certify the student is eligible for the fund, Student Financial Planning displays the input data fields. Enter all
the required data for each individual period and add additional periods if necessary and then save. Once the fund has
been added and the student record is repackaged, you can see the non-federal fund in the student's package.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• NFF Workflow

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student > Financial Information > Non-Federal Funds
3. Choose a fund type to add
4. Select the associated award year
5. Click the Select Fund Type
6. Review the eligibility requirements that Student Financial Planning automatically checks

Note:  Review and verify any other eligibility criteria necessary based on institutional policy before certifying
the fund.

7. Check box to certify the student is eligible to receive the fund
8. Enter all input data for each non-federal fund period
9. Add additional periods as needed

10. Save

Edit Non-Federal Funds Period  
You can Edit a Non-Federal Fund Period through the Student Financial Planning user interface.
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Overview
Simply select the award and period to modify and update the data input fields as necessary. After updating a non-
federal fund period, a repackage is triggered and once complete the updates should be visible on the packaging screen.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• NFF Workflow

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student > Financial Information > Non-Federal Funds
3. Choose a fund type and award year to edit
4. Update data inputs as necessary
5. Save

Remove Non-Federal Fund  
You can remove a Non-Federal Fund from the student's package through the Student Financial Planning user interface.

Overview
Simply select the award and period to remove and update the data input fields as necessary. After updating a non-
federal fund period, a repackage is triggered and once complete the updates should be visible on the packaging screen.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• NFF Workflow

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
Navigate to Student  > Financial Information > Non-Federal Funds

2. Choose a fund type and award year to remove
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3. Update Add to Package data input to No
4. Update Award Amount data input to $0.00
5. Save

Process An NFF Document - Task  
When a Non-Federal Fund document with a configured document code is received for a student that requires review for
Non-Federal Fund to be packaged, Student Financial Planning creates a Process an NFF Document task and requires a
user to review the document.

Overview
When the document/document code is received it's required to complete the Financial Aid Documentation Collection
process. Once it has completed the document collection process, Student Financial Planning creates a new Process an
NFF Document task for each configured Non-Federal Fund document received for the student.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• NFF Forms Task Review

• NFF Workflow

• Document Permissions associated with Non-Federal Funds

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Dashboard  > Re-Evaluate NFF Fund task queue
2. Start task

Tip:  Review the Non-Federal Fund Document(s) and determine what needs to be done next. Make updates
as needed.

3. Complete task.

Re-Evaluate NFF Fund - Task  
Student Financial Planning creates a Re-Evaluate NFF Fund task at various points in the financial aid process that
requires a user to review the student's award.

Overview
A separate alert is created for each Non-Federal Fund that is reduced by the packaging engine due to an over award
situation and when the fund amount accepted does not equal the maximum projected award up to packaging limit.
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This task is triggered based on configuration. If the Re-Evaluate Prior to Disbursing Indicator in the NFR_ATTRIB.csv is
TRUE, this task is triggered prior to disbursement.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• NFF Workflow

• NFF Eval Review Task

• Document Permissions associated with Non-Federal Funds

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Dashboard > Re-Evaluate NFF Fund task queue
2. Start Task

Review the Non-Federal Fund and determine if the fund can disburse as is or if it should be updated. Make
updates as needed.

3. Complete Task

Manual Non-Federal Fund Academic Year Changes  
Whenever a manual non-federal fund changes academic years, the fund remains within the academic year originally
assigned.

Overview
This triggers a task in the Re-evaluate non-federal fund task queue titled Manual Non-federal fund no longer aligns
with academic year. This task prompts you to review the fund manually so that students are awarded correctly. To
resolve the issue, you can update the academic year dates and award year that the non-federal fund is in.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• NFF Workflow

• NFF Eval Review Task

• Document Permissions associated with Non-Federal Funds

See Set General Permissions Matrix for additional information.
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Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

Enter the student's external student ID number in the search field located in the upper right-hand corner

1. Navigate to Dashboard > Re-Evaluate NFF Fund task queue.
2. Start Task. Review the Non-Federal Fund and determine if the fund can disburse as is or if it should be updated.

Make updates as needed.
3. Complete Task.

Disburse Non-Federal Funds  
Non-Federal Funds (NFF) disbursements follow guidelines unique to those funds.

Non-Federal Funds are disbursed as one disbursement equal to the maximum Non-Federal Fund projected award
amount. Disbursement dates for each Non-Federal Fund period being awarded are set or updated. If the fund has
already been disbursed, the disbursement dates aren't updated.

If the Disbursement Outbound Message Indicator in the Disbursement Configuration Workbook is configured to TRUE,
the Disbursement message is sent for all funds once the Disbursement Status is updated to Disbursed. For NFF funds,
the Disbursement Status is updated to Disbursed when all disbursement criteria are met and Disbursement QC Holds
are released. As part of the disbursement criteria for NFF funds, there is a check that the disbursement hasn't been
placed on hold within the NFF workflow and, if the Re-Evaluate Prior to Disbursing Indicator is configured as TRUE in
the Non Federal Funds Attributes Configuration Workbook, whether the task to complete re-evaluation is completed.

Here is the progression of NFF Disbursement processing:

1. Anticipated Disbursement Date is reached.
2. The scheduled batch process evaluates funds for configured disbursement criteria.
3. If the disbursement is on hold within the NFF workflow, the disbursement criteria is not met.
4. If all criteria are met and the fund Re-Evaluate Prior to Disbursing Indicator is configured as TRUE, a re-

evaluation task is created.
5. Once the task has been completed and all disbursement criteria are met, there is a check for the Disbursement

QC Hold.
6. If the Disbursement QC Hold is configured, the disbursement is held for QC Review.
7. Once the QC Review Hold task is completed, the Disbursement Status is set to Disbursed,and the Disbursement

message is triggered for funds where the Disbursement Outbound Message Indicator is configured as TRUE in
the Disbursement Configuration Workbook.

The frequency of Disbursement Messages for NFF Funds depends on the user reviewing relevant tasks and releasing
holds and how frequently the batch job is scheduled.

CommonLine Loans  
Student Financial Planning (SFP) manages CommonLine (CL) alternative student loan application files, packages loans
for the student, certifies loans for eligibility, and disburses funds using the CL4 standard maintained by the National
Council of Higher Education Resources. CL loan awards are loans are managed using the SFP Non-Federal Funds (NFF)
framework.
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Overview
Here are some things you can do:

• Upload all school certification requests and response files up to guarantee processing.

• View unmatched and error records after the inbound record validation process. Also, unmatched records are
automatically re-evaluated with each FasStudentUpdateEvent (SDI) load.

• View CL loan awards in the Packaging UI.

• Generate Application Send files for all loans queued up and pending certification.

• Re-download previously generated files.

• Manage exceptions including the ability to manually re-trigger Application Send certifications by loan.

• Upload Disbursement Rosters and disburse loans.

• View student history entries with inbound and outbound file identifiers.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Matches CommonLine Files with Students
When you upload CL Application Response files, Student Financial Planning performs a file level validation. If the
file passes validation, SFP matches file information to existing students using Social Security number. These are the
supported file types:

• School Certification Request (SCR)

• Application Response

• Modification

• Termination

The application also recognizes CL files where the student isn’t the borrower and can match those to the related
student.

Creates a CommonLine Loan Application
When a SCR is received and matched with a student, a CL loan is created. Also, whenever an initial
FasStudentUpdateEvent (SDI)message is received, it’s compared to unmatched SCR records to determine if there are
any matches.

When the loan is created, a Student History entry is also created and includes these statuses:

• CommonLine Loan Status: the status assigned by the external loan processor.

• CommonLine Processing Status: the status of the loan in SFP.

When there are changes to the Loan and Processing statuses, additional Student History entries are created. The
application also supports multiple loan applications from a single student for the same or overlapping loan periods.

Packages Alternative Student Loans
When a SCR is received from a lender and matched with a student, the packaging process is triggered, and the student
is awarded an Alternative Loan, if eligible. Matching on the CommonLine Unique Identifier (CLUID) in a Loan Application
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allows the application to support multiple loan applications from a single student for the same or overlapping loan
periods to create or update award packages.

SFP uses the automated Non-Federal Funds (NFF) framework to package CL loans. NFF periods and loan
disbursements are created as needed based on the SCR loan period dates and configured academic term dates.

If the application determines that the student is eligible to receive the CL loan in the award package, it updates the
CL Processing Status to Packaged. If all NFF periods amounts are $0, the student isn’t eligible for the fund and the
Processing Status is set to Not Certified.

The application evaluates the configured Awarding Criteria as it does for all NFF funds, and once all NFF periods
associated with the CommonLine Loan are awarded, the application updates the CL Processing Status to Awarded.

Creates Disbursements for CommonLine Loans
When the CL Loan is added to the student’s package, the application also creates one disbursement per NFF period
associated with the fund. The disbursement is created for the amount set in the package for the NFF period and is
scheduled based on the NFF Period Start Date. The application adjusts the disbursement amounts based on the eligible
amount in the package.

The application uses existing NFF Disbursement statuses, however additional data from the Application Response file
and Disbursement Roster is also used to determine if the Disbursement status should be updated.

Identifies Loan Applications for Certification
Once all NFF periods associated with the CL loan are awarded and the sum of the Award Amount for all associated NFF
Periods are greater than $0, the loan is ready for certification. On the CommonLine Management UI, the Certify Loans
button is activated when there are loans ready to be selected for the Application Send file. Once selected, the loan’s
CommonLine Loan Status is set to File Pending.

Once the Application Send file is generated from the selected loans, the CL Loan Status is updated to File Generated.
The generated files are then available for download to be sent to a loan processor. Once downloaded the CL Loan Status
is updated to File Downloaded.

If the CommonLine Loan amount changes and the CommonLine Loan hasn’t yet been guaranteed, the application
sends the new certified amount in the next generated Application Send file.

Identifies Guaranteed Loans for Change Processing
When certain changes to guaranteed loans are identified, a Change Transaction file with the correct detailed change
records is created. You can download the Change Transaction files and upload them directly into your Loan Servicer.
Here are the supported changes;

• Loan Period Date Changes

• Grade Level Changes

• Program Completion Date Changes

• Disbursement Amount Changes (excludes disbursement cancellations or returns)

• Disbursement Date Changes

• Holding or Release of Disbursements (post-guarantee)

• Disbursement Cancellations

• Loan Cancellations

• Cancelled Disbursement Reinstatements
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• Disbursement Returns

• Loan Increases, including:

◦ Post Cancellation

◦ Post Disbursement

◦ Post Disbursement Return

• Disbursement Roster Discrepancies

All changes detected within the application are in real time. If a new change is detected while the Loan Processing
Status is File Pending, the new change overrides the original change.

Note:  The application removes a pending file if the change is no longer required and reverts back to the original loan
information.

Manual overrides trigger a Change Transaction file. If a manual override to the disbursement amount or anticipated
disbursement date is made on the Disbursement page, manually triggering Repackaging on the Packaging page is
required to trigger a pending change.

When you download a file, you can view a Change Transaction Send File which includes this information:

• A Header record which contains school identifying information.

• One Borrower (@1-02) Detail Record in the file for each borrower.

• The Change Transaction Send File contains at least one of the following records:

◦ Loan Period Change (@1-07) Detail Record for loan period changes. This detail record is submitted if
revising loan period begin and end dates, student’s grade level, and/or student’s anticipated completion
date.

◦ Disbursement Cancellation/Change (@1-09) Detail Record for each disbursement change. This detail
record is submitted for each disbursement to be canceled, rescheduled, held or released and/or added
prior to the release of funds for the disbursement. If submitting a Hold or Release Change, the @1-09
detail record isn’t used for any other change transactions (for example, disbursement date or amount
changes). Other changes must be submitted in a separate @1-09 change transaction, but may be
submitted under the same @1-02 record.

◦ Disbursement Notification/Change (@1-10) Detail Record type for post-disbursement returns. This detail
record is submitted for any disbursement that has been entirely or partially returned

◦ Loan Increase (@1-24) Detail Record type for communicating loan increases. This detail record is
submitted for the following reasons:

- Loan Increases when all Disbursements are Disbursed.
- Loan Increases when Disbursements are Partially Disbursed.
- Loan Increases when a return exits on the loan.

• A Trailer record.

Each change includes change information within a specific @1 Record Number based on the Change Reason. The
Change Reason is only viewable within the Student History Entry created when a Change Transaction Processing Status
is updated or via the actual file in the <School Use Only> field.

The Loan Change Reasons are:
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Change Reason (Abbreviation
used in the <School Use Only>
Field)

Pre-Defined Change Description
and System Trigger

@ Record Number Generated Pre-Disbursement or
Post-Disbursement

Loan Period Changed (LPC) Loan Period dates have changed. @1-07 Both

Grade Level Changed (GLC) Grade Level changed for loan. @1-07 Both

Program Completion Date
Changed (PCD)

Program completion date has
changed for the student associated
to the loan.

@1-07 Both

Disbursement Amount Changed
(DAC)

Positive Total Disbursement
Amount for a disbursement is
increased or decreased and is not
$0 after the change.

@1-09 Pre-Disbursement

Disbursement Date Changed (DDC) Disbursement Dates Changed. @1-09 Pre-Disbursement

Disbursement Put on Hold (DRH) When the Disbursement Hold /
Release Indicator is R and the
"Ready to be Disbursed” indicator
becomes FALSE, the disbursement
is placed on hold.

@1-09 Pre-Disbursement

Disbursement Released (DRI) When the Disbursement Hold /
Release Indicator is H and the
"Ready to be Disbursed” indicator
becomes TRUE, the disbursement
is released.

@1-09 Pre-Disbursement

Loan Cancelled (LC) Cancellation Reason is set for
all NFF periods associated with
the loan and the sum of loan
disbursements is reduced to zero;
all disbursements are canceled.

@1-08 Pre-Disbursement

Disbursement Cancelled (DC) Cancellation Reason has been
set for a disbursement and the
disbursement amount is reduced
to zero.

@1-09 Pre-Disbursement

Disbursement Reinstated (DRD) An existing loan, where the
disbursement amount for an Alt
Loan was reduced to zero and then
increased. If an entire loan requires
reinstatement, the @1-09 record
type is used to reinstate the loan
by reinstating each disbursement
individually.

@1-09 Pre-Disbursement

Disbursement Returned (DR) Disbursement is fully returned. @1-10 Post-Disbursement

Disbursement Partially Returned
(DPR)

Disbursement is partially returned. @1-10 Post-Disbursement

Loan Increase Requested (LIR) Certified Loan Amount increase is
requested.

@1-24 Both
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Repackages CommonLine Loans
When any Application Response file from a loan processor is uploaded and matched to a student and existing loan, SFP
triggers repackaging and updates the application as needed. All updates are displayed in Student History.

Processes Disbursement Rosters
Once the Anticipated Disbursement Date is reached, the application evaluates whether there are criteria that need to
be evaluated prior to disbursing. If the Disbursement Criteria Required column of the NFR_ATTRIB.cvs Configuration
Workbook has a value of TRUE, the application evaluates the standard NFF disbursement criteria and other criteria
configured for the CommonLine Loan; such as additional criteria configured in Disbursement Criteria column of the
DISBURSEMENT.csv Configuration Workbook.
When all other disbursement criteria is met, the application creates a "Disbursement Roster has been received"
disbursement criteria to be released when the Disbursement Roster is received. When a Disbursement Roster file
from a loan processor is uploaded, it's matched to the student based on the SSN and then matched to the specific
disbursement using the CommonLine ID and Disbursement Period Number. The application updates the Disbursement
Date, Gross Amount, Net Amount, and Fees as applicable based on data in Disbursement Roster.

If the Gross Amount received in the Disbursement Roster is different than what was previously scheduled, the
application triggers a repackage to ensure the amount is adjusted accordingly. All updates are displayed in Student
History.

Updates Student History
Throughout the CommonLine process, Student History is updated with changes, including CommonLine Loan Status,
CommonLine Processing Status, and Award Packaging events.

CommonLine Loan Statuses
These statuses are triggered by CL Record Code Status Code field in Application Response files received from an
external loan processor.

SFP Loan Status Description Trigger

Certification Requested School certification is requested for application. When a new Response File is loaded for @1
Detailed record with a record status code of C.

Pending Promissory Note Initial processing is successful, and the lender
will guarantee or obtain guarantee for the loan
upon receipt of the promissory note.

When a new Response File is loaded for @1
Detailed record with a record status code of A.

Pending Further Approval Initial processing successful, and the loan is
pending further approval.

When a new Response File is loaded for @1
Detailed record with a record status code of I.

Guaranteed The loan has been guaranteed. When a new Response File is loaded for @1
Detailed record with a record status code of G,
 M, or, if there is not a Change Transaction Error
(@6) Detail Record, R.

Guaranteed and Approved for Disbursement The loan has been guaranteed, the promissory
note has been received, and the loan is
approved for disbursement.

When a new Response File is loaded for @1
Detailed record with a record status code of B.

Pending Errors The loan is pending processing for error
resolution by the sending organization.

When a new Response File is loaded for a @1
Detailed record with a record status code of P.
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SFP Loan Status Description Trigger

Denied The loan was denied, rejected, or incomplete,
 and no further processing can occur unless the
school, borrower, or lender provides updated
data.

When a new Response File is loaded for a @1
Detailed record with a record status code of D.

Loan Terminated The loan is terminated. When a new Response File is loaded for a @1
Detailed record with a record status code of T.

CommonLine Process Statuses
Application processes trigger these internal statuses:

Loan Processing Status Description Trigger

Matched to Student CommonLine loan fund has been matched to a
student but isn’t included in student's package.

CommonLine NFF fund has been matched
to a student but is not included in student's
package. This happens after every Application
Response file is uploaded and matched.

Packaged CommonLine loan has been included in the
student's package.

CommonLine NFF fund has been included in
the student's package and disbursements have
been created, but not all NFF Periods associated
to the fund are awarded.

Awarded CommonLine loan has been awarded. All NFF periods associated to the CommonLine
NFF fund have been awarded.

Not Certified CommonLine Loan NFF is determined to not be
eligible in the packaging process.

If all NFF period amounts are $0, the student
is not eligible for the fund, and the fund is not
certified.

File Pending • CommonLine Loan has been certified and
is pending being added to the Application
Send File, or

• A change has been identified for a
CommonLine Loan that has already been
guaranteed, and is pending being added
to the Change Transaction File.

Fund has met certification criteria by either
the application evaluating or user manually
selecting fund in CommonLine Admin UI,
 but the Application Send File hasn’t yet been
generated.
 
Fund has met change criteria by either the
application evaluating or user manually
selecting fund in CommonLine Admin UI, but
the Change Transaction File hasn’t yet been
generated.
 

File Generated • CommonLine Loan has been certified, and
Application Send File is ready to be sent,
 or

• A change has been identified for a
CommonLine NFR fund that has already
been guaranteed, and Change Transaction
File is ready to be sent.

Loan has met certification criteria by either
the application evaluating or user manually
selecting fund in CommonLine Admin UI, and
Application Send File has been created and
awaiting user to download.
 
Fund has met change criteria by either the
application evaluating or user manually
selecting fund in CommonLine Admin UI, and
Change Transaction File has been created and
awaiting user to download.
 

File Downloaded • Application Send file or Application Send file has been downloaded by
user.
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Loan Processing Status Description Trigger

• Change Transaction file has been
generated and downloaded by the user.

 
Change Transaction file has been downloaded
by user.
 

Uploading CommonLine Application Response Files
You can upload files sent by a loan processor to update CommonLine loans and download files generated by the
application to send to a loan processor.

Accessing the files you want to upload from a loan processor is a process outside of SFP. Uploading Application
Response files from the processor triggers application processes that create and update CL Loan Applications and
application Award Packaging processes.

You can download SFP application-generated files and share them with loan processors. You can also re-download
historical application-generated files as needed.

Configurable Attributes
You are able to configure Funds for CL loan products. These configured Funds are used to create CL Loan applications
and package CL loans. These are the Configuration Workbooks that you use:

• Fund Priority

• Non Federal Fund Attributes Configuration Workbook; with particular attention to the NFR Periods Groovy
script that determines award periods and disbursement amounts

• Disbursements

Required Role Permissions
• CommonLine Processing

Here’s how to upload Application Response files from a loan processor:

1. Navigate to Student Financial Planning User Interface > Administration > Commonline Management..
2. Click Upload Files.
3. Click Select Files to open a window to select a file from a computer drive or drag and drop files from a

computer drive.

Viewing Packaged CommonLine Loans and Student History
When CL Application Response files are uploaded, application processes are triggered that can potentially create new
loans and update or cancel existing loans. To see these changes, you view students’ award packages and Student
History updates.

Configurable Attributes
There are no configurable attributes for this feature.

Required Role Permissions
• Student

Here's how to view packaged CL loans:

• Navigate to Student Financial Planning User Interface > Student Financial Information > Packaging..

If a student has applied for multiple loans with distinct CLUIDs, the application displays each application and the
corresponding NFF Periods distinctly.
Here's how to view Student History:

• Navigate to Student Financial Planning User Interface > Student History/Comments > Student History.
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Certifying CommonLine Loans
After packaging, you can certify CL Loans. After certification, you can download SFP application-generated files and
share them with loan processors. You can also re-download historical system application-generated files and resend
them to a loan processor as needed.

Configurable Attributes
There are no configurable attributes for this feature.

Required Role Permissions
• CommonLine Processing

Here’s how to certify packaged CL loans:

1. Navigate to Student Financial Planning User Interface > Administration > Commonline Management.
2. Click Certify Loans.

Note! The Certify Loans button is only activated when there are loans ready for certification by the application. Clicking
the Certify Loans button certifies all loan applications that are ready.

Here’s how to download CL files to submit certified loans to a loan processor:

1. Navigate to Student Financial Planning User Interface > Administration > Commonline Management.
2. Click Download Files.
3. Share downloaded files with a loan processor using your internal process.

Here’s how to re-download CommonLine files to re-submit certified loans to a loan processor:

1. Navigate to Student Financial Planning User Interface > Administration > Commonline Management.
2. Click Download Files.
3. Click the Download History tab.
4. Click the Published link in the Processing Status column.
5. Share downloaded files with a loan processor using your internal process.

Manually Editing CommonLine Loans
You can manually edit CL Loans. You can make these changes from selecting to edit a CL loan from the Packaging
UI or searching for a loan to edit from the Commonline Management UI. When you save changes, the application
automatically triggers a change file to be included the next time certify loans to send to the loan servicer.

Configurable Attributes
There are no configurable attributes for this feature.

Required Role Permissions
• NFF Fund Override

• CommonLine Processing

• Student

Here’s how to manually edit an existing CL loan for an NFF Period:

1. Navigate to Student Financial Planning User Interface > Student > Student Financial Information >
Packaging.

2. Click the Edit link for the CL loan award that you want to edit.
3. Modify the fields that you want to edit:

a. Maximum Projected Award Amount: Update this amount as needed. If you update it to Zero, then the CL
loan for the context CLUID and NFF Period will be canceled.

b. Fund Status.
c. Start Date.
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d. End Date.
e. Allocation Period End Date.
f. Disbursement Date.

g. Disbursement Hold.
h. Number of Credits.
i. Commonline Unique Identifier: This is a drop-down list of all CLUIDs associated with the student. The

value defaults to the CLUID of the NFF Period selected to edit from the Packaging page.
4. Click Save. Any edits made are automatically queued from the next time you certify CL loans and download a

file to the loan processor.
Here’s how to manually add an NFF Period to an existing CL loan:

1. Navigate to Student Financial Planning User Interface > Student > Student Financial Information >
Packaging.

2. Click the Add NFF Period link for the CL loan award that you want to add an NFF Period to.
3. Modify the fields that you want to edit:

a. NFF Period.
b. Maximum Projected Award Amount: Update this amount as needed. If you update it to Zero, then the CL

loan for the context CLUID and NFF Period will be canceled.
c. Fund Status.
d. Start Date.
e. End Date.
f. Allocation Period End Date.

g. Disbursement Date.
h. Disbursement Hold.
i. Number of Credits.
j. Commonline Unique Identifier: This is a drop-down list of all CLUIDs associated with the student. The

value defaults to the CLUID of the NFF Period selected to edit from the Packaging page.
4. Click Save. Any edits made are automatically queued from the next time you certify CL loans and download a

file to the loan processor.

Manually Selecting CommonLine Loans to Certify
You can manually select loans to certify, including loans that have been previously certified, for inclusion in an
Application Send file for a loan processor.

Configurable Attributes
There are no configurable attributes for this feature.

Required Role Permissions
• CommonLine Processing

Here’s how to select loans that you want to certify and send to the loan processor:

1. Navigate to Student Financial Planning User Interface > Administration > Commonline Management.
2. Click Search Loans.
3. Enter search criteria.
4. Select the loans you want to certify.
5. Click Certify Selected Loans. This creates the file to send to the loan servicer.

Creating Change Transactions Files for Guaranteed Loans
When there have been changes to an NFF Alternative Loan award, you can download Change Transaction files to send
to a loan processor.
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Configurable Attributes
There are no configurable attributes for this feature.

Required Role Permissions

• CommonLine Processing

Here’s how to create Change Transaction files to send to a loan processor:

1. Navigate to Student Financial Planning User Interface > Administration  > Commonline Management..
2. Click Generate Changes.

Note:  The Generate Changes button is only activated when there are Change Transactions ready to send to
a loan processor. Clicking the Generate Changes button creates a Change Transaction file for all changes that
are ready.

Here’s how to download CL files to submit Change Transactions to a loan processor:
1. Navigate to Student Financial Planning User Interface > Administration  > Commonline Management..
2. Click Download Files.
3. Share downloaded files with a loan processor using your internal process.

Here’s how to re-download Change Transactions to re-submit to a loan processor:

1. Navigate to Student Financial Planning User Interface > Administration  > Commonline Management..
2. Click Download Files.
3. Click the Download History tab.
4. Click the Published link in the Processing Status column.
5. Share downloaded files with a loan processor using your internal process.

Uploading CommonLine Disbursement Rosters
You can upload Disbursement Roster files sent by a loan processor to update CommonLine loans and disburse funds.

Accessing the files you want to upload from a loan processor is a process outside of SFP. Uploading Disburse Roster files
triggers the application to process the disbursement and send the Disbursement Information Outbound Message to the
school's accounting system, based on configuration.

Configurable Attributes
There are no configurable attributes for this feature.

Required Role Permissions
• CommonLine Processing

Here’s how to upload Disbursement Roster files from a loan processor:

1. Navigate to Student Financial Planning User Interface > Administration > Commonline Management.
2. Click Upload Files.
3. Click Select Files to open a window to select a file from a computer drive or drag and drop files from a

computer drive.

Viewing CommonLine Files in Student Context
You can view CommonLine files that have been sent for the student and the responses that have been matched to the
student.
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For each CommonLine Loan, the CommonLine Information UI displays detailed information for all associated outbound
and inbound files listed in order of date and time across all Academic Years with the most recent files displayed first.

• Inbound CommonLine Files

◦ Certification Request (File Identifier Name is COMMON RESPONSE and Record Status Code is C.)

◦ Application Response (File Identifier Name is COMMON RESPONSE and Record Status Code = A, I, G, B, P,
N, or D.)

◦ Modification (File Identifier Name is COMMON RESPONSE and Record Status Code is M.)

◦ Termination (File Identifier Name is COMMON RESPONSE and Record Status Code is T.)

◦ Disbursement Roster (File Identifier Name is COMMON DISB ROS.)

◦ Change Response (File Identifier Name is COMMON RESPONSE and Record Status Code is R.)

• Outbound CommonLine Files

◦ Application Send (File Identifier Name is COMMON APPLICATIONS.)

◦ Change Transaction (File Identifier Name is CHANGE TRANS.)
- Loan Period Change.
- Disbursement X Cancellation / Change, where “X” represents the disbursement number for the

Change Record.

Detail information displays in hover text for each CommonLine Unique ID (CLUID) and each of its corresponding file
transactions. Selecting a transaction displays additional details.

Configurable Attributes
There are no configurable attributes for this feature.

Required Role Permissions

• CommonLine View

Here's how to view CommonLine Files in Student Context:

• Navigate to Student Financial Planning User Interface > Student > Financial Information > Commonline
Information.

Packaging  
Student Financial Planning packages the student for each academic year in a student's program according to program
and student eligibility.

Overview
The application determines the student's eligibility and Maximum Projected Award Amount for each fund. The
application then goes through each fund the student is eligible to receive and adds it to the package based on the
institution's configured awarding priority. Funds are added to the student's package until the configured limit is reached
at which point Student Financial Planning sets the Maximum Projected Award Amount up to the Packaging Limit and
Actual Fund Amounts.
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What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Determines the packaging start date and schedule
Student Financial Planning determines which date to begin packaging a student using the combination of the data in
the SAFI and the FasPackagingStartDateEvent message, if needed. This event message includes Enrollment ID and
Program Code elements. You can use these elements to assign a Packaging Start Date for a particular Enrollment ID or
Program Code. If neither the Program Code element nor Enrollment ID element is populated, the Packaging Start Date
applies to all enrollments.

• If the Program Code element is populated but the Enrollment ID element isn’t, the Packaging Start Date applies
to all enrollments with the specified Program Code.

• If the Enrollment ID element is populated but the Program Code element isn’t, the Packaging Start Date applies
only to the enrollment with that specific Enrollment ID.

• If there is not a program code or enrollment ID specified for the packaging start date, it will be used for all
enrollments including future enrollments

• If a Packaging Start Date needs to be removed, the message can be sent with the Program Code element
populated and a blank date in the Packaging Start Date element.

For a Scheduled Academic Year (SAY) Term Packaging Schedule:

• If there isn’t a Packaging Start Date associated to the Enrollment, packaging is based on the first Academic Year
included in the SAFI in the Program Element, regardless of the program start date.

• If there is a Packaging Start Date associated to the Enrollment, packaging is based on the first Academic Year
on or after the Packaging Start Date.

For a Borrower-Based Academic Year (BBAY) Term Packaging Schedule:

• If there isn’t a Packaging Start Date associated to the Enrollment, packaging is based on the first Term included
in the SAFI in the Program Element, regardless of the program start date.

• If there is a Packaging Start Date associated to the Enrollment, packaging is based on the first Term on or after
the Packaging Start Date.

For a Non Term Packaging Schedule where the student isn’t a re-entry, external transfer, or internal transfer:

• If there isn’t a Packaging Start Date associated to the Enrollment, packaging is based on the first course start
date on or after program start date.

• If there is a Packaging Start Date associated to the Enrollment, packaging is based on the first course date on or
after the greater of the Packaging Start Date and Program Start Date.

Packages the Student
Student Financial Planning evaluates all of the institution's configured funds and packages the student with all eligible
Title IV funds, student resources, and Non-Federal Funds the student is eligible to receive. The student is packaged for
each academic year of the student's program up to the Packaging Limit according to a configured awarding priority
list. For funds that are automated, Student Financial Planning calculates them automatically to determine the eligibility
and award amounts. For funds that are manual, Student Financial Planning checks to see if the fund has already been
included in the student's package and includes the packaged amount.
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With the exception of the Title IV Pell Grant, the application automatically reduces a fund source if adding it to the
package causes the student to be over-awarded. If a manually awarded fund causes an over-award, Student Financial
Planning packages the student according to the Actual COA. If an over-award is created and cannot be resolved, an
Evaluate Overaward Packages task is created.

Student Financial Planning sets the disbursement amount, Maximum Projected Award Amount, and the Maximum
Projected Award up to the Packaging Limit.

Student Financial Planning also determines if there is a projected shortfall or over-award after all eligible funds have
been included in the student's package.

In the Student Financial Planning user interface, the application breaks out the student's package and illustrates the
total amount the student is packaged for, the amount accepted and/or pending acceptance, whether the student's
tuition and fees are being covered, and the amount used toward living and other expenses.

SFP Triggers the Packaging Process based Persistent and Non-Persistent Triggers

Persistent Packaging Triggers

The process is triggered when:

• A Student Academic and Financial Information (SAFI) message is received and the student exists in the
application

• The minimum number of inputs are received to start packaging

• Explicitly requested by a user

• Requested via the packaging Application Program Interface (API)

Non-Persistent Packaging Triggers

The process is triggered when:

• A Financial Plan Web Service Request is received without a student ID and all required data; for example, SDI/
Program/Course/ISIR data.

• A Financial Plan Web Service Request is received with student ID and some data. If data received in the Web
Service Request is different than the data in the student record, the Packaging Engine uses the data received in
the Web Service Request for the package.

• A user modifies an estimated ISIR prior to making an ISIR correction

• A user modifies estimated packaging inputs

◦ ISIR

◦ LOA

◦ Financial Aid History

◦ COA

◦ Course Changes (Schedule, Grades, Completion Date)

Triggers Repackaging
Student Financial Planning repackages a student when configured conditions are met as a result of updated information
and saves and displays the repackaging reason each time a repackage is initiated.

Repackaging Hold
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Student Financial Planning prevents a repackage from occurring if any of the following are true:

• The application is waiting for a response from COD on any of the student's disbursements in the package
(Disbursement status is equal to Origination Sent to COD or Disbursement Sent to COD).

• There is an Evaluate Student Change of Program task pending completion for the student.

While the repackage is on hold, the application queues up every SAFI message that is received.

Once the hold reason is resolved, the application triggers a repackage for each SAFI that is received and uses the latest
inputs for each package (i.e. ISIR, Fund Acceptance, and so on.

Repackaging Triggers

Trigger Source Trigger Description (i.e. Repackaging Reason)

SAFI Message Student Academic and Financial Information Message was received

ISIR status has been updatedISIR

Subsequent ISIR was not validated prior to Valid ISIR Deadline being reached

Student Demographic Information
Message

Student Demographic Message was received

Fund Acceptance Message was receivedFund Acceptance

Fund Acceptance was not received by due date

SAP Status Updated SAP Status was updated

LOA LOA/Breaks Message was received

LOA Student has begun LOA

PLUS Loan Application Message was received

Credit Status Response Message was received

Credit Decision Override Message was received

TEACH Grant Counseling acknowledgment Message was received

COD Message Classes

ATS Note acknowledgment Message was received

Disbursement Criteria Disbursement Criteria not met by due date

Disbursements Canceled Disbursement were re-evaluated

Aid Year Close Out Award Year is closed and pending disbursement exists

Award Management At least one fund has become Awarded

NFR NFR Fund was added or modified

NSLDS NSLDS/FAH Message was received

Package Detail Override Package details were manually overridden

Package Detail Override COA details were manually overridden
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Academic Year / Payment Period
Instructional Weeks and Credits have been
met

Student's Academic Year / Payment Period Credits and Instructional Weeks have been met

External Transfer Overlapping Loans for External Transfers Evaluated

Change of Program Student Changed Programs

Re-Entry within 180 Days Student re-entered within 180 days

Re-Entry after 180 Days Student re-entered after 180 days

Student Record Hold Student Record Hold was released

Sequester Reduction Required Sequester Reduction was Required

Payment Period Disbursement Amount
or Payment Period Max Disbursement
Amount is Updated

Disbursements are updated, affecting projections for future loans.

Fund Allocation Fund allocation has been reached and amount needs to be adjusted

At will repackaging Student was repackaged at will

COA Adjustment An adjustment was made to the student's COA

Academic Year Overrides Academic year info overridden

Default Overpay Code Overridden Borrower Default Overpay Code Manually Overridden

Student Record Manually Overridden Student Record Details were manually overridden

Awarding Close Out Awarding has closed and funds not Awarded

Student Ended PP After Credits and Weeks
Met

Student Ended PP After Credits and Weeks Met

CommonLine Application Response was received for a CommonLine fund associated to the studentCommonLine

CommonLine Disbursement Amount updated due to receipt of a Disbursement Roster

Sets the Packaging Status
Student Financial Planning determines the Packaging Status for an academic year based on the Fund Status listed in the
package for that academic year, to make users aware of which academic year package is Estimated, Partially Awarded,
Awarded, or Pending Repackage

Packaging Statuses

The packaging status is found on the Packaging screen under the Packaging Summary

Status Description

Estimated All funds in the Academic Year are Estimated or Projected

Partially Awarded At least one fund in the Academic Year is Awarded and at least one other fund in the Academic Year is
not Awarded

Awarded All fund statuses in the Academic Year are Awarded
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Pending Repackage If the package has been or needs to be manually repackaged

Creates a New Packaging Version
Student Financial Planning creates a new Packaging Version when the student is initially packaged and each time the
student is repackaged, in order to help you understand changes in the student's package from one period of time
to another. Packaging Versions increase incrementally every time a package is generated for a student; for example,
Version 1: 01/01/2018, Version 2, 01/02/2018).

You are able to view historical packaging versions, but by default, Student Financial Planning displays the current
version for the current academic year.

Creates and Sends the Financial Plan Outbound (FPO) Message
Student Financial Planning generates a financial plan for all existing students per academic year for the student's
program. The application makes financial projections for the entire program, in order for a student to gain insight into
how their projected aid would be affected by a change in certain variables. The Financial Plan Outbound (FPO) message
provides a snapshot of the student's financial aid package for the entire length of their program.

When Student Financial Planning receives a FPO request for an existing student's saved package via web-service
request it sends the information for the requested packaging version. If a package version number is not requested, the
application sends the student's latest package.

The application sends the FPO message when any of the following occurs:

1. When a new Student Academic and Financial Information (SAFI) message is received
2. The student is repackaged due to an award message being sent to a student or when a Fund Acceptance or

Late Disbursement Acceptance message is received.
3. When a Late Disbursement and/or Post Withdrawal Disbursement (PWD) Acceptance Message is received for a

withdrawn or graduated student

See the latest Product Release Notes and review the API Updates to view the XSD files associated with the
FasFinancialPlanOutbound.xsd and FasFinancialPlanOutboundV2.xsd. See Doc ID 2613016.1 on My Oracle Support.

Creates an Evaluate Overaward Packages Task
When a student resource fund causes packaged funds to exceed the Packaging Limit, Student Financial Planning
creates an Evaluate Overaward Packages task so the package can be manually adjusted to resolve the over-award. If
the funds and/or student resources are adjusted, the Packaging Status is updated. If a subsequent re-package resolves
an over-award before the Evaluate Overaward Packages task is completed, Student Financial Planning cancels or
completes the task associated with the previous packaging version.

Configurable Attributes
Configure the Packaging Limit
The institution can configure the Packaging Limit according to institutional policy so that Student Financial Planning
can automate how packaged fund amounts are determined.

The institution can configure the Packaging Limit that the Packaging Engine uses to determine the default dollar
amount to include in each academic year for a student. You can then choose to use the Total Cost of Attendance (COA)
or Actual COA.

Configure General Fund Attributes
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Student Financial Planning enables the school to configure all of the available funding sources that are supported at the
institution. Configuration for the Fund Source Definition and award/refund priorities are required for each fund.

You can configure all funding sources and the associated rules that will be used by Student Financial Planning to
determine:

• What the fund type, fund code, and fund description is; for example, "Title IV Grant", "Discount", and so on).

• Whether the fund reduces the student's need.

• What the priority of the fund is as it relates to all other available funding sources for awarding and refunding.

Configure fund source description attributes
You can configure fund source description attributes for all funding sources used by the packaging engine.

Configure fund priority attributes
You can configure fund priority attributes for all funding sources used by the packaging engine and Student Financial
Planning supports an effective start date for the configuration to allow for updates as needed.

Required Role Permissions
The user must have a role with the following General Permission through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view Packaging after querying a student:

1. Navigate to Student Financial Planning User Interface > Student > Financial Information > Packaging
2. Click Package Summary and then:

◦ Click Cost of Attendance to view and edit COA details, including the Cost of Attendance Type.

◦ Click a Term link (for example, Term 11 - Fall Semester 2020) to view additional course details.

3. Click FSA Data Summary and then:

◦ Click the Award Year (for example, 2020) to View ISIR Details.

◦ Click the Received Date (for example, 01/01/2020) to View NSLDS Details.

4. Click Fund Information to view eligibility details, and then:

◦ Click the Fund Type link (for example, Federal Pell Grant) to view disbursement and amount details.

Academic Year And Payment Period - Non-Term  
To accurately award students, Student Financial Planning defines the student's Borrower-Based Academic Year (BBAY)
to be used for the student.

Overview
Student Financial Planning uses the student's program information, course information, and days of scheduled
instruction for each course eligible to receive financial aid to calculate academic year, loan period, and grant period
dates.
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What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Determines the student's academic year start and end dates
Student Financial Planning identifies the academic year start and end dates for the student's current and future
academic years and determines if each academic year status is Actual or Projected.

Student Financial Planning creates the student's schedule by mapping out all courses that are and are not eligible
for financial aid in the student's program. If a student decides to repeat a course that they passed and the course is
financial aid eligible, the repeated session is not eligible for financial aid. Student Financial Planning stops adding
courses once the student completes the program (based on completed credits).

Student Financial Planning maps out all weeks in the student's program based on the student's schedule. Student
Financial Planning uses the first scheduled day of instruction for the first course in the student's program to determine
how to map out the weeks. For example, if the first scheduled course begins on a Tuesday, then weeks are based on
Tuesday through Monday. To determine how many weeks can be considered instructional weeks, Student Financial
Planning uses each of the scheduled days of instruction for all courses on the student's schedule.

Student Financial Planning uses the student's academic year definition as the minimum length to determine the
number of credits and instructional weeks required to close out an academic year. Anytime Student Financial Planning
identifies there are fewer weeks and/or credits than defined by the academic year definition a shortened academic year
is created. This may occur if the student is entering the institution with an overlapping loan, advancing degrees, or is
completing their last academic year.

When the student's first academic year is shorter than the academic year definition, Student Financial Planning retains
the number of credits and weeks. If the student should transfer internally during their first academic year, the system
uses the retained shortened academic year weeks/credits when mapping out the new program academic year(s).

Before the next academic year is created, Student Financial Planning evaluates the current academic year to ensure that
the total number of weeks and credits meet the academic year definition. If the total number of credits or instructional
weeks do not meet the academic year definition, Student Financial Planning evaluates the "minimum number of credits
in the final academic year to extend the previous academic year" configuration, (e.g. If there are two credits expected to
be in the final academic year, then the institution may configure Student Financial Planning to include those course in
the previous academic year, which causes the previous academic year to be greater than the academic year definition).

If the student completes a course after the last day of scheduled instruction, Student Financial Planning uses the
Incomplete Resolution Date from the Student Academic and Financial Information (SAFI) message to determine which
academic year the course credits should apply towards and the appropriate academic year end date.

Determines the number of credits and instructional weeks currently completed per
academic year
Student Financial Planning determines the number of credits and instructional weeks the student has completed per
academic year, to track the student's progress for each academic year. On a daily basis, Student Financial Planning (via
batch process) updates the number of completed instructional weeks and the academic year/payment period status.

Student Financial Planning only counts credits for passed courses that are financial aid and program eligible. Credits
and/or instructional weeks for courses that the student previously passed but repeated are not considered.

Student Financial Planning determines the number of instructional weeks the student has completed per academic year
so that student's academic year progression can be tracked. Student Financial Planning uses the first scheduled course
day in the student's program to determine the day of the week to use to determine if a week can be considered an
instructional week. For example, if the first scheduled course begins on a Tuesday, then a course needs to be scheduled
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for Tuesday through Monday in order to count as an instructional week. Student Financial Planning does not count any
instructional week after the student has withdrawn from the course.

Instructional weeks are counted beginning with the academic year start date to the lesser of the following:

• Official Last Date of Attendance

• Academic Year End Date

• Current system date

Calculates the Number of Months in the academic year
Student Financial Planning calculates the number of months in each academic year in the student's program in order to
calculate the Cost of Attendance (COA).

Defines the Student loan period and loan payment periods for Non-Term Credit Hour
Schools
Student Financial Planning determines the student's loan period and the corresponding loan payment periods
according to the U.D. Department of Education, guidelines for non-term credit-hour schools for each of the student's
academic years. Student Financial Planning determines the loan period award year and if the loan period/loan payment
period is considered actual or projected.

Student Financial Planning defines the student's loan period as the lesser of the following:

• The length of the student's academic year

• The length of the student's program (if the length of the program is less than the academic year)

• The remaining length of the student's program (if the remaining length of the program is less than the
academic year)

If the institution has a low cohort default rate and the length of the student’s academic year is less than or equal to 12
credits, Student Financial Planning considers the student to have only one loan period (with one loan payment period).

Updates the student's loan period dates and academic year dates
Student Financial Planning updates the student's loan period and subsequent loan payment periods for each of the
student's academic years whenever there is an academic year re-evaluation completed so that the loan periods match
the student's academic year.

Student Financial Planning calculates the academic year-end date based on the instructional weeks for the program
for each academic year that is less than the program's academic year definition. Student Financial Planning reduces
the student's loan period to 1/2 the length if the student withdraws and does not receive any Sub/Unsub/PLUS award
amounts in the second loan payment period.

Determines the payment periods for non-term credit hour schools
Student Financial Planning determines the (actual or projected) payment periods for non-term credit hour schools so
that funds can be disbursed according to the appropriate payment period schedule. Student Financial Planning assigns
one payment period if the remaining credits are equal to or less than half an academic year. If the remaining credit
hours are greater than half an academic year but less than a full academic year, Student Financial Planning assigns two
payment periods.
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Student Financial Planning calculates the following for each payment period

• Payment period start/end dates

• Number of expected credits

• Number of expected instructional weeks

• Number of credits currently completed

• Number of instructional weeks currently completed

Updates the academic year definition/academic year end date
Student Financial Planning updates the academic year definition academic year end date based on the extension of the
loan period end date while the student is in the last academic year of their program.

The system should only extend the academic year definition academic year end date

• If the number of credits in the student's last academic year remains the same when the student is repackaged,
but the number of days between the loan period start date and loan period end date is updated

• By the number of days the loan period end date was extended from the prior evaluation

Determines and Updates Loan Fees Associated with Loans for a Given Academic Year
See Loan Fee Management for more details.

To view the Loan Fees associated with a specific Award Year, please see New Award Year Updates information in the
Product Release Notes. Choose the award year you want to review. See Doc ID 2613016.1 on My Oracle Support.

Configurable Attributes
Configure the academic year definition
The institution can configure the academic year definition by defining the number of instructional weeks and credits
required to complete an academic year.

Configure the minimum number of credits in the final academic year to extend previous academic year
You can configure the minimum number of credits required for an academic year. If the minimum number of credits
can't be completed due to the student completing their last academic year, the institution can configure Student
Financial Planning to include those final credits (that total less then the minimum required credits) in the previous
academic year. When this occurs, the academic year will exceed the number of credits and/or instructional weeks for a
defined academic year.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the packaging (academic year/loan period information), navigate to Student Financial Planning User
Interface > Student > Financial Information > Packaging > Academic Year Summary table.
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Academic Year And Payment Period - Term  
To accurately award students, Student Financial Planning (SFP) defines the student's Academic Year and Loan Periods.
SFP uses the information in the Student Academic and Financial Information (SAFI) message to calculate terms,
academic years, and loan periods.

What SFP Does Automatically
SFP automatically:

Determines which academic year and payment period logic to use
The SAFI message indicates how to treat the student based on the data sent. When SFP receives a SAFI, the application
associates courses to terms based on the course start and end dates and how they align to the term start and end dates.

SFP accepts courses that have start and end dates within the term start and end dates, The application also supports
courses that may begin before the term start date or extend past the term end date. When SFP receives a SAFI message,
the application associates courses to terms based on what term the course overlaps.

For students that have a Course that overlaps multiple terms, that Course must have a TermStartDate in the SAFI
message. When a Course has a TermStartDate, the Course is associated with the Term that starts on the Course-level
TermStartDate. As TermStartDate is optional, the application rejects the SAFI with an error in the APP Event Error Report
if the student's Course overlaps multiple terms, and the TermStartDate isn't present at the Course level.

Mapping Logic for Term Schools

There are two ways to map academic years for term schools:

• Standard Academic Year (SAY)Term.

• Borrower-Based Academic Year (BBAY) Term.

Determines course credits needed (UI Purposes Only)
SFP determines the number of credits the student needs to complete their program. The application doesn't prevent
packaging a student if the SAFI doesn't contain enough courses to graduate; this is purely for UI purposes. The
application determines the number of:

• Total program credits.

• Credits the student has passed out of.

• Accepted transfer credits from each institution

• Institutionally-completed credits that are applicable and have been completed before the Program Start Date.

• First-time passed retakes

• Course credits needed to complete the program; not including program courses completed.

Determines the total program scheduled units (UI Purposes Only)
SFP maps the entire schedule for all eligible courses listed in the Student Academic and Financial Information (SAFI)
message, beginning with the first scheduled course in the student's program. The application begins mapping based on
whichever Academic Year contains a Program Start Date or a Packaging Start Date and calculates the sum of credits for
all courses in the term.
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If the course status is Passed, Scheduled, Projected, Enrolled or Incomplete, SFP adds the course units. If the course
status is Failed or Withdrawn, SFP only adds the course units if the enrollment status is Withdrawn or Deceased and the
OLDA is within the courses start and end dates.

SFP only packages the student for Title IV funds for terms where the (Packaging Start Date is < Term Start and Term End
Date) OR (Term End Date< = Packaging Start Date > = Term Start Date).

Maps out a Standard Academic Year
SFP saves the academic year dates according to how they were sent in the SAFI message, then saves the Term Start and
End Dates for each term in the Academic Year Period. The application only includes a Summer term in the Academic
Year if the Summer term indicator is true, and there is a course scheduled within the term. Otherwise, SFP ignores the
Summer term.

There can be more than one or two terms in the Academic Year Period because it's based on how the program is set up.

Maps out Borrower-Based Academic Year
For borrower-based programs, you map out an academic year based on the number of terms required to complete an
academic year. The only caveat is that you cannot begin an academic year for which you do not have any courses.

SFP determines the number of terms required to complete an Academic Year for the program via the <BbayTerm>
element in the SAFI message. Beginning with the first Academic Year, the application determines the first term and sets
the academic year start date. SFP reviews each subsequent term sent in the SAFI message and completes the academic
year based on the required number of terms in an academic year (irrespective of whether there is a course within a
term). To complete the process the application continues to look for the next subsequent term that contains a course
and sets the academic year start date and repeats the process until the student has enough academic years/terms to
complete the program.

Determines the loan periods and loan period dates
SFP evaluates both the number of total terms in the academic year as well as the student's scheduled enrollment for
each term (in other words, term contains at least 1 course). If the academic year contains less than or equal to two terms,
the application creates a single loan period for the entire academic year. If the academic year contains more than two,
but less than or equal to four terms, the application may have to create multiple loan periods for the academic year
depending on the student's enrollment in each term. If the student has courses in every term in the academic year, then
SFP creates a single loan period. Otherwise, SFP creates a loan period inclusive of each consecutive set of terms that
has enrollment. If there is a term for which there is no enrollment, then SFP ends the loan period, skips the term without
enrollment and starts a new loan period beginning with the next term with enrollment

Loan Period Numbering
SFP numbers the loan periods in sequential order. If a new loan period needs to be created, the application uses the
next available number.

Example

Trimester school w/4 academic years w/single loan period

• Academic Year 1 w/ Loan Period #1

• Academic Year 2 w/ Loan Period #2

• Academic Year 3 w/ Loan Period #3
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• Academic Year 4 w/ Loan Period #4

• If the student decides not to enroll in an Academic Year 1, Term 2, the application shortens Loan Period #1
to only cover the first term, and a NEW loan period is created for the third term. Since Loan Period 1-4 have
already been created, the new Loan Period # will be 5. So you'll have Academic Year 1 w/ Loan Period #1 and
Loan Period #5.

• If the student then decides to enroll in Academic Year 1, Term 2, the application extends Loan Period # 1 to
cover the entire academic year and essentially "cancel out" Loan Period #5.

• If the student decides not to enroll in a Academic Year 1, Term 2, the application, again, shortens Loan Period #1
to only cover the first term and re-use Loan period #5 for Term #3 since it was already created and associated
to Term 3 previously.

Determines the number of completed credits for term schools
SFP determines the number of completed credits (Term/Academic Year) by calculating the sum of all course units where
the scheduling status is Passed for the term and/or for the academic year.

Determines the term enrollment status
SFP reviews each term in the student's schedule and determines how many credits are in the term and then sets the
appropriate enrollment status for the term. SFP takes into consideration if the SAFI Received Date is greater than or
equal to each course end date before determining whether to count the credits in the term. Example, if the student does
not have an ARA in the course and the course is in the past, the credits aren't counted.

Factors to consider to count credits

SAFI Create Date vs Course End Date ARA Count Credits?

SAFI Creation Date > Course End Date Yes Yes

SAFI Creation Date > Course End Date No No

SAFI Creation Date <= Course End Date Yes Yes

SAFI Creation Date <= Course End Date No Yes

Determines term enrollment status for withdrawn students
When a program enrollment status of Withdrawn or Deceased is received for a student, the application re-calculates the
enrollment status for the term the withdrawal occurs (based on the official last date of attendance). After selecting the
term, SFP counts the credits for all courses that have an Attendance Related Activity (ARA) and a start and end date that
falls before and within the students' official last date of attendance.

Enrollment Statuses

Total Course Units Enrollment Status

12+ Full Time

9-11 Three Quarter-Time

6-8 Half-Time
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Total Course Units Enrollment Status

<6 Less than Half-Time

0 Not Attending

Determines if the academic year or term is considered Actual or Projected
If the Academic Year or Term does not meet the following requirements, the Academic Year or Term is considered
Projected.

Requirements for the Academic Year or Term to be Considered Actual

• Academic Year = Actual

a. The current date is greater than or equal to the Academic Year End Date
b. All of the courses in the academic year have one of the following scheduling statuses:

- Passed
- Failed
- Withdrawn
- Incomplete

• Term = Actual

a. The current date is greater than or equal to the Term End Date
b. All of the courses in the academic year have one of the following scheduling statuses:

- Passed
- Failed
- Withdrawn
- Incomplete

Determines and Updates Loan Fees Associated with Loans for a Given Academic
Year
For more details, see Loan Fee Management.

To view the Loan Fees associated with a specific Award Year, see New Award Year Updates in the Product Release Notes.
Choose the Award Year you want to review. See Document ID 2613016.1 on My Oracle Support.

Configurable Attributes
This feature does not have any configurable features.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.
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Navigation to the SFP User Interface Functionality
To view the Academic Year Term Dates:
SFP User Interface > Student > Financial Information > Packaging

To view the Course dates for each term, click on the Academic Year Summary graph.

COA, SAI/EFC, and Financial Need  
Student Financial Planning automatically calculates the student Cost of Attendance (COA) and uses with the student's
Student Aid Index (SAI)/Expected Family Contribution (EFC) to determine the student's financial need.

What Student Financial Planning Does Automatically
SFP automatically does the following things:

Determines which COA Configuration to Use
The application correctly determines which institutionally-configured Cost of Attendance (COA) to use to award a
student based on the student’s attributes.

If the student is in a Non-Term program, the application uses the COA configuration according to the award year
associated with the loan period. If the student is in a Term program, the application uses the COA configuration that
matches the student's program Type, program ID, Term Number, and Modality.

Calculates the Total COA
The application calculates a student's Total COA using the defined configuration and the academic year length. The
Total COA is then used for Federal Student Aid (FSA) eligibility and awarding purposes. The application creates a
sum of all configured and non-configured COA components to determine the Total COA for each academic year. The
application uses standard rounding rules when the calculated Total COA isn't a whole number.

Standard Rounding Rules: Round up if the decimal is .50 or higher; round down if it is less than .50.

The application calculates and displays the Total COA for each academic year in the student's program.

Term Program: The application calculates the Total COA for each academic year in the student's Term program. The
application calculates the Total COA for each Term that the student attends separately and sums the COAs for all of the
terms in the academic year to determine the Total COA. The application must use the Military Costs and Budget Costs
when calculating the student's budget and provide a breakdown of the COA per term for the academic year. A Summer
Term COA is added to any Academic Year in which the summer term is associated.

Non-Term Program: The application calculates the Total COA for the full Academic Year.

Total COA Equation: Sum of all COA Components equals Total COA Attendance.

COA Component Equation: Sum of all COA Items equals COA Component.

Budget Costs: The application uses Budget Costs unless the institution configures one of these following enhanced
components to be present. The application determines which to use based on the FasStudentInitiationEvent message:

• Budget Costs - With Parent.

• Budget Costs - Off Campus.
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• Budget Costs - On Campus.

Calculates Direct Costs
The application calculates a student's direct costs based on received invoiced charges to determine if there is a shortfall
in the student's package. The application completes a summation of Actual and Projected student, program and course
level charges per academic year. The application only uses Actual charges in order to calculate the Student's Direct Cost.

Actual: An invoiced charge.

Projected: A non-invoiced, projected charge.

Calculates Actual COA
The application calculates and displays the student's Actual COA based on all Actual charges and uses the standard
rounding rules. The application applies the Actual COA on an academic year basis.

The application calculates and displays the Actual COA as an alternative to the Total COA value

Term Program: The application calculates the Actual COA for each academic year in the student's Term program.
The application creates a sum of all configured and non-configured COA components to determine Total COA for the
academic year. The application must use the Military Costs and Budget Costs when calculating the student's budget and
provide a breakdown of the COA per term for the entire academic year.

Non-Term Program: For non-term programs, the application calculates the Actual COA for the full Academic Year.

Actual COA Equation: Direct Costs plus the Budget Costs equal the Actual COA.

Budget Costs are :

• Budget Costs - Off Campus.

• Budget Costs - With Parents.

• Budget Costs - On Campus.

• Military Costs, if Basic Allowance for Housing is indicated.

• Loan Fees; if configured to add Actual Loan Fees.

The application uses Budget Costs unless you configure one of these enhanced components. The application
determines which to use based on the FasStudentInitiationEvent message:

• Budget Costs - With Parent.

• Budget Costs - Off Campus.

• Budget Costs - On Campus.

Calculates Pell COA for Non-Term programs
The application calculates a prorated Total COA for students that are enrolled in programs either greater than or
less than the US Department of Education’s (ED) standard academic year definition of 24 credits or 30 weeks. The
application prorates the Total COA up when a student is attending less than an academic year or prorates down for
students who are attending for periods greater than an academic year.

Prorated COA Equation for Non-Term Programs

Prorated COA: Lesser Value of Equation 1 or 2 times the Total COA equals the Prorated COA.
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The application uses standard rounding rules when the calculation does not result in a whole number.

Equation 1

Credit Hours in Academic Year Definition divided by Credit Hours Awarded.

Equation 2

Weeks in Academic Year Definition divided by Weeks Provided.

Calculates COA for Students with Less Than Half-Time Enrollment
The application calculates the COA (Total or Actual) for a student with an enrollment status of Less than Half-Time
based on the Less than Half-Time COA configuration. This excludes COA items not permitted for students enrolled Less
than Half-Time. The application treats the Total or Actual COA for a student with Less than Half-time enrollment status
as it would treat any other Total or Actual COA for a student.

Calculating the Pell Term COA
The application calculates the Pell Term COA on a per Term basis using the Pell award year determined for that term.
The application calculates the Pell Term COA using the enrollment status determined in the term. For example, if the
students' enrollment status was less-than-half-time for the term, the application will use less than half-time configured
budget items to calculate the COA.

The Pell Term COA calculation uses costs for a full academic year (9 months), and the application calculates the Full-
Time Full-Year COA using Actual COA components.

Calculates Campus-Based COA
When a student withdraws, the application calculates the Campus-Based COA so that campus-based funds can be re-
calculated correctly using only costs associated with courses or time that the student attended the payment period. The
application calculates the Campus-Based COA for a student when Campus-Based re-calculation criteria are Met and
uses the student's Cost of Attendance for the withdrawn payment period or term. The application calculates the number
of attended months in the withdrawn payment period or term and completes the Campus-Based COA calculation before
the R2T4 calculation occurs for a Withdrawn student.

Campus-Based COA Component Equations

• To calculate Tuition costs, the application sums the net charges for courses in which the student had been
invoiced up to the point of withdrawal.

◦ - For the final courses, the application adds back any MEM-DROP adjustments made for those
courses.

- For all courses included in the tuition cost calculation, the application adds back any SIS other
resource adjustments associated with those courses.

• To calculate Budget costs, the application sums all configured budget components by the number of attended
months within the payment period.

◦ The application will add Loan Fees charged to the student for the Academic Year in which the withdrawal
occurred.

The application uses standard rounding rules when the calculation does not result in a whole number.
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Updates the COA
The application updates the student’s COA (Total/Actual) when repackaging a student or Loan Fees have been added.
To update the COA, the application calculates the correct values for each applicable fee component; for example, Total
Subsidized/Unsubsidized Loan Fee, Total PLUS Loan Fee, and so on.

Obtains the Official SAI/EFC
The application uses the Primary SAI/EFC field from the active ISIR to package the student. If there isn't an ISIR for the
current award year, the application uses the Primary SAI/EFC from a previous ISIR to estimate a package for the student.
If a Valid ISIR does not exist, the application does not return a value for the SAI/EFC.

If applicable, for the 2023-2024 and prior Aid Years only, the application captures the Primary Alternate Month EFC from
the official ISIR.

Displays the SAI/EFC Used in Calculations
The primary SAI/EFC is displayed in the UI; Student Summary, ISIR and in the FSA Data Information section of the
packaging page.

For the 2023-2024 and prior Aid Years only, the Primary EFC is displayed unless the Primary Alternate Month EFC
Amount is used to determine the fund amount within the student's package for the academic year.

Determines which SAI/EFC to Use
For the 2024-2025 and future Aid Years, the application uses the 9-month SAI from the ISIR. The SAI is never prorated.

For the 2023-2024 and prior Aid Years, the application uses the EFC from the Valid ISIR during the Packaging process.
The nine-month EFC is used when awarding Pell and Teach grants. The primary or adjusted EFC based on a shortened
Academic Year, if applicable, is used to award Title IV Loans, Federal Supplemental Educational Opportunity Grant
(FSEOG) and Iraq and Afghanistan Service Grant (IASG).

Determines the Student's Financial Need
For the 2024-2025 and future Aid Years, the application calculates the student's financial need using the student's
COA, SAI, and any higher priority funds in accordance with ED guidelines so that the appropriate fund types and
amounts are used to package the student's need-based Federal Student Aid.

Financial Need Calculation

• If higher priority funds are Projected or Awarded, COA minus SAI minus the Sum of all higher priority funds
where the Reduce Need Indicator equals True equals Financial Need.

• If higher priority funds aren't Projected or Awarded, then COA minus SAI equals Financial Need.

For the 2023-2024 and prior Aid Years, the application calculates the student's financial need using the student's COA,
EFC, and any higher priority funds in accordance with ED guidelines so that the appropriate fund types and amounts are
used to package the student's need-based Federal Student Aid.

Financial Need Calculation

• If higher priority funds are Projected or Awarded, then COA minus EFC (prorated, if applicable) minus the
Sum of all higher priority funds where Reduce Need Indicator equals True equals Financial Need.

• If higher priority funds aren't Projected or Awarded, then COA minus EFC (prorated, if applicable) equals
Financial Need.
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Configurable Attributes
Configure Full Time, Full Year Student

The institution can configure what it takes to be a Full Time, Full Year Student, per program type as a minimum.

Configure COA Items

An institution can configure categories and components to make up the COA. The application accurately calculates the
student’s COA and determine the Federal Student Aid (FSA) award amounts.

The COA is defined for groups of students that share common attributes, such as program and Location. The total
amount is an average for a period of enrolment. The application use the COA applicable to a defined group of students,
such as students enrolled in a particular program and/or taking classes at a specific location.

The institution can define rules for when each applicable COA item and amount would apply to the student; for
example, students enrolled in an online graduate program will have a Tuition rate of $500 per credit.

The institution can define components for each COA item. These are configured components such as tuition and fees,
Loan Fees, Budget Costs, and Military Costs. Within each component, the institution can configure applicable COA
items; for example, Room and Board under the Budget Costs component, and a formula that the application uses to
determine the amounts. Configurations are per institution, per award year.

Configure COA Applicability, Components, and Items

The institution can configure the COA

Term Program

• per school

• per effective date

Non-Term Program

• per school

• per award year

• per effective date

The institution can configure the COA for a set group of students composed of COA Components and their
corresponding COA Items.

Example Program Type: Bachelors, Modality: Ground.

Cost of Attendance Components

Component Description

1 Tuition and Fees

2 Loan Fees

3 Budget Costs

4 Budget Costs - With Parent

5 Budget Costs - Off Campus
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6 Budget Costs - On Campus

7 Military Costs

The institution can also configure the COA for students enrolled Less than Half-Time.

Required Role Permissions
The user must have a role with this General Permission through Roles Management to view COA information:

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the COA, SAI/EFC and Direct Cost:
Student Financial Planning User Interface > Student > Financial Information > Packaging

Award Management  
Once a student has been packaged for an academic year using valid data, Student Financial Planning begins the
Awarding Process to determine if the student's funds are ready to be Awarded.

Overview
Once the configured criteria are met, award amounts are created and an outbound message is sent to the external
client Student Information System (SIS) to communicate all the funds awarded to the student for that academic year. If
updates are made to awarded amounts, Student Financial Planning creates and sends another outbound message to
communicate the updates.

The system identifies which funds require Active Confirmation/Fund Acceptance, sends the outbound fund acceptance
message, receives the inbound fund acceptance message and triggers the disbursement updates (if necessary) based
the accepted amounts.

Status Definitions
Fund Status

The Fund status is found in the Fund Information Table on the Packaging Screen.

Status Description

Projected Required input data is not Actual
 
For inputs to be Actual the following is required:
 

• Valid ISIR or an Unverified ISIR (ISIR status is based on fund type)

for the Award Year that is being awarded

◦ If the ISIR is Valid for a past award year, the status will remain Projected
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Status Description

• NSLDS record received within the last 30 days

Estimated Required input data is Actual
 

• ISIR and NSLDS are acceptable to progress to Estimated status

Award criteria batch job has run and fund type has Not Met all configured award criteria
 

• Award Criteria is visible.

For Non-Federal Funds (NFF) the status should be manually set during the awarding process
 

Awarded Award Criteria batch job has run and fund type has Met all configured award criteria or the fund type
does not have to satisfy any award criteria
 
For NFF Funds the status should be manually set during the awarding process
 
For Other Resource Funds, Student Financial Planning sets the status to Awarded
 

Packaging Statuses

The packaging status is found on the Packaging screen under the Packaging Summary

Status Description

Estimated All funds in the Academic Year are Estimated or Projected

Partially Awarded At least one fund in the Academic Year is Awarded and at least one other fund in the Academic Year is
not Awarded

Awarded All fund statuses in the Academic Year are Awarded

Pending Repackage If the package has been or needs to be manually repackaged

Fund Acceptance Statuses

Status Description

Pending Acceptance Fund has met configured award criteria but requires fund acceptance

Accepted Fund has been accepted

Fund Not Accepted Fund not accepted by the student

Fund Not Accepted by Due Date Fund acceptance not received by configured due date for fund type

Awarding: What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Triggers the awarding process
The Awarding Process begins when the student is packaged and the fund status is updated to Estimated or when the
Payment Period (PP) Maximum Disbursement Amount increases for a PP and the fund status is updated to Awarded.
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Once the awarding process begins Student Financial Planning determines whether the configured Awarding Criteria is
met.

Generates award amounts
Student Financial Planning calculates award amounts for both the academic year and payment period levels based on
the payment period maximum disbursement amount. If the Fund Limited by Previous Acceptance indicator is set to True
for the payment period, Student Financial Planning calculates the award amount for the payment period according to
the award amount on file at the time the indicator was set.

Sets the awarded indicator
Once the configured Awarding Criteria has been met, the awarded indicator for the payment period is set and Student
Financial Planning begins subsequent processes and actions.

Sends the award outbound message
Student Financial Planning sends an Award Outbound Message to communicate to the student they can view their
award. The Outbound Message contains information on all awarded funds within a student's package for a specific
academic year. The award amount at the academic year and payment period levels for the fund, the fund acceptance
status, indicator, and due date for all applicable funds are included in the message.

Student Financial Planning triggers the Award Outbound Message anytime:

• The Payment Period Max Disbursement Amount value has been updated for an Awarded payment period. The
fund must pass all Awarding Criteria to be increased and before the Outbound Message is sent.

• The Fund Limited by Previous Acceptance Indicator has been set for a payment period.

• The Fund Acceptance has been received for a fund.

• The Fund Acceptance deadline has been extended by a user via At-Will

Sets the awarding version
Student Financial Planning sets the awarding version after the award outbound message is initially sent to the student,
and subsequently thereafter for each time, a new message is triggered, to communicate changes in the student's
awarded funds from one period of time to another.

When the student's award message is triggered for the first time, the awarding version number is set to 1. Each time
the message is triggered for a specific academic year the awarding version number increase by one whole number.
Awarding version numbers are calculated and grouped per academic year. The calculated awarding version number is
included in each award outbound message.

The date the Award Outbound Message is sent and all the award message information is saved per Awarding Version.

Receives award information web service request
Student Financial Planning accepts the award information web service request and sends the award outbound message
and includes all award information for that academic year, upon receiving the External Student ID, the academic year
and the award version within the web-service request. The fund acceptance information with the highest version
number associated with the award version number requested is included.

Fund Acceptance: What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

321



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 10
Using Financial Information

Calculates the fund acceptance due date
Student Financial Planning calculates the Fund Acceptance due date so that Student Financial Planning knows the date
in which Fund Acceptance is required to be received.

Student Financial Planning triggers the Fund Acceptance due date calculator to determine/calculate the Fund
Acceptance due date when the system has indicated that Fund Acceptance is required for the fund. Student Financial
Planning defaults to the latest due date generated per academic year award.

Runs the fund acceptance due date batch job
Student Financial Planning runs a daily batch job to identify all funds that require Fund Acceptance but have not
received acceptance by the calculated due date so that the Fund Acceptance statuses can be updated.

If a fund is not accepted by the configured Fund Acceptance Due Date, Student Financial Planning cancels the
disbursement(s). If the award amount for the fund increases subsequently, Student Financial Planning considers the
previously accepted amount before increasing the award amount.

Receives the fund acceptance inbound message
Student Financial Planning receives the Fund Acceptance inbound message for all funds packaged in Student Financial
Planning (except Student Resource funds), even for those that do not require Fund Acceptance/Active Confirmation.
Upon the receipt of the Inbound Fund Acceptance message, Student Financial Planning determines all payment periods
in which the Fund Acceptance message applies based on the award year close-out for the fund type and sets the
accepted amount. The accepted amount received within the Fund Acceptance message is the value Student Financial
Planning awards and updates the disbursement amount if necessary.

Student Financial Planning records all Fund Acceptance message information received from the external client system
per academic year.

Configurable Attributes
Configure Awarding Criteria

The institution can configure the awarding criteria per fund, per effective start date and Student Financial Planning will
not award the student until the configured conditions are met.

The following attributes can be configured per effective start date for all Title IV Funds:

• Enrollment statuses

• Academic statuses

• Admission statuses

• The # of days before the Borrower-Based Academic Year (BBAY) start date

• The # of days from the first-course start date and the course status does not have a Projected state

For Non-Federal Funds specific conditional logic to determine the award criteria can be configured per effective start
date per non-federal fund code.

If the institution does not configure a value for any of the parameters, the system will not check for that specific criterion
to be met.

Configure fund acceptance requirements

The institution can configure whether Fund Acceptance is required for each individual fund type and actively confirm
the amount the student is accepting. In addition, the institution can configure a due date (if applicable). The school can
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set the number of days the student has to accept the award from the date the outbound award message is sent to the
student to communicate Fund Acceptance is required.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

• Fund Eligibility Viewer

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the students awards
Student Financial Planning User Interface > Student > Financial Information > Packaging

General Title IV Eligibility Requirements  
General Title IV Eligibility Requirements specify the general eligibility requirements that all students must meet to be
considered eligible for Title IV funds.

Overview
Student Financial Planning determines if the student and the student's program meet general Title IV eligibility
requirements in accordance with the U.S. Department of Education. Student Financial Planning automatically
determines the student's Federal Student Aid (FSA) eligibility by evaluating the student's Institutional Student
Information Record (ISIR), National Student Loan Data System (NSLDS) record, the Common Origination and
Disbursement (COD) file, and the Student Academic and Financial Information (SAFI) message. If the student meets
all of the General Title IV eligibility requirements, the student is eligible to receive Title IV funds and is packaged. If the
student does not meet one or more of the general Title IV requirements, the student is not eligible to receive Title IV
funds and is packaged with non-federal funds only.

Eligibility Statuses

Status Description

Eligible Student meets eligibility requirements for the type of Title IV funding

Ineligible Student does not meet eligibility requirements for the type of Title IV funding

Student Financial Planning Automatically
Determines if the Student is Title IV Eligible
If the student meets all of the Title IV eligibility requirements in each eligibility section, then the student is eligible to
receive Title IV funds. If the student does not meet one or more of the eligibility requirements in each eligibility section,
then the student is not eligible to receive Title IV funds.

General Title IV Eligibility Requirements
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Eligibility Section Requirement Check

Program Student is enrolled in an approved financial aid
program

SAFI Program element FA Eligible Indicator
equals true
 
Program FA Eligible = Yes
 

High School Equivalency Student obtained a high school diploma or the
equivalent of a high school diploma (can be
bypassed through configuration)

ISIR Field 29: HS Diploma or Equivalent
 
Eligible:
 

• 1 = High school diploma

• 2 = GED

• 3 = Home Schooled

Ineligible:
 

• 4 = None of the above

• Blank

• Null

Satisfactory Academic Progress (SAP) Student maintained SAP requirements if the
student is currently enrolled in the institution

SAP status
 
Eligible:
 

• RG (Regular)

• FW (Financial Aid Warning)

• FP (Financial Aid Probation)

• No SAP status from any previous payment
period

Ineligible: FD (Financial Aid Disqualification)
 

Drug Conviction

Note:  This eligibility criterion doesn't need
to be checked beginning with the 2021-2022
Award Year.

Student abides by federally mandated drug
conviction requirements in order to be Title IV
eligible
 

• If all of the associated C-Codes have been
resolved, Student Financial Planning sets
Drug Conviction Eligibility to Eligible

• If one or more of the associated C-Codes
are unresolved, Student Financial Planning
sets Drug Conviction Eligibility to Not
Eligible

◦ C-Codes

- 053 Applicant left drug conviction
question blank

- 054 Applicant's response to drug
conviction question was 2 Yes Part-Year

- 056 Applicant's response to drug
conviction was 3 Yes on the original paper
FAFSA

- 058 Applicant's response to drug
conviction question was 3 Yes on
transactions other than original paper
FAFSA

ISIR Field 26: Drug Conviction Affecting
Eligibility
 

Eligible Ineligible If
C-Code is
Unresolved

C-Code

1 = No 2 = Yes, part-
year

054

N/A 3 = Yes, Don't
Know

056
 
058
 

N/A Blank 053
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Citizenship Student is currently a U.S. citizen or an eligible
non-citizen
 

• If all the associated C-Codes have been
resolved, Student Financial Planning sets
the Citizenship Eligibility status to Eligible

• If one or more of the associated C-Codes
are unresolved, Student Financial Planning
sets the Citizenship Eligibility status to Not
Eligible

• C-Codes

◦ 068 It was not indicated on FAFSA that
the applicant is a U.S. citizen or an eligible
non-citizen

◦ 141 Applicant changed from eligible
non-citizen to citizen or changed Alien
Registration Number and thus,

the applicant must submit proof of
citizenship change

◦ 142 Student did not provide Alien
Registration Number or provided invalid
Alien Registration Number

◦ 144 DHS did not confirm applicant's non-
citizen eligibility

◦ 046 DHS did not confirm eligible non-
citizen status

◦ 105 DHS has not yet confirmed eligible
non-citizen status

◦ 109 DHS did not have enough information
to confirm eligible non-citizen status

◦ 146 The Social Security Administration
did not confirm that the applicant is a U.S.
citizen

ISIR Field 17: Student's Citizenship Status
 

Eligible Ineligible If C-Code is
Unresolved

1 = U.S.
citizen
or U.S.
national

3 = Neither 1 nor 2 or not
eligible

2 = Eligible
non-citizen

Blank

 

Sets Title IV Eligibility Status eligible sections
Student Financial Planning updates the status of the Title IV fund source to Eligible or Not Eligible based on the result of
the student's general Title IV eligibility requirement evaluation.

Configurable Attributes
There are no configurable attributes for this feature.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.
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Related Topics
• Fund Eligibility

• ISIR

• Satisfactory Academic Progress

Fund Management  
Automated packaging of funds is managed using U.S. Department of Education (ED) guidelines and system
configuration.

Overview
Eligibility for Title IV grants and loans is based on ED regulations by Award Year and the institution's guidelines as
applicable. Once eligibility for any eligible grants is determined, the application calculates the award amount(s) to be
disbursed. Here are the Federal grants and loans for which student applicants are considered:

• Pell Grant

• Teacher Education Assistance for College and Higher Education Grant (TEACH)

• Iraq and Afghanistan Service Grant (for the 2023-2024 and prior Aid Years)

• Federal Supplemental Educational Opportunity Grant (FSEOG)

• Direct Stafford Subsidized Loan

• Direct Stafford Unsubsidized Loan

• Direct Parent PLUS Loan

• Direct Graduate PLUS Loan

Non-Federal Funds and Student Resources available through the institution can also be configured and managed.

Pell Grants for the 2023-2024 and Prior Aid Years
The following sections discuss what the application does automatically for Pell Grants for the 2024-2024 and prior Aid
Years..

Note:  The Pell Payment schedule is defined in the Pell Schedule Guide.

Determines Pell Grant Eligibility
The application checks to see if the student meets all general Title IV eligibility requirements and reviews the student's
program, ISIR, courses, and financial aid history information to determine eligibility. The application determines if the
student is enrolled in an undergraduate Pell eligible program and has an eligible enrollment status before awarding Pell.
The application prevents retroactive Pell awarding if the student does not meet Satisfactory Academic Progress (SAP) or
has unusual enrollment restrictions.

For Pell-eligible students, the application uses the program type, Pell Cost of Attendance (COA), and Expected Family
Contribution (EFC) by incorporating them into the federal Pell disbursement matrix based on the student's enrollment
status to determine a Pell scheduled award. For students enrolled in a program that does not align with the standard
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academic year metrics, the scheduled award is prorated based on the number of credit hours or weeks in the academic
year to calculate the student's annual award.

Determines Pell Grant Awards
If the student is eligible to receive Pell grant funds, the application determines the award amount and includes it in the
student's package. The payment period award year is established and the application determines if the student qualifies
for Zero EFC treatment based on the calculated EFC number. The application uses the COA, nine-month EFC (or Zero
EFC), and enrollment status when calculating the student's scheduled award. For students that are enrolled in periods
longer or shorter than an academic year, the application uses a prorated COA.

The application determines if the student has exceeded the aggregate (Lifetime Eligibility Used (LEU)) and/or the award
year (Percent of Eligibility Used (PEU)) limits. The application determines the maximum projected award per payment
period by selecting the lesser of the Pell scheduled award disbursement amounts or the Pell LEU/award year Limit
and does not award less than the regulatory minimum amount for Pell. The final amount(s) to be disbursed adheres to
ground rules for Pell formula fraction calculations and rounding.

Calculates Pell Grant Disbursement Amounts for Non-term Credit-hour Institutions
The application utilizes Pell Formula 4 to calculate the disbursement amounts per payment period for a non-term
credit-hour institution. Pell Formula 4 prorates the student’s scheduled award based on the number of credit hours
in the payment period as compared to the credit-hours in the defined academic year or the number of weeks of
instructional time in the payment period as compared to the weeks of instructional time in the academic year.

Determines Pell Grant Awards for a Crossover Payment Period
The application calculates the Pell award amounts when a crossover payment period exists. If a crossover exists, the
application always defaults to the first award year if there is remaining eligibility. If there is no remaining eligibility in the
first award year of a crossover payment period, the application uses the second award year to award Pell funds.

When Pell eligibility conditions exist for the first and second award year, the application calculates the maximum
projected award for both award years in the crossover payment period and determines if there is a Valid ISIR for both
award years. The application utilizes the same formula for calculating the payment for a crossover payment period, the
same as any other payment period in the award year.

Updates the Pell Grant Award Status
The application updates the fund status from Estimated to Projected to Awarded during the packaging process once
the fund meets the configured awarding criteria. Once the status has updated to Awarded it does not revert back to an
Estimated or Projected unless the ISIR is updated from Valid to Invalid. If the ISIR status is updated to Invalid, the fund
status would be updated from Awarded to Projected. If an award amount increases and the student doesn't pass the
award criteria check, the application does not award the additional increased amount.

Pell Grants for the 2024-2025 and Future Aid Years
To determine Pell Grant eligibility, the application checks to see if the student meets all general Title IV eligibility
requirements and reviews the student's program, ISIR, courses, and financial aid history information. The application
prevents retroactive Pell awarding if the student does not meet Satisfactory Academic Progress (SAP) or has unusual
enrollment restrictions.

To determine Pell Grant award amounts, the application:

• Uses a combination of the Maximum and Minimum Pell Eligible Indicators, Pell Grant Eligibility flag, SAI, Iraq
Afghanistan Student Grant (IASG)/Children of Fallen Heroes indicators, configured Minimum and Maximum
Pell Award amounts, and Pell Cost of Attendance (COA) to determine the Pell Scheduled Award amount.
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• Takes the Enrollment Intensity configured output by term and multiplies it by the Pell Scheduled Award amount.

• Uses the appropriate Pell Formula.

• Checks adherence to the student Pell Lifetime Eligibility Used (LEU) and Percent of Eligibility Used (PEU) limits.

Then, the amount is included in the student's financial aid award package.

To calculate Pell Grant Disbursement Amounts for Non-term Credit-hour Institutions, the application uses Pell
Formula 4 to calculate the disbursement amounts per payment period for a non-term credit-hour institution. Pell
Formula 4 always uses an Enrollment Intensity of 100%.

TEACH Grants
The following sections discuss what the application does automatically for TEACH.

Determines TEACH eligibility
The application determines if the student is eligible to receive a TEACH grant by evaluating the student’s Institutional
Student Information Record (ISIR), the Student Academic and Financial Information (SAFI) message, and institutionally
configured policy.

To be considered eligible for a TEACH grant the student must meet the following criteria:

• Be from a TEACH eligible state, country, and/or jurisdiction

• Complete initial TEACH grant counseling and the Agreement-to-Serve (ATS)

• Be enrolled in a TEACH grant eligible program

• Be using funds for first baccalaureate and post-baccalaureate programs combined (those after the first are not
eligible) or student is using for a graduate degree

• Meet the minimum GPA on a 4.0 scale

• Maintain a TEACH eligible enrollment status

The application prevents retroactive TEACH awarding when the student does not meet default C-Code clearance rules.

Determines TEACH award amount
The application calculates the award amount and includes it in the student's package. To determine the student's
TEACH grant award, the application:

• Determines the award year for a payment period

• Determines the student's scheduled award established by the department, per enrollment status

• Reduces the student's scheduled award according to sequester requirements based on the student's
disbursement date

• Determines if the student has surpassed annual and/or aggregate limits

• Uses the previously determined disbursed amount(s) as inputs into the aggregate/award year calculation

• Determines the maximum projected award per payment period by selecting the lesser of the payment period
disbursement amount for the award year, remaining award year eligibility, and the remaining TEACH grant
eligibility amount

• Determines if the student's award meets the regulatory minimum amount

• Sets the manual award indicator based on the TEACH configurable attributes used to determine each maximum
projected award per payment period for the academic year

• Determines the fund status associated to the maximum projected award
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• Saves all inputs/outputs used to determine the fund eligibility and maximum projected award amount

Calculates the TEACH payment period amount for non-term credit hour schools
The application calculates the TEACH grant payment period amounts. When calculating TEACH payment period
amounts, the application utilizes the TEACH grant formula configured specifically to the school's academic year set up,
to calculate the amounts per payment period. Further, the application ensures that each payment period amount is
greater than the minimum allowable amount.

The application utilizes TEACH grant formula 4, and the enrollment status for TEACH formula 4 to calculate the
amounts prepayment period for non-term credit-hour institutions.

The calculation for the payment period prorates a student’s scheduled award based on the number of credit hours in
the payment period as compared to the credit-hours in the defined academic year profile or the number of weeks of
instructional time in the payment period as compared to the weeks of instructional time in the academic year profile.

The application makes sure each payment period amount is greater than the minimum allowable amount. If the
minimum allowable amount is not attainable, the student is not packaged with TEACH grant funds.

Updates the TEACH fund status
The application updates the fund status from Estimated to Projected to Awarded during the packaging process once
the fund meets the configured awarding criteria. If an award amount increases and the student doesn't pass the award
criteria check, the application does not award the additional increased amount.

IASG Grants for the 2023-2024 and Prior Aid Years
The following sections discuss what the application does automatically for IASG for the 2023-2024 and Prior Aid Years.

Note:  For the 2024-2025 and future Aid Years, IASG is folded into Pell Grant eligibility determination.

Determines Iraq and Afghanistan Service Grant (IASG) eligibility
The application determines if the student meets all general Title IV eligibility requirements for Federal Student Aid (FSA)
and the IASG. IASG very closely follows the same guidelines for the Pell grant, and a student can only receive one or the
other (not both). In order to receive the IASG instead of Pell, the student must have an Expected Family Contribution
(EFC) greater than the allowable EFC to receive the Pell grant.

The application uses the student's program, courses, financial aid history and ISIR to determine eligibility. The
application evaluates and determines if the student meets the following requirements:

• Eligible IASG program

• Eligible IASG enrollment status

• Eligible degree (bachelors degree or a first professional degree)

• Eligible EFC (must be greater than the federal maximum allowable EFC for Pell)

The application prevents retroactive awarding when the student does not meet Satisfactory Academic Progress (SAP) or
has unusual enrollment restrictions.

Determines IASG award
Once eligibility is established, the maximum projected award amount of IASG is determined and the application does
not award an amount less than the regulatory minimum. The application determines the payment period award year,
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the student's scheduled award based on the student's enrollment status and reduces the scheduled award according to
sequester requirements based on the student's disbursement date (if necessary).

Calculates IASG disbursement amount for non-term credit hour schools
The application utilizes Pell Formula 4 to calculate the disbursement amounts per payment period for a non-term
credit-hour institution. The calculation for the Pell Formula 4 prorates the student’s scheduled award based on the
number of credit hours in the payment period as compared to the credit-hours in the defined academic year or the
number of weeks of instructional time in the payment period as compared to the weeks of instructional time in the
academic year.

Determines IASG award(s) for a crossover payment period
The application calculates the IASG award amounts when a crossover payment period exists. If a crossover exists, the
application always defaults to the first award year if there is remaining eligibility. If there is no remaining eligibility in the
first award year of a crossover payment period, the application uses the second award year to award IASG funds.

When IASG eligibility conditions exist for the first and second award year, the application calculates the maximum
projected award for both award years in the crossover payment period and determines if there is a Valid ISIR for both
award years. The application utilizes the same formula for calculating the payment for a crossover payment period, the
same as any other payment period in the award year.

Updates the IASG fund status
The application updates the fund status from Estimated to Projected to Awarded during the packaging process once
the fund meets the configured awarding criteria. If an award amount increases and the student doesn't pass the award
criteria check, the application does not award the additional amount.

FSEOG
The following sections discuss what the application does automatically for FSEOG.

Determines FSEOG Eligibility
The application determines if the student passes general Title IV eligibility requirements for Federal Student Aid
(FSA) funds and the student's eligibility for FSEOG funds for each payment period within the student's academic year.
When establishing FSEOG eligibility, the application uses the data from the student's active valid Institutional Student
Information Record (ISIR), Student Academic and Financial Information (SAFI) message, guidelines established by the
U.S. Department of Education, and the institution's FSEOG fund configuration.

The student must be awarded the Pell Grant in order to receive FSEOG funds. FSEOG can be configured using the FAS
Fund Config workbook to be awarded for the entire Award Year or a single term.

The application determines FSEOG eligibility for an academic year, provided at least one FSEOG Award Year matches
the Loan Period Award Year. If there is no match, SFP determines the student ineligible for FSEOG for that Academic
Year. If the student is not eligible for any Title IV loans for the Academic Year FSEOG is being determined eligible for,
then SFP does not consider whether the FSEOG award year matches the Loan Period Award Year.

FSEOG funds are based on a Fund Allocation; therefore, funds must be available in the Allocation Period the student
becomes eligible for the fund. The Allocation Period is based on the students Academic Year Start Date. The student's
Academic Year Start Date must fall on or after the Allocation Period Start Date and on or before the Allocation Period
End Date.
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For the student to be eligible for FSEOG, the ISIR must be valid and all C-Codes must be cleared by the end of the first
eligible Payment Period. If the C-Codes are not cleared by the end of the first eligible Payment Period, SFP determines
the student to be ineligible for the fund for that Academic Year.

Finally, FSEOG is not a fund that is projected by the application. SFP requires actual inputs (for example, valid ISIR and
NSLDS FA History file) in order to award the fund. The NSLDS file contains data to determine Pell eligibility, therefore if
there is not a valid/payable ISIR or NSLDS FA History file, the application determines the student ineligible for FSEOG
funds.

Determines a maximum projected FSEOG award
The application determines a student's maximum projected FSEOG award for each eligible payment period and makes
sure the student meets the minimum requirement per payment period before awarding the student FSEOG. If the
FSEOG funds do not meet the minimum amount required per payment period, the student is considered ineligible to
receive FSEOG. The student's maximum projected FSEOG award for the academic year is calculated by adding the total
fund amount for each PP award.

SFP determines the student's remaining eligibility based upon the Award Year Limit for each Payment Period within the
Academic Year.

• SFP uses any institutionally configured Award Year limit for FSEOG awards minus the Institutional Award Year
Limit.

• Award Year Limit (configured value) - FSEOG award(s) for current/previous Award Year for the Award Year
Payment Period being considered = Remaining Award Year eligibility.

The application sets the fund status prepayment period and the manual award Indicator (if applicable) associated with
the maximum projected FSEOG award.

Updates the FSEOG fund status
The application updates the fund status from Projected to Estimated to Awarded during the packaging process once
the fund meets the configured awarding criteria. If an award amount increases and the student doesn't pass the award
criteria check, the application does not award the additional amount.

Title IV Loans: What the Application Automatically Does
The application automatically does the following things for Title IV Loans.

Determines Stafford loan eligibility
If the student passes general Title IV eligibility requirements for a Stafford loan, the student is packaged with the
appropriate funding. Direct Stafford loan eligibility requirements are evaluated per award year and the application
determines if the student has exceeded the annual and/or aggregate loan limits or if the student had a prior loan
discharged due to disability or total and permanent disability.

The application evaluates the student's program type (for example, graduate or undergraduate) and determines which
type of Stafford loan the student is eligible to receive.

When the application receives loan period information, the application determines if the loan period is for the past,
present or future.

For undergraduate students, the dependency status from the student’s ISIR is considered to determine if the student is
eligible for the Dependent or Independent unsubsidized loan limit.
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Determines Subsidized and Unsubsidized Direct Loan limits
Student Title IV loan awards are packaged using maximum limits determined by the U.S. Department of Education by
grade level and dependency status. Grade levels are determined by calculating the total number of credits that can be
applied toward program completion and the institution's academic year definition. Calculating the number of credits
to use toward program completion includes summing the total number of credits completed and accepted transfer
credits. Unacceptable transfer credits, credits earned from taking courses that are not applicable to the program, and or
credits earned prior to the start of the current program that do not count toward program completion aren’t used when
determining the student's current grade level. Once the current grade level is determined, future grade levels for the
remainder of the student's program are projected.

For undergraduate students, the dependency status from the student’s ISIR is considered to determine if the student is
eligible for the Dependent or Independent unsubsidized loan limit.

Determines Additional Unsubsidized Direct Loan Limits
Additional Unsubsidized Direct Loan awards are calculated by determining the grade level limit up to the independent
grade level limit taking into consideration any loans that overlap the current loan period using NSLDS data.

Dependent students who have a PLUS Loan Denial Indicator of True on the ISIR are automatically considered for
Additional Unsubsidized Direct Loan funds. Also, a dependent student may have their Unsubsidized Direct Loan amount
manually increased to where it is over the grade level limit for combined subsidized and unsubsidized Direct Loans.

• If a student is awarded Additional Unsubsidized Direct Loans due to a PLUS denial, the Additional Unsubsidized
Eligibility Indicator is automatically set to True when reporting the loan to COD.

• If you manually award Additional Unsubsidized loans, you can set or unset the <Additional Unsubsidized
Eligibility Indicator> by following the Edit Fund instructions at Add, Edit, or Remove a TIV Fund.

In either case, the Additional Unsubsidized Eligibility Indicator is set to True when reporting the loan to COD.

Students in selected medical programs can also be awarded Additional Unsubsidized Direct Loan funds. The amount is
determined using the student’s academic program and fund configuration.

Fund Configuration for Additional Unsubsidized Direct Loans for student in selected medical programs is not part of the
Baseline Configuration. Take these steps in the FAS Fund Config workbook (FAS_FUND_CONFIG.csv) to configure an
Unsubsidized Direct Loans fund for selected medical programs:

1. Enter DUNSUB in the Fund_Code column.
2. Reference a Groovy Script in the Medical_Eligible_Program_Amount_Info column. In this script, you can

determine which programs are eligible for the Additional Unsubsidized Direct Loan amounts and how much a
student should receive. When students are awarded Direct Loans using this script, the Fund Description display
includes "Medical".

For any student who is packaged Additional Unsubsidized Direct Loan funds in a selected medical program, the HPPA
Indicator is set to True when reporting the loan to COD.

Determines if loan limit needs to be prorated
The application prorates the student's loan limit if the student is in an undergraduate certificate program and the
program length is less than a standard academic year. To prorate the loan limit, the application multiplies the student's
loan limit (based on grade level) by the lesser of the following ratios:

• Remaining Program Credits ÷ Academic Year Definition Credits

• Remaining Program Weeks ÷ Academic Year Definition Weeks
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If the student is in an undergraduate Bachelors program and the Borrower-Based Academic Year (BBAY) has a partial
academic year, the application prorates the student's loan limit. To prorate the loan limit, the application multiplies the
student's loan limit (based on grade level) by the following ratio:

• Remaining Program Credits ÷ Academic Year Definition Credits

To identify the final academic year to be considered for proration, SFP uses the last academic year received in the
Student Academic and Financial Information (SAFI) message. To ensure correct Direct Loan calculations, all academic
years up to the end of the student's program must be sent in the SAFI Message.

Determines the current and projected subsidized loans awards
The application determines the maximum projected award amount, based on the annual and aggregate award year
loan limits established by the U.S. Department of Education for the current loan period and all future loan periods in the
student's program so the student can review how much can be received for the entire program.

When determining the student's maximum projected Stafford loan award(s) for a loan period, the application takes into
account the student's:

• Financial Need.

• Subsidized loan limit.

• Unsubsidized loan limit.

• Grade level loan limit.

• Prorated loan limit.

• Remaining overlapping loan limit.

• Remaining loan eligibility based on NSLDS annual limits and overlapping loans.

• Remaining loan eligibility based on NSLDS aggregate limits, if applicable.

Updates the Stafford Loan fund status
The application updates the fund status during the packaging process from Estimated or Projected to Awarded once
the fund meets the configured awarding criteria. Once the status has updated to Awarded it does not revert back to
an Estimated or Projected unless the ISIR is updated from Valid to Invalid. If the ISIR status is updated to Invalid, the
fund status would be updated from Awarded to Projected. If a student is awarded and then the eligible fund amount is
adjusted, the fund status remains Awarded; however, the award amount is adjusted and the fund requires acceptance as
necessary.

The Financial Plan Outbound (FPO) message is generated based on the student's packaging status updates. This is
used to inform the student if the packaging status is Projected, Estimated, or Awarded.

Parent PLUS and Grad PLUS
The following sections discuss what the application does automatically for Parent PLUS and Grade PLUS loans.

Determines Stafford PLUS loan eligibility
Undergraduate and Graduate students are eligible for a PLUS Loan, per award year. Direct Stafford PLUS Loan eligibility
requirements are evaluated per award year and the application determines if the student had a prior loan discharged
due to disability or total and permanent disability and if so, Comment Code 137 has been cleared. The application
checks if the student/borrower is a citizen of the Marshall Islands, Micronesia or Palau, and requires the student/
borrower's Alien Registration Number if they are. If the student passes general Title IV eligibility requirements for a
Stafford PLUS loan, the student is packaged with the appropriate funding.
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Once the PLUS Loan Application is received, the application takes the Credit Decision results into consideration while
determining the student's eligibility.

Determines if there is prior PLUS application for the borrower in the Academic Year
The application can award multiple PLUS or Graduate PLUS loans within an academic year, including loans
received by more than a single borrower. This is done by taking these steps in the FAS Fund Config workbook
(FAS_FUND_CONFIG.csv):

1. Enter PLUS or GPLUS in the Fund_Code field.
2. Reference a Groovy Script in the PLUS_Credit_Decision_Matching_Criteria field. In this script, you can

determine the terms within a student's program that a PLUS application are matched to. When students are
awarded Direct PLUS Loans using this script, the Fund Description display includes the Borrower Name and
Application ID.

Evaluates the credit decision
If the student is eligible for a PLUS loan based on the final Credit Decision status for the academic year being evaluated,
the application determines if the loan period is for the past, present or future.

If the borrower has an accepted/approved Credit Decision that is processed during the current Academic Year and it
has not expired, the borrower is eligible for a PLUS Loan. The application does not award a borrower a PLUS Loan if
their Credit Decision is denied. If the borrower is denied, the PLUS Loan Denial Indicator is updated so the student can
receive additional Unsubsidized funding. If a new PLUS Loan Application with an updated Credit Decision is received,
the application updates the PLUS Loan Denial Indicator.

Form Name Updated

The credit decision form name has been updated from Credit Decision Override to Credit Status Response. Both form
names are still visible in the application user interface, depending on the Award Year the form was received.

• Award Years 2014-2015 and before: Credit Decision Override.

• Award Years 2015-2016 and beyond: Credit Status Response.

If a Credit Status Response message is received, the application considers the Credit Decision result while determining
the student's eligibility.

If the borrower has multiple Credit Decisions, the application first determines if the borrower has an accepted/approved
Credit Decision and then uses the latest Credit Decision to determine Stafford PLUS Loan eligibility. If the Credit
Decision is denied, but the borrower has an Endorser, the application obtains the Endorser Amount and considers the
Endorsed Amount during awarding.

When a PLUS Application/Credit Status Response file is received and associated with a student, the application
evaluates the credit decision status and calculates the Application Loan Amount associated with the credit decision
status. When a Credit Status Response is received for a student, the application considers the override code received
within the file.

When a PLUS Application or Credit Status Response file is received for a student, the application determines if the
credit decision is for a Parent PLUS or Grad PLUS Loan, the associated academic year(s), the credit decision status and if
applicable, associates an endorser amount to the credit decision status.

Determines the current and maximum projected PLUS award amount
The application determines the Maximum Projected Award amount for the current loan period and all future loan
periods in the student's program.
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The application also determines the Maximum Projected PLUS Award for an academic year in which all eligibility
requirements have been satisfied and awards up to the amount left unpackaged. The student's Maximum Projected
PLUS award is limited by either the Unpackaged Amount, the Endorser Amount (if applicable), and/or Application Loan
Amount (if applicable).

Sets the final credit decision status
The final credit decision status is confirmed or updated when a PLUS Application/Credit Status Response file is received
and associated to an academic year and the final status is used to determine the student's eligibility for a PLUS award.
The application packages a separate PLUS loan for all approved credit decisions received that have been matched to an
academic year or term within the student’s program.

Once the Final Credit Decision status is determined for an academic year, the application sets the Plus Denial Indicator
based on the credit decision status.

Updates the PLUS fund status
The application updates the fund status during the packaging process from Estimated or Projected to Awarded once
the fund meets the configured awarding criteria. Once the status has updated to Awarded it does not revert back to
an Estimated or Projected unless the ISIR is updated from Valid to Invalid. If the ISIR status is updated to Invalid, the
fund status would be updated from Awarded to Projected. If a student is awarded and then their eligible fund amount is
adjusted, the fund status remains Awarded; however, the award amount is adjusted and the fund requires acceptance as
necessary. If an award amount increases and the student doesn't pass the award criteria check, the application does not
award the additional amount.

Campus Funds: What the Application Does Automatically
The application automatically does the following things for Campus Funds.

Non-Federal Funds
The following sections discuss what the application does automatically for Non-Federal funds.

Provides a Non-Federal Funds Workflow
The application provides a workflow to assist the user in making the final determination whether a student is eligible for
a state grant and the amount the student is eligible to receive.

Determines Non-Federal Funds periods
The application displays the Non-Federal Funds period(s) and additional detailed information in the Non-Federal Funds
workflow based on the period start and end dates in order to determine how much to award the student during the
period.

A list of all periods is displayed and the application automatically determines the period start and end dates (based on
configuration) in the fund configuration engine. The maximum number of consecutive days the student is on a break
within the Non-Federal Funds period start and end dates, excluding institutional breaks and exemptions made by the
institution because of inclement weather or an administrative error are also displayed.

Awards or Estimates an amount per period
The application automatically calculates the student's Non-Federal Fund period award amount (if configured) or
allows a user to manually set the award amount so that the packaging engine can package the Non-Federal Fund. The
application allows the user to manually modify the Non-Federal Fund period award amount and updates the status to
Estimated or Awarded.
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Adds Non-Federal Funds to the academic year
Once a user determines the student is eligible for the fund, the application adds the fund to the appropriate academic
year within the student's package.

The application determines which Borrower-Based Academic Year (BBAY) to package the award is based on the Non-
Federal Fund period start date. If the user is modifying a Non-Federal Fund, the application verifies the fund is added
to the appropriate academic year again. The application sets the maximum projected award amount for each academic
year being Estimated or Awarded by completing a summation of all Non-Federal Fund period award amounts within the
academic year.

If the fund has an associated configured fund allocation, the application makes sure there are sufficient funds prior to
adding the award to the student's package.

The application disburses the Non-Federal Fund as one disbursement equal to the maximum Non-Federal Fund
projected award amount and sets or updates the disbursement dates for each Non-Federal Fund period being awarded.
If the fund has already been disbursed, the application does not update the disbursement dates.

The Application Creates a Re-Evaluate NFF Fund Task
The application creates a Re-Evaluate NFF Fund task at various points in the financial aid process that requires a user
to review the student's award. A separate alert is created for each Non-Federal Fund that has been reduced by the
packaging engine due to an over award situation and when the fund amount accepted does not equal the maximum
projected award up to packaging limit.

The Application Creates a Process an NFF Document task
When a Non-Federal Fund document with a configured document code is received for a student that requires review
for Non-Federal Fund to be packaged, the application creates a Process an NFF Document task and requires a user
to review the document. When the document/document code is received it's required to complete the Financial Aid
Documentation Collection process. Once it has completed the document collection process, the application creates a
new Process an NFF Document task for each configured Non-Federal Fund document received for the student.

Student Resources
The following sections discuss what the application does automatically for Student Resources.

Determines which academic year to apply Student Resources
The application determines how to associate a fund from the student resource tag in the Student Academic and
Financial Information (SAFI) message by the academic year associated with the course the student resource is tied to.
If the student resource fund is not tied to a course, the application uses the academic year found in the ledger posting
date.

If the application is unable to associate a student resource fund to the student's academic year or the correct fund
configuration is not in place in the fund configuration engine, the application utilizes the exception handling process.

Sets the fund amount and fund status
The application sets the actual fund amount and fund status after the fund is associated to an academic year. The
actual fund amount is equal to the student resource amount and the fund status is updated to Awarded. If a SAFI
message is received for a student and it contains more than one student resource that shares the same fund code,
these student resources are listed as separate entries in the student's package.
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Triggers a repackage if Student Resources affect the package
The application determines whether the addition of a student resource fund (or updated information) affects the
student's current package for the associated academic year and automatically repackages the student with the updated
information upon receiving a new student resource.

Configurable Attributes
Configure Fund Attributes

The institution can configure certain attributes in order for funds to be awarded properly.

Configure Student Resource Funds

The application is able to account for funding that has been provided to the student outside of the application through
the student resource tag within the SAFI Message. In order to ensure that the application understands how to handle
the received fund amount, the fund has to be configured in the Fund Configuration Engine. Configuration for the fund
within the Fund Configuration Engine allows the application to understand what Borrower Based academic year (BBAY)
to place the fund in, if the fund goes towards funding up to the COA, and other such items that help the application on
the packaging and advisory side.

It should be noted that any received fund amounts through the student resource tag should not be adjusted by the
application in the student's package, even if the fund is lower in priority than a Title IV fund. (for example, if the
application is packaging a student up to COA and they've hit COA without accounting for the student resource fund, the
Packaging Engine reduces the funds that are higher in priority within the Fund Configuration Engine to account for all
of the student resource funds).

If the fund is unknown to the application because it is not configured via the Fund Configuration Engine, the application
does not process the fund and the fund goes through the application exception handling process.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Application User Interface Functionality
To view the packaged funds
the application User Interface > Student >  > Financial Information > Packaging > Student > Financial Information >
Packaging

Historical Fund Information Event Message  
The Historical Fund Information message is required for Pell Originations for two types of students:

• Students that have at least one disbursement in an outside system disbursed in an academic year prior to the
first Student Financial Planning academic year
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• Students that are segmented into Student Financial Planning and are a re-entry after 180 days but have a
disbursement in an outside system

The intention is that the HFI message is sent prior to the 1st Student Academic and Financial Information (SAFI)
message.

Note:  Student Financial Planning is currently only configured to accept HFI files for PELL. When entering the
<FinancialAwardType> it must be identical to the FUND_CODE in the FAS_FUND_CODE_DEFN table. If anything other
than PELL is entered for Fund Type, it will return a Validation Error.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
Testing Steps.

• Student

• XML Viewer

• Administration

• System Management

• Disbursement Administration

See Set General Permissions Matrix for additional information.

Year-Round Pell Grant  
A student can be evaluated for Year-Round Pell Grant eligibility if the Year-Round Pell Grant Indicator has been
configured and set to True.

Overview
If the Year-Round Pell Grant Indicator is equal to True, Student Financial Planning uses the configured Year-Round Pell
Grant Multiplication Factor for the maximum Pell Grant Scheduled Award. For 2018, one and a half times the maximum
scheduled award is allowed in the award year. The Scheduled Award for 2018 Award Year is equal to $5,920, so a student
would be eligible for a Maximum Projected Award of $8,880 ($2,960 per payment period).

The majority of Pell Grant calculator evaluations remain the same except for the following:

• Determine Payment Period and Payment Period Award Year.

• Calculate Pell Grant Payment Period Disbursement Amounts.

• Determine Remaining Eligibility Based on NSLDS Award Year Limits.

Eligibility for Year-Round Pell Grant
To be eligible for Year-Round Pell Grant, the student must meet the following criteria:

• Year-Round Pell Grant Indicator Must Equal True.

• Enrollment Status Must Equal:
◦ Full Time (F).
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◦ Three-Quarter Time (Q).

◦ Half Time (H).

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Determines if the Payment Period being evaluated is a Crossover Payment Period
Crossover Payment Period

• Student Financial Planning evaluates and determines the Maximum Projected Award per Payment Period for
both crossover award years.

Non-Crossover Payment Period

• Student Financial Planning evaluates and determines the Maximum Projected Award per Payment Period for
the payment period award year

Note:  If Year-Round Pell Grant would benefit the student, but they aren't enrolled in a crossover payment period, the
Pell Maximum Projected Award per Payment Period is evaluated using the normal Pell Grant calculation for that award
year. Also, all Pell Grant calculator evaluations remain the same except for the Determine Remaining Eligibility Based
on NSLDS Award Year Limits logic.

Determine if a Valid ISIR exists for Crossover Award Years
If an award year ISIR is flagged for Verification, the application doesn't consider it until it's been verified and status
updated to Valid. If only one of the award years has a Valid ISIR, the application chooses the award year that has a Valid
ISIR to calculate the Maximum Projected Award per Payment Period amount.

If both award year ISIRs are Valid, Student Financial Planning calculates the Maximum Projected Award per Payment
Period amount for each of the award years.

All Pell Grant calculator evaluations remain the same except for the Determine Remaining Eligibility Based on NSLDS
Award Year Limits logic. When calculating the Maximum Projected Award per Payment Period amount, the application
updates the “Percent of Award Year Eligibility Remaining” calculation. The value updated is the Maximum allowable
Scheduled Award Percent (First Value in the equation).

Calculates the Percent of Award Year Eligibility Remaining

Note:  The Maximum Eligibility Percent turns the configured Year-Round Pell Grant Multiplication Factor into a
percentage.

• Year-Round Pell Grant Multiplication Factor of 1.5 = 150%.

• Year-Round Pell Grant Multiplication Factor of 2.0 = 200%.

Maximum Eligibility Percent - NSLDS "Percent of Eligibility Used" - Prior Maximum Projected Award per Payment Period
Percent (for AY) + Current & Future Payment Period Amount Percent Total (for AY) = Percent of Award Year Eligibility
Remaining
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Determines in which Award Year to place the Payment Period to be most beneficial to
the Student
When the payment period is a crossover, the application compares the Maximum Projected Award per Payment Period
for both award years and puts the payment period in the award year that produces the greater amount for the student.

Communicates Additional Pell Grant to COD
If additional Pell Grant is given in an award year for a payment period, Student Financial Planning communicates a value
equal to True in the <AdditionalEligibilityIndicator> tag that is included in COD origination/disbursement files.

Note:  The <AdditionalEligibilityIndicator> tag should always be included in the COD origination/disbursement files
(for example, subsequent originations, disbursement cancellations, returns, and so on) as True/False based on the
first accepted origination.

Configuration Updates
Year-Round Pell Grant Indicator

The application is configured to support a Year-Round Pell Grant Indicator. If the Year-Round Pell Grant Indicator is set
to True, the application uses the configured Year-Round Multiplication Factor.

Year-Round Pell Grant Multiplication Factor

The application is configured to use the Year-Round Pell Grant Multiplication Factor if the Year-Round Pell Grant
Indicator is set to True. If the Year-Round Pell Grant Indicator is set to True, the Year-Round Pell Grant Multiplication
Factor is required.

The Year-Round Pell Grant Multiplication Factor for the Award Year 2018 is equal to 1.5.

Note:  If award year configuration has not been set for the award year, the application defaults the Year-Round Pell
Grant Indicator and Year-Round Pell Grant Multiplication Factor configuration to latest configured year.

Navigation to the Student Financial Planning User Interface Functionality
To view the disbursements per Payment Period, navigate to Student Financial Planning User Interface > Student >
Student Record > Disbursing.

Note:  You may need to review multiple Academic Years.

Loan Fee Management  
Student Financial Planning determines the Disbursement Loan Fee and Interest Rebate Amount for Direct Stafford
Subsidized, Unsubsidized, and PLUS Loans. The Loan Fee amounts are included in the Cost of Attendance (COA) and
the student's financial aid package.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:
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Determines Disbursement Loan Fee and Interest Rebate Amounts
Student Financial Planning determines the disbursement fee and interest rebate amounts for each loan period and each
loan fund including Subsidized, Unsubsidized, Parent PLUS and Grad Plus. The following information is determined and
saved to the student record:

• The loan fee and interest rebate percentage that correspond to the first disbursement date of a loan.

• The student's disbursement fee amount and interest rebate amount for each disbursement.

• The total loan fee by subtracting the total interest rebate amount from the total disbursement fee amount.

If updates to the Direct Loan disbursement amounts are required due to Fund Acceptance or Disbursement Acceptance,
Student Financial Planning updates the disbursement fee and interest rebate amounts accordingly.

Student Financial Planning also updates COD with the loan fee for academic year disbursements when the first
disbursement date changes to a future loan fee period:

• If not yet disbursed, Student Financial Planning cancels the loan and re-originates with the new fee and new
first disbursement date in the new loan fee period.

• If disbursed, Student Financial Planning returns the disbursed funds and re-originates with the new fee and
new first disbursement date in the new loan fee period.

Updates Loan Fees and Interest Rebate Amounts due to Annual Regulatory Updates
Each Year the Department of Education (DOE) updates the loan fee for a borrower to receive a Direct Loan. The DOE
communicates a loan fee percent that must coincide with the loan's first disbursement date for all Direct Loan types
including Subsidized, Unsubsidized, and PLUS Loans. When the DOE communicates the dates for loan fees to be
updated SFP is updated to use the new loan fees and the system automatically updates all existing awarded and
originated Direct Loans and originates any new loans with the loan fee associated to loan's first disbursement date.

SFP automated updates that are determined and saved to the student record include the following:

• Any required updates to loan fees and interest rebate percentages that correspond to the first disbursement
date of a loan.

• Any required updates required to update COD if a different loan fee has been previously communicated and
accepted and is now changed after the DOE communication.

◦ In order to do this, SFP first zeros out the existing loan with COD and once accepted sends the loan again
with the updated, new loan fee.

To view the Loan Fees associated with a specific Award Year, see New Award Year Updates in the Product Release Notes.
Choose the Award Year you want to review. See Doc ID 2613016.1 on My Oracle Support.

Includes Direct Loan Fees in the COA
Student Financial Planning determines the Total Direct Loan Fee and includes them in the Cost of Attendance (COA).
Total Direct Loan Fees includes fees for, Subsidized, Unsubsidized, PLUS Loan Fee or Total Grad PLUS Loan Fee.

Determines Loan Period Award Year
Student Financial Planning determines the Loan Period Award Year based on the first disbursement date for the Direct
Loan for the Academic Year being awarded for each Direct Loan.
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Student Financial Planning repackages the fund if the current Loan Period Award Year does not equal the previous Loan
Period Award Year or if there is no previous Loan Period Award Year and if the current Loan Period Award Year does not
equal the Award Year from the Loan Period Information Table.

Configurable Attributes
This feature does not require any institutional configurations

Navigation to the Student Financial Planning User Interface Functionality
To View the Loan Fees Via the COA
Student Financial Planning User Interface > Student Record > Financial Information > Packaging > COA > View
Details (button)

1. Search for Student Record by IRN, First or Last Name
2. Hover over the Financial Information tab
3. Click Packaging
4. Click the View Details button under the Package Summary
5. Review the Loan Fees within the Cost of Attendance table

To View the Loan Fees Via the Disbursement
1. Navigate to the Student Record

a. Hover over Financial Information
b. Click Disbursing

2. Click the Sequence # for any applicable fund type
3. Review the Loan Fee/Rebate Details Table

Re-Entry Packaging  
When Student Financial Planning determines a student is re-entering within 180 days the system re-initiates the
financial aid process according to FSA regulations and reviews every current financial aid processes including the return
to Title IV calculation, grant overpayments, post-withdrawal disbursements, late disbursements, exit counseling and
repackages and/or disburses as necessary.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Determines if the student is re-entering
Student Financial Planning determines if the student is re-entering into the same program ensuring that the re-entry
date is less than 180 days from the student's Official Last Date of Attendance (OLDA). Student Financial Planning
evaluates if the student has any prior enrollment(s) for the same program and concentration in which the student
withdrew. Programs with different version numbers are considered a re-entry into the same program.

Updates pending R2T4 calculations
If the student has a pending R2T4 calculation upon re-entry within 180 days of the OLDA, Student Financial Planning
first determines if the pending R2T4 calculation is due to a configured delay (i.e. pending ISIR or repackage) or due to
a student not officially rescinding the withdraw. If the student is in an officially withdrawn status and the pending R2T4
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calculation is due to a pending ISIR or repackage, Student Financial Planning does not cancel the R2T4. Once an R2T4
calculation is completed on the prior enrollment, Student Financial Planning repackages the student and update the
package and disbursements for the current enrollment.

If the pending R2T4 is not due to a configured delay, Student Financial Planning cancels the pending R2T4.

Updates prior R2T4 calculations
When the student is a re-entry within 180 days and the R2T4 has been completed, Student Financial Planning updates
any disbursements that were canceled as a result of the completed R2T4. The cancellation reason is removed for all
disbursements that were canceled with the following cancellation reason, Future Disbursement Cancelled after R2T4.
The disbursement status is updated depending on whether the fund requires COD communication or not. If the fund
requires COD communication, Student Financial Planning updates the disbursement status to Origination ready to be
sent to COD; otherwise, the disbursement status is updated to Disbursement Scheduled.

Updates prior grant overpayments
If there is a pending grant overpayment when the student re-enters within 180 days Student Financial Planning updates
the grant overpayment appropriately by first determining if the grant overpayment has been reported to National
Student Loan Data System (NSLDS) and/or Debt Resolution Services (DRS). If the grant overpayment has not been
reported to NSLDS, Student Financial Planning updates the grant overpayment to Resolved. If the grant overpayment
has been reported to NSLDS and/or DRS, Student Financial Planning creates a Report Grant Overpayment Resolution to
NSLDS and DRS task for user review to resolve the grant overpayment with NSLDS.

Updates prior post-withdrawal disbursements
Student Financial Planning determines if there are pending post-withdrawal disbursements (PWDs) when the student
re-enters within 180 days, cancels the PWD and draws down the appropriate funds after re-enrollment repackaging.
If the student/parent have been sent a PWD Fund Acceptance notification, Student Financial Planning sends a
subsequent message to the student/parent to notify them due to re-enrollment the PWD has been canceled.

If the student/parent already declined the PWD or did not accept the funds before the PWD Fund Acceptance Due
Date and Student Financial Planning cancels the funds, the disbursement status and amounts are updated to the prior
state as a result of repackaging. Student Financial Planning then awards these funds and the student/parent have the
opportunity to accept these funds for the new enrollment.

If the student/parent accepts the PWD, Student Financial Planning updates the fund amounts to what they were prior
to the student withdrawing as a result of repackaging. If there is a difference between what was previously disbursed
and what the student is currently eligible to receive, Student Financial Planning makes necessary updates and awards
appropriately.

If Student Financial Planning receives a fund acceptance message for a pending PWD when a student is considered a
re-entry, Student Financial Planning updates the packaging based on the fund acceptance that results from the new
award message.

Updates prior late disbursements
Student Financial Planning determines if there are any late disbursements when the student re-enters within 180 days.

If the student re-enters within 180 days, Student Financial Planning checks if there are any late disbursements for a
prior enrollment that falls within the current academic year. If the late disbursements are for the current academic year,
Student Financial Planning removes the "late disbursement" indicator. If the late disbursements are for a past academic
year, the student is still required to accept the late disbursement and all existing rules apply.

If a late disbursement notification has been sent for the current academic year, Student Financial Planning sends a
subsequent notification to inform the student/parent the late disbursement has been canceled due to re-enrollment
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and the disbursement(s) are no longer considered late disbursements and Student Financial Planning updates the
disbursement amount based on the original late disbursement amount.

If the student declined the late disbursement or did not accept the funds before the due date and Student Financial
Planning cancels the funds and updates the disbursement status and amounts to what they were prior to the student
withdrawing upon completion of repackaging. Student Financial Planning then awards these funds and the student/
parent has the opportunity to accept these funds for the new enrollment.

If the student accepts the late disbursement, Student Financial Planning updates the fund amounts to what they were
prior to the student withdrawing upon completion of repackaging. If there is a difference between what was previously
disbursed and what the student is eligible to receive, Student Financial Planning awards these funds and disburses the
difference.

If the system receives a fund acceptance message for a pending late disbursement, Student Financial Planning updates
the student's package and only updates it based on the fund acceptance that results from the new award message.

Update pending exit counseling notifications
If there are pending exit counseling notifications when the student re-enters within 180 days, Student Financial Planning
closes any open notifications and sends the student a subsequent notification to communicate they no longer need to
take action. If the student already completed the exit counseling, Student Financial Planning maintains the information
without making any updates and takes no further action.

Re-initiates valid ISIR process for active ISIR on record
When a student re-enters within 180 days, Student Financial Planning needs to re-initiate the Valid ISIR process and
identify the active ISIR on the student record. Student Financial Planning identifies the active ISIR for each Award Year if
the student requires being packaged over multiple award years.

If the student re-enters into a payment period that crosses into a new award year, Student Financial Planning identifies
the active ISIR transaction for the new award year. If the active ISIR is in a Valid (or Unverified, if Verification canceled)
state, the re-entry process also considers the ISIR for the additional award year.

Repackages upon re-entry within 180 days
When Student Financial Planning identifies the student re-entered within 180 days, Student Financial Planning
automatically begins the repackaging process using the same enrollment. During repackaging Student Financial
Planning re-instates the current payment period using the previous enrollment. The student must pick up where they
left off during the payment period that was active when they withdrew during the prior enrollment.

Example:

If the student was enrolled in a 60 credit program and withdrew in the 1st payment period of the 2nd Academic Year
with 6 credits completed out of 12, they will return with 6 credits remaining in their 2nd Academic Year, Payment Period
1, and 12 credits remaining in Academic Year 2 Payment Period 2 (and the remaining 12 credits in academic year 3)

The student must also maintain the same loan period that was active when the student withdrew from the prior
enrollment. Student Financial Planning re-initiates the loan period start and end dates based on the re-instated
academic year dates.

During repackaging Student Financial Planning re-instates the Cost of Attendance (COA) from the previous enrollment.

• The COA is the costs associated with the original period before the student withdrew.

• The COA for a student returning to the same program within 180 days must reflect the original educational
costs associated with the payment period from which the student withdrew
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• The Cost of Attendance must remain the same for the returning payment period

Initiates the disbursement release process for the resumed payment period
based on repackage
Student Financial Planning automatically re-initiates the disbursement release process when a student re-enters within
180 days so that eligible disbursements for the resumed payment period can be drawn down.

If the disbursement for the resumed payment period did not occur, Student Financial Planning disburses those funds
after the student is repackaged. If the student is eligible for a different amount based on a Valid ISIR, Student Financial
Planning make necessary adjustments and disburses the appropriate amount.

Re-opens award year for re-entries if granted administrative relief
If an Award Year is manually re-opened, Student Financial Planning repackages the student.

Student Financial Planning alerts the user if there are any re-entry students in the same program within 180 days that
require an award year to be opened for a resumed payment period. Student Financial Planning repackages the student
once the user updates the Fund Close Out Date configuration and opens the award year for each fund the user selects.

Re-initiate SAP status
Student Financial Planning re-initiates the SAP status when the student is re-entering into the same program within 180
days to ensure that the correct SAP status is being carried forward. Student Financial Planning considers all the courses
in the student's program when calculating the quantitative and qualitative components.

• For the Qualitative component, the system should use the GPA for all courses in the student's program, up to
the end of the payment period, including courses prior to the student dropping and re-enrolling.

• For the Quantitative component, the system should consider all attempted and completed courses in the
student's program, including courses prior to the student dropping and re-enrolling, to determine the
maximum time frame and pace of completion.

When determining the SAP status, Student Financial Planning considers the student's SAP status prior to withdrawing.
The student is placed in a Disqualified status if the student fails the GPA or Pace of Completion evaluation and was in
a Warning or Probation status prior to withdrawing. However, if the student passes the GPA and Pace of Completion
evaluation and was in a status of Probation, Disqualified or Warning status prior to withdrawing, they are placed in a
Regular status.

Repackages upon re-entry  after  180 days
Student Financial Planning repackages a student who is re-entering after 180 days and the new enrollment is created
by starting a new academic year. The academic year is based on the first-course start date and all credits completed
previously count as completed credits toward the program.

Configurable Attributes
There are no configurable attributes for this feature.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management to view the following
information.

• Student
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See Set General Permissions Matrix for additional information.

Manual Overrides - Packaging  

Overview of Packaging Overrides for Title IV Funds  
This is a general overview of information to help you effectively override Title IV financial aid awards as needed.

You are able to manually override funds and costs of attendance as needed. This is a summary of actions and impacts.

Add a Title IV Fund

• How: See Add, Edit, or Remove a TIV Fund.

• Impact: The fund is added based on the values you enter, and disbursements are automatically created. After
saving the change, the fund will need to be managed manually for the Academic Year for Title IV Funds as
future automation for that fund won't occur.

• Future Automation Impact: Yes.

Edit a Title IV Fund

• How: See Add, Edit, or Remove a TIV Fund.

• Impact: The fund is adjusted based on the values you enter, and downstream disbursements are automatically
made. After that, the fund will need to be managed manually for the Academic Year for Title IV Funds as future
automation for that fund won't occur.

• Future Automation Impact: Yes.

Add a Non-Federal Fund

• How: See Add Non-Federal Fund.

• Impact: The fund is added based on the values you enter and disbursements are automatically created. The
fund will need to be managed manually for the Non-Federal Funds Period as future automation for that fund
won't occur.

• Future Automation Impact: Yes.

Edit a Non-Federal Fund

• How: See Edit Non-Federal Funds Period.

• Impact: The fund is adjusted based on the values you enter and downstream disbursements are automatically
made. After that, the fund will need to be managed manually for the Non-Federal Funds Period as future
automation for that fund won't occur.

• Future Automation Impact: Yes.

Edit Fund Acceptance Status

• How: See Overriding Fund Acceptance.
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• Impact: Fund Acceptance Status is updated based on your override, but future changes to Fund Acceptance
Status, for example from Student Self-Service, are automatically processed.

• Future Automation Impact: No.

Adjust Cost of Attendance (COA)

• How: See Add An Adjustment To The COA.

• Impact: COA adjustment is made based on values you input, and won't be updated by the system. Automated
calculations will continue to be driven off COA configuration.

• Future Automation Impact: No.

Change COA Type

• How: See Update COA To Actual Or Total.

• Impact: Once changed, the system won't automatically select which COA type, Total or Actual, should be used
in the student’s package for the Academic Year being overridden.

• Future Automation Impact: Yes.

Override Academic Years

Note:  Only do this for non-term-based programs.

• How: See Override Academic Years.

• Impact: Once you manually override Academic Year dates, subsequent SAFI messages won't trigger
Repackaging or be used by the Packaging logic for student’s entire program. This ensures your changes aren't
overridden.

• Future Automation Impact: Yes.

Manage Summer Terms

Note:  Only do this for term-based programs.

• How: See Manage Summer Term.

• Impact: If you make changes, the application will stop automatically determining whether the summer term
is a header or trailer or which Academic Year it belongs to. Downstream impacts to funds are processed
automatically by the system.

• Future Automation Impact: Yes.

Repackage a Student

• How: See Trigger Repackage Process.

• Impact: Using this feature forces the application to repackage the student using existing data as inputs, but this
doesn't have any impact on future automation.
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• Future Automation Impact: No.

Packaging Holds  
Packaging Holds are put in place for various reasons, including:

• Funds in transit to COD.

• Enrollment Review Tasks.

• Prior enrollment has an R2T4 pending.

• Student Record Hold exists.

In the Packaging page, you can see if Packaging holds exist for a student and access details and resolution instructions.

When the Resolve Hold button is clicked a pop-up window appears displaying why the package is on hold, with detailed
information that relates to the hold, as well as instructions on what steps a user can take (if any) to resolve the hold. The
user will also be able to see any packaging triggers that have been queued while the package was on hold. Once the
hold is removed, the queued triggers will package in the order they were received.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

• Displays a Resolve Hold button on the Packaging Page.

Students with Packaging Holds have the following displayed on their Packaging page:

◦ An (On Hold) indicator displayed next to Current Package.

◦ A Resolve Hold button displayed on their Packaging page.

When you click Resolve Hold, a pop up window displays details, including why the Package is on hold,
instructions to resolve the hold, and the Pending Package Triggers.

These are the Packaging Holds and resolutions:

Hold Reason Message Process

COD Hold The student's package has been placed on
hold due a disbursement currently being
processed with COD. If the disbursement
has a had a status of "Origination Sent to
COD" or "Disbursement Sent to COD" for
longer than 1 business day, please verify the
status on COD. If needed, the disbursement
status can be manually updated via the
Disbursement Administration UI.

The user verifies the status of the
disbursement and sequence in a "Sent
to COD" status on the COD website if the
hold has been present for more than 1
business day. If the SFP disbursement
status is different than the disbursement
status on the COD website, update the SFP
disbursement status to match COD.

Enrollment Review "The student's package has been placed on
hold due to student changing programs and
having a pending enrollment review task.
Please complete this task on the Evaluate
Student Change of Program UI. Once the

The user must navigate to the Enrollment
Review task queue, and complete the task
for the student.
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Hold Reason Message Process

task has been completed, the student will be
automatically repackaged."

Pending R2T4 "The student's package has been placed
on hold due a pending Return to Title IV
calculation in the prior enrollment. Please
complete the Return to Title IV calculation,
 including releasing any resulting Quality
Control holds. Once the Return to Title IV
calculation has been completed, the student
will be automatically packaged for the new
enrollment."

The user must review prior enrollments and
release any R2T4 QC holds.

Student Record Hold "The student is currently on a student
record hold and the package will not be
processed unless it is required for a Return
to Title IV calculation. If the student should
not be on a student record hold, please
remove the hold on the Student Record
Hold UI. Once the student record hold is
released, the student will be automatically
repackaged."

The user should review the Student Record
Hold and release the hold it’s no longer
needed.

• Resolves Holds

If holds are due to actions that are in process, for example, funds in transit to COD, the holds are released when
the actions are complete.

• Processes Queued Triggers

Once a Packaging hold is removed, any queued triggers package in the order they were received.

Configurable Attributes
This feature does not have any configurable features.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps listed below.

• At Will Repackage

See Set General Permissions Matrix for additional information.

Manual Processing Steps

1. Navigate to Student > Financial Information > Packaging
2. Click Resolve Hold, if displayed.
3. Follow instructions in the pop-up window.
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Packaging Errors  
Packaging Errors can happen for a variety of reasons that are specific to an individual student’s situation. Therefore, the
process to correct Packaging Errors can be very individual to a student.

Overview
You can view detailed information about what errors are blocking the Packaging process for an individual student in the
Student Packaging UI.

The same information you see in the UI is available by running the Application Event Error Report. This report can be
used to identify why a student’s package is on hold or blocked. It provides the same information as the UI. You can run
this report to determine all errors that occurred within a specified time frame.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

• Displays a Resolve Blocked Calc Button on the Packaging page.
Students with Packaging Errors have a Resolve Blocked Calc button displayed on their Packaging pages.
Clicking the button displays a pop-up window with detailed information into why the package is blocked, the
date the blockage occurred, and what manual steps, if any, can be taken to correct the error.

• Processes queued Triggers.
When you take the directed steps to resolve the Packaging Errors, any queued triggers package in the order
they were received.

Configurable Attributes
This feature does not have any configurable features.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps listed below.

• At Will Repackage

See Set General Permissions Matrix for additional information.

Manual Processing Steps
1. Navigate to Student > Financial Information > Packaging
2. Click Resolve Blocked Calc, if displayed.
3. Follow instructions in the pop-up window.

Trigger Repackage Process  
You can manually trigger a repackage using the FAS UI. When you repackage using the UI, the system only repackages
the student for the enrollment that you’re viewing in the UI.

Overview
You can also use the FasAtWillRepackageEvent message to manually repackage. When using this message, you can
specify a particular enrollment or trigger repacking for all enrollments associated with the student.

350



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 10
Using Financial Information

Downstream Impact: Not Applicable

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps.

• Student

• At Will Repackage

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI).

1. In the FAS, search for the student's external student ID number.
2. Navigate to Student > Financial Information > Packaging.
3. Click Repackage.
4. Enter a repackaging reason in the Description field.
5. Click Repackage.
6. Refresh the screen and review Repackaging Reason. You can see the Repackaging Reason in the Package

Summary and if you mouse over the Packaging Version.

Override Academic Years  
You can Override the Academic Year Dates from the Packaging page.

Overview
If you manually adjust a single Academic Year, ensure you set up all other Academic Years properly.

Note:  The application doesn't enforce this, so it's possible to manually adjust a single Academic Year and save your
changes without reviewing other Academic Years' setups.

When you save manual changes to an Academic Year, the application repackages the student using those changes.
Also, once you manually override Academic Year dates, subsequent SAFI messages don't re-trigger repackaging.
However, a subsequent SAFI message will trigger the credit balance engine to determine if there is a credit balance.

To trigger a repackage after you receive a subsequent SAFI message, re-map the student's Academic years.

Downstream Impact
You need to monitor students with manually Overridden Academic Year Dates for the duration of the student's program.

At certain points, you need to evaluate unprocessed SAFIs to determine if you want to use a more recent SAFI. To use a
more recent SAFI, select the SAFI you want to use and follow the Manual Processing Steps to complete the updates.

Tips for Overriding the Academic Year
Check Non-Federal Fund Periods first.

You must take into consideration if there are any Non-Federal Funds (NFF) before overriding the Academic Year. If there
are NFFs, check the NFF Period Start and End Dates and make sure that when you update the Academic Year, the NFF
Period Dates are within the updated Academic Year Dates.
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Note:  If you update the Academic Year Dates and it results in the NFF period dates being outside of the Academic
Year Dates, future repackages may fail or an app event error may occur.

If a manual update to an Academic Year results in an NFF Period being outside the acceptable dates, the application
creates a Re-Evaluate NFF Fund task.

Required Role Permissions
The user must have a role with these General Permissions through Roles Management to complete the manual
processing steps:

• Student.

• Override Academic Years.

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Override Academic Year Dates

1. Sign into the Student Financial Planning User Interface (UI).
2. Enter the student's external student ID number in the search field located in the upper right-hand corner.
3. Navigate to Student > Financial Information > Packaging.
4. Expand the Historical Packaging Versions and take note of the number of latest Version Number.
5. Override Academic Years.
6. Select SAFI Version.
7. Configure Academic Year and Payment Period Course Dates.
8. Enter an Academic Year Start Date of Overlapping Loan if applicable.

AcY Start Date of Overlapping Loan: Only update this data field if the student has an unfinished academic
year at a prior institution that overlaps with the current enrollment's first academic year. If an overlap exists,
update this data field to equal the date of the prior institution's Academic Year Start Date.

9. Enter a Final Academic Year End Date if applicable.

Final AcY End Date: Don't update the final academic year end date unless the final academic year is shorter
than the academic year definition. If it is shorter, calculate the academic year end date based on the number of
weeks required to complete an academic year and update this data field with the calculated value (AcYr Start
Date + AYD Weeks = AcYr End Date).

10. Update Payment Period Dates if necessary.

AcY Start/End & PP Start/End Dates: If you need to adjust dates further after configuring the Academic Year
Start, Middle and End dates, use the date picker in the Override Summary section to update the academic year
start and end dates or the payment period start and end dates.

11. Click Save.
12. Click OK to confirm update and refresh the screen to see updates.
13. Confirm that the updates were saved and the repackaging reason is: Academic year info was overridden.

Held SAFIs

After an academic year has been overridden, subsequent SAFIs no longer trigger a repackage. New SAFI
messages are held (stored, but unprocessed) and do NOT trigger a repackage. Subsequent SAFI messages have
to be accepted, and each academic year's payment period dates need to be mapped out for the remainder of
the student's program.
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One Course Academic Year

If you have an academic year that is only one course, you need to enter the PP1 End Date and PP2 Start Date:

• The PP1 End Date must be between the Academic Year Start Date and the Academic Year End Date.

• The PP2 Start Date must be between the PP1 End date and the Academic Year End Date.

Override Academic Year Dates with Overlapping Courses
When an Academic Year includes overlapping courses, make sure to select dates based on the appropriate start and end
dates. Make sure to use the start and or end dates that include all courses included in the payment period. So long as
the course start and end dates fall between the payment period start and end dates, it will be included in the payment
period.

Make sure to update the payment period start and end dates so that the student meets instructional weeks at the half
when you are overriding an academic year with overlapping courses.

Add, Edit, or Remove a TIV Fund  
You can add Title IV funds to a student record, edit existing Title IV funds, and remove Title IV funds.

Overview
You're are required to add or edit each of the fields to override the fund information.

Note:  To add, edit, or remove a Non-Federal Fund (NFF), see Non-Federal Funds.

Downstream Impact
Once you manually change fund information, Student Financial Planning (SFP) repackages the student using the
manually overridden fund information from that packaging version moving forward. However, you must continue
to monitor the manually overridden fund for the duration of the Academic Year and all edits must be manual.No
additional automated changes will be made for that fund.

If any subsequent events occur that impact the fund amounts, revisit the student record and make additional edits as
needed.

Here are some subsequent events that may impact the fund amounts:

• Subsequent ISIR FPS/CPS Transaction.

• New NSLDS record.

• Subsequent SAFI(s) that result in a Cost of Attendance change.

• Updated Fund Acceptance messages.

Note:  A manual update should be made using the UI where it will have the most impact to downstream processing.
For example, if a Disbursement Amount is inaccurate, you must determine if the update should be made at the
Fund Level (Student > Financial Information >  > Packaging) or at the Disbursement Level (Student > Financial
Information >  > Disbursing). If the Fund Amount is updated at Fund Level, future re-packages won't impact
Disbursements downstream. However, if the Disbursement Amount is updated at Disbursement Level, future re-
packages could cause the Disbursement Amount to be updated, resulting in an inaccurate Disbursement Amount due
to new information.
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Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete
these manual processing steps:

• Student

• Package Fund Edit

• Edit Fund Acceptance

See Set General Permissions Matrix for additional information.

Tips for Adding, Editing, and Removing Title IV Funds
Here are some tips for adding:

• Pell Grants

• Direct Loans

• PLUS/GPLUS Loans

Read these tips before using the manual processing steps to add, edit, or remove a fund.

Manual Processing Tips for Pell Grants

• Take into consideration all amounts for the Award Year including the current enrollment and all prior
enrollments.

• Enter the Decimal Carry Over Amount correctly. If you don't enter this data correctly, it may result in inaccurate
awarding in future payment periods/academic years. If you enter the Decimal Carry Over Amount as $0.00
Student Financial Planning doesn't add or subtract any amount in the subsequent payment period. When you
enter a negative value (i.e. -0.5) that amount is subtracted from the subsequent payment period; whereas when
a positive value (0.5) is entered that amount is added to the subsequent payment period.

Note:  If the Decimal Carry Over Amount is entered incorrectly, future disbursements may be incorrectly
awarded or rejected.

Current Payment
Period Award
Amount

Correct Decimal
Carry Over Amount

Resulting Amount
of the "NEXT" PP
Standard Rounding
Rule Applied

Incorrect  Decimal
Carry Over Amount

Resulting Amount
of the "NEXT" PP
Standard Rounding
Rule Applied

Resulting Value
Impacted?

2907.5 0.0 2908 0.5 2908 No

2907.5 -0.5 2907 0.0 2908 Yes

2907.5 0.5 2908 -0.5 2907 Yes

Manual Processing Tips for Direct Loans

• Take into consideration all amounts for all overlapping loans (external or internal).

• Take into consideration all amounts including the current enrollment and all prior enrollments and make sure
the total annual combined aggregate limit is not exceeded.

• Make sure the student's grade level is correct.
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Note:  If you do not enter the grade level correctly it may result in either an over-award or the student may be
underfunded

Manual Processing Tips for PLUS/GPLUS Loans

• When you are adding or editing a PLUS or Grad PLUS loan, you must make sure to select the correct PLUS
Response Info.

Note:  If you do not select the correct PLUS Response file, COD will not be able to associate the borrower with
the loan.

Manual Processing Steps to Add a Fund
Log into the Student Financial Planning User Interface (UI).

1. Enter the student's external student ID number in the Search Student field.
2. Navigate to Student > Financial Information > Packaging.
3. Click Add Fund.
4. Choose Fund Type.
5. Enter all fields.
6. Click Save.
7. Confirm the fund and award amount is successfully added to the student's package.

Manual Processing Steps to Edit a Fund

Note:  Use the same tips for Manual Processing Steps to Add a Fund.

Log into the Student Financial Planning User Interface (UI).

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student > Financial Information > Packaging.

Note:  You can review a prior packaging version's input values. Use this as a reference only. Don't copy and
paste the values, but rather use the information as a reference to modify the current packaging version
inputs.

3. Click the Edit Fund link for the Fund Type you want to edit.
4. Review every field and update as needed.
5. Click Save.
6. Click OK to confirm.
7. Refresh and confirm student repackaged due to: Package Details were manually overridden.
8. Confirm fund and fund amount updated.
9. Confirm subsequent processing occurred (for example, Disbursement Updates).

Manual Processing Steps to Remove a Fund
Manual Processing Tip to Remove a Fund

• To remove funds, update each field, and reduce the Award Amount to $0.00.

Log into the Student Financial Planning User Interface (UI).

1. Enter the student's external student ID number in the Search Student field.
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2. Navigate to Student > Financial Information > Packaging.
3. Click the Edit Fund link next to the fund type you want to remove.
4. Update the Fund Amount to $0.00.
5. Update the Is Eligible to "False".
6. Add a comment.
7. Click Save.
8. Click OK to confirm.
9. Refresh and confirm student repackaged due to: Package Details were manually overridden.

10. Confirm fund and fund amount updated to $0.00.
11. Confirm subsequent processing occurred.

Overriding Fund Acceptance  
You can override Fund Acceptance statuses.

Manual Processing Steps to Override Fund Acceptance
Manual Processing Tips for Overriding Fund Acceptance

• You can update the Fund Acceptance Status and extend or remove the Fund Acceptance Due Date. This
includes being able to reverse actions that occur when a student does not accept their award by the due date.
If you update the Fund Acceptance Status to Fund not Accepted, the Fund Accepted Amount must be zero.
If you update the Fund Acceptance Status to Accepted, the Fund Accepted Amount must be a whole integer.
You can delete or change future Fund Acceptance Due Dates.

• Updates create an entry in Student History and are reflected throughout the system where Fund Acceptance
data is used and displayed.

Log into the Student Financial Planning User Interface (UI).

1. Enter the student's external student ID number in the Search Student field.
2. Navigate to Student > Financial Information > Packaging.
3. Click Edit Fund Acceptance link for the Fund Type to open the Edit Fund Acceptance window.
4. Edit the Acceptance Status, Accepted Amount, and Fund Acceptance Due Date as needed by Term.
5. Click Save.
6. Confirm changes.

Note:  After overrides are completed, the system will continue to update the Fund Acceptance information if
subsequent Fund Acceptance updates are submitted by either the student or parent.

Update COA To Actual Or Total  
You can manually update the student Cost of Attendance to Total or Actual.

Overview
Downstream Impact

The institution may need to monitor students with a manually overridden cost of attendance during the academic year
that is overridden. Once the COA has been overridden, it remains overridden for the duration of the Academic Year
regardless of any future repackage.

Student Financial Planning automatically calculates a student's Total COA using defined configuration and the
academic year length. The Total COA is used in the Federal Student Aid (FSA) eligibility and awarding purposes. Student
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Financial Planning creates a sum of all configured and non-configured COA components/items to determine the Total
COA for each academic year and uses standard rounding rules when the calculated Total COA is not a whole number.

SFP calculates and displays the Total COA for each academic year in the student's program:

Term Program: For term programs, Student Financial Planning calculates the Total COA for each academic year in
the student's Term program. Student Financial Planning calculates the Total COA for each Term that the student
attends (separately), saves it, and then adds up all of the terms in the academic year to determine the Total COA for the
academic year. Student Financial Planning must use the Military Costs and Budget Costs when calculating the student's
budget and provide a breakdown of the COA per term, for the entire academic year. A Summer Term COA is added to
any Academic Year in which the summer term is associated (header or trailer).

Non-Term Program: For non-term programs, Student Financial Planning calculates the Total COA for the full Academic
Year.

Total COA Equation: Sum of all COA Components = Total COA Attendance

COA Component Equation: Sum of all COA Items = COA Component

Budget Costs

Student Financial Planning uses Budget Costsunless the institution configures one of the following enhanced
components to be present. Student Financial Planning determines which to use based on the FasStudentInitiationEvent
message.

• Budget Costs - With Parent

• Budget Costs - Off Campus

• Budget Costs - On Campus

Student Financial Planning Automatically calculates and displays the student's Actual COA based on all Actual charges
and uses standard rounding rules when the calculated Actual COA is not a whole number. Student Financial Planning
applies the Actual COA on an academic year basis.

SFP calculates and displays the Actual COA as an alternative to the Total COA value:

Term Program: For term programs, Student Financial Planning calculates the Actual COA for each academic year in
the student's Term program. Student Financial Planning calculates the Actual COA for each Term that the student
attends (separately), saves it, and then adds up all of the terms in the academic year to determine the Total COA for the
academic year. Student Financial Planning must use the Military Costs and Budget Costs when calculating the student's
budget and provide a breakdown of the COA per term, for the entire academic year.

Non-Term Program: For non-term programs, Student Financial Planning calculates the Actual COA for the full
Academic Year.

Actual COA Equation: Direct Costs + (the Budget Costs) = Actual COA

Budget Costs

• Budget Costs - Off Campus

• Budget Costs - With Parents

• Budget Costs - On Campus

• Military Costs (if BAH is indicated)

• Loan Fees (if configured to add Actual Loan Fees)
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Student Financial Planning uses Budget Costs unless the institution configures one of the following enhanced
components to be present. Student Financial Planning determines which to use based on the FasStudentInitiationEvent
message.

• Budget Costs - With Parent

• Budget Costs - Off Campus

• Budget Costs - On Campus

Standard Rounding Rules: Round up if the decimal is .50 or higher; round down if it is less than .50

Student Financial Planning calculates a student's Direct Costs, based on received invoiced charges in order to determine
if there is a shortfall in the student's package. Student Financial Planning completes a summation of Actual and
Projected student, program and course level charges per academic year. Student Financial Planning only uses Actual
charges in order to calculate the Student's Direct Cost.

Status Definitions

Actual: A charge that has been invoiced

Estimated: A projected charge that has not been invoiced

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Edit COA

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student > Financial Information > Packaging
3. Click the icon in the Cost of Attendance table to update
4. Choose Actual or Total based on need
5. Add a Comment
6. Save
7. Review the current packaging version and compare it to the packaging version prior to the COA update

Current Package

Previous Package

Related Topics
• COA, SAI/EFC, and Financial Need

Add An Adjustment To The COA  
You can add a positive or negative adjustment to the student's Cost of Attendance. Student Financial Planning accepts
any value you enter.
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Overview
Downstream Impact

Once an adjustment is added to a student record, every package moving forward includes the COA adjustment for that
Academic Year.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• COA Adjustment

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
◦ Navigate to Student > Financial Information > Packaging

2. Click the icon to add an adjustment to the COA
3. Add Adjustment
4. Enter Item
5. Enter Amount
6. Add Comment
7. Save Adjustment
8. OK to confirm
9. Wait for the student record to repackage and review the new packaging version

Repackaging Reason: An adjustment was made to the student's COA
10. Review updates to the Cost of Attendance
11. Review updates to the packaged funds
12. Click the icon to view the added adjustment
13. Review the Adjustments section and confirm the adjustment was added

Evaluate Overawards Packages  
When a student resource fund causes packaged funds to exceed the Packaging Limit, Student Financial Planning
creates an Evaluate Overaward Packages task so the package can be manually adjusted to resolve the over-award.

Overview
If the funds and/or student resources are adjusted, the Packaging Status is updated. If a subsequent re-package
resolves an over-award before the Evaluate Overaward Packages task is completed, Student Financial Planning cancels
or completes the task associated with the previous packaging version.

Triggering Action

Assumption: Fund is Associate to Academic Year being Packaged
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The student is packaged above the packaging limit and Student Financial Planning cannot reduce any other funds in
the package.

• The manually awarded flag is equal to True and the fund type is equal to Other Resources or Discounts and the
unpackaged amount minus the actual fund amount is greater than $0.00.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Over Award Review Task

• Permissions associated with manual packaging overrides (i.e. Edit COA, COA Adjustment, Package Fund Edit)

See Set General Permissions - Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Navigate to Dashboard > Evaluate Overaward Packages
2. Click the Claim a Task button
3. Click the Start Task button

◦ Update Package to Resolve: Review the funds in the student's package. Update the Cost of Attendance if
that resolves the over award or manually update the funds to resolve the over award.

- ◦ Navigate to Student > Financial Information > Packaging

◦ Make updates as necessary

4. Update the Resolution Description
5. Complete task

Summer Headers and Trailers  
Use the Standard Academic Year (SAY) Summer Configurator to define when a student population should have a
summer term treated as a Header or Trailer.

Overview
The Summer SAY Configurator uses groovy scripts to determine when to award a Summer Term and whether to treat it
as a Header or Trailer. However, you can always manually add a summer term as a Header, Trailer, or remove a summer
term for a student using the UI.

What Is a Summer Term
Summer terms are either before an upcoming academic year as Header or after a completed academic year as a Trailer.
Summer terms are optional and most students attend them voluntarily if they want to progress quicker than normal
or to repeat courses for a better grade. You can decide if you how you want to treat the summer term as its placement
impacts students fund eligibility.
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FasSafiSyncEventV2 (SAFI) Message: SummerTerm Element
The Summer Term element in the SAFI is nested within the <Term> Element, but after the <AcademicYears> element
because:

• It isn't technically part of the Academic Year.

• It can be added as a Header or Trailer based on the configuration.

The Summer Term should contain all <TermPeriods> eligible to be Summer Terms regardless if the student is attending
that term or not. Also, it can't overlap with any other term.

Oracle People Soft Campus Solutions delivers Summer Term integration with the product. he <SummerTerm> element
of the SAFI message includes terms with TERM_TBL - TERM_CATEGORY = “Summer Term”.

SummerTerm Element

 <Term>

   <TermType>Semester</TermType>

   <AcademicYears>

      <AcademicYear>

         <AcademicYearNumber>1</AcademicYearNumber>

         <StartDate>2018-08-28</StartDate>

         <EndDate>2019-05-16</EndDate>

         <TermPeriods>

            <TermPeriod>

               <Description>Fall Semester, 2018</Description>

               <StartDate>2018-08-28</StartDate>

               <EndDate>2018-12-13</EndDate>

            </TermPeriod>

            <TermPeriod>

               <Description>Spring Semester, 2019</Description>

               <StartDate>2019-01-22</StartDate>

               <EndDate>2019-05-16</EndDate>

            </TermPeriod>

        </TermPeriods>

      </AcademicYear>

   </AcademicYears>

   <SummerTerm>

      <!--A Summer Term will be outside of the normal Academic Years sent in the SAFI as
 it could be a header or trailer (not always up to the SIS)-->

      <TermPeriods>

         <!--Term period element will be identical to the existing ones.  Summer terms
 must not overlap other terms-->

         <TermPeriod>
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            <Description>Summer Term 2018</Description>

            <StartDate>2018-06-15</StartDate>

            <EndDate>2018-08-15</EndDate>

         </TermPeriod>

         <TermPeriod>

            <Description>Summer Term 2019</Description>

            <StartDate>2019-06-10</StartDate>

            <EndDate>2019-08-05</EndDate>

         </TermPeriod>

      </TermPeriods>

   </SummerTerm>

</Term>

Configurable Attributes
Configure the Summer Term as a Header or Trailer.
Using groovy script, you can configure the application to add a Summer Term automatically as a Header or a Trailer if
there is enrollment in the term. The configuration to control this behavior has two controls, first the CSV file and second,
the groovy script.

1. The CSV File
a. PKGSCHEDATTRIB.csv
b. Column: SUMMER_TERM_SCRIPT (this is the file path)
c. Data Type: Groovy Script

• Level: Set per OPEID

◦ The Groovy Script

The following code block is a simple sample Groovy Script that would return a Summer Term as a Summer Trailer.

Sample Summer Trailer Groovy Script

return "trailer";

Summer Header or Trailer Groovy Script: Explained
You have complete flexibility through Groovy Scripting to treat Summer Terms as Headers or Trailers globally or for very
specific student populations.

Review the following table to see an example of a few simple scripts and their descriptions.

Sample Groovy Script Description

return "header"; The application automatically defaults students with an enrollment in a Summer Term to be a Summer
Header

return "trailer"; The application automatically defaults students with an enrollment in a Summer Term to be a Summer
Trailer
 
If the Summer Term is before the first academic year, then the Summer Term is considered a Header
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null The application automatically defaults students with an enrollment in a Summer Term to be a Summer
Trailer
 
If the Summer Term is before the first academic year, then the Summer Term is considered a Header
 

Configure When Summer Terms Are Awarded
Using groovy script, you can configure:

• When to start awarding a Summer Term. For example, 20 days before Spring Term Ends plus enrollment in the
Summer Term.

• When to freeze the Fall/Spring awards and roll over the remaining eligibility for Direct Loans to the Summer
Term plus any additional funds. For example, grade level increases.

You have complete flexibility as to when you want to start packaging a Summer Term through groovy configuration.
The delivered Baseline Configuration packages a Summer Term when the Standard Academic Year has ended, but
you can package the Summer Trailer much earlier if you want, but modifying the Groovy Script provided through the
Baseline Configuration.

The configuration to control this behavior has two controls, first the CSV file and second, the groovy script.

1. The CSV file:
a. FAS_FUND_CONFIG.csv
b. Column: AWARD_OVERRIDE_CRITERIA
c. Data Type: CLOB (Groovy Script)
d. Level: Set per Fund
e. Possible Values:

2. The Groovy Script

The following code block is a copy of the Baseline Configuration Groovy Script for Direct Subsidized Loans (DSUB) and
Direct Unsubsidized Loans (DUNSUB).

Full Baseline Configuration Groovy Script Expand source

/* Baseline - Award Overriding Criteria for DSUB DUNSUB - combined Term and Non-Term */

import org.joda.time.LocalDate;

optimizer

         .setCumulativeGradeLevelLimitApplicable(

                 (term == null || term.isStandard())

                 && (program.isUndergraduate() || !isLastAcy))

         .setFundingForPeriodFilter {fundCode, fundType -> fundCode != "DISCOUNT"};

if (pp.getStatus() == "CANCELED")

{

    return awardInfo.withMaxAmount(0).withRetainedAmount(0);

}

if (program.isTerm())

{

    def overlappingTerms = primaryProgram.getTerms().getOverlappingWith(term);
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    /* Methods returning collection, as well as filters, will be plural; otherwise
 singular */

    if (overlappingTerms.getStudentsTermStatuses().contains("WITHDRAWN")) 

    {

        log.debug("STUDENT TERM IS WITHDRAWN");

    

        def r2t4OverlappingTerms = r2t4.getOverlappingWith(term)

                .getWithProcessStatuses(["NOT_REQUIRED", "COMPLETED"])

                .getWithOldas(overlappingTerms.getOldas());

            

        if (!r2t4OverlappingTerms.isEmpty())

        {

            log.debug("R2T4 Overlapping Terms isn't empty, FREEZING!");

        

            def sum = disbursements.getInAcademicYear(acyNo)

                    .getWithFundCode(fundCode)

                    .getInAwardYear(awy)

                    .getInLoanPeriod(lpNo)

                    .getInPaymentPeriod(ppNo)

                    .filterStatuses { status -> status != "DISBURSEMENT_CANCELED" }

                    .getPpMaxDisbursementAmount();

                

            return awardInfo.withMaxAmount(sum).withRetainedAmount(sum);

        } 

        else

        {

            log.debug("R2T4 PROCESS NOT YET IN A FREEZING STATE");

        }

    }

    

    if (enrollmentStatus == "NOT_ATTENDING" || enrollmentStatus == "LESS_THAN_HALF_TIME"
 || (sapStatus != null && sapStatus == "FD_FINANCIAL_AID_DISQUALIFICATION"))

    {

                 log.debug("ZEROING - enrollmentStatus={}, sapStatus={} ",
 enrollmentStatus, sapStatus);

        return awardInfo.withMaxAmount(0).withRetainedAmount(0);

    }

    

         def freezingDateForStandard = acy.getTerms()

                 .filter {t -> t.isSummerTrailer() && t.isAttending() } 
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                 .min() // get the earliest (yields an optional value)

                 .map {t -> t.getStartDate()} // map optional to its start date

                 .getOrElse(lp.getEndDate()); // if optional absent (no summer trailers)
 take lp.getEndDate

def now = LocalDate.now();

    if (log.debug(lp.getEndDate() <= now, "LOAN PERIOD IN THE PAST") // Update this line
 to determine when to freeze the standard terms and roll over unused funds to summer terms

         || log.debug(term.isStandard() && freezingDateForStandard <= now, "SUMMER TRAILER
 STARTING")

         || log.debug(term.isSummerHeader(), "SUMMER HEADER")

         || log.debug(term.isSummerTrailer() && now < freezingDateForStandard, "TOO EARLY
 FOR SUMMER TRAILER"))

    {

        def sum = disbursements.getInAcademicYear(acyNo)

               .getWithFundCode(fundCode)

               .getInAwardYear(awy)

               .getInLoanPeriod(lpNo)

               .getInPaymentPeriod(ppNo)

               .filterStatuses { status -> status != "DISBURSEMENT_CANCELED" }

               .getTotalDisbursementAmount();

         log.debug("FREEZING TO {}", sum);               

         return awardInfo.withMaxAmount(sum).withRetainedAmount(sum);

    }

}

return awardInfo; 

Summer Term Section of the Groovy Script: Explained
Using the Baseline Configuration Groovy Script for Direct Subsidized Loans (DSUB) and Direct Unsubsidized Loans
(DUNSUB), the application doesn't award or package the student for loans until the Standard Academic Year (SAY) ends.
For example, when both the Fall and Spring Terms are complete.

Once the Academic Year ends, the application lowers the awards for the Fall and Spring to match the sum of the
disbursements. For example, down to the accepted amount. Then, the application rolls any remaining eligibility for the
loan period over to the Summer Term (Summer Trailer).

This code block is the portion of the Baseline Configuration Groovy Script for DSUB and DUNSUB that is associated with
packaging a Summer Term.

Summer Term Section of the Groovy Script

 def freezingDateForStandard = acy.getTerms()

                 .filter {t -> t.isSummerTrailer() && t.isAttending() } 

                 .min() // get the earliest (yields an optional value)

                 .map {t -> t.getStartDate()} // map optional to its start date
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                 .getOrElse(lp.getEndDate()); // if optional absent (no summer trailers)
 take lp.getEndDate

def now = LocalDate.now();

    if (log.debug(lp.getEndDate() <= now, "LOAN PERIOD IN THE PAST") // Update this line
 to determine when to freeze the standard terms and roll over unused funds to summer terms

         || log.debug(term.isStandard() && freezingDateForStandard <= now, "SUMMER TRAILER
 STARTING")

         || log.debug(term.isSummerHeader(), "SUMMER HEADER")

         || log.debug(term.isSummerTrailer() && now < freezingDateForStandard, "TOO EARLY
 FOR SUMMER TRAILER"))

    {

        def sum = disbursements.getInAcademicYear(acyNo)

               .getWithFundCode(fundCode)

               .getInAwardYear(awy)

               .getInLoanPeriod(lpNo)

               .getInPaymentPeriod(ppNo)

               .filterStatuses { status -> status != "DISBURSEMENT_CANCELED" }

               .getTotalDisbursementAmount();

         log.debug("FREEZING TO {}", sum);               

         return awardInfo.withMaxAmount(sum).withRetainedAmount(sum);

    }

}

return awardInfo;

1. FREEZING A TERM means the application is setting its award for the specific fund under evaluation to the
Total Disbursement Amount of non-cancelled disbursements for that term; usually one disbursement. This
also works for Summer Terms without disbursements, in which case their awards are frozen to $0.00. When
the term is frozen, its award isn't subject to fund optimization. This means that it is taken into consideration,
affecting other term awards that aren't frozen, but isn't amenable to change. Freezing a term is done in the then
part of the last if statement:

Section of Sample Groovy Script: DSUB and DUNSUB

        def sum = disbursements.getInAcademicYear(acyNo)

               .getWithFundCode(fundCode)

               .getInAwardYear(awy)

               .getInLoanPeriod(lpNo)

               .getInPaymentPeriod(ppNo)

               .filterStatuses { status -> status != "DISBURSEMENT_CANCELED" }

               .getTotalDisbursementAmount();

          log.debug("FREEZING TO {}", sum);               

          return awardInfo.withMaxAmount(sum).withRetainedAmount(sum);
2. freezingDateForStandard:The main dynamics being implemented here is this: Summer Headers are always

frozen and then either Standard Terms or Summer Trailers are frozen. Summer Trailers remain frozen to $0.00
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when they are in the future. When the first Summer Trailer in an academic year has passed, Standard Terms
are frozen, and the application allows the Summer Trailer to receive remaining fund eligibility due to fund
optimization. So, an important variable is freezingDateForStandard, defined as:

Section of Sample Groovy Script: DSUB and DUNSUB

 def freezingDateForStandard = acy.getTerms()

           .filter {t -> t.isSummerTrailer() && t.isAttending() } // from summer
 trailers (probably at most 1)

           .min() // get the earliest (yields an optional value)

           .map {t -> t.getStartDate()} // map optional to its start date

           .getOrElse(lp.getEndDate()); // if optional absent (no summer trailers)
 take lp.getEndDate

freezingDateForStandard is defined as the Start Date of the earliest Summer Trailer (hence min()) having
attendance in that academic year. Or, in the event there are no Summer Trailers, the application defaults to
lp.getEndDate(), which is the end date of the respective Loan Period. Now all the relevant freezing rules appear
in the condition through the last if statement, namely:

Section of Sample Groovy Script: DSUBare and DUNSUB

     if (log.debug(lp.getEndDate() <= now, "LOAN PERIOD IN THE PAST") 

            || log.debug(term.isStandard() && freezingDateForStandard <= now,
 "SUMMER TRAILER STARTING")

            || log.debug(term.isSummerHeader(), "SUMMER HEADER")

            || log.debug(term.isSummerTrailer() && now < freezingDateForStandard,
 "TOO EARLY FOR SUMMER TRAILER"))

3. The Respective LOAN PERIOD IS IN THE PAST: This happens for any terms if the respective Loan Period is in
the past that is being frozen. This is what freezes earlier terms in donut scenarios. A donut scenario is when a
student attends Term 1, does not attend Term 2, and returns in Term 3.

4. The SUMMER TRAILER STARTING: In this condition, you can see term.isStandard() so the term under
evaluation is a Standard Term and the current date is past the freezingDateForStandard (if this happens to be
lp.getEndDate() this condition is equivalent to #3). Therefore, the application freezes the Standard Term and
rolls resources over to the Summer Trailer.

5. PART 5 - SUMMER HEADER: For this condition, the application freezes all Summer Headers regardless. If
this condition is removed, Summer Headers are awarded just like Standard Terms and compete for available
resources. Summer Headers are frozen to $0.00 unless there are disbursements for them.

6. PART 6 - TOO EARLY FOR SUMMER TRAILER: This is exactly what prevents Summer Trailers from
being awarded early and competing for resources with Standard Terms. In this condition, you can see
term.isSummerTrailer() so the term under evaluation is a Summer Trailer and it is in the future, so the
application freezes it and the value is $0.00 unless there are disbursements.

Tip:  #4 and #6 are mutually exclusive. When you freeze Standard Terms, you aren't freezing Summer
Trailers unless #3 applies.

Other Configuration Considerations
1. Months Calculation: You may want to analyze your institution's months configuration and update it to

calculate the designated number of months for Summer Terms (See lines 10-12 in the sample below).
a. Table: FAS_PACK_SCHED_CONF
b. Filed: PP_MONTHS_SCRIPT
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Sample Months Calculation Groovy Script

import org.joda.time.LocalDate;

def returnValue = 0.0;

if (program.getTermType() == null)

{

    log.debug("PP MONTHS CALCULATION CONFIG: ERROR, null value passed from API");

    return 0.0;

}

log.debug("PP MONTHS CALCULATION CONFIG: Program Term Type = {}",
 program.getTermType());

def programTermType = program.getTermType();

def safiTerm = program.getTerms().getOverlappingWith(term).get(0);

if (safiTerm.isSummer()) {

    returnValue = 2.0;

}

// Standard from this point on

else if (programTermType == "Semester")

{

    returnValue = 4.5;

}

else if (programTermType == "Trimester")

{

    returnValue = 3.0;

}

else if (programTermType == "Quarter")

{

    returnValue = 3.0;

}

return returnValue;
2. Cost of Attendance Calculation: You may want to update your institution's cost of attendance for Summer

Terms if it differs from Standard Terms
3. Enrollment Status Configuration: You may want to update the enrollment status configuration if the

enrollment status calculation is different for Summer Terms
4. Other Areas: Anytime your institution treats Summer Terms differently than Standard Terms

Notable Application Behavior
1. What if there are no courses in the Summer Term?

a. The application packages the student according to the Academic Years and Terms sent in the SAFI and
ignores the Summer Terms.
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2. What if there are two Summer Terms and the student is taking the second as a Trailer?

◦ The application adds the second Summer Term as a Trailer and doesn't package the student with funds
for the first Summer Term.

3. What if there is no SUMMER_TERM_SCRIPT configured?
a. If the summer term exists before Academic Year 1, and the Summer Term has enrollment, the application

defaults the Summer Term to be a Header.
b. If the summer term exists after Academic Year 1 and there is Summer Term enrollment, the application

defaults the Summer Term to be a Trailer.
4. What if the groovy script associated with the PKGSCHEDATTRIB.csv column SUMMER_TERM_SCRIPT is

malformed?
a. The application acts as if there is no SUMMER_TERM_SCRIPT configured and logs an APP_EVT warning

message to notify you of the malformed groovy.
5. What happens if I Manually update a Summer Term?

◦ If you manually modify the configured behavior of a Summer Term, the application ignores the default
configuration for that Summer Term moving forward.

Note:  If you have manually overridden an award/fund for a term for which you later need to remove/move, you
should:

1. Reduce the award down to $0.00 manually.
2. Remove the Term from the Academic Year.
3. Add the term to the new Academic Year (if applicable).
4. Increase the fund in the new Academic Year manually, if applicable.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to view, add, edit
or remove a Summer Term:

• Student.

• Manage Summer Term.

• Package Fund Edit.

See Set General Permissions Matrix for additional information.

Navigation to the SFP User Interface Functionality
To view the Packaging Details:

SFP User Interface > Student > Financial Information > Packaging

To view the Disbursing Details:

SFP User Interface > Student > Financial Information > Disbursing
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Alternate Summer EFC Calculation  
You can generate a separate need calculation for Scheduled Academic Year (SAY) term programs in the summer to
award Title IV funds independently from the standard terms.

Alternate Summer EFC Method

Note:  This is applicable to the 2023-2024 and prior Aid Years only.

Note:  The alternate summer need calculation is only used for Subsidized Direct Loans and FSEOG.

With this approach, you calculate a separate need calculation for the Standard and Summer terms.

• For Summer Trailers:

◦ The Standard Term EFC is selected based on the number of months established for the standard terms.

◦ The Summer EFC is determined by taking the Primary Alternate EFC corresponding to the total months
enrolled in the academic year minus the standard term EFC.

• For Summer Headers:

◦ The Summer EFC is selected based on the Primary Alternate EFC corresponding to the number of
months in the summer period.

◦ The Standard term EFC is selected by subtracting the Primary Alternate EFC used for the summer from
the Primary Alternate EFC that corresponds to the total number of months the student will be enrolled
during the academic year.

• The existing TERM_PP_Months configuration will be used to determine the months in standard or summer
terms.

The alternate summer need calculation is only used for Subsidized loans and FSEOG.

Required Setup

• Enter an effective date in the Summer_EFC_Need_Calc column introduced in the School workbook
(SCHOOL.csv).

• Ensure you have the latest Award_Override_Criteria script used in the FAS Fund Config workbook
(FAS_FUND_CONFIG.csv) delivered in the baseline configuration for Subsidized and Unsubsidized loans.

Here are some tips and considerations:

• Don't enable the feature for academic years which contain courses in the summer or for which you have
already packaged summer financial aid, as this impacts the direct loan calculations. If summer has already
been packaged before enabling the alternate summer EFC calculation, enabling the alternate summer EFC
calculation will generate a re-calculation of need for FSEOG and Direct Subsidized Loans for the standard and
summer terms and may create a re-distribution in amounts in the student's package.

• The Summer EFC calculation is applied if the academic year end date is greater than the effective date set in
the Summer_EFC_Need_Calc column of the School workbook (SCHOOL.csv).
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Alternate Summer SAI Calculation  
You can generate a separate need calculation for Scheduled Academic Year (SAY) term programs in the summer to
award Title IV funds independently from the standard terms.

Alternate Summer SAI Method

Note:  This is applicable to the 2024-2025 and future Aid Years only.

Note:  The alternate summer need calculation is only used for Subsidized Direct Loans and FSEOG.

When the Enhanced Calculation for Summer SAI feature is enabled, the summer need calculation uses the SAI and
Summer Cost of Attendance (COA) and Other Financial Assistance (OFA). This is applicable for both Summer Headers
and Trailers.

Required Setup

• Enter an effective date in the Summer_EFC_SAI_Need_Calc column introduced in the School workbook
(SCHOOL.csv).

• Ensure you have the latest Award_Override_Criteria script used in the FAS Fund Config workbook
(FAS_FUND_CONFIG.csv) delivered in the baseline configuration for Subsidized and Unsubsidized loans.

Here are some tips and considerations:

• Don't enable the feature for academic years which contain courses in the summer or for which you have already
packaged summer financial aid, as this impacts the Direct Loan calculations. Enabling the alternate summer
EFC calculation after Summer financial aid has already been packaged will generate a re-calculation of need
for FSEOG and Direct Subsidized Loans for the standard and summer terms and may create a re-distribution in
amounts in the student's package.

• The Summer SAI calculation is applied if the academic year end date is greater than the effective date set in the
Summer_EFC_SAI_Need_Calc column of the School workbook (SCHOOL.csv).

Manage Summer Term  
If you need to accommodate a single student because their situation is in opposition to the baseline configuration, you
can easily Manage Summer Terms manually through the user interface.

Overview
You can remove a Summer Trailer from one Academic Year and even add it as a Header to the next or vice versa. You
have the ability to make updates to a single student record in order to structure the academic year to be most beneficial
to the student. The Mange Summer Term pop out dialog box provides a visual representation of the academic year
being modified in its current state. The available Summer Terms section lists each summer term that is available to be
added to (or removed from) the selected academic year.

To move a summer term from a trailer to a header, you will complete two simple steps.

1. First, remove the Summer Term from the Academic Year that contains the Trailer.
2. Second, add the Summer Term as a Header on the subsequent Academic Year and the system will

automatically repackage the student based on the changes.
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Once the user makes their desired selection and saves, the system:

• Repackages the student

• Adjusts the academic year accordingly

• Updates the student’s eligibility/disbursements (as applicable)

• Communicates the update to COD (as applicable)

If the term isn’t part of the current Academic Year, the Enrollment Status is Not Attending. If added to the current
academic year, the system updates the Enrollment Status to the appropriate value based on the institutions
configuration.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Manage Summer Term

• Package Fund Edit

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner

◦ Navigate to Student > Financial Information > Packaging

2. Manage Summer Term
3. Choose to Add to Academic Year # or Remove from Academic Year #
4. Save
5. Confirm the Summer Term is removed
6. Confirm the Funds are repackaged

If you have manually overridden an award/fund for a term for which you later need to remove/move, you should:

1. Reduce the award down to $0.00 manually by Editing the Fund
2. Remove the Term from the Academic Year using the Manage Summer Term Manual Processing Steps
3. Add the term to the new Academic Year (if applicable)
4. Build the fund back up in the new Academic Year manually (if applicable)

If you manually modify the configured behavior of a Summer Term, the system ignores the default configuration for
that Summer Term moving forward.

Professional Judgment  
As outlined in the U.S. Department of Education (ED) regulations, an institution can exercise the process of Professional
Judgment on a case by case basis for students that have special circumstances.

372



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 10
Using Financial Information

Overview
Student Financial Aid initiates the Professional Judgment Process when all documents are received and all configured
conditions for Professional Judgment have been met. For most Professional Judgments the student must have a Valid
ISIR; however, Student Financial Aid will proceed with the Professional Judgment Process with an Invalid ISIR for a
Parental Non-Disclosure, a Selective Service Override, and a Dependency Override request. If your student has been
selected for Verification, the ISIR must complete the ISIR Verification Process and clear the Verification prior to the
Professional Judgment Process.

• Dependency overrides are a separately regulated area within the scope of the PJ process and cover its own
examples and scenarios.

• PJ adjustments are valid only if a school is making such adjustments, not the student. The school submits a
PJ change electronically, via FAA Access to FPS/CPS Online or via third-party software (for example, Student
Financial Aid), and may do so without a signature from the student or parent. When a PJ is made, the next ISIR
will indicate Professional judgment processed.

• If an SAI/EFC change takes place as a result of PJ, the resulting SAI/EFC must be used consistently for awarding
of all funds.

Examples of when a PJ may be required:

• Divorce or separation.

• Death or disability of a wage earner

• Loss of employment (involuntary), income (income or benefits), underemployment, dislocated worker.

• Medical or dental expenses paid or committed during the current year that is not covered by insurance.

• Unusually high childcare costs.

• Nursing home expenses not covered by insurance.

• Unusually high dependent care expenses.

• A student who is a dislocated worker.

• Parents’ refusal to complete a FAFSA (sub-scenario within PJ regulations: DCL GEN-08-12).

• IRA conversion into Roth IRA.

What Student Financial Aid Does Automatically
SFA automatically does the following things:

Initiates the Professional Judgment Process
SFA evaluates the student record and makes sure that the student has resolved any ISIR codes, ISIR discrepancies,
completed the ISIR Verification Process (if applicable), met all configured conditions, and submitted all required
documentation in addition to any initiating documents (i.e. Professional Judgment Request Form). Dependency
Overrides, Parental Non-Disclosures, and Selective Service, Professional Judgment requests are considered special
cases and SFA proceeds with the Review Professional Judgment task, even when the ISIR status is Invalid. For all
other Professional Judgments, the ISIR status must be Valid and when all Professional Judgment criteria (based on
configuration) have been met, SFA initiates the Professional Judgment Process by creating a Review Professional
Judgment task.

Dependency Overrides, Parental Non-Disclosures, and Selective Service PJs move to the PJ Review task queue, even if
the ISIR is in an invalid status.
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Requests documentation to support the Professional Judgment Process
To make sure you have all the documentation you need to approve or reject a Professional Judgment request, SFA
requests documentation to support the Professional Judgement before creating the Review Professional Judgment task.
If your student provides documentation that results in an additional document request (based on configuration), SFA
requests the additional documents.

Professional Judgment PLUS Request

In the following scenarios, the following documents are required to complete the Professional Judgment Process:

• If the Professional Judgment PLUS document shows that the parent has a fixed income, SFA requests a fixed
income document

• If the Professional Judgment PLUS document shows a bankruptcy, SFA requests a proof of bankruptcy
document

• If the Professional Judgment PLUS document shows an incarceration, SFA requests an incarceration record
document

Transmits ISIR corrections for Approved Professional Judgments
SFA submits ISIR corrections after you update the ISIR field(s) as a result of an Approved, Professional Judgment

Sends student notification for Professional Judgment updates
SFA informs the student about the progress of the Professional Judgment Process by sending the student notifications
when the process is initiated, documents are required, put on hold, approved, denied, or canceled.

Processes Special Cases
SFA does not require a Valid ISIR for PJs that are considered to be special cases. SFA determines if all initiating
conditions have been met, initiating documents received, requests additional documents if necessary and begins the PJ
Process per the PJ Type once all required documents and conditions have been met.

Configurable Attributes
Configure the different types of Professional Judgments

SFA enables the institution to configure different types of Professional Judgments based on business process.

Examples may include but are not limited to these:

• PLUS Request

• Needs Analysis

• Dependency Overrides (Special Case)

• Selective Service Overrides (Special Case)

• Parental Non-Disclosure (Special Case)

Configure how the Professional Judgment Process is Initiated

The institution decides which initial and/or additional documents and conditions are required to be met prior to
initiating the Professional Judgment Process for each type of Professional Judgment. This ensures that specific
information and/or documents are available within SFA prior to the Professional Judgment being requested.
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Configure the logic for required documentation to support the Professional Judgment Process

To make sure there is adequate information to make a Professional Judgment Decision the institution can configure
what documents are needed initially, and additional documentation requests depending on the student/spouse/
parents information received through documents, ISIR fields, and student record information.

Required Role Permissions
The user must have a role with this General Permission through Roles Management to view required role permissions:

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Aid User Interface Functionality
To view Professional Judgment Information  Student Financial Aid User Interface > Student > Financial
Information > Professional Judgment

Override Professional Judgment Decision Status  
You can Override Professional Judgment Decision Status within the Professional Judgment screen of the Student
Financial Aid user interface. For example, after deciding whether a request is Approved or Denied through the Review
Professional Judgment task queue.

Overview
Student Financial Aid (SFA) automatically triggers all actions upon completion of a Professional Judgment (PJ) Review
Task and updating of the status of a student letter, outbound event, student history, and so on.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps:

• Student.

• Professional Judgment Review Task.

• Updating Professional Judgment Decision Status.

See Set General Permissions - Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI):

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
2. Navigate to Student > Financial Information  > Professional Judgment .
3. Override Professional Judgment Decision Status.
4. Choose a new Decision Status.
5. Save update.
6. Confirm updated.
7. Review update.
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Review Professional Judgment - Task  
When you Review Professional Judgment tasks, you can complete any necessary ISIR corrections record a decision of
approved, denied or canceled. If additional documentation is needed, you can also request documents, enter comments
and clear ISIR codes as a result of an approved Professional Judgment.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• Professional Judgement Review Task

• Updating Professional Judgement Decision Status

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Aid User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
a. You can review the student record prior to starting the task

2. Navigate to Dashboard > Review Professional Judgement task queue
3. Start/Resume task for student
4. Review all tabs
5. Choose a Reason from the drown down menu
6. Approve, Deny or Cancel the PJ Request
7. Click the Complete Task button

Make ISIR Corrections
Log into the Student Financial Aid User Interface (UI)

• Navigate to Dashboard > Review Professional Judgement task queue

• Start/Resume task for student

1. Click the ISIR Fields tab
2. Click Make Corrections
3. Review each ISIR section and update data fields as needed
4. Click Continue when you are ready to finish making corrections
5. Review/Edit changes (before submitting corrections)
6. Click Finish (to submit corrections)
7. Review pending corrections

See Make ISIR Corrections to learn how to make ISIR corrections from the ISIR screen.
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Add Comments
Log into the Student Financial Aid User Interface (UI)

1. Navigate to Dashboard > Review Professional Judgement task queue
2. Click Start/Resume task for student
3. Click the Comments tab
4. Add comment
5. Enter comment
6. Save comment
7. Review comment

◦ Click the Edit icon to edit the comment

◦ Click the Delete icon to delete the comment

R2T4 Information  
The Student Financial Planning Return to Title IV (R2T4) Process completes the R2T4 Calculation as required when the
student's enrollment status is updated to withdrawn or deceased.

Overview
Student Financial Planning receives information from the institution's Student Information System (SIS). The student's
enrollment status of withdrawn/deceased, Official Last Day of Attendance (OLDA) and Date of Determination (DOD) are
all required and documented on the student record before the R2T4 calculation is triggered. Student Financial Planning
uses the student's OLDA to determine if an R2T4 is required and which term or payment period to access when an R2T4
calculation is required. You can view the status of the R2T4 calculation in the Student Financial Planning UI.

R2T4 Process Statuses

Status Description

Not Required The R2T4 calculation isn't required.

Not Started The R2T4 calculation has not started.

Scheduled The R2T4 calculation has been scheduled.

Paused The R2T4 calculation has been paused.

Held for QC Review The R2T4 calculation is on hold due to a QC Hold.

Canceled The R2T4 calculation has been canceled.

Completed The R2T4 calculation has been completed.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:
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Determines if an R2T4 calculation is required
When a student is withdrawn, Student Financial Planning evaluates criteria to determine if an R2T4 is required. The
following elements are evaluated:

• Whether an ISIR was received before the student's withdrawal date (OLDA).

• Whether the student received any Title IV disbursements in the term or payment period.

• Title IV eligibility rules.

• Whether the student has started attending.

• Whether funds have been Awarded.

• Academic and Admission Status.

• Could Have Been Disbursed Criteria Configuration.

Determines if other processes are pending before completing the
calculation
Student Financial Planning evaluates all pending processes before beginning a calculation. Some processes can cause
the R2T4 calculation to be put on hold until the other pending process is completed, to ensure an accurate calculation.

Examples:

• If an ISIR was received before the OLDA but isn't valid, the R2T4 will not be completed until the ISIR becomes
valid or until the R2T4 Calculation Deadline has been met

• If the student is in the process of being packaged/re-packaged, the R2T4 will not be completed until the
packaging/re-packaging process is complete

• Before completing the R2T4, Student Financial Planning determines if all disbursements with a Payment ID
have a Student Academic Financial Information (SAFI) - Ledger Posting Date that has been reconciled with the
Disbursement Date

R2T4 Process Pending Reasons

Status Description

Pending Configured Delay The school can configure the R2T4 to trigger immediately or after a specific number of days based
on the type of withdrawal. For example, if a student has a withdrawal type of Official Withdrawal, and
the configured delay is 0 days, the R2T4 calculation may be triggered once the enrollment status is
received. However, if a student has a withdrawal type of Unofficial Withdrawal, and R2T4 calculation
has a configured delay of 14 days the R2T4 calculation will be triggered on the 15th day from the
student's Date of Determination (DOD).
 
Withdrawal Types (also refer to the Status Definitions chapter: Enrollment Statuses (Sub Types).
 

• Official Withdrawal

• Unofficial Withdrawal

• Administrative Withdrawal

• Deceased

Notes: The default trigger time frame for all withdrawal types will be 0 days if no configuration is
defined.
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Any changes that effect the trigger time frame that are received before the R2T4 calculation is
triggered, do not change the scheduled calculation. For example, if the student's DOD is changed
within the time period that an R2T4 calculation is scheduled, the calculation will still be triggered on
the day it was originally intended.
 

Pending R2T4 SAFI The R2T4 calculation is ready to be calculated and Student Financial Planning has requested an R2T4
SAFI (in other words, the ReturnToTitleIvSafiIndicator is true). Student Financial Planning will wait until
the new SAFI is received, and will allow any repackaging prior to doing the R2T4 calculation.

Pending Valid ISIR Process If the status of an active award year ISIR associated to the term or payment period is Pending, Student
Financial Planning will wait for the open Valid ISIR process to be completed before triggering the R2T4.

Pending Packaging Process If the Academic Year Packaging status for the term or payment period being assessed is Pending
Repackage, Student Financial Planning waits until the packaging or repackaging process is completed
before doing the R2T4.

Pending Ledger Date Reconciliation If the Ledger Posting Date in the Student Resource Element of the latest SAFI does not equal the
disbursement date for the matching payment ID or have all the payment IDs, Student Financial
Planning waits until a new SAFI is received and completes the reconciliation prior to doing the R2T4.

Pending Override Completion If there is an R2T4 override that is still processing, the calculation will wait for it to be completed before
doing the R2T4 calculation.

Note:  Student Financial Planning triggers the R2T4 calculation 30 days from the Date of Determination, to ensure
that the calculation is run within the required time frame set by the Department of Education (for example, 45 days
to process return of funds to the Department of Education and 30 days to request authorization to make a post-
withdrawal disbursement of Title IV loan funds). Student Financial Planning does consider the current state of the
active ISIR, package and disbursements at this time. If the active ISIRs for the associated award years of the term or
payment period being assessed for R2T4 are not in a status of Valid or Unverified, the system triggers a cancellation
of all future disbursements that rely upon the active ISIRs. The R2T4 calculation persists based on the current state of
anticipated disbursements that have been canceled (and/or have a cancellation reason set).

Determines time frame when calculation should be triggered
To remain compliant Student Financial Planning completes the R2T4 calculation within 30 days from the Date of
Determination (DOD). However, Student Financial Planning will not trigger the R2T4 calculation until the configured
time frame has elapsed based on configuration for the enrollment status sub-type within the Student Academic and
Financial Information (SAFI) message.

Enrollment Statuses (Sub Type)

Status Code Description

Deceased D Student is deceased.

Official Withdraw OW Student has officially withdrawn from their
program or term at this institution.

Unofficial Withdraw UW Student stopped attending all classes in their
program or term at this institution but did not
officially withdraw.
 
Student did not re-enroll at this institution for
the next regular (non-summer) term without
completing the course of study.
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Administrative Withdraw AW Student has been withdrawn due to a failure to
pay tuition and fees.

Requests R2T4 Data to complete an R2T4 Calculation
When Student Financial Planning determines an R2T4 is required, the trigger time frame has elapsed (for example, 0
days for OW, 14 days for UW), and there is no pending processes or it has been 30 days from the DOD, Student Financial
Planning sends an outbound message to notify the school the R2T4 is ready to be calculated and the institution needs
to send the data that should be used to perform the R2T4 calculation via an (R2T4) SAFI message with a "Return to Title
IV Indicator" set to true.

While Student Financial Planning is waiting for the R2T4 SAFI, the R2T4 process status is Pending. Once the R2T4 SAFI
is received with the "Return to Title IV Indicator" set to true, Student Financial Planning repackages the student and
continues the R2T4 process.

Determines what funds to include in R2T4 Calculation
Student Financial Planning determines what Title IV funds to designate as Disbursed or Could Have Been Disbursed
(CHBD). Student Financial Planning also determines if funds have been packaged or disbursed on the student's record
and if the student is eligible for those funds. If the student isn't eligible, the funds are returned.

The CHBD criteria within the R2T4 calculation includes any disbursement where the cancellation reason is set to a value
(for example, Fund Not Accepted) but isn't canceled with COD. Only canceled disbursements that have been accepted
by COD are excluded from CHBD criteria.

The system considers any loan funds that have a COD origination request prior to or equal to the OLDA, whether or not
there was a positive acceptance received from COD.

To provide additional flexibility, the system default criteria is set to use the origination request date, but a configurable
option is available to allow institutions to make this requirement more strict, and alternatively rely on the COD
acceptance to determine eligible loan funds.

Determines the Term or Payment Period Dates for R2T4 Calculation
Student Financial Planning determines the number of days completed up to the OLDA and the number of days in the
entire term or payment period being evaluated. To maintain an accurate count, Student Financial Planning excludes
breaks (for example, Institutional Breaks, Leave of Absence, Unapproved Breaks, and so on.) from the R2T4 calculation.

Determines the Percentage of Aid Earned
Student Financial Planning determines the percentage of Title IV earned in the payment period using the following
equations:

• Completed Days Minus Breaks

• Calendar Days Minus Breaks

• Percentage of PP Completed

If the answer is equal to 60.01 or greater, update Box H to 100% otherwise show the actual percentage returned for
Percentage of Completed Days Minus Breaks ÷ by Calendar Days Minus Breaks.
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Break Exclusions
R2T4 calculations exclude breaks (based on configuration) when a student takes an unapproved break during the
middle of a course. The days between the withdrawn courses Last Date of Attendance (LDA) and the day prior to the
Start Date of the next course the student is enrolled to attend are counted as a break, and are excluded from the total
completed and total calendar days in Step 2 of the R2T4 calculation. When breaks overlap one another Student Financial
Planning will calculate and displays the breaks according to institutional Policy configuration (for example, when a Leave
of Absence (LOA) occurs within course start/end dates and overlaps an Unapproved Course Break, the R2T4 calculation
only counts and displays the LOA).

Types of Breaks

Acronym Break Type System Calculated or LOA
Message

Details

ISB INSTITUTIONALLY SCHEDULED
BREAKS

Contained in the LOA Message Based on institutional policy

LOA LEAVE OF ABSENCES Contained in the LOA Message Based on institutional policy

IWC INCLEMENT WEATHER
CONDITIONS

Contained in the LOA Message Based on institutional policy

AE ADMINISTRATIVE EXCEPTIONS Contained in the LOA Message Based on institutional policy

BBC BREAKS BETWEEN COURSES Calculated by Student Financial
Planning

When a break is >= 5 days between
courses

URB UNAPPROVED REENTRY BREAK Calculated by Student Financial
Planning

When a student withdraws from
their Program and then re-enters
within 180 days. The URB begins
the day after the LDA of the
withdrawn course and ends the day
prior to the Start Date of the course
they are re-entering.

UCB* UNAPPROVED COURSE BREAK Calculated by Student Financial
Planning

When a student withdraws from a
course, not their Program. The UCB
begins the day after the LDA of the
withdrawn course and ends the day
prior to the Start Date of the next
enrolled course.

*Student Financial Planning no longer excludes this break from the R2T4 Calculation. Calculations completed before the
update will still reflect this break type in Step 2 of the calculation.

Determines if Student is Eligible for a Post-Withdrawal Disbursement
Student Financial Planning determines whether the student is eligible for a Post Withdrawal Disbursement (PWD).

Determines Institutional Charges
Student Financial Planning determines what the actual and estimated charges are for the term or payment period and
which institutional charges to include in the R2T4 calculation.
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Determines the Refund of Title IV by the school
Student Financial Planning determines what amount needs to be refunded by the institution. To decrease the
disbursement amounts, Student Financial Planning begins the Reduction of Funds process and sends a notification to
COD and returns excess funds through the G5 process once the R2T4 calculation is complete.

If a refund is required, a student notification is sent out after the R2T4 calculation is complete.

Determines the Refund of Title IV by the student
Student Financial Planning determines what amount needs to be refunded by the student and notifies the student upon
completion of the R2T4 calculation.

Determines if a Grant Overpayment Exists
Student Financial Planning determines if a Grant Overpayment exists and reports funds appropriately. Student Financial
Planning does not consider Pell, FSEOG, TEACH and IASG an overpayment if the amount is less than $50. For amounts
over $50, Student Financial Planning initiates the Grant Overpayment process.

Cancels Future Disbursements
Student Financial Planning cancels any ineligible un-disbursed Title IV funds for program withdrawals once the R2T4
calculation is complete so that future disbursements are no longer processed.

Sends an Alert when a Course Overlaps with the Term or Payment Period
End Date
If a student withdraws in the first term or payment period and there is a course that overlaps the Term or Payment
Period End Date, Student Financial Planning alerts the user to manually review the R2T4 calculation.

Prevents Repackaging Post R2T4 Post Withdrawal or Graduation
This system only allows certain types of repackages to be processed after an R2T4 Program Withdrawal is completed
or after a student has Graduated. The system prevents all automated forms of repackaging post R2T4/Graduation (for
example, new SAFI received, new NSLDS file received, new Fund Acceptance received, and so on), however, the system
allows repackaging to occur if triggered by the following manual overrides:

• Manual Fund Overrides.

• Manually Overriding of Cost of Attendance.

• Selecting the At Will Repackaging button from the Packaging UI.

• Updating the Borrower Default Overpay Code.

• Manually Overriding the Student's Academic Years.

• Modifying or Creating a Non Federal Fund via the Non Federal Fund UI.

Configurable Attributes
Configure withdrawal types

You can configure the different withdrawal types.
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Enrollment Statuses (Sub Type)

Status Code Description

Deceased D Student is deceased.

Official Withdraw OW Student has officially withdrawn from their term
or program at this institution.

Unofficial Withdraw UW Student stopped attending their term or
program at this institution but did not officially
withdraw.
 
Student did not re-enroll at this institution for
the next regular (non-summer) term without
completing the course of study.
 

Administrative Withdraw AW Student has been administratively withdrawn
due to a failure to pay tuition and fees.

Configure the R2T4 calculation trigger time frame

You can configure when an R2T4 calculation should be triggered, based on withdrawal type. The configured delay is the
time frame the R2T4 calculation is delayed. These values may vary based on withdrawal type, state regulations, or other
school defined configuration settings.

Example Trigger time frames:

• Official Withdraw - 0 Days
◦ Triggers immediately once the withdraw SAFI is received

• Unofficial Withdrawal - 14 Days
◦ Calculation is delayed for 14 days and is triggered on the 15th day

Configure the notification for R2T4 refund messaging

You can configure the message the student/borrower receives when a return is required.

Configure the R2T4 institutional charge types

You can configure charge types to be used to determine institutional charges used in the R2T4 calculation.

Charge Type Examples:

• Tuition

• Student Resources

• Taxes

• Miscellaneous

• Resource

Configure deadline for R2T4 calculation

You can configure the R2T4 calculation deadline (for example, 45 days from the Date of Determination).

Configure Could Have Been Disbursed (CHBD) Eligibility Criteria

You can configure additional criteria that should be evaluated when determining if a fund meets CHBD eligibility.
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Configure R2T4 cancellation criteria

You can configure when the R2T4 should be canceled and updated to Not Required based the school's policy.

Configure R2T4 CHBD Criteria

You can configure the system to use the COD Request Date or the COD Acceptance Date to determine if loan funds
should be included in the CHBD field

Navigation to the Student Financial Planning User Interface Functionality
To view the R2T4 calculation   Student Financial Planning User Interface > Student > Financial Information > R2T4
Information

Termination Management  
Termination management is the process of determining the next steps in the Financial Aid Process when a student
terminates their enrollment within a term or program.

Overview
Title IV funds are evaluated and awarded to a student under the assumption that the student attends school for the
entire period for which the assistance is evaluated/awarded. When a student withdraws, the student may no longer
be eligible for the full amount of Title IV funds the student was originally scheduled to receive. If a recipient of Title IV
grant or Title IV loan withdraws after beginning attendance, the amount of federal aid earned by the student must be
determined.

A student is considered to have withdrawn from a term or payment period or period of enrollment if

Non-Term or Non-Standard Term

The student is not scheduled to begin another course within a payment period or period of enrollment for more than 45
calendar days after the end of the module the student ceased attending, unless the student is on an approved leave of
absence

Credit Hour Program

The student does not complete all the days in the term or payment period or period of enrollment that the student was
scheduled to complete

Clock Hour Program

The student does not complete all of the clock hours and weeks of instructional time in the payment period or period of
enrollment that the student was scheduled to complete.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Completes any required financial aid processing when a student becomes inactive
When the student's enrollment status becomes inactive for their program, Student Financial Planning terminates
the Financial Aid Process and initiates any student/parent Exit Processing required for any graduated or deceased
student. All collected documentation (including any new or updated integration messages received from the Student
Information System (SIS) and external SAIG files are saved to the student record. Future integration messages or
external SAIG files are automatically matched to the student record.
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Begins exit processing when an active student withdraws from their program
Student Financial Planning recognizes when a student withdraws and received an ISIR prior to their Last Date of
Attendance (LDA) and therefore, needs to proceed through financial aid exit processing. Student Financial Planning
processes updates to the enrollment status based on the Student Academic and Financial Information (SAFI) message.
If a student was previously in an active enrollment status, Student Financial Planning automatically begins the R2T4
process.

If the ISIR is not Valid or is in an Unverified status, the valid ISIR process must be completed first. Once the ISIR status is
Valid, any necessary repackaging is completed and the student then proceeds through exit processing.

When a student’s enrollment status becomes Inactive, the student’s record, related history, received files and
documents remain available in case the student returns and/or for future reference.

All collected documentation, integration messages, and external files received through the Student Aid Internet
Gateway (SAIG) are saved to the student record

Any additional files received through the SAIG after the student becomes inactive (e.g. ISIR, MPN, Entrance Counseling,
etc.) will continue to be matched to the student record

Processes enrollment status updates
Student Enrollment Status Updated to Withdrawn

If the student's program enrollment status is updated to:

• Withdrawn (W), Student Financial Planning initiates the exit counseling process

◦ If the prior enrollment status was not an Active status or the student did not start attending, the student
will not be eligible for an R2T4 and no further processing is required

◦ If the previous enrollment status was an Active status, Student Financial Planning determines if the
student received an ISIR prior to the Official Last Date of Attendance (OLDA) that is not in a status of
Valid or Unverified

- If student has an ISIR received before their OLDA in a pending status, the Valid ISIR process must
be completed

- Once the Valid ISIR process is completed and the ISIR status is Valid/Unverified, any necessary
repackaging is triggered followed by the R2T4 process

- If the student has not received an ISIR, the Student Financial Planning triggers the R2T4 process
- Once this process is complete, no further FA processing is required

Student Enrollment Status No Longer Active

If the student's program enrollment status is updated to:

• Cancel (C), no further Financial Aid processing is required on the student record

• Deceased (D), Student Financial Planning initiates the Deceased Students process

• Graduated (G), Student Financial Planning initiates the Exit Counseling process

Enrollment Statuses Recognized by SFP

Enrollment Statuses (Student)

Status Code Description
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Admitted/Not Started AM The student has not yet started any coursework
but has been admitted to the institution.

Full-time F Student is enrolled full-time and is actively
attending class.

Half-time or more, but less than full-time H Student is enrolled at least half-time, but less
than full-time.
 

Less than half-time L Student is enrolled less than half-time.
 

Approved Leave of Absence A Student is currently enrolled at this institution
but is on an approved leave of absence.

Never Attended X Individual on whose behalf a loan was certified
or awarded, who was admitted, may have
enrolled (registered), but never attended
classes at this institution.
 
(Institution does have a record of the
individual.)
 

Cancel C Student has canceled their prospective
enrollment.

Graduated G Student has completed the course of study and
is not currently admitted to, nor enrolled in, a
different course of study at this institution.

Deceased D Student is deceased.

Withdrawn (voluntary or involuntary) W Student has officially withdrawn from all
courses at this institution, stopped attending all
classes at this institution but did not officially
withdraw, or for any reason did not re-enroll
at this institution for the next regular (non-
summer) term without completing the course
of study.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management to view the following
information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the enrollment status
Student Financial Planning User Interface > Student > Student Record > Program Information

You can also view the enrollment status in the student header, which is visible on every screen in the Student Financial
Planning user interface if you click the student's name.
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Summary of Steps 1-10  
Within a matter of seconds, Student Financial Planning can process a 10 step Return to Title IV (R2T4) calculation.

Overview
The calculation is based on U.S. Department of Education (ED) regulations, and the system follows the Credit Hour R2T4
Worksheet.

When the calculation is triggered, Student Financial Planning automatically determines if:

• The student completed an Academic Related Activity (for example, Posts Attendance).

• The student was eligible for Title IV Aid.

• An ISIR was received by the Official Last Date of Attendance (OLDA).

Required Role Permissions
The user must have a role with the following General Permission through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Page Summary
The R2T4 has a page dedicated to each step of the calculation, but there are some features that are visible for every
step.

Number Feature Description

1 Header The header has the OLDA, Status, Completion
Date and the DOD listed

2 Comments The comments can be expanded or collapsed
by clicking on the word "Comments" or the icon
found in the side panel

3 Side Panel The side panel displays all R2T4 calculations
and all completed steps
 
The side panel can be collapsed or expanded
by using the double arrow icon at the bottom of
the side panel
 

4 Calculations At the top of the side panel, you can choose
to view the latest or a previous calculation by
clicking on the link or the icon

Tool tips have been added to define acronyms. Hover over acronyms, icons or other data in the header or side panel to
view the tool tip.
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Step 1 - Student's Title IV Aid Information
The application records and displays which funds Disbursed and should be included in the R2T4 Calculation and which
funds Could Have Been Disbursed (CHBD) and should also be included in the R2T4 Calculation.

Click the information icon to see the Credit Hour Calculation data inputs for the calculations:

• E: Amount of Title IV Grants Disbursed (A) + Amount of Title IV Loans Disbursed (B) = Total Title IV aid
disbursed for the period (E).

• F: Amount of Title IV Grants Disbursed (A) + Amount of Title IV Grants that CHBD (C) = Total Title IV grant aid
disbursed and that CHBD for the period (F).

• G: Amount of Title IV Grants Disbursed (A) + Amount of Title IV Loans Disbursed (B) + Amount of Title IV Grants
that CHBD (C) + Amount of Title IV Loans that CHBD (D) = Total Title IV aid disbursed and that CHBD for the
period (G).

Click the fund type to view additional details.

Step 2 - Percentage of Title IV Aid Earned
The package drives all the Payment Period information for Step 2. Underneath the Break Detail Information table is a
link to the specific R2T4 Package Version this calculation maps to.

Step 2 Detail Table

This table shows you all of the data inputs and the entire calculation to determine the value for (H).

Completed Days ÷ Calendar Days (Total Days) = (H) Percentage of Payment Period (PP) Completed.

Footnotes are displayed under this table to provide additional details

Break Detail Information Table

The application automatically calculates breaks between courses but is also able to receive an inbound message
from the SIS to capture other types of breaks (i.e. Leave of Absence, Institutional Breaks, etc...). Each break is listed in
chronological order.

• Sum of Break Days is the Total Number of Break Days.

• Completed Break Days is the Break Days Included up to the Official Last Date of Attendance (OLDA).

◦ The sum value of this column is used to calculate the Completed Days Minus Breaks.

• Calendar Break Days is the Break Days Included up to the Payment Period (PP) End Date.

◦ The sum value of this column is used to calculate the Calendar Days Minus Break Days.

• The Payment Period (PP) Start Date row indicates where the PP starts including breaks in the R2T4
Calculation.

• The Payment Period (PP) End Date row indicates where the application stops including breaks in the R2T4
Calculation.

• The Withdrawal row indicates the student's OLDA.

• Breaks that occur after the OLDA are not included in the Completed Break Days column or to calculate the
Completed Days Minus Breaks.

• Breaks that are less than 5 days are not included in the calculation.

• If a break is subject to Institutional Policy Configuration (IPC), the application makes necessary adjustments.

388



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 10
Using Financial Information

Under this table is important information about the data used to calculate the R2T4.

• View Program Details for Withdrawal Safi: Click link to see additional Program Information page details using
the data inputs from the R2T4 SAFI.

• R2T4 Packaging Version: Click link to view additional details on the Packaging page and view the packaging
version associated with the R2T4 calculation.

R2T4 SAFI Course Table

This table provides a full list of the courses in the program but highlights courses scheduled during the assessed
payment period.

Completed Days Minus Breaks

Calendar Days Minus Breaks (Total Days).

Credit Hour Calculation data inputs for Box H: Completed Days ÷ Calendar Days (Total Days) = (H) Percentage of
Payment Period (PP) Completed.

Step 3 - Amount of Title IV Aid Earned by the Student
The application automatically calculates the TIV Aid Earned by the Student and shows the math used to calculate those
amounts.

Percentage Earned (H) × Total Title IV Aid Disbursed and CHBD for the Period (G) = Amount of Title IV aid earned by the
student (I).

Step 4 - Title IV Aid to be Disbursed or Returned
This is a calculation of the aid to be disbursed as a Post-Withdrawal Disbursement (PWD) or returned to the lender.

• If the R2T4 Calculation results in a PWD, the calculation stops here and the PWD Amount is listed.

• If this calculation results in a Grant Overpayment (GOP), it’s completed through Step 10.

• If there is an R2T4 return for the school or student to make, the calculation continues through Step 8.

The application automatically follows through the entire disbursing process including requesting any additional
acceptance for loans if necessary.

Amount of Title IV Aid Earned by the Student (I) - Total Title IV aid disbursed for the period (E) = Title IV aid to be
returned (K).

Step 5 - Amount of Unearned Title IV Aid Due from the School
Institutional Charges come from the packaging information. Whatever the school provides for courses that are included
in the assessed R2T4 payment period, the application automatically pulls in those charges and records them in Step 5.
To accurately account for institutional charges in the calculation, configure the Charge_Types in the R2T4_Charges.csv
configuration workbook. Also, the Charge Date needs to be within the payment period being assessed.

Total Institutional Charges (L)

100% − Percentage Earned (H) = Percentage of unearned Title IV aid (M).

Total Institutional Charges (L) × Percentage of unearned Title IV aid (M) = Amount of unearned charges (N).

Compare The amount of Title IV aid to be returned (Item K) to Amount of unearned charges (N).
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The lesser amount of (K) and (N) = Amount for school to return (O).

Step 6 - Return of Funds by the School
• Displays the fund types and amounts the school should return.

• The order in which funds are returned hard coded based on ED regulations.

The school must return the unearned aid for which the school is responsible ((Amount for school to return (O)) by
repaying funds to the following sources, in order, up to the total net amount disbursed from each source.

Total loans the school must return = (P).

Step 7 - Initial Amount of Unearned Title IV Aid Due from the Student
The application automatically calculates the TIV Aid Due from the student.

Title IV aid to be returned (K) − Amount for school to return (O) = Initial Amount of Unearned Title IV Aid Due from the
Student (Q).

Step 8 - Repayment of the Student Loans
The application automatically calculates the amount of Student Loans.

• Returned by the school.

• Repaid by the student.

Amount of Title IV Loans Disbursed (B) − Total loans the school must return (P) = Amount of Title IV loans the student is
still responsible for repaying.

Step 9 - Grant Funds to be Returned
The application automatically calculates the Amount of Grant Funds the student is required to return.

• Initial Amount of Unearned Title IV Aid Due from the Student (Q) − Amount of Title IV loans the student is still
responsible for paying (R) = Initial Amount of Title IV grants for the student to return (S).

• Total Title IV grant aid disbursed and that could have been disbursed for the period (F) × 50% = Amount of Title
IV grant protection (T).

• Initial Amount of Title IV grants for the student to return (S) − Amount of Title IV grant protection (T) = Title IV
grant funds for student to return (U).

Step 10 - Return of Grant Funds by the Student
Displays a table with the Grant Funds and the associated amounts to be returned by the student.

Grant Overpayment
The application follows regulations set by ED with respect to grant overpayments. The system automatically triggers a
task based on the regulatory deadlines so that you can report a payment whether it is partial or in full, and then report
any remaining Grant Overpayment to NSLDS and Default Resolution Services (DRS).

The student must return the unearned grant funds for which they are responsible (U). The grant funds returned by the
student are applied in order as indicated, up to the amount disbursed from that grant program minus any grant funds
the school is responsible for returning to that program in Step 6.
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Note:  The student isn't responsible for returning funds to any programs to which they owe $50.00 or less.

Inadvertent Overpayment  
If Student Financial Planning determines that a disbursement is made to a student after the student's Official Last Date
of Attendance (OLDA) up to the Date of Determination (DOD), the system considers the disbursement an Inadvertent
Overpayment and includes the value in the R2T4 calculation as Could Have Been Disbursed (CHBD) aid.

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Determines if an inadvertent overpayment exists
If Student Financial Planning determines that a disbursement is made to a student after the student's Official Last Date
of Attendance (OLDA) up to the Date of Determination (DOD), the system considers the disbursement an Inadvertent
Overpayment and includes the value in the R2T4 calculation as Could Have Been Disbursed (CHBD) aid.

Example

The student stops attending on Friday 1/1/20xx but then receives a scheduled disbursement on Monday 1/4/20xx.

Student Financial Planning checks the disbursement date (1/4/20xx) and determines whether the disbursement date is
between the OLDA and the DOD

• If the student's enrollment status is withdrawn or deceased and the disbursement date is on the student record
after the OLDA, but on or before the DOD then an inadvertent overpayment exists

Sends the outbound disbursement acceptance message
Student Financial Planning automatically creates and sends a disbursement acceptance information message
containing late disbursement information to the student when an inadvertent overpayment exists for a grant or
loan. If there are multiple Post-Withdrawal Disbursements (PWDs) or Late Disbursements (LDs), Student Financial
Planning creates a message lists all eligible fund types and requests disbursement acceptance for any loans. If the
PWD/LD is associated with a grant, the message is sent to the student, but the disbursement acceptance status is set to
Disbursement Acceptance Not Required. If the PWD/LD is associated with a loan, the message is sent to the student, and
the disbursement acceptance status is set to Disbursement Acceptance Pending.

For a PWD, the message is sent within 30 days from the date it is determined the student withdrew.

Status Definitions

Disbursement Acceptance Statuses
A disbursement may require acceptance (i.e. Late Disbursements and PWDs) and will follow certain state transitions
throughout it's life-cycle

Status Description

Disbursement Acceptance Pending For Title IV loans, Disbursement Acceptance outbound message is sent to student/parent and requires
accepted value
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Disbursement Acceptance Not Required For Title IV grants, eligible PWD or Late Disbursement is automatically disbursed and does not require
acceptance

Disbursement Accepted For Title IV loans, the PWD or Late Disbursement has an accepted value from student/parent

Disbursement Not Accepted For Title IV loans, the PWD or Late Disbursement was not an accepted from student/parent

Disbursement Not Accepted by Due Date For Title IV loans, the PWD or Late Disbursement was not an accepted from student/parent by
configured due date

Determines the disbursement acceptance due date

Student Financial Planning sets the disbursement acceptance due date for both Title IV Grants and Loans although
disbursement acceptance is not required for grants.

Student Financial Planning does not allow the disbursement acceptance due date to be 180 days past:

• The Award Year/Loan Period for active students

• The student's date of determination for withdrawn students

• The student's graduation date for graduate students

If you manually override the calculated due date, Student Financial Planning uses the overridden date instead and
triggers a new outbound message to the student with the updated date(s).

Configurable Attributes
Configure the late disbursement acceptance due date
You can configure the deadline for when a Disbursement Acceptance Inbound Message needs to be received for each
specific fund so that an inadvertent overpayment disbursement is canceled after a configured deadline is met and
acceptance has not been received.

Student Financial Planning does not allow the disbursement acceptance due date to be 180 days past:

• The Award Year/Loan Period for active students

• The student's date of determination for withdrawn students

• The student's graduation date for graduate students

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to view the
following information.

• Student

See Set General Permissions Matrix for additional information.

Navigation to the Student Financial Planning User Interface Functionality
To view the R2T4 Information
Student Financial Planning User Interface > Student > Financial Information > R2T4 Information
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Override R2T4 Data  
You can override Return to Title IV (R2T4) data and re-run the R2T4 process in order to validate eligibility for Title IV
funds if any input data changes the original calculation.

Overview
Changes that aren’t corrections are allowed only if the change can be made in time for the institution to meet the R2T4
Funds deadline (for example, 45 days).

What is a Correction?

A change is not a correction if the calculation was correct at the time it was processed.

For example, a school that used the midpoint as the withdrawal date may want to go back and revise an already
processed R2T4 calculation to use the last date of attendance at an academically related activity past the midpoint. This
change is not a correction because the use of the midpoint was not a mistake in contrast to the mistake of using the
wrong amount of a Pell Grant disbursement. Similarly, the signing of a promissory note after a calculation is processed
is not a correction because failing to sign a promissory note is not a mistake.

Fields that can be Overridden

• Date of Determination (any step)

• Disbursed/Could Have Been Disbursed Eligibility (Step 1)

• Could Have Been Disbursed Criteria (Step 1)

• Withdrawal Date (OLDA) (Step 2)

• Payment Period Start Date (Step 2)

• Payment Period End Date (Step 2)

• Completed Break Days up to the OLDA (Step 2)

• Calendar Break Days in the Payment Period (Step 2)

• Institutional Charges (update existing charges or add new line items) (Step 5)

When the calculation is re-run, Student Financial Planning uses the latest data inputs from the time the calculation was
initially completed (i.e. SAFI data and disbursement amounts/statuses). You can override those data inputs, but re-
running the R2T4 does not result in any repackaging.

Student Financial Planning automatically updates the R2T4 calculation results once the re-run calculation is complete.
After the R2T4 is re-run, Student Financial Planning triggers any resulting processes and determines if any additional
refunds are required, if any Title IV funds need to be brought back, if a PWD is still required or needs to be updated, if a
Grant Overpayment still exists or needs to be updated and if any previous unreleased QC Holds need to be re-triggered.

You can only re-run the R2T4 off the Last Completed Enrollment calculation, you cannot re-run an R2T4 off of Prior
Calculation.

If you attempt to manually re-run the R2T4 more than 45 days past the Date of Determination (DOD) of the student's
initial withdrawal, Student Financial Planning displays the following prompt, "The current system date is now (for
example, 47) days past the DOD of the student's initial withdrawal, please select to continue or cancel."

Multiple Overrides
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If you need to make any additional manual overrides, you can use the Hide an R2T4, Create R2T4 or Replace an R2T4
features to complete multiple overrides

What Student Financial Planning Does Automatically
Student Financial Planning automatically does the following things:

Compares the results of the manually re-run calculation against the most recent
(previous) calculation
Updates Triggered due to Re-Run Results:

Refund

When a previous calculation resulted in a refund and the new R2T4 also results in a refund, Student Financial Planning
does the following:

• Persists any prior returned disbursements in their current status. If any returns are yet to be drawn down,
Student Financial Planning keeps the existing return in the pending G5 drawdown for the day.

• If the prior calculation and the new calculation are equal, no update is required.

• If the prior calculation did not result in a Refund, but the new calculation does, Student Financial Planning
triggers the Refund process.

• If the prior calculation resulted in a Refund that is less than the new calculation, Student Financial Planning
subtracts the prior refund from the total of the new refund to determine the remaining refund and sends a new
Return to Lender message. To decrease previous disbursements, Student Financial Planning using Decreasing
Disbursement logic and processes the return through the Reduction of Funds process.

• If the prior calculation resulted in a Refund that is greater than the new calculation, Student Financial Planning
subtracts the new refund from the total of the previous refund to determine the additional amount the student
is eligible for and triggers an increase to the disbursements, up to the appropriate amount using Increasing
Disbursement logic.

• All resulting COD communications are triggered after the disbursements are updated and accepted responses
are received, then Student Financial Planning sets the appropriate G5 status for the new drawdown amount.

Post-Withdrawal Disbursement (PWD)

Once the R2T4 Re-Run is complete, Student Financial Planning completes the following actions:

• If the prior calculation and the new calculation are equal, no update is required.

• If the prior calculation did not result in a PWD, but the new calculation does, Student Financial Planning triggers
the PWD process.

• If the prior calculation resulted in a PWD that is less than the new calculation, Student Financial Planning re-
triggers the PWD process.

• If the prior calculation resulted in a PWD that is greater than the new calculation, Student Financial Planning re-
triggers the PWD process.

Grant Overpayment

Once the R2T4 Re-Run is complete, Student Financial Planning determines if the student has a grant overpayment.

• If the prior calculation and the new calculation are equal, no update is required.
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• If the prior calculation did not result in a Grant Overpayment, but the new calculation does, Student Financial
Planning triggers the Grant Overpayment process.

• If the prior calculation resulted in a Grant Overpayment that is less than the new calculation, Student Financial
Planning re-triggers the Grant Overpayment process.

• If the prior calculation resulted in a Grant Overpayment that is greater than the new calculation, Student
Financial Planning re-triggers the Grant Overpayment process.

Creates a Student History Entry
Student Financial Planning creates the following Student History Entry after re-running an R2T4 calculation R2T4
calculation has been re-run for the student.

Required Role Permissions
The user must have a role with the following General Permissions through Roles Management in order to complete the
manual processing steps listed below.

• Student

• R2T4 Override Edit

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.

◦ Navigate to Student Record > Financial Information > R2T4 Information.

2. Override R2T4 Data.
3. Add a comment.
4. Click Comments to expand collapse the comment box (comment box displays for each step when expanded).
5. Update the DOD (if applicable).
6. Click Step 2.
7. Update the Withdrawal Date (OLDA) (if applicable).
8. Update the Payment Period Start Date (if applicable).
9. Update the Completed Break Days up to OLDA (if applicable).

10. Update the Payment Period End Date (if applicable).
11. Update the Calendar Break Days in PP (if applicable).
12. Click Step 5.
13. Override R2T4 Charges Information.
14. Update an existing Amount (if applicable).
15. Update an existing R2T4 Indicator (if applicable).
16. Add a New Charge Type (if applicable).
17. Enter New Line Item details.

a. Choose the Charge Type.
b. Enter a Description.
c. Choose the Status.
d. Pick a Date.
e. Enter the Amount.
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f. Enter the Open Amount.
g. Set the R2T4 Indicator.
h. Remove any line item manually entered it in error.

18. Click Save.
19. Review changes.

Note:  If, in Step 1, you try to:

◦ Update a disbursement in any Not Disbursed status to show in the Disbursed column;

◦ Update a disbursement in a Disbursed status to show in the Could Have Been Disbursed column;

◦ Override a disbursement with a Could Have Been Disbursed Flag when the disbursement is not
flagged to show in Could Have Been Disbursed Flag column;

A warning is returned in the UI.

You can proceed or go back to make check changes or make additional changes.
20. Click Finish when the updates are complete and accurate.
21. Click Cancel or Back if you need to make additional updates.
22. Refresh the screen to confirm updates.
23. Manual Overrides on the R2T4 calculation are indicated by person icon. Hover over the icon to see additional

details.

Student Financial Planning automatically updates the R2T4 calculation results once the re-run calculation is complete.
After the R2T4 is re-run, Student Financial Planning triggers any resulting processes and determines if any additional
refunds are required, if any Title IV funds need to be brought back, if a PWD is still required or needs to be updated, if a
Grant Overpayment still exists or needs to be updated and if any previous unreleased QC Holds need to be re-triggered.

If you need to make any additional manual overrides, you can use the Hide an R2T4, Create R2T4 or Replace an R2T4
features to complete multiple overrides

Terminate An R2T4  
You can terminate or cancel the Return to Title IV (R2T4) calculation process through the Student Financial Planning
user interface.

Overview
Canceled R2T4s are visible from the Hidden R2T4 list found below the latest calculation section in the left sidebar.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Student

• R2T4 Override Edit

See Set General Permissions Matrix for additional information.
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Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner
2. Navigate to Student Record > Financial Information > R2T4 Information
3. Terminate R2T4
4. Choose a Status
5. Choose a Reason
6. Terminate
7. Confirm
8. Review

Hide an R2T4  
If a Return to Title IV (R2T4) calculation was completed with invalid input data or is the result of an erroneous manual
override, you can Hide an R2T4.

Overview
Hiding the completed R2T4 calculation removes the R2T4 that was triggered. Hiding the R2T4 allows the student to be
repackaged and Student Financial Planning updates the QC Hold status of the existing R2T4 calculation to No Longer
Valid and triggers a new student history entry for the hidden record. The R2T4 record displays in a new list, View Hidden
R2T4 Calculations. The new list is visible based on the user's security permissions.

Along with Hiding an R2T4 record, you can now trigger a new R2T4 calculation on demand, by selecting from a list
of withdrawn/deceased R2T4 SAFIs from the student record. If there is an existing R2T4 record, you can Replace the
current R2T4 record, which allows you to hide the existing record and replace it with a new one. If there is no existing
R2T4 record (or all existing records have been hidden), you can Create a new R2T4 record from a previously received
R2T4 SAFI. Upon Creating or Replacing an R2T4 record, a list of withdrawn/deceased SAFIs that contain a positive R2T4
SAFI indicator is displayed with associated identifiers in order for you to select the desired input data (i.e. SAFI message
ID, date/time stamp, program code, enrollment status and R2T4 SAFI indicator). Once the SAFI is selected, Student
Financial Planning creates a new R2T4 record and triggers the applicable QC Hold and student history entry.

Hide R2T4

If there is an existing R2T4 record, you can Hide it.

• The latest R2T4 record should be hidden to allow for a subsequent repackage with any withdrawn SAFI

• The Hide R2T4 button only shows calculations that have been triggered (it will not display for scheduled or
pending calculations)

• The "View Hidden R2T4 Calculations" list displays both Hidden and Canceled calculations

• Hiding an R2T4 Record only updates a QC Hold to No Longer Valid, if it was On Hold

◦ You have to refresh the screen to view canceled calculations due to manual overrides

The new list is flagged appropriately in the database for use in creating queries and reports to review any hidden
records.

Manually Repackage via Packaging Screen
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Note:  After creating or replacing an R2T4, if the Status is Pending Packaging Process, navigate to the packaging
screen and manually "Repackage" the student.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Hide R2T4

• View Hidden R2T4

See Set General Permissions Matrix for additional information.

Create R2T4  
You can trigger a new Return to Title IV (R2T4) calculation on demand, by selecting from a list of withdrawn/deceased
R2T4 SAFIs on the student record.

Overview
If there is no existing R2T4 record (or all existing records have been hidden), you can create a new R2T4 record from
previously received R2T4 SAFI. Upon creating an R2T4 record, a list of withdrawn/deceased SAFIs containing an R2T4
SAFI indicator equal to true displays associated identifiers so you can select the desired input data (i.e. SAFI message ID,
date/timestamp, program code, enrollment status and R2T4 SAFI indicator). Once the desired SAFI is selected, Student
Financial Planning creates a new R2T4 record and triggers the applicable QC Hold and student history entry.

Replace and Hide

If there is an existing R2T4 record, you can replace it with a new one. After you replace it, you can then hide that record.

• The latest R2T4 record should be hidden to allow for a subsequent repackage with any withdrawn SAFI.

• The Create R2T4 button only shows if the student is in a withdrawn or deceased enrollment status.

• The Hide R2T4 button only shows calculations that have been triggered (it will not display for scheduled or
pending calculations).

• The View Hidden R2T4 Calculations link displays both Hidden and Canceled calculations.
◦ You have to refresh the screen to view canceled calculations due to manual overrides

• Hiding an R2T4 Record only updates a QC Hold to No Longer Valid, if it was On Hold.

Note:  After creating or replacing an R2T4, if the Status is Pending Packaging Process, navigate to the packaging
screen and manually repackage the student.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Create R2T4

• Hide R2T4
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• View Hidden R2T4

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the Student Financial Planning User Interface (UI)

1. Enter the student's External Student ID Number in the Search Field.
2. Navigate to Student Record > Financial Information > R2T4 Information
3. Hide all R2T4 records (see Hide an R2T4 to learn more).
4. Click Create R2T4.
5. Select the SAFI message. This immediately processes your selection.
6. Click OK when you receive the confirmation message.

Replace An R2T4  
To replace a Return to Title IV (R2T4) calculation, you can trigger a new R2T4 calculation on demand by selecting from a
list of withdrawn/deceased R2T4 SAFIs from the student record.

Overview
If there is an existing R2T4 record, you can replace the current R2T4 record, which allows you to Hide an R2T4 record
and replace it with a new one. If there is no existing R2T4 record (or all existing records have been hidden), you can
create a new R2T4 record from a previously received R2T4 SAFI. Upon creating or replacing an R2T4 record, a list of
withdrawn/deceased SAFIs that contain a positive R2T4 SAFI indicator is displayed with associated identifiers in order
for you to select the desired input data (i.e. SAFI message ID, date/timestamp, program code, enrollment status and
R2T4 SAFI indicator). Once the SAFI is selected, Student Financial Planning creates a new R2T4 record and triggers the
applicable QC Hold and student history entry.

Replace and Hide

If there is an existing R2T4 record, you can replace it with a new one. After you replace it, you can then hide that record.

• The latest R2T4 record should be hidden to allow for a subsequent repackage with any withdrawn SAFI.

• The Create R2T4 button only shows if the student is in a withdrawn or deceased enrollment status.

• The Hide R2T4 button only shows calculations that have been triggered (it will not display for scheduled or
pending calculations).

• The View Hidden R2T4 Calculations link displays both Hidden and Canceled calculations.

◦ You have to refresh the screen to view canceled calculations due to manual overrides

• Hiding an R2T4 Record only updates a QC Hold to No Longer Valid, if it was On Hold.

Note:  After creating or replacing an R2T4, if the Status is Pending Packaging Process, navigate to the packaging
screen and manually repackage the student.
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Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Create R2T4

• Hide R2T4

• View Hidden R2T4

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Replace the Current R2T4 Calculation
Log into the Student Financial Planning User Interface (UI).

1. Enter the student's External Student ID Number in the Search Field.
2. Navigate to Student Record > Financial Information > R2T4 Information.
3. Click Replace R2T4.
4. Select the SAFI message. This immediately processes your selection.
5. Click OK when you receive the confirmation message.

Tip:  After creating or replacing an R2T4, if the Status is Pending Packaging Process, navigate to the packaging screen
and manually repackage the student.

Hide the Prior R2T4 Calculation
If you chose a SAFI that does not have the same DOD as the current, you will need to hide the prior calculation.

1. Navigate toStudent Record > Financial Information > R2T4 Information.
2. Click the Latest Calculation link to access the Prior Calculation and click the Prior Calculation.
3. Click Hide R2T4.
4. Click Yes to confirm you want to hide the prior R2T4 Calculation.

Replace R2T4 with the same DOD
When you replace an R2T4 with the same DOD, you will be prompted to hide the prior R2T4.

1. Click Replace R2T4.
2. Choose a SAFI with the same DOD.
3. Check Hide R2T4.
4. Click Save.

Trigger R2T4 Calculation  
Student Financial Planning allows you to Trigger R2T4 Calculation at-will when the R2T4 Process Status is Paused or
Scheduled.
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Overview
The Trigger R2T4 Calculation button initiates the calculation when a student has an R2T4 record that is scheduled
(i.e. Pending Configured Delay) or in a pending state (i.e. Pending Packaging Process, Pending R2T4 SAFI). After you
click the Trigger R2T4 Calculation verify you want to trigger the calculation. Once triggered, the R2T4 calculation is
completed and displayed in the UI as the current calculation and downstream processing is initiated.

R2T4 Process Statuses

Status Description

Not Required The R2T4 calculation is not required.

Not Started The R2T4 calculation has not started.

Scheduled The R2T4 calculation has been scheduled.

Paused The R2T4 calculation has been paused.

Held for QC Review The R2T4 calculation is on hold due to a QC Hold.

Canceled The R2T4 calculation has been canceled.

Completed The R2T4 calculation has been completed.

R2T4 Process Pending Reasons

Reason Description

Pending Configured Delay The school can configure the R2T4 to trigger immediately or after a specific number of days based
on the type of withdrawal. For example, if a student has a withdrawal type of Official Withdrawal, and
the configured delay is 0 days, the R2T4 calculation may be triggered once the enrollment status is
received. However, if a student has a withdrawal type of Unofficial Withdrawal, and R2T4 calculation
has a configured delay of 14 days the R2T4 calculation will be triggered on the 15th day from the
student's Date of Determination (DOD).
 
Withdrawal Types ((also refer to the Status Definitions chapter: Enrollment Statuses (Sub Types)).
 

• Official Withdrawal.

• Unofficial Withdrawal.

• Administrative Withdrawal.

• Deceased.

Note:  The default trigger time frame for all withdrawal types will be 0 days if no configuration is
defined.

 
Any changes that effect the trigger time frame that are received before the R2T4 calculation is
triggered, do not change the scheduled calculation. For example, if the student's DOD is changed
within the time period that an R2T4 calculation is scheduled, the calculation will still be triggered on
the day it was originally intended.
 

Pending R2T4 SAFI The R2T4 calculation is ready to be calculated and Student Financial Planning has requested an R2T4
SAFI (i.e. the ReturnToTitleIvSafiIndicator is true). Student Financial Planning will wait until the new
SAFI is received, and will allow any repackaging prior to doing the R2T4 calculation.
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Pending Valid ISIR Process If the status of an active award year ISIR (associated to the term or payment period) is Pending, Student
Financial Planning will wait for the open Valid ISIR process to be completed before triggering the R2T4.

Pending Packaging Process If the Academic Year Packaging status for the term or payment period being assessed is Pending
Repackage, Student Financial Planning waits until the packaging or repackaging process is completed
before doing the R2T4 .

Pending Ledger Date Reconciliation If the Ledger Posting Date in the Student Resource Element of the latest SAFI does not equal the
disbursement date for the matching payment ID or have all the payment IDs, Student Financial
Planning waits until a new SAFI is received and completes the reconciliation prior to doing the R2T4.

Pending Change of Program Task Queue The R2T4 calculation is pending the completion of an Evaluate Student Change of Program task.
Student Financial Planning waits because if the student remains in the same term or payment period
the R2T4 calculation will be canceled.

Pending Override Completion If there is an R2T4 override that is still processing, the calculation will wait for it to be completed before
doing the R2T4 calculation.

Note:  Student Financial Planning triggers the R2T4 calculation 30 days from the Date of Determination, to ensure
that the calculation is run within the required time frame set by the Department of Education (i.e. 45 days to process
return of funds to the Department of Education and 30 days to request authorization to make a post-withdrawal
disbursement of Title IV loan funds). Student Financial Planning does consider the current state of the active ISIR,
package and disbursements at this time. If the active ISIR(s) for the associated award years of the term or payment
period being assessed for R2T4 are not in a status of Valid or Unverified, the system triggers a cancellation of all
future disbursements that rely upon the active ISIR(s). The R2T4 calculation persists based on the current state of
anticipated disbursements that have been canceled (and/or have a cancellation reason set).

The Trigger R2T4 Calculation button is not displayed if the R2T4 Process Status is Not Started, Not Required, Held for
QC Review, Completed, or Canceled. When the R2T4 Process status is in one of these states you will be able to Create
R2T4, Hide an R2T4, or Replace an R2T4.

Required Role Permissions
The user must have a role with the following General Permission(s) through Roles Management in order to complete the
manual processing steps listed below.

• Create R2T4

See Set General Permissions Matrix for additional information.

Manual Processing Steps
Log into the FAS User Interface (UI)

1. Enter the student's external student ID number in the search field located in the upper right-hand corner.
a. Navigate to Student Record > Financial Information > R2T4 Information.

2. Click Trigger R2T4 Calculation (to initiate process).
3. Enter a comment.

a. Click Trigger R2T4 Calculation (to complete process).
4. Verify you want to Trigger R2T4 Calculation.
5. Confirm Process is complete and refresh UI.
6. Review each step of the R2T4 Calculation.
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11  Using Oracle Analytics Server Reports

Reports Overview  
You can run reports using system data with Oracle Analytics Server (OAS).

For information on getting started with and using OAS, see Overview of Reporting in the Implementation Guide. There,
you can learn more about OAS including reporting data models, delivered reports, user-defined reports, and report
scheduling.

Report Release Process
New releases of Student Financial Aid contain all the reports objects ever created regardless if they have been updated
for the release or not. If there are no updates for a new release, the reports are cloned from the prior release and put
into the deployment file for the new release. The deployment file, with or without release updates, is deployed to a OAS
environment. Differences between the existing release and the new release aren't automatically called out as part of this
practice; everything in the file is uploaded and OAS simply recognizes this as an upload.

Delivered Reports  
Oracle delivers and maintains several Oracle Analytics Server (OAS) reports.

You can find these by navigating to the Product Reports folder. Click Catalog > Shared Folders > SFA Reports >
Product Reports.

For a list of delivered reports, see Oracle Student Financial Aid: Delivered Oracle Analytics Server Reports (Doc ID
2797029.1) on My Oracle Support (MOS).

If a report includes both Summary and Detail output, only a single run of the report is required. In this case, the
Summary and Detail outputs are displayed on different tabs. In OAS, you must select Apply when you navigate to each
tab to view results.

Note:  If all parameters are left blank, the report results will include all data.

Note:  If you do not select values for all of the Required parameters, the report won't return any results.

User-Defined Reports  
You can create your own reports from scratch or by modifying delivered reports. You can also share reports or have
reports that are only visible to you by using the Shared Folders and My Folders feature of Oracle Analytics Server (OAS).

• Shared Folders reports can be seen by all users with the correct permissions.
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• My Folders reports can only be seen by you.

For reports that use Federal Tax Information (FTI) data:

• Column names where the column contains FTI data end with _FTI to denote the values in the column are FTI
values and should be treated as restricted data. FTI values in the column don't contain the CUI labeling to
preserve the data types.

• Report writers should use a format function FASRPT.fasrpt_mv_util_pkg.format_fti to label FTI data outputs
with CUI//SP-TAX prior to the value in any output.

◦ Here is a generic example:
- select

◦ FASRPT.fasrpt_mv_util_pkg.format_fti('FIELD1_FTI', FIELD1_FTI) as FIELD1,

◦ F FASRPT.fasrpt_mv_util_pkg.format_fti('FIELD2_FTI', FIELD2_FTI) as FIELD2,

◦ FASRPT.fasrpt_mv_util_pkg.format_fti('FIELD3_FTI', FIELD3_FTI) as FIELD3,

◦ FASRPT.fasrpt_mv_util_pkg.format_fti('FIELD100_FTI', FIELD100_FTI) as FIELD100

- from FASRPT.<view_name>;

◦ Here is an example using reporting views:
- select

◦ FASRPT.fasrpt_mv_util_pkg.format_fti('STUDENTFTIM_ADJUSTEDGROSSINCOME_FTI',

a.STUDENTFTIM_ADJUSTEDGROSSINCOME_FTI)as AGI,

- FASRPT.isir_fields_all_v2_vw a;

- Value output on the report would be "CUI//SP-TAX 9500".

To create a report, see Designing and Publishing Pixel-Perfect Reports in Oracle Analytics Server - Create Reports.

You can copy and paste reports into multiple folders in OAS. You can also download reports and upload them to
different environments as needed.

Running Reports  
These are the steps to run Oracle Analytics Server (OAS) reports.

For a list of delivered reports with a description and OAS navigation, see Oracle Student Financial Aid: Delivered Oracle
Analytics Server Reports (Doc ID 2797029.1) on My Oracle Support (MOS).

To run a report, follow these steps:

1. Navigate as directed in the list of delivered reports.
2. Select the desired parameters. Parameters that are required or only applicable to the Detail part of the report

are indicated.

Note:  If you do not select values for all of the Required parameters, the report won't return any results.

3. Click Apply.
4. View results.
5. Save the results in your desired format.
6. If there are multiple report tabs, for example, Summary and Detail, you must repeat Steps 2 and 3 when you

navigate between tabs.
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12  Using Student Self-Service

Self-Service Features  

Self-Service Overview for Student Financial Planning  
Student Self-Service, sometimes referred to as the Student Portal, guides student and guest users through the Financial
Aid process. Administrative users can manage user access and select options for the Self-Service UI. They can also look
up a student to access the student’s view for financial aid counseling purposes.

The Student Self-Service landing page displays a Welcome greeting and the student’s current Enrollment Type and
Program Type. You can access prior or future Enrollments by clicking the View More Programs link. A numeric callout
displays with the link if there are actions that need to be completed for any Enrollments other than the one in context.
When you click View More Programs, all Enrollments associated with the student are listed with their respective Start
Dates. The Programs are sorted by Active (Enrolled) then Non-active (Withdrawn, Deceased, Graduated) Enrollment
status. Within Active and Non-active, the programs are sorted in ascending order by Academic Program Start Date. You
can select any program to change the context of the Home page.

For active students, those in an Enrolled status, the Home page displays Steps for Active Students that guide the user
and provides information about any pending actions required for the student to become financial aid eligible, review
and accept available awards, and receive funds.

For inactive students, those in a Withdrawn, Deceased or Graduated status, the Home page displays Steps for
Inactive Students that guide the user and provides information about exit counseling, refunds or overpayments, and
notifications associated with receiving any funds that the student is still eligible to receive

In addition to the guided steps, users can select linked tabs that open pages for information and instructions for the
following areas:

• Home - Select the Home tab to return to the Home page.

• Documents - Select the Documents tab to view and act on Document requests. These are the same
Documents accessed in the FAS by navigating to Student > Documents.

• Notifications - Select the Notifications tab to view the student’s Notifications. These are the same
Notifications that can be accessed in the FAS by navigating to Student > Student Record > Notifications.
If there are pending Notifications, a number is displayed over the Notifications tab that shows how many
notifications are in Pending status.

• Financial - Select the Financial tab to see summaries of and act on the student’s financial aid awards by
Academic Year.

• Messages - Select the Messages tab to see letters that have been sent to the student. These are the same
letters that can accessed in the FAS by navigating to Student > Student Record > Letters.

Note:  If there are pending actions for any tab, a numeric call-out is displayed next to the tab with the number of
pending actions.
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Viewing by Academic Year  
You can view a student's Financial Aid information by Academic Year.

Once a Student Academic and Financial Information (SAFI) message is received and at least one Packaging version
exists, the Home page displays tabs for each of student’s Academic Years in the selected Academic Program context.
The Academic Year tabs aren’t displayed on the Documents, Notifications, Financial, or Messages pages.

The Academic Year data is retrieved from the Financial Plan Outbound (FPO) message and isn't dependent on the
student's enrollment status.

The Academic Year tab displayed by default is the student's current Academic Year or, if between Academic Years, the
upcoming Academic Year. To view the Home page in the context of all Academic Years, select All in the Academic Years
bar. This displays a consolidated list of information related to all Academic Years for the context enrollment.

Steps for Active Students  
This is the Student Self-Service workflow for Active students.

These are the financial aid steps for Active Students:

• Active Student Step 1: Become Financial Aid Eligible.

• Active Student Step 2: Review/Accept your Financial Aid Awards. (Student Financial Planning only)

• Active Student Step 3: Receive Your Funds. (Student Financial Planning only)

Active Student Step 1: Become Financial Aid Eligible  
Here are the details for Active Student Step 1: Become Financial Aid Eligible.

FAFSA Completion Messages

• When Student Financial Aid (SFA) creates a Free Application for Federal Student Aid (FAFSA) Completion
notification, a message for the specific Award Year is displayed in this form: “Complete CCYY-CCYY FAFSA”;
for example, “Complete 2021-2022 FAFSA”. The message is a hyperlink to the U.S. Department of Education’s
FAFSA website.

• The FAFSA Completion Period is configurable in SFA per award year. See Regulatory Management for more
information. If the student has multiple Academic Years that cross over a single FAFSA Completion Period, the
same message can be displayed for multiple Academic Years.

If the SFA FAFSA Completion notification is Open, a status of Pending is displayed beside the message. If the
SFA FAFSA Completion notification is Closed, a status of Completed is displayed beside the message. If the
FAFSA completion period isn't configured, isn't yet open, or there is no FAFSA notification for the student based
on the Financial Aid System (FAS) Notification web service, the message displayed is Not Yet Available.

• FAFSA Completion messages are displayed for the appropriate Academic Year. If the student's Academic Year
crosses over two Award Years, two messages may be displayed for the same Academic Year.
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ISIR Code Messages

• When SFA flags an ISIR Code for student follow-up, a message is displayed in this form: “Follow-up on Required
CCYY-CCYY FAFSA Questions”; for example, “Follow-up on Required 2019-2020 FAFSA Questions”. The
message is a hyperlink to the Notifications tab of Student Self-Service.

• As long as the ISIR Code is on the active ISIR, the message displays a Pending status. When the active ISIR
no longer has ISIR Codes, the message isn’t displayed. The Student Follow-Up status is based on the Code
Clearing Script field in the ISIR C-Code Configuration Workbook that indicates if it's flagged as Student Follow-
Up. Student Self-Service pulls the latest status from the Valid ISIR Process Status Request/Reply message.

• ISIR Code messages are displayed for the appropriate academic year. If the ISIR Corrections period crosses
Academic Years, a message could display over two Award Years.

Required Documentation Messages

• When SFA creates Document Requests, a single message is displayed regardless of the number of documents
requested. The message is in this form: “Submit all Required Documentation.”, and is a hyperlink to the
Notifications tab of Student Self-Service.

• If any Document Request has a status of Requested or Unacceptable, the message displays a Pending status. If
the document status is Received, Acceptable or Inactive, the message displays a Completed status. If there are
no documents requested for the student for that Award Year, the message displays a Not Required status.

• When a document is configured for an Award Year, the document is requested for all Academic Years that span
that Award Year. When a document is configured as a Lifetime document, it's associated with all Academic
Years and won't be requested again as long as the document doesn't expire; for example, Passport, Driver’s
License, and so on.

Note:  Active Student Steps 2 and 3 are applicable to Student Financial Planning (SFP) only.

Active Student Step 2: Review/Accept your Financial Aid Awards  
Here are the details for Active Student Step 2: Review/Accept your Financial Aid Awards.

Fund Acceptance Messages

• When a student has Financial Aid awards, a single message is displayed regardless of the number of awards
that require acceptance. The message is this form: “Review/Accept Awards”, and is a hyperlink to the Fund
Acceptance Wizard.

• If an award has a Fund Acceptance Status of Pending Acceptance or Pending Additional Acceptance, the
message displays a Pending status. Once electronically signed using the Fund Acceptance Wizard, the message
displays a Completed status.

• If the student is only awarded funds that don’t require acceptance, for example, Federal Pell Grants, the
message isn’t displayed.

• The Fund Acceptance Status comes from the Award Information web service based on the student's External
Student ID and is displayed for the appropriate Academic Year. Fund acceptance is configurable per fund type
in the Fund Priority Configuration Workbook.

• For students awarded using a term-based Academic Model, you can configure the application so that the fund
acceptance workflow is to accept awards for the whole Academic Year or by Term. See Manage Self-Service
System Settings Configuration.
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Note:  In order for the Fund Acceptance notification to be enabled, any related Quality Control (QC) Holds for the
award must be released in the Admin (SFP) system.

Note:  If there are no Financial Aid award notifications, a message is displayed in this form: “There are no pending
awards that require review.”

Accepting PLUS and Graduate PLUS Loans

• You can configure the system to allow Self-Service Users to accept PLUS and Graduate PLUS Loans in the Fund
Acceptance flow from the Self-Service Home page. This requires:

◦ Selecting Enable PLUS in Fund Acceptance workflow and Enable GPLUS in Fund Acceptance workflow
in Manage Self-Service System Settings Configuration, as appropriate. You must have the Access Enable
PLUS in Fund Acceptance workflow setting and Access Enable GPLUS in Fund Acceptance workflow
setting Self Service Permissions set up in Manage Role Permissions to set these configurations.

◦ The user to have the Accept Parent Fund Awards and Accept GPLUS Awards Self-Service Permissions set
up in Manage Role Permissions.

• Alternatively, the user can more directly accept PLUS and GPLUS loans using the Financial tab instead of using
the Fund Acceptance flow from the Home page. The user must still have Self-Service Permissions of Accept
Parent Fund Awards and Accept GPLUS Awards, as appropriate, as set up in Manage Role Permissions.

Authorization to Hold Election Message

• This message is populated on the Home page for active students based on the Award and Authorization to
Hold web service message. When a student has Financial Aid Awards in an Awarded status and all associated
QC Holds are in a Released status, the Authorization to Hold Election message is displayed. The message is
in this form: “Select your Authorization to Hold Elections.”, and is a hyperlink to the Authorization to Hold
Elections form. If the Authorization to Hold Election hasn’t been received, the message displays Pending status.

• If the Authorization to Hold election has been received, the message displays a Completed status. Authorization
to Hold notifications are not Award Year or Academic Year specific, so the notification may be displayed for
multiple academic years.

Note:  This message is enabled using the Settings page in the Student Self-Service UI by a user with an Admin role.

Active Student Step 3: Receive Your Funds  
Here are the details for Active Student Step 3: Receive Your Funds.

Entrance Counseling Messages

• Entrance Counseling messages display based on notification from the
FasStudentNotificationInformationRequest/Reply event message. The student may have multiple Entrance
Counseling notifications based on loan types: Subsidized and Unsubsidized Entrance Counseling and Grad
PLUS Entrance Counseling.

• When SFP creates an Entrance Counseling notification, a message is displayed in this form: “Complete (Fund
Type) Entrance Counseling”. The message is a hyperlink to the Federal Student Aid website. If the SFP Entrance
Counseling notification is Open, the message displays a Pending status. If the notification is Closed, the
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message displays a Completed status. If there are no Entrance Counseling notifications for the student, no
message is displayed.

• Once the Entrance Counseling requirement is met, it is applicable across Award Years.

Annual Student Loan Acknowledgment Messages

• Annual Student Loan Acknowledgment, formerly known as Informed Borrower, notifications display based on
open notifications from the FasStudentNotificationInformationRequest/Reply event message. The student may
have multiple notifications based on the type of borrowers:

◦ Subsidized, Unsubsidized, or Grad PLUS Informed Borrower Acknowledgment Required; sent for a
student borrower.

◦ PLUS Informed Borrower Acknowledgment Required; sent for a parent borrower.

• When an Annual Student Loan Acknowledgment notification is created, a message is displayed in this form:
“Complete your (Borrower Type) Annual Student Loan Acknowledgment.” The message is a hyperlink to a U.S.
Department of Education website for completion of the acknowledgment.

• If the notification is Open, the message displays a Pending status. If the notification is Closed, it displays a
Completed status. The notification displayed is associated with the appropriate Academic Year. If there are no
Annual Student Loan Acknowledgment notifications for the student, the message isn’t displayed.

Master Promissory Note (MPN) Messages

• MPN notifications display based on open notifications from the FasStudentNotificationInformationRequest/
Reply event message. The student may have multiple MPN notifications based on the counseling types:

◦ Subsidized and Unsubsidized MPN.

◦ PLUS MPN.

◦ Graduate PLUS MPN.

• When SFP creates a MPN notification, a message is displayed in this form: “Sign Your (Fund Type) Loan MPN.”
The message is displayed as a hyperlink to the Federal Student Aid website.

• If the SFP MPN notification is Open, the message displays a Pending status. If the notification is Closed, the
message displays a Completed status. The notification displayed is associated with the appropriate Academic
Year. If there are no MPN notifications for the student, the message isn’t displayed.

PLUS Application Messages

• PLUS Application Messages display based on notifications from the
FasStudentNotificationInformationRequest/Reply event message. The student may have multiple PLUS
Application notifications based on the counseling types:

◦ PLUS MPN.

◦ Graduate PLUS MPN.

• When SFP creates a PLUS Application notification, a message is displayed in this form: “Complete (Fund Type)
Application”. The message is displayed as a hyperlink to the Federal Student Aid website.

• If the SFP PLUS Application notification is Open, the message displays a Pending status. If the SFP PLUS
Application notification is Closed, the message displays a Completed status. The notification is by Award Year
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and displayed for all Academic Years that span the Award Year. If there are no PLUS Application notification for
the student, the message isn’t displayed.

TEACH Messages

• TEACH messages display based on notifications for the student from the
FasStudentNotificationInformationRequest/Reply event message. The student may have multiple TEACH
notifications related to TEACH Grant Counseling or the Agreement to Serve (ATS). The message is displayed as
a hyperlink to the Federal Student Aid website.

• When SFP creates a TEACH Grant Counseling notification, a message displays for the specific Award Year in
this form: “Complete CCYY-CCYY TEACH (Grant Counseling or ATS).” If the TEACH notification is Open, the
message displays Pending status. If the TEACH notification is Closed, the message displays a Completed status.
TEACH notifications are populated by Award Year and are displayed for all Academic Years that span the Award
Year. If there is no TEACH notification for the student, it won't be displayed.

Late Disbursement Messages

• Late Disbursement notifications are based on the FasDisbursementInformationRequest/Reply message.

• When a student completes an academic year, but their funds did not disburse, the student may be eligible for
a Late Disbursement. If a disbursement is flagged as a Late Disbursement, a Late Disbursement message is
displayed if all related QC Holds are in a Released status. The message is displayed in this form: “Review/Accept
Late Disbursement”. The message is displayed as a hyperlink to the Disbursement Acceptance Wizard.

• If any late disbursements require acceptance and are Pending Disbursement Acceptance, the message displays
with a Pending status. If late disbursements require acceptance and the student or parent has completed the
Disbursement Acceptance Wizard with an Accepted, Partially Accepted, or Denied status, the message displays
a Completed status. If late disbursements don't require acceptance, the message displays a Not Required
status. If the student doesn't have any late disbursements that require acceptance, this message isn't displayed.

• Late Disbursement notifications are associated with the appropriate academic year. If multiple Late
Disbursements notifications, only one message is displayed. The student can complete Disbursement
Acceptance for each eligible disbursement on the Financial page or use the Disbursement Acceptance Wizard.

• If the student's enrollment status is Withdrawn or Graduated, the message displays in the Inactive view of the
Home page. All other enrollment statuses display in Active view.

• For users who have a Pending Message to "Accept/Receive PLUS Late Disbursements", the user is
automatically validated by comparing the user's email address to the loan borrower's email address. If the
automatic validation fails,the user can alternatively validate by entering the borrowers' last 4 digits of their SSN
and Date of Birth. Also, the Borrower name and Application ID is displayed in the Financial tab so a user can
distinguish between multiple PLUS loans.

If there are PLUS Late Disbursements for a borrower, the status displays Pending until all PLUS disbursements
matched to the borrower have been accepted or declined. When they have all been accepted or declined, the
status displays Completed.

Note:  If there are no pending actions for receiving funds, a message is displayed in this form:, “There are no pending
actions required to receive your funding."

410



Oracle Fusion Cloud Student Financial Planning
Using Student Financial Planning

Chapter 12
Using Student Self-Service

Steps for Inactive Students  
This is the Student Self-Service workflow for Inactive students.

These are the financial aid steps for Inactive Students:

• Inactive Student Step 1: Complete Exit Counseling

• Inactive Student Step 2: Review any Refunds or Overpayments

• Inactive Student Step 3: Receive Your Funds

Inactive Student Step 1: Complete Exit Counseling  
Here are the details for Inactive Student Step 1: Complete Exit Counseling.

Exit Counseling Messages

• Receiving a SAFI message with an Enrollment Status of Withdrawn, Deceased, or Graduated triggers an Exit
Counseling notification. Exit counseling messages are displayed based on open notifications for the student
from the FasStudentNotificationInformationRequest/Reply event message. The student may have multiple Exit
counseling notifications based on the student's required counseling types, but only one message displays on
the Home page.

• When an Exit Counseling notification is created, a message displays in this form: “Complete (Fund Type) Exit
Counseling.” The message is displayed as a hyperlink to the Federal Student Aid website to complete Title IV
Loans Exit Counseling and TEACH Grant Exit Counseling.

• If the Exit Counseling notification is Open, the message displays a Pending status. If the Exit Counseling
notification is Closed, the message displays a Completed status. If there are no Exit Counseling notifications
for the student, this message is displayed: “There is no required exit counseling to complete.”

Note:  The system doesn’t trigger exit counseling notifications if the student had originated funds at another
institution and doesn't have any disbursed payments within SFP.

Note:  If a follow-up notification is triggered, the system only displays one message for Title IV Loans or
TEACH Grants. However, the Notifications tab displays each individual notification, as returned in the
FasStudentNotificationInformationReply message.

Inactive Student Step 2: Review any Refunds or Overpayments  
Here are the details for Inactive Student Step 2: Review any Refunds or Overpayments. If displaying the Inactive view
and there are no notifications associated with Step 2 Review any Refunds or Overpayments, the following message is
displayed: There are no pending refunds or overpayments that require review.

Refund Messages

• Refund Due notifications are displayed based on open notifications for the student from the
FasStudentNotificationInformationRequest/Reply event message. The student may have multiple Refund Due
notifications based on the student's required counseling types.
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• When a student withdraws and a Return to Title IV (R2T4) calculation results in a Return on the student record,
a Refund Due notification is created and is displayed in this form: “Review any Refunds or Overpayments”. The
message is displayed as hyperlink to the Student Self-Service Notifications page.

• If the Refund Due notification is Open , the message displays a Pending status. If the notification is Closed,
the message displays a Completed status. The Review Refund Due notification displayed is associated with
the appropriate Academic Year. If there are no Refund Due notifications for the student, the message isn’t
displayed.

Grant Overpayment Messages

• The Grant Overpayment notification is based on the FAS Student Notification Web Service for Pell Grants,
FSEOG Grants, TEACH Grants, and IASG Grants..

• When a student withdraws and a Grant Overpayment notification is create, a message displays in this form:
“Review Grant Overpayment“. The message is displayed as a hyperlink to the Self-Service Notifications page.

• If the notification is Open, the message displays a status of Pending. If the notification is Closed, the message
displays a status of Completed. If the student doesn't have a Grant Overpayment, no message is displayed.

• Grant Overpayment notifications are associated with an academic year, but they aren’t Award Year or Academic
Year specific. Therefore, the message can display for multiple academic years. If there are multiple Grant
Overpayments are created, only one message is on the Home page, but each notification is displayed on the
Notifications page.

Inactive Student Step 3: Receive Your Funds  
Here are details for Inactive Student Step 3: Receive Your Funds.

Post Withdrawal Disbursement (PWD) Messages

• The Disbursement Acceptance notification is based on the FasDisbursementInformationRequest/Reply
message.

• When a student withdraws, passes away or graduates before eligible disbursements are disbursed, they may
be eligible for a Post Withdrawal Disbursement (PWD). The message is displayed in this form: “Review/Accept
Late Disbursement”. The message is displayed as a hyperlink to the Disbursement Acceptance wizard. If a
disbursement is flagged as a PWD, the Disbursement Acceptance message isn't displayed until all related QC
Holds are Released.

• If any PWDs require acceptance and are Pending Disbursement Acceptance, the message displays a Pending
status. If PWDs require acceptance but the student or parent has completed the Disbursement Acceptance
wizard (accepted, partially accepted, or denied the PWD), the message displays a Completed status. If PWDs
don't require acceptance, the message displays a Not Required status. If the student doesn't have any PWDs
that require acceptance, the message isn't displayed.

• Disbursement Acceptance notifications are associated with the appropriate academic year. If multiple PWDs
are created, only one message is displayed on the Home page, but the student can complete Disbursement
Acceptance for each eligible disbursement on the Financial page or using the Disbursement Acceptance
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Wizard. Here are the related message statuses that are displayed based on the PWD Disbursement Acceptance
statuses:

Notification Status to Message Status Mapping

Notification Status Message Status

Disbursement Acceptance Pending Pending

Disbursement Accepted Completed

Disbursement Not Accepted Completed

Disbursement Not Accepted by Due
Date

Completed

Disbursement Acceptance Not
Required

Not Required

• For users who have a Pending Message to "Accept/Receive PLUS Post Withdrawal Disbursements", the user
is automatically validated by comparing the user's email address to the loan borrower's email address. If the
automatic validation fails,the user can alternatively validate by entering the borrowers' last 4 digits of their SSN
and Date of Birth. Also, the Borrower name and Application ID is displayed in the Financial tab so a user can
distinguish between multiple PLUS loans.

If there are PLUS Post Withdrawal Disbursements for a borrower, the status displays Pending until all PLUS
disbursements matched to the borrower have been accepted or declined. When they have all been accepted or
declined, the status displays Completed.

Note:  If there are no PWD notifications, the “There are no pending actions required to receive your funding.” is
displayed.

Self-Service Documents  
Select the Documents tab to view and act on Requested Documents.

Tips for Using the Documents Page
• For Document Requests with a status of Unacceptable, any comments entered in the Received Document page

in the FAS or from the Review Document for Approval task queue are displayed in the Student Self-Service
Documents Upload page. This provides more information about the Document Request to the Self-Service
user, such as outstanding questions from the Financial Aid Administrator, in order to complete the Document
Request.

• In the Documents Requiring Attention section, use the Upload icon in the Submit Document column to
upload documents.

• In the Document History section, use the Upload icon in the Update Document column to re-upload
documents.
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• When uploading a file as part of a document request, you can use the Update File button to use a different file
without re-entering the associated metadata. You can also add additional files when responding to a document
request by clicking the Add Additional Pages button.

• Some documents don't require a document upload; for example, Verification Worksheet documents which are
submitted as smart forms.

• Some documents may not require a document image depending on institutional configuration.

• Users can click the upload an unrequested document link on the Documents page to upload one or more
configured Documents.

Tips for Verification Worksheets
Independent and Dependent Verification Worksheets are smart forms that can be accessed on the Documents page.

• Verification Worksheet smart forms use the ISIR to populate marital statuses, number in household, and
number in college with default values.

• For the Parent Signature requirement on the Dependent Verification Worksheet smart form, the parent last
name, date of birth, and last four digits of their Social Security Number (SSN) are validated against the Parent
ISIR fields. For a parent who doesn't have an SSN, for example, an international parent, they can select the No
SSN link to override the SSN requirement.

• The Household section on Verification Worksheets is dynamically hidden if it isn't required based on regulatory
scenarios defined in the Application and Verification Guide of the Federal Student Aid Handbook. To support
this behavior, update the document attributes found in the Document Metadata workbook related to Household
member fields. For each active award year Verification Worksheet document, you need to update the value in
the Is_Required column to False so that each Household member attribute is optional.

Self-Service Notifications  
Select the Notifications tab to view the student’s Notifications.

These are the same Notifications that can be accessed in the FAS by navigating to Student > Student Record >
Notifications. If there are Pending Notifications, a number is displayed over the Notifications tab that displays how
many notifications are in Pending status.

Self-Service Financial  
Select the Financial tab to view and manage awards, refunds, and overpayments.

The Financial tab doesn't display awards that are on hold, but does display the latest validated financial aid information
for the Academic Year. Quality Control (QC) Hold information is used to validate open award holds and displays financial
information using the packaging version prior to the earliest award hold for that academic year. If awards are on hold,
the Financial tab displays: "Your Disbursements are currently being evaluated. Please check back later." If there are
no packages available without award holds for that academic year, the Financial tab displays: "There is no financial aid
summary information available at this time."

Using the Fund Acceptance Wizard, the user can accept, partially accept, or decline the offered financial aid awards.
In the E-Sign step of the Fund Acceptance Wizard, the user reviews the generated award letter with an option to
electronically sign and confirm the award. The letter is available for download for the user’s records.
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College Financing Plan  
You can view the student's College Financing Plan (CFP) in Student Self-Service.

Overview
Student Financial Planning (SFP) Self-Service supports the U.S. Department of Education (ED) CFP requirement. The
CFP can be used as a cover sheet or in lieu of your institution's Financial Aid award letter.

Required Role Permissions
The user must have a role with the following Permissions through Roles Management in order to complete the manual
processing steps listed below.

• Student, Parent or Admin: To view the CFP.

• Admin: To enter CFP configuration.

See Configuration Administration for additional information.

Manual Processing Steps
Review the College Financing Plan
Log into the SFP Self-Service User Interface (UI).

1. Enter the student's external student ID number in the search field.
2. Navigate to Student > Financial.
3. Click College Financing Plan.
4. Review College Financing Plan.
5. Click Download XML or Download PDF, as desired.

Self-Service Messages  
Select the Messages tab to see letters that have been sent to the student.

These are the same letters that can accessed in the FAS by navigating to Student > Student Record > Letters.

Self-Service Profile  
In addition to the linked tabs, there is a Profile link that displays as a person icon silhouette.

From this link:

• Student users can update their User profile, change their password, and sign their FERPA form.

• Administrative users can look up students, manage Users, and access Student Self-Service page settings. When
an Administrative user logs in, they need to look up a student record before landing on the student’s Home
page.

Sign FERPA Form And Provide Consent  
The student can Sign a FERPA form and Provide Parent Consent on the Profile page.
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Overview
The parent uses the student's External Student ID as the initial password when the parent logs in for the first time.
The first time the parent logs in, the parent is required to change their password. The parent can view the Home,
Documents, Notifications, and Financial information the same as the student.

Required Role Permission
The user must have a role with the following Permission through Roles Management in order to complete the manual
processing steps listed below:

• Student

Manual Processing Steps
Student Self-Service Login

1. Log into Student Self-Service as a Student.
2. Click the drop-down arrow in the tool bar.
3. Select Profile.
4. Click Sign FERPA & Provide Consent.
5. Select a consent option.
6. Select Roles for the Guest (for example, Parent) user.
7. Click I Accept.
8. Enter the External Student ID and Student’s Last Name.
9. Click Sign & Finish.

Self-Service Setup  

Manage Users  
As an Administrative user, you can search for, add, edit, and remove users.

Search for a User
Log into Student Self-Service as an Admin user.

1. Click the drop-down arrow in the tool bar.
2. Enter External Student ID, Username, First Name, Last Name, Email, or Phone Number into the Search for

users field.
3. Click Search.
4. Select a User from the results to edit or remove.

Add a User
Log into Student Self-Service as an Admin user.

1. Click the drop-down arrow in the tool bar.
2. Click Manage Users.
3. Click the Add User icon.
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4. Select or enter the following information:
◦ User Type.

◦ Roles. At least one is required.

◦ External Student ID.

◦ Username. This is case-sensitive.

◦ First Name.

◦ Last Name.

◦ Email.

◦ Phone Number. This is optional.

◦ Password.

5. Click the Save icon.

The Username is case-sensitive. If the user attempts to log in and does not enter the case correctly,the Student Self
Service UI returns a Bad Credentials error.

The password must meet the defined password policy. You’re required to enter a confirmation password and the
passwords must match. If the password doesn’t meet the defined password policy or do not match, you’re not able to
save the new user record.

Users may reset their passwords by selecting Forgot Password? on the sign-on screen. After entering the prompted
email address, the application sends an activation link to reset their password. The activation link is good for 7 days.

The application displays these warnings when the password doesn't meet the password policy:

• Password must be minimum 8 characters, and contain at least 1 upper case, 1 lower case, 1 numeric, and 1
special character from the set [ ; : ! @ # $ % ^ *].

• Confirm Password is required.

Edit a User
Log into Student Self-Service as an Admin user.

1. Click the drop-down arrow in the tool bar.
2. Click Manage Users.
3. Click the Edit User icon.
4. Edit the user using the same guidelines as Add a User.
5. Click the Save icon.

Remove a User
Log into Student Self-Service as an Admin user.

1. Click the drop-down arrow in the tool bar.
2. Click Manage Users.
3. Click the Remove User icon.
4. Click Remove and confirm.

Automatic User Log Off
The default application setting is that users get an alert and are signed out of Student Self-Service after 20 minutes of
inactivity. To change the 20 minute threshold, log a service request with Oracle.
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Manage Role Permissions  
As an Administrative user, you can search for, add, edit, and remove user role permissions.

Overview
With user Role Permission settings, you can control access to viewing data and completing actions by establishing
permissions associated with different roles within the existing role categories of: Student, Proxy (Guest or Parent), and
Admin. These are the Role Permission management features:

• The ability to create multiple roles with the same Role Category. For example:
◦ An Admin with View Only access and an Admin Super User with complete access.

◦ A Proxy with FAFSA Parent Delegate access and a Proxy with Non-FAFSA Parent Delegate access.

• Available permissions are appropriate to the selected Role. For example, a Student role can’t have permission to
manage Self-Service Settings.

In addition to managing Role Permissions through the Self-Service UI, you can establish newly defined roles via SAML.

Manage Role Permissions
Create and maintain Role Permissions to control access to the Student Self-Service UI by Role Categories.

Manual Processing Steps
Student Self-Service Login

A Self-Service User Type of Admin is required to access Settings.

1. Log into Student Self-Service as an Admin.
2. Navigate to Settings > Role Permissions.

To add a Role:

1. Click Add Role.
2. Under the Details tab:

a. Select a Category: Student, Admin, or Proxy.
b. Enter a Description. This value populates the Code field by default.
c. Click the pencil icon to edit the Code field. This field must be unique. Don’t enter a previously used Role

Code.
d. Select the desired Permissions for this Role by selecting the associated check boxes.

3. Click Save.

To remove a Role:

1. Select a Role.
2. Click Remove Role.
3. Click Remove.

To view users, assign users to a Role, or un-assign users from a Role:

1. Select a Role.
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2. Select the User Assignment tab. All users are displayed. Users who are assigned that role have an active check
box.

3. To search for a user, enter any part of the user’s First Name, Last Name, or External Student ID into the Search
for users to assign field and click Search to filter the list of users. Searches are in the context of the selected
Role.

4. To assign a user to a Role, select the check box beside their name, and click Save.
5. To un-assign a user from a Role, deselect the check box beside their name, and click Save.

Manage Self-Service Branding  
As an Administrative user, you can define the branding appearance for the delivered self-service pages.

Manual Processing Steps
Student Self-Service Login

A Self-Service User Type of Admin is required to access Settings. The Branding Preview window display changes
dynamically as you alter the settings.

1. Enter the Institution Name Label. This is the preferred institutional name label displayed in the page footer
and the About prompt that displayed when clicking the logo.

2. Enter the Primary Color. This is the hexadecimal color scheme you want to use.
3. Enter the Logo Height. This controls the size of your logo in terms of number of pixels.
4. Click the UPLOAD A LOGO IMAGE button to upload an image of your logo in one of these formats: png, jpeg,

gif or svg. The maximum file size is based on the value configured in Application Properties in the environment
which defaults to 25MB. To change your maximum file size configured in Application Properties, submit a
Service Request on My Oracle Support at https://support.oracle.com.

5. Select Advanced Logo Configuration to access optional fields to configure your logo. These adjustments are
made in terms of number of pixels:

◦ Enter the Logo Top Margin.

◦ Enter the Logo Left Margin.

◦ Enter the Logo Max Height. Use this field to customize the maximum Logo Height.

6. Click Save.

Manage Email Communication Preferences  
As an Administrative user, you can manage email communication preferences.

Overview
You can enable Student Self-Service users to receive an email communication when an Admin user manually adds a
new user through the manage users page or through the API. Parent users can also receive an email communication
notifying them of account creation once a student completes the FERPA process and adds the account. The triggered
email includes the username and an activation link to reset their password upon initial login. The activation link
included in email communication expires after 7 days.
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Manage Email Communication Preferences
Select which user types you want to receive enable account creation emails.

Manual Processing Steps
Student Self-Service Login

A Self-Service User Type of Admin is required to access Settings.

1. Log into Student Self-Service as an Admin.
2. Navigate to Settings > Email Communication Preferences.
3. Select the check box for the user types you want to enable: Admin, Student, Guests.
4. Click Save.
5. Click the Reset button to clear selections.

Manage SAML Attribute Names  
As an Administrative user, you can manage Security Assertion Markup Language (SAML) Attribute Names.

Overview
You can configure user-friendly names for data items used in SAML single sign-on when accessing Student Self-
Service.

Manage SAML Attribute Names
Use this feature to assign user-friendly names to SAML Attribute Data Items. Here are the delivered data items with the
corresponding default attribute names (labeled Attribute Names or Friendly Names):

Data Item Attribute Name or Friendly Name

First Name FirstName

Last Name LastName

Email EmailAddress

Roles Roles

Phone PhoneNumber

External ID StudentID

Manual Processing Steps
SFA Administration Sign In

The application requires a Role Permission of Administration.

1. Log into the Student Financial Aid FAS UI.
2. Navigate to Administration > System Management > Configuration Administration.
3. Select the appropriate SAML_ATTRIBUTE.CSV workbook file and submit.
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Student Self-Service Sign In

The application requires a Self-Service User Type of Admin to access Settings.

1. Sign into Student Self-Service as an Admin.
2. Navigate to Settings > SAML Attribute Name Mapping.
3. Select the data item to modify.
4. Enter an attribute name or friendly name.
5. Click Save.

Manage Guest and Student Authentication Mode  
As an Administrative user, you can Manage Guest and Student Authentication Modes.

Overview
You can choose how to authenticate students, guests, and parents when they access the system.

These are the possible user setting combinations for accessing the Self-Service UI:

• Guest and Student Local Authentication

• Guest and Student SAML Authentication

• Guest Local Authentication and Student SAML Authentication

For more information about authentication and access, see Integration of SAML 2.0 and SSO.

Manual Processing Steps
Student Self-Service Login

A Self-Service User Type of Admin is required to access Settings.

1. Log into Student Self-Service as an Admin.
2. Navigate to Settings > Guest And Student Authentication Mode.
3. Select the radio button for the desired mode.
4. Click Save.

Define Configurable Content  
As an Administrative User, you can Define Configurable Content for Self-Service.

Overview

Note:  Configuration that is applicable to Student Financial Planning (SFP) only is indicated.

You can configure text for:

• Cost of Attendance Component Labels.

• Electronic Consent Message.
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• Electronic Signature Consent.

• Financial (Future Projection) (SFP only).

• Fund Acceptance (3 distinct pages) (SFP only).

Each of the configuration pages is pre-populated with text that can be edited with the included rich text editor. The
editor has a placeholder drop down of predefined variables that can be inserted into the text. This allows you to include
contextual, student-specific information.

Define Cost of Attendance (COA) Component Labels (SFP only)
The Cost of Attendance (COA) on the Financials tab contains two rows: one row for COA components configured as
Standard (for example, Tuition and Fees) and one for COA components configured as Budget (for example, Living and
Other Expenses). The default label for the Standard COA components row is Tuition and Fees, and the default label for
the Budget COA components is Living and Other Expenses. Use the Budget COA components and Standard COA
components tabs to configure different labels for each row, as needed. If you don't configure different COA component
labels, then the default labels are used. Any configuration for the Standard COA label is also used in Step 2 of the Fund
Acceptance workflow in Self-Service.

Define the Electronic Consent Message
The Student Self-Service User Interface includes a prompt for a new user to accept a consent to do electronic business
transactions with the institution. You can configure the text for the consent message from the Self-Service settings
screen. After a user accepts the consent, the user is not prompted in subsequent logins. Only student or parent users
are prompted. Admin Self-Service users are not prompted.

Define the Electronic Signature Consent Page
Configure the content for the following displays in the Self-Service UI where an electronic signature can be used:

• Financial Tab - Fund Acceptance Workflow, Step 4. (SFP only)

• Review/Accept your Post-Withdrawal Disbursements Wizard. (SFP only)

• Review/Accept your Late Disbursements Wizard. (SFP only)

• Verification Worksheet (Dependent and Independent) Smart Form.

• Authorization to Hold (ATH) election Wizard. (SFP only)

Define the Financial (Future Projection) Page (SFP only)
Configure the content for the Self-Service Financial page for when the user selects a future award year to view.

Define the Fund Acceptance 1 Page (SFP only)
Configure the content for Step 1 – Summary of the Accept Your Funds Self-Service page.

Define the Fund Acceptance 2 Page (SFP only)
Configure the content for Step 2 – Accept Loans of the Accept Your Funds Self-Service page.
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Define the Fund Acceptance 3 Pages (SFP only)
Configure the content for Step 3 – Confirm of the Accept Your Funds Self-Service page. The language can vary
depending upon the action taken in Step 2 – Accept Loans so there are three different configurations to set up:

• For users who accept the entire award as offered, use the Fund Acceptance 3 (Fully-funded) page to edit the
content.

• For users who request a higher amount than offered but within maximum limits, use the Fund Acceptance 3
(Over-funded) page to edit the content.

• For users who accept a lower amount than offered, use the Fund Acceptance 3 (Under-funded) page to edit
the content.

Manual Processing Steps
Student Self-Service Login

A Self-Service User Type of Admin is required to access Settings.

1. Log into Student Self-Service as an Admin.
2. Navigate to Settings > Configurable Content.
3. Select the tab for the content you want to configure.
4. Add or edit the text.
5. Click Save.
6. Click the Reset button to re-populate the field with the message delivered with the application.

Manage Student Announcements  
As an Administrative User, you can manage student announcements.

Overview
The Student Self-Service User Interface can display an Announcement message at the top of the Home page when a
user logs in. The announcement can added, edited, or removed by an Admin user in the Self-Service settings screen.

Manual Processing Steps
Student Self-Service Login

A Self-Service User Type of Admin is required to access Settings.

1. Log into Student Self-Service as an Admin.
2. Navigate to Settings > Manage Student Announcements.
3. To add an announcement:

◦ Click New Message.

◦ Enter the message title and text.

◦ Click Save.

4. To edit an announcement:

◦ Click Edit.
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◦ Edit the title or text or both.

◦ Click Save.

5. To remove an announcement:

◦ Click Remove.

◦ Click OK.

Manage College Financing Plan  
You can configure the information displayed on the student's College Financing Plan (CFP), formerly known as Shopping
Sheet.

Manual Processing Steps
Student Self-Service Login

A Self-Service User Type of Admin is required to access Settings.

1. Log into Student Self-Service as an Admin.
2. Navigate to Settings > College Financing Plan Configuration..

Note:  CFP Funds Configuration that was previously setup in Self-Service Settings is now done using the
Fund CFP Guide.

3. Click Configuration tab to enable the CFP by Template Type and Award Year.
4. Select a Template Type:

◦ Graduate Students.

◦ Undergraduate Students.

5. Select an Award Year.
6. Click Loan Options.
7. Select an Award Year.
8. Select a Template Type:

◦ Graduate Students.

◦ Undergraduate Students.

9. Enter the Interest Rate and Loan Fees for each loan type.
10. Click Save.
11. Click Work Options.
12. Select an Award Year.
13. Select a Template Type:

◦ Graduate Students.

◦ Undergraduate Students.

14. Enter the:

◦ Work-Study Hours Per Week (estimated) (graduate or undergraduate).

◦ Work-Study Amount Per Year (graduate or undergraduate).

◦ Assistantships Amount Per Year (graduate only).

◦ Other Campus Job Amount Per Year(undergraduate only).
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Note:  Beginning with the 2023-2024 Aid Year and forward, if you package students with Fund Codes that
have a CFP_Category of Work Study, Other Campus Job, or Assistantship, you don't need to enter values
for these fields. Only enter a value in these fields if you would like to display a standard value for a specific
template type and Aid Year when a student isn't packaged for the corresponding Fund Code.

15. Click Save.
16. Click Configurable Content Options.
17. Enter Institution Name.
18. Select an Award Year.
19. Select a Template Type:

◦ Graduate Students.

◦ Undergraduate Students.

20. Enter text in the:

◦ Loan Amounts Section: Default text is delivered beginning with the 2022-2023 Award Year.

Note:  For the 2021-2022 Award Year, enter the text provided by U.S. Department of Education in their
CFP templates for the Loan Amounts Section.

◦ For More Information Section.

◦ Education Tax Benefits Section: Removed effective with the 2022-2023 Award Year.

Note:  For the 2021-2022 Award Year, enter the text provided by U.S. Department of Education in their
CFP templates for the Education Tax Benefits Section.

◦ Next Steps Section.

◦ Customized Information Section.

21. Click Save.

Manage Self-Service Documents  
As an Administrative User, you can manage self-service documents.

You can make PDF templates of documents available for assignment in Student Self-Service for users to download,
complete, and upload to meet Document requirements.

Manual Processing Steps
Student Self-Service Login

A Self-Service User Type of Admin is required to access Settings.

1. Log into Student Self-Service as an Admin.
2. Navigate to Settings > Document Settings.
3. To add a document:

a. Click Upload New Template.
b. Select the document name.
c. Enter a template name.
d. Choose a PDF.
e. Click Upload File.
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4. To remove a document:
a. Click the Remove link for the document.
b. Click OK.

Manage Self-Service System Settings Configuration  
You can enable or disable a variety of Student Self-Service System Settings.

Manage System Settings
Here are the system settings available for Student Self-Service.

Note:  Settings applicable to Student Financial Planning (SFP) only are indicated.

• Enable Authorization To Hold Notification -(SFP only): Select this option to prompt student and parent users
to elect whether they would like the school to hold their credit balances to cover specific fees and/or future
charges. Only enable this option if the school is leveraging SFP to calculate the credit balance for the student or
parent.

• Enable Pell Fund Acceptance -(SFP only): Select this option to enable students to accept a Pell Grant award.

• Enable IASG Fund Acceptance -(SFP only): Select this option to enable students to accept an IASG award.

• Enable FSEOG Fund Acceptance -(SFP only): Select this option to enable students to accept a FESOG award.

• Enable TEACH Fund Acceptance -(SFP only): Select this option to enable students to accept a TEACH award.

• Enable ISIR Only View: Select this option to limit the student or parent user’s view to Step 1– Become Financial
Aid Eligible on the Home page and hide the Financial tab in Student Self-Service.

• Enable FERPA Consent: Select this option to make verification of FERPA consent a requirement when enabling
delegated access to a guest or parent user in the student’s profile.

• Enable Delegated Access: Select this option to enable the application to validate whether a FERPA consent
form has been signed and if the logged-in user matches the delegated access user.

• Enable Two Step Dependent VWS Signatures: Select this option to require the dependent verification
worksheet be signed by two different users in two different login sessions. If not selected, the worksheet can be
signed by two users in one session.

• Enable PLUS in Fund Acceptance workflow -(SFP only): Select this option to include PLUS offers with other
Direct Loan fund types in the fund acceptance workflow.

• Enable GPLUS in Fund Acceptance workflow -(SFP only): Select this option to include Graduate PLUS offers
with other Direct Loan fund types in the fund acceptance workflow.

• Maximum Number of Document Uploads: Select the maximum number of files that a user can upload when
uploading unrequested Documents. Default value is 10.

Manual Processing Steps

A Self-Service User Type of Admin is required to access Settings.

1. Log into Student Self-Service as an Admin.
2. Navigate to Settings > System Settings Configuration > System Settings.
3. To enable a system setting, select the check box for the setting.
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4. To disable a system setting, deselect the check box for the setting.

Manage Funds Configuration (SFP only)
Enable or disable which Fund's awards are displayed in Student Self-Service when they are in Projected status.

Manual Processing Steps

A Self-Service User Type of Admin is required to access Settings.

1. Log into Student Self-Service as an Admin.
2. Navigate to Settings > System Settings Configuration > Funds Configuration.
3. To enable display of a Projected award from a Fund in Student Self-Service, select the check box for the Fund.
4. To disable display a Projected award from a Fund in Student Self-Service, deselect the check box for the Fund.
5. Click Save.

Manage Self-Service Password Policy  
Manage the requirements for Self-Service passwords.

You can define the password policy for users accessing Self-Service.

Manual Processing Steps
Student Self-Service Sign In

A Self-Service User Type of Admin and Role permission of Update Password Policy is required to access Settings and
manage the Self-Service Password Policy Configuration.

1. Gin into Student Self-Service as an Admin.
2. Navigate to Settings > Password Policy Configuration > System Settings.
3. Enter a value for each field you want to use to define password requirements. All fields are optional except for

Special Characters:

◦ History Count specifies the number of previous passwords saved for each user and compares it with
an intended new password. If there is a match with one of the previous passwords, or with the current
password, it will reject the intended new password.

◦ Expiration Period (days) is the number of days after which a password expires.

◦ Minimum Length is the minimum number of characters required.

◦ Minimum Lower Case Characters is the minimum number of lower case characters.

◦ Minimum Upper Case Characters is the minimum number of upper case characters.

◦ Minimum Numbers is the minimum number of numeric characters.

◦ Minimum Special Characters is minimum number of special characters.

◦ Special Characters are the available special characters that can be used. Choose at least 1 of these: ~!@#
$%^&*()_-+={}[]\|:;'<>,.?/".

4. Click Save.
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